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FOREWORD 

 
The Forensic Biology Section in the Forensic Services Division of the Indiana State 
Police (ISP) conducts tests on various body fluids, body fluid stains, and human 
hair for criminal justice agencies.  DNA analysis is performed as needed on various 
biological materials.  The Forensic Services Division reserves the right to evaluate 
and prioritize the items submitted and limit the total number to expedite service and 
to manage available resources.  The accuracy and specificity of test results are 
ensured by running known controls with each set of tests. 
 
The analysts of the Forensic Biology Section shall have a minimum of a 
baccalaureate or an advanced degree in a natural science or a closely related field.  
Analysts should have successfully completed college coursework covering  subject 
areas such as genetics, biochemistry, molecular biology, and statistics.  All analysts 
undergo a formalized training program covering forensic techniques and 
instrumentation. Successful completion of the Training Program is required before 
analysis of evidence is performed.  Additionally, all analysts participate in external 
proficiency testing from an accredited vendor. 
 
A technician shall follow the same guidelines and procedures as an analyst in all 
methods in which they are authorized.   
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1.  Serology Methods: 

1.1. Scope: This test method is designed for the guidance of Biology Section personnel who assist 
investigations where body fluids or stains occur as physical evidence in a variety of alleged criminal 
activities.  The scope of this type of evidence includes but is not limited to the following:  identification 
of human blood, semen, and human hair.  This test method may be expanded or altered as 
techniques and/or new genetic analyses are found applicable and validated. 

1.1.1. Trace evidence including but not limited to hair, fibers, glass, or paint may be examined.  Trace 
evidence shall be retained in the original packaging unless value is immediately apparent.  
Appropriate notes shall be taken on the trace evidence collected.  When appropriate, hairs may 
be evaluated for the possibility of human origin and the potential for future analysis. 

1.1.1.1. If evidentiary value is immediately apparent, microscopic hair identification or DNA 
analysis may be performed. If no microscopic examination is performed, both ends of one 
hair shall be cut into the same tube for extraction. 

1.1.2. A search is made of submitted items for the presence of biological material.   
1.1.3. Previously retained items may be released at the prosecutor’s request.  The request shall be 

documented in the case record.  A valid court order shall circumvent this procedure. 
1.2. Precautions/Limitations: 

1.2.1. Evidence 
1.2.1.1. Liquid items such as blood standards shall be refrigerated not frozen.  Stained materials 

may be frozen, refrigerated or stored at room temperature in a dry environment.  Items to 
be analyzed for latent prints should not be frozen or refrigerated. 

1.2.1.2. Stains that are still moist shall be air dried in a secure area before submission to a 
Regional Laboratory. 

1.2.1.3. Clean paper or cardboard containers shall be used to package dried evidence.  Plastic 
containers shall not be used for packaging because they hold moisture which often leads 
to putrefaction of biological materials.  Exceptions to this rule would include blood tubes, 
body tissue samples and condoms.  Each item should be placed in separate containers 
from the point of collection.   

1.2.1.4. If multiple items are placed in one container at time of collection, they may be submitted in 
the single, original package. 

1.2.1.5. Specific examinations performed on items of serological evidence shall be determined by 
Forensic Services Division personnel. 

1.3. Related Information:  
1.3.1. Appendix 1 Flow Charts 
1.3.2. Work Sheet Manual 

1.4. Instruments: 
1.4.1. Balances – An analytical balance used for preparation of analytical reagents and buffers. 
1.4.2. Centrifuges – A serofuge capable of operating at 3,400 rpm and a microcentrifuge capable of 

greater than 15,000 rcf, are used for separation of solid components from fluids. 
1.4.3. Alternate light source (ALS) – A light source to aid in the location of stains and trace evidence 

by use of various wavelengths of light. 
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1.4.4. Crosslinker - Preprogrammed ultraviolet exposure unit which is factory set to ~120,000 
microjoules per cm2.  

1.4.5. Digital camera – Used to document evidence and/or the packaging. 
1.4.6. Microscopes – A light microscope with magnification up to 400X, a stereoscope for general 

screening of items, and a phase contrast microscope for the identification of spermatozoa. 
1.4.7. Miscellaneous Laboratory Equipment – Supportive laboratory equipment including ovens, 

incubators, pipettors, rotators, stirring/heating plates, vortex mixers, vacuum pumps, UV lights, 
and refrigerators/freezers for storing of reagents, buffers, and evidence.   

1.4.8. pH meter – An instrument capable of manual or automatic temperature compensation and 
reading +/- 0.01 pH units.  Used for preparation of buffers and reagents. 

1.5. Reagents/Materials: See Reagent Preparation Manual for instructions and logs.  
1.5.1. Alpha Naphthyl Phosphate Solution 
1.5.2. Acid phosphatase Acetate Buffer 
1.5.3. Acid phosphatase Dye Solution 
1.5.4. Glucose, saturated 
1.5.5. HemDirect Hemoglobin Cassettes 
1.5.6. HemDirect Hemoglobin Buffer 
1.5.7. 3% H2O2 
1.5.8. Phenolphthalein Stock Solution 
1.5.9. Phenolphthalein Working Solution 
1.5.10. 10% Sodium Hydroxide 
1.6. Hazards/Safety: 
1.6.1. All chemicals shall be handled in a safe method as referenced in the specific SDS. 
1.6.2. Preparation of the Phenolphthalein Stock Solution shall be performed in a chemical fume hood. 
1.6.3. Universal Precautions shall be in use whenever biological materials are being handled. 
1.6.4. Extreme caution shall be used when handling liquid body fluid samples. 
1.6.5. Biological waste shall be disposed of in the appropriate waste receptacle. 

1.7. Reference Materials/Controls/Calibration Checks:  
1.7.1. HemDirect Hemoglobin tests shall be performance checked before use in casework. 

1.7.1.1. Each new lot of HemDirect Hemoglobin Tests shall be analyzed with a 1:10 dilution of 
blood dried on filter paper or a 1:500 dilution of liquid human blood.  A positive result as 
described in the HemDirect test method shall be obtained before use in casework.  The 
worksheet used to record the results shall be retained. 

1.7.1.2. If the lot fails, the quality control test it may be retested.  If it fails a second time the lot 
shall not be used for casework.  The Technical Leader shall be informed within one 
business day of the failure.  

1.7.2. Running known controls with each test ensures the accuracy and specificity of the test results.  
See the specific test procedure for the appropriate controls to be run. 

1.8. Procedures/Instructions: 
1.8.1. Examination Procedure 

1.8.1.1. Standards for Comparison 
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1.8.1.1.1. Appropriate standards, such as whole blood or buccal swabs, from those individuals 
involved should be submitted along with the unknown materials to be analyzed. 

1.8.1.1.2. The whole blood standard should be submitted in a purple top tube that contains 
ethylene-diamine-tetra-acetic acid (EDTA).  Prior to examination, while in the custody 
of the ISP Forensic Services Division, this tube shall be refrigerated. 

1.8.1.1.3. A stain card may be prepared from at least one whole blood standard from each 
individual. 

1.8.1.1.4. Buccal swab standards containing multiple swabs from an individual may be labeled 
and treated as one item. 

1.8.1.1.5. Oral swabs in a sexual assault kit with no identified standard may be used as a 
standard if a single source profile is obtained.    

1.8.1.1.6. The analyst’s notes shall indicate the presence of hair standards. In sexual assault 
kits where a blood or buccal swab standard is present the hair standards do not need 
to be opened or examined, just noted. 

1.8.1.1.7. DNA profiles shall be generated from suspect standards in all cases and from victim 
and elimination standards in crimes against person cases. DNA profiles may be 
developed for victim and elimination standards in property crimes; however it is not 
required if no unknown profiles are developed for comparison. If any analysis is 
performed (e.g. extraction through quantification), then the DNA profile data should 
be generated. 

1.8.1.1.8. In cases where a secondary standard is needed, the item to be used as a secondary 
standard shall be clearly identified as such in the item description section of the case 
report.   

1.8.1.1.8.1. The use of a blood stained article of clothing may be appropriate if stains from 
the person wearing the clothing can be definitively identified (i.e., blood from 
around the wound area). 

1.8.1.1.8.2. In the case of a missing person, personal items such as toothbrush, hairbrush, 
razor or other item may be submitted.  

1.8.1.1.8.3. When a contributor requests items to be used as secondary standards during the 
submission process, it should be indicated on the Request for Laboratory 
Examination form. 

1.8.1.1.8.4. Items collected as surreptitious standards or from trash pulls to be used for 
comparison shall be clearly identified within the body of the report. If a statistic is 
calculated, it shall be reported as “purported to belong to” or “contributor of the 
DNA profile from item #.” 

1.8.1.1.8.4.1. If items within the trash pull generate profiles from different individuals of 
the same sex as the person of interest, no assumptions of profile 
ownership shall be done and no statistics shall be calculated. 

1.8.1.1.8.4.2. Mixtures from trash pulls shall not be utilized for comparison.    
1.8.1.2. Trace Evidence 

1.8.1.2.1. A clean piece of paper shall be used under each item as it is examined.  The exam 
paper should be retained in the original package.  After returning the item to its 
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package, fold the exam paper, tape it closed (making sure all trace evidence is 
secure within the bundle) and place it in the package with the item. 

1.8.1.2.2. Items may be tape lifted to collect evidence.  Where tape lifting is not appropriate, 
tweezing and/or scraping may be substituted.  Items involving multiple examination 
requests shall only be tape lifted or scraped after consultation with analysts from the 
other disciplines. 

1.8.1.2.3. All collected trace evidence shall be stored with original item unless value is 
immediately apparent. 

1.8.1.2.4. Analysts shall document in the notes the presence of hair, fibers, plant material, 
glass, paint, etc.  Such trace evidence shall be reported out only when it is deemed 
to have value.  In those cases where the material appears to be extraneous debris of 
no significance, the trace statement may be omitted from the report. 

1.8.1.2.5. Hair combings need not be opened or examined, just their presence noted. If 
opened, the approximate number and quality of hairs shall be documented. 

1.8.1.2.6. In cases where there is other DNA evidence of investigative value that has been 
tested and profiles obtained, no DNA testing of the collected hair shall be performed 
without the approval of a Biology Unit Supervisor or Laboratory Manager. 

1.8.1.2.7. When appropriate, examination of the hair collected may be performed to determine 
if hair consistent with human origin is present. 

1.8.1.2.8. Human hairs can be submitted for DNA analysis when evidentiary value is 
immediately apparent. 

1.8.1.2.9. If microscopic examination is not performed prior to DNA analysis, both ends of 
possible hairs shall be cut into one tube for DNA analysis. 

1.8.1.3. Dried Stains  
1.8.1.3.1. Visual Inspection – A visual inspection of the item shall be conducted to determine 

the location, if present, of unknown stains.  An ultraviolet light or an alternate light 
source may be used to help locate stains. 

1.8.1.3.2. Confirmatory testing for semen and blood/human blood is at the discretion of the 
analyst. 

1.8.1.4. Stain Evaluation – Sexual Assault kits  
1.8.1.4.1. No serological testing shall be performed on samples within a kit. 
1.8.1.4.2. Exceptions require notification to a supervisor with documentation in the case record. 
1.8.1.4.3. Acid Phosphatase testing and sperm searches may be done at the request of a 

Prosecutor with proper justification and documentation in the case record.  
1.8.1.5. Stain Evaluation – All other   

1.8.1.5.1. After attempting to identify the stain, the stain shall be evaluated for further testing. 
1.8.1.5.2. If no biological material is identified on the item, no further testing shall be performed, 

except for instances where touch DNA or handler/wearer analysis is appropriate. 
1.8.1.5.3. If the stain is found to be biological, the analyst shall determine if DNA testing is 

performed based on an evaluation of the stain.  Things that may be considered 
include, but are not limited to, the amount, size, concentration, location, and 
condition of the stain. 
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1.8.1.6. Collection and labeling of swabs (or other items such as shoes, sheets, etc.) 
1.8.1.6.1. Each swab in a submitted item shall have a unique identifier if serological testing is 

performed on any of the swabs for that item.  If different testing results are obtained 
between swabs in the same item, each result will be reported. 

1.8.1.6.2. Swabs may be used as a sampling method for DNA analysis. If no serological testing 
is performed and the swabs are being treated as one sample (i.e., portions of all 
swabs are combined together for DNA analysis), the swabs do not need to be 
distinguished in the report or described as “combined”. 

1.8.1.6.2.1. If the swabs are being treated differently for DNA analysis (i.e., one swab 
is tested while the other is not), the samples shall have unique identifiers 
and be reported separately.  

1.8.2. Sampling of items that may contain unknown or dangerous drugs 
1.8.2.1. Caution should be exercised when opening and examining evidence with unknown 

powders and liquids or known dangerous powders or liquids.  Every effort should be made 
to prevent exposure to potentially hazardous materials. If there is any concern or 
knowledge about a specific hazard, analysts may use a fume hood for processing. 

1.8.2.2. Narcan (or similar product) should be available and in a clearly marked location during 
analysis. 

1.8.3. Phenolphthalein (Kastle-Meyer Reagent), Presumptive Test for Blood 
1.8.3.1. Principle:  Phenolphthalein is an oxidizable organic molecule, which can be oxidized by 

free hydroxyl ions liberated by peroxidase-like action.  The heme group of hemoglobin 
possesses a peroxidase-like activity, which may catalyze the breakdown of hydrogen 
peroxide to form free hydroxyl radicals.  Phenolphthalin (reduced form) is oxidized by the 
free hydroxyl ions to phenolphthalein (oxidized form), producing a pink color. 
Phenolphthalein (abbreviated Phe on controlled worksheets) is a presumptive test for the 
presence of blood.  Confirmatory testing shall be performed for conclusive identification.  
Phenolphthalein has been shown to give false positives or weak reactions with various 
oxidizing agents, plant material, etc. 

1.8.3.2. Procedure 
1.8.3.2.1. Rub the suspected bloodstain with a piece of filter paper or a cotton swab or make a 

small cutting of the suspected bloodstain and place on white filter paper or in a white 
spot plate well. 

1.8.3.2.2. Add one to three drops of the phenolphthalein working solution to the stain. 
1.8.3.2.3. Wait 10-15 seconds, assuring no pink color develops at this time. 
1.8.3.2.4. Add one to three drops of 3% Hydrogen Peroxide. 
1.8.3.2.5. Upon addition of the Hydrogen Peroxide an immediate pink color is indicative of the 

possible presence of blood. 
1.8.3.3. Reagents shall be tested with positive and negative controls and the results recorded in 

the case notes.  This shall be performed and recorded daily when in use and prior to use 
on evidence.  Lot numbers and/or preparation dates of reagents shall also be recorded. 

1.8.4. HemDirect Hemoglobin Test, Confirmatory Test for Human Blood 
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1.8.4.1. Principle:  Human blood reacts with an anti-human hemoglobin antibody, which forms a 
red line in the “test” region of the HemDirect cassette.   

1.8.4.2. Procedure 
1.8.4.2.1. Place a ~2mm² cutting, a few flakes, a few drops of liquid blood diluted to 1:500, or 

~1/8 of a swab in the tube of supplied extraction buffer.  The cutting shall remain in 
the buffer solution for 5 minutes.  A maximum extraction time of 10 minutes may be 
utilized for inhibited samples. 

1.8.4.2.2. Add three drops of the extraction buffer/sample mix with the provided pipette to the 
sample well of the cassette. 

1.8.4.2.3. A positive result may be recorded as soon as red lines are observed in both the “C” 
(control) and “T” (test) regions.   

1.8.4.2.4. Negative results (a red line in only the “C” region; no line in the “T” region) should be 
confirmed after 10 minutes. 

1.8.4.2.5. If a line in the “C” region does not appear after 10 minutes, test results are invalid 
and shall be repeated. 

Each new lot of HemDirect kits shall be performance checked before use.  Additional 
testing of reagents with positive and negative controls before use on evidence is not 
required.  Lot numbers of reagents and the result of the internal positive control shall be 
recorded. 

1.8.5. Acid Phosphatase, Presumptive Test for Semen 
1.8.5.1. Principle: Seminal fluid is typically found to contain acid phosphatase in levels 400 -1000 

times those found in other body fluids.  This test uses the ability of acid phosphatase to 
hydrolyze a phosphate ester substrate to release a free alcohol, which in turn reacts with a 
diazonium salt to give a brilliantly colored end product. 

 Acid Phosphatase (abbreviated AP on controlled worksheets) is a presumptive test for the 
presence of semen.  Conclusive identification of semen can only be done by performing 
confirmatory testing.  Possible sources of acid phosphatase other than semen include 
vaginal secretions, urine, sweat or fecal material. 

1.8.5.2. Procedure: Prepare substrate and dye solution immediately prior to testing.  These 
solutions will be stable for 1-2 hours at room temperature.  Alternatively, use previously 
aliquoted and frozen solutions.  

1.8.5.2.1. Weigh out about 20 μg of alpha naphthyl phosphate and place in shell vial or small 
test tube. 

1.8.5.2.2. Weigh out about 20 μg of fast blue or fast red dye (shall be in diazonium salt form) 
and place in second shell vial or small test tube. 

1.8.5.2.3. Add about 1 ml of acetate buffer to each and mix. 
1.8.5.2.4. Cut a small (approximately 2 mm x 2 mm) portion of the stained material and place it 

on a small piece of filter paper, in a white ceramic spot plate well or in a small test 
tube.  An extract can be used. 

1.8.5.2.5. Wet the cutting with the alpha naphthyl phosphate solution.  Wait about 1 minute. 
1.8.5.2.6. Add 1-2 drops of the dye solution to the cutting. 
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1.8.5.2.7. The development of color (depending on dye used) in less than 15 seconds is 
indicative of the presence of acid phosphatase.  Color soaked into the filter paper 
under the sample is also indicative of a positive test.   

1.8.5.2.8. A slow development of color could be an indication of acid phosphatase from 
sources other than semen.  This may be indicated on the worksheet as a slight color 
change (SCC).  A SCC result shall be reported as a negative result.    

1.8.5.2.9. The interpretation of the results shall be reported by the analyst. 
1.8.5.3. Reagents shall be tested with positive and negative controls and the results recorded in 

the case notes.  This shall be performed and recorded daily when in use and prior to use 
on evidence.  Lot numbers and/or preparation dates of reagents shall also be recorded. 

1.8.6. Extraction of Body Fluid Stains 
1.8.6.1. Principle: Evidentiary stains can be extracted and the extracts used for body fluid stain 

identification. 
1.8.6.2. Procedure 

1.8.6.2.1. Prepare samples (and backgrounds, if used) for testing by eluting a cutting of the 
stain (approximately 3 mm by 3 mm) in an appropriate amount of distilled water in a 
microcentrifuge tube overnight in the refrigerator.  Alternatively, the sample can be 
eluted in a 37°C oven for a minimum of 30 minutes or at room temperature for a 
minimum of 1 hour. 

1.8.6.2.2. After incubation, the cutting should be removed, placed into the cap with holes for 
drainage or a spinex basket, and the extract spun down. 

1.8.7. Confirmation of Seminal Material 
1.8.7.1. Principle: The visual identification of spermatozoa is a scientifically accepted method of 

positively identifying the presence of seminal material. 
1.8.7.1.1. The observations should be rated using the following system: 

POS (+) Only a few sperm or sperm heads on the entire slide. 
1+     One sperm or sperm head per several fields of view. 
2+     One sperm or sperm head in about half of all fields of view. 
3+     One sperm or sperm head in most fields of view. 
4+     Several sperm or sperm heads in most fields of view. 

1.8.8. Phase Contrast Microscopy for the Visual Observation of Spermatozoa 
1.8.8.1. Principle: Phase contrast microscopy is used to differentiate the cellular appearance.  

Spermatozoa are round to ovoid with an acrosomal cap, midpiece, and tail.  When the tail 
and midpiece are not present, the distinctive flattened profile of turned spermatozoa 
should be observed. 

1.8.8.2. Procedure 
1.8.8.2.1. Place ~10 μl of the pellet from the bottom of a previously extracted sample on a 

microscope slide and cover. 
1.8.8.2.2. Alternatively, a small (1 mm x 1 mm) cutting may be eluted directly onto the slide 

with a drop of distilled water, agitating with forceps.  Remove the cutting and cover 
the extract with a cover slip. 
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1.8.9. Christmas Tree Stain (Kernechtrot-Picroindigocarmine Differential Stain) (Optional 
procedure to help visualize spermatozoa) 

1.8.9.1. Principle: The Christmas tree stain is used to assist in scanning slides for the presence of 
spermatozoa.  Red and green colored stains are utilized to enhance the appearance of 
spermatozoa and epithelial cells in biological samples. 

1.8.9.2. Procedure 
1.8.9.2.1. Pipette ~5-10 μl of the pellet from the bottom of extracted sample tube and place 

onto microscope slide.  Previously prepared slides from the evidence collection kit 
may go directly to heat fix and staining procedures. 

1.8.9.2.2. Alternatively, a small (1 mm x 1 mm) cutting may be eluted directly onto the slide 
with a drop of distilled water, agitating with forceps.  Remove the cutting and cover 
the extract with a cover slip. 

1.8.9.2.3. Also prepare a slide from a 1:50 dilution of a sperm positive semen stain to use as a 
positive control for the staining procedure. 

1.8.9.2.4. Heat fix the sample.  Pre-heat a hot plate to approximately 200°C.  Place the 
prepared slides on the hot plate for approximately 30 seconds. Ensure that the 
sample is dry. Alternatively, a lower temperature with a longer time can be used and 
adjusted, as needed, to adequately fix the sample (e.g. 100 – 140°C heated for  5 – 
20 minutes). 

1.8.9.2.5. After the slide has cooled, place on a level surface and add several drops of the 
SERI Christmas Tree Stain A (red stain) to the slide.  Stain for about 10 to 15 
minutes. 

1.8.9.2.6. Rinse stain from the slide by gently running distilled water over the slide. 
1.8.9.2.7. Return slide to a level surface and add several drops of the SERI Christmas Tree 

Stain B (green stain) to the slide. Stain for about 10 seconds. 
1.8.9.2.8. Rinse stain from the slide by gently running 95 to 100% ethanol over the slide. 
1.8.9.2.9. Allow slide to air dry or dry in 56°C oven.  After drying, slide is ready to view 

microscopically applying bright field procedure. 
1.8.9.3. Reagents shall be tested with a positive control and the results recorded in the case notes.  

This shall be performed and recorded with each batch of staining.  Lot numbers and/or 
preparation dates of reagents shall also be recorded. 

1.8.9.4. Interpretation 
1.8.9.4.1. Spermatozoa will appear as small red/pink structures and have the following staining 

characteristics: 
 Acrosomal cap clear to pink 
 Post acrosomal cap dark pink to red 
 Midpiece green to blue 
 Tail green to blue 

1.8.9.4.1.1. Nucleated epithelial cells will appear as green rhomboid-like structures with a 
red/pink nucleus.  The cell’s appearance can vary in shape, often being folded 
or overlapping and are normally larger than the spermatozoa heads. 

1.8.9.4.2. NOTE:  The smear slides contained in evidence collection kits shall be viewed using 
phase contrast microscopy before proceeding to the Christmas tree stain procedure. 
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1.8.10. Visual Observation of Human Hair 
1.8.10.1. Principle: Before DNA analysis is performed on hair collected as evidence, a 

determination of possible human origin and the identification of the root may be 
performed. 

1.8.10.1.1. Alternatively, both ends of a hair may be cut into one tube for DNA analysis. 
1.8.10.2. Procedure for Identification of Human Hair 

1.8.10.2.1. When the unknown hairs are on a tape lift, the lift should be examined using 
a stereomicroscope to eliminate obvious hair fragments, fibers, and animal 
hairs.  All hairs of possible human origin with sufficient root material should 
be removed from the lift and placed in a paper bindle.  A wet mount should be 
prepared when further examination is required to determine human origin 
and/or presence of root material.  Unknown hairs are placed on a microscope 
slide with a drop of distilled water, covered with a cover slip, and examined 
with a light microscope.  The number and general appearance of human hairs 
should be noted when practical.  If additional hairs/fibers are present in the 
original package, they should be placed in a separate bindle and retained in 
the package. 

1.8.10.2.2. Observation should begin with the presence of scales (imbricate in humans 
and some animals).  Human hairs demonstrate a wide variety in color and 
pigment distribution among individuals.  The color in the cortex should be 
fairly uniform throughout the length and breadth of the hair.  An exception 
would be dyed or bleached hairs, which could demonstrate a sudden or 
gradual color change at the dye line. (Animal guard hairs demonstrate a 
characteristic color banding).  The medulla (the amorphous central core) can 
be continuous, discontinuous, fragmentary, or not present in human hair.  
Medullary index should be one-third or less the total diameter of the hair.  
There is considerable variation in the general appearance of human hairs 
depending on the body area.  In general, there is less variation in diameter 
along the length in human hairs than in animal hairs.  The appearance of the 
root is very important both in determining origin and in determining the area 
to sample for DNA.  The appearance of a large skin tag is not necessarily an 
indication of success in extraction of DNA. 

1.8.10.2.3. Examination documentation shall be of sufficient detail so that an equally 
qualified analyst is provided enough information in the case notes so as to 
reach the same conclusion.  In the case of hair, when a “human hair” 
conclusion is reached the notes shall include observations regarding scale 
type, medulla, coloring/pigment distribution and any other pertinent 
observations. 

1.8.11. Crosslinker Procedure 
1.8.11.1. Consumables (pipette tips, microtubes, columns, etc.) may be exposed in the crosslinker 

for 2 to 15 minutes before use in casework.  Time in excess of 15 minutes shall have the 
approval of the Technical Leader documented in the case record. 

1.8.11.2. The use of the crosslinker may reduce the presence of amplifiable DNA.  
1.9.   Records: 
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1.9.1. If a worksheet is utilized, the examination of sexual assault kits and suspect collection kits shall be 
recorded on an approved worksheet.  

1.9.2. Results of testing of body fluids shall be recorded on the worksheets designed for that purpose, 
or alternatively be recorded in the case notes within the description of the item as long as all 
required controls are documented appropriately. 

1.9.3. All photos and electronically created documentation shall be stored as part of the case record.  
See Appendix 9 for instructions. 

1.9.4. The technical review of the case record shall be recorded on the worksheet provided for that 
purpose. 

1.10. Interpretations of Results: 
1.10.1. The quality and quantity of a sample shall determine which tests are performed.  Conclusions 

reached are based on the actual tests performed in each case.  See specific tests for 
interpretation guidelines. 

1.10.2. The analyst shall report out any identified body fluid stains present and list the number of 
samples tested for DNA in the report. 

1.11. References: 
1.11.1. Forensic Science Handbook. ed. Richard Saferstein. 1982. Prentice-Hall. New Jersey. 
1.11.2. Forensic Science Handbook, Volume I.  ed. Richard Saferstein. 2002. Prentice-Hall. New 

Jersey. 
1.11.3. Forensic Science Handbook, Volume II.  ed. Richard Saferstein. 1988. Prentice-Hall. New 

Jersey. 
1.11.4. Forensic Science Handbook, Volume III.  ed. Richard Saferstein. 1993. Prentice-Hall. New 

Jersey. 
1.11.5. Gaensslen, R.E.  1983.  Sourcebook of Forensic Serology, Immunology and Biochemistry. 

United States Government Printing Office, Washington D.C. 
1.11.6. Jungreis, Ervin.  1997.  Spot Testing Analysis.  John Wiley & Sons, New York. 
1.11.7. Laux, D. L. 1992.  Detection of bloodstains; A Training Manual.  Richfield Ohio. 
1.11.8. Jeyendran, R. S. 2000. Interpretation of Semen Analysis Results, a Practical Guide. Press 

Syndicate of the University of Cambridge, Cambridge, United Kingdom. 
1.11.9. Deedrick, D. W. and Koch, S. L. Microscopy of Hair, Part 1: A Practical Guide and Manual for 

Human Hairs.  Forensic Science Communications. January 2004.  Volume 6(1). 
1.11.10. Deedrick, D. W. and Koch, S. L. Microscopy of Hair, Part 2: A Practical Guide and Manual for 

Animal Hairs.  Forensic Science Communications. July 2004.  Volume 6(3). 
1.11.11. Practical Aspects of Rape Investigation: A Multi Disciplinary Approach. Third Edition. eds.  

Robert R. Hazelwood and Ann Wolbert Burgess.  Elsevier, New York. 
1.11.12. Saferstein, R. 1995. Criminalistics, An Introduction to Forensic Science. Fifth Edition. Prentice 

Hall, New Jersey. 
1.11.13. Instructions for use: SERATEC® HemDirect (Cat No: HBF07).  Rev: 02.2016 
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2. DNA METHODS: 
2.1. Scope: This test method is designed for the guidance of Biology Section personnel who assist 

investigations where the specificity of DNA testing is needed.  Evidence amenable to DNA testing 
includes blood, seminal fluid, saliva, bone, tissue, and hair.  This manual may be expanded or altered 
as new techniques and/or genetic systems are found applicable. 

2.1.1. The DNA is first extracted from the biological sample, quantified, amplified to produce many 
fluorescently tagged copies of specific regions of the DNA and finally processed to separate 
and detect a DNA profile(s).  The analyst compares the DNA profile identified in the sample 
with the DNA profile from a reference standard from an individual to determine similarities 
or dissimilarities.  In addition, the analyst may provide likelihood ratio statistic to give weight 
to the strength of an inclusion or exclusion.   

2.1.2. Return of Evidence 
2.1.2.1. Stain cards from whole blood samples, cuttings from body fluid stains, appropriate 

DNA extracts, and other selected DNA evidence may rarely be retained by the 
Forensic Services Division for any possible future testing.   

2.1.2.2. All extracts are considered work product. Extracts should only be retained if needed 
for pending additional analysis, such as Y-STR, NGS or outsourced analysis. Extracts 
shall be discarded after administrative review when analysis is complete.  

2.1.2.3. Subitems or extracts may be retained in long-term storage with supervisor notification.  
Special storage conditions may be required for long-term retention of extracts.   

2.1.2.3.1. Retained extract tubes shall be labeled with the case number and unique 
sample designation. 

2.1.2.3.2. Unresolved unidentified human remains cases or cold case violent crimes 
against persons cases where additional testing is likely should be considered for 
retention.  

2.1.2.4. Any retained items may be released at the prosecutor’s request.  The request shall be 
documented in the case record.  A valid court order shall circumvent this procedure. 

2.2. Precautions/Limitations: 
2.2.1. Evidence 

2.2.1.1. Liquid items such as blood standards shall be refrigerated. 
2.2.1.2. Stains which are still moist shall be air dried in a secure area before submission to the 

Forensic Services Division. 
2.2.1.3. Clean paper or cardboard containers shall be used to package dried evidence.  

Plastic containers shall not be used for packaging because they hold moisture which 
often leads to putrefaction of biological materials. Exceptions to this rule would include 
blood tubes, body tissue samples and condoms. 

2.2.1.4. Specific examinations performed on items for DNA analysis shall be determined by 
Forensic Services Division personnel. 

2.3. Related Information: 
2.3.1. Worksheet Manual 
2.3.2. Appendix 6 PowerPlex® Fusion 6C Stutter Table 

2.4. Instruments: 
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2.4.1. Applied Biosystems® 3500 Genetic Analyzer Capillary Electrophoresis Instrument – 
Simultaneously separates and detects multiple amplified DNA samples by size by capillary 
electrophoresis using fluorescent tagged primers. 

2.4.2. Applied Biosystems® 7500 Real Time PCR System – Measures accumulation of amplification 
product over time to determine total DNA present by the use of a fluorescent reporter molecule. 

2.4.3. Autoclave - An instrument that uses heat and steam to sterilize solutions, contaminated 
equipment and waste. 

2.4.4. Balance - An analytical balance used for preparation of analytical reagents and buffers. 
2.4.5. BIOMEK i5 Automation Platform – Robotic liquid handling system. 
2.4.6. Centrifuges - A microcentrifuge capable of operating at greater than 15,000 rcf and a clinical 

serofuge capable of operating at a maximum of 3,400 rpm; used for the purification of DNA in 
evidence samples and the separation of solid components from liquids, respectively.  

2.4.7. Crosslinker - Preprogrammed ultraviolet exposure is factory set to 120,000 microjoules per cm2.    
Preset ultraviolet time exposure is factory set to 2 minutes. 

2.4.8. Laminar Flow Hood – An air purifying biohazard cabinet that maintains a nominal inflow velocity 
of 80 fpm which prevents contaminants from entering or escaping the work area.   

2.4.9. Maxwell® 16, Maxwell® FSC, Maxwell® RSC – Robotic extraction system. 
2.4.10. Microscope - A light microscope with magnification up to 400X, a stereoscope for general 

screening of items, and a phase contrast microscope for the identification of spermatozoa. 
2.4.11. Miscellaneous Laboratory Equipment - Supportive laboratory equipment including ovens, 

incubators, pipettors, rotators, stirring/heating plates, vortex mixers, vacuum pumps, UV lights, 
and refrigerators/freezers for storing of reagents, buffers and evidence. 

2.4.12. pH Meter – An instrument capable of manual or automatic temperature compensation and 
reading +/- 0.01 pH units.  Used for preparation of buffers and reagents. 

2.4.13. Thermal cycler - An instrument that can be programmed to rapidly cycle between high and low 
temperatures.  This process is used to make many fluorescently tagged copies of specific 
regions on a DNA strand(s). 

2.4.14. Water Purification System - An apparatus that routes water through a series of filtering devices 
to produce high quality, uncontaminated water used in buffer preparation and DNA typing 
methods. 

2.5. Reagents/Materials:  See Reagent Preparation Manual for instructions and logs where 
appropriate.  Reagents critical to the DNA analysis process are listed in the Critical Reagent Manual. 

2.5.1. Bone Demineralization Buffer 
2.5.2. Digest/Wash Buffer 
2.5.3. DTT 0.39M 
2.5.4. DTT 1M 
2.5.5. EDTA 0.5M 
2.5.6. Nuclease Free Water (NFH2O) 
2.5.7. Phenol/Chloroform/Isoamyl Alcohol 
2.5.8. Proteinase K (Pro K) 10 mg/ml 
2.5.9. Proteinase K (Pro K) 18 mg/ml 
2.5.10. Proteinase K (Pro K) 20mg/ml 
2.5.11. Sarkosyl 20% w/v 
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2.5.12. SDS 20% w/v 
2.5.13. Stain Extraction Buffer Stock Solution 
2.5.14. Stain Extraction Buffer with DTT 
2.5.15. Stain Extraction Buffer for Automation 
2.5.16. TE -4 
2.5.17. TRIS/EDTA/NaCl Solution 
2.5.18. TRIS-HCl pH 7.5, 1M 
2.5.19. TRIS-HCl pH 8.0, 1M 

2.6. Hazards/Safety: 
2.6.1. All chemicals shall be handled in a safe method as referenced in the specific Safety Data 

Sheets (SDS). 

2.6.2. The addition of phenol/chloroform/isoamyl alcohol during extraction, vortexing of the extracts, 
and transfer to Microcon® shall be performed in a chemical fume hood. 

2.6.3. The manual preparation of samples for electrophoresis by the addition of Hi-Di™ formamide 
shall be confined to a chemical fume hood. Caution:  Formamide is an irritant and teratogen; 
therefore, universal precautions and a fume hood shall be utilized when manually working with 
formamide to avoid inhalation and contact with the skin. 

2.6.4. Universal Precautions shall be in use whenever biological materials are being handled. 
2.6.5. Extreme caution shall be used when handling liquid body fluid samples. 
2.6.6. Biological waste shall be disposed of in the appropriate waste receptacle. 

2.7. Reference Materials/Controls/Calibration Checks: 
2.7.1. The accuracy and specificity of test results are ensured by running known DNA controls and 

reagent controls at the same time as evidence samples.  See the specific test for the 
appropriate controls to be run and the interpretation of the results. 

2.8. Procedures/Instructions: 
2.8.1. Examination Procedure 

2.8.1.1. Standards for Comparison 
2.8.1.1.1.  Appropriate standards, preferably whole blood or buccal swabs, from individuals 

involved, should be submitted along with the questioned materials. 
2.8.1.1.2. Whole blood standards should be submitted in a purple top tube that contains 

ethylene-diamine-tetra-acetic acid (EDTA).  This tube shall be refrigerated. 
2.8.1.1.3. Alternately a swabbing taken from the inside cheek of an individual may be 

collected, dried, and placed in a sealed envelope to be used as a standard. 
2.8.1.1.4. When supplied, a secondary standard shall be clearly marked as such and 

treated as a standard. 
2.8.1.1.4.1. Surreptitious standards or items collected from trash pulls shall be 

clearly marked and may be extracted separately from both unknowns 
and standards, depending on the sample type. 

2.8.1.2. DNA Analysis 
2.8.1.2.1. If more than one swab from an area/stain is present within an item the analyst 

must indicate whether a single swab, multiple swabs, or a combined sample of 
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two or more swabs are being analyzed in the case notes. Combined samples in 
which not all samples within the item were combined shall be tracked in the case 
notes by a unique identifier.  

2.8.1.2.1.1. If an analyst is sampling an item by swabbing and the swabs are 
combined into one extract, this can be documented in the notes and 
report as a single sample. 

2.8.1.2.1.2. If an analyst is sampling an item by swabbing and the swabs are 
extracted separately, these are considered separate samples.  They 
shall be tracked in the case notes by a unique identifier and the 
number of samples tested shall be indicated in the report.      

2.8.1.2.2. Sexual assault kit processing will depend on case scenario and requires analyst 
discretion. In order to expedite traditional SAK workflow, an optional tier-based 
process is allowed for situations with a female victim and a single male 
assailant.  

2.8.1.2.3. Sexual Assault kits (female victim/single male assailant): A minimum of four 
samples/body areas may be chosen for the first tier of analysis based on the priority 
list below.  If a foreign contributor (suitable for comparison) with information at eight 
or more loci is not obtained from first tier testing, the remaining samples present in 
the kit shall be tested in a second tier of testing.  Analysts may choose to test all 
samples in the first tier.  Not testing additional samples if no informative results are 
obtained requires permission of a supervisor with documentation in the case record.    

2.8.1.2.3.1. If the kit contains the samples listed below, these samples shall be 
selected for testing utilizing differential extraction methods. Regular 
extractions may be utilized for these samples for cases in which only 
digital penetration or fondling is indicated. Supervisor notification is 
required in these instances. If meaningful results are not obtained and 
quantification results indicate a differential extraction could be beneficial, 
the analyst should repeat the extraction as a differential. 
2.8.1.2.3.1.1. Either vaginal/cervical swabs or vaginal wash (choice to 

pick one is only for first tier priority testing.  If all samples are 
required to be tested, both shall be tested, if present.)  

2.8.1.2.3.1.2. Anal/rectal swabs 
2.8.1.2.3.1.3. External genital swabs 

2.8.1.2.3.2. Additional samples shall be chosen based on the following suggested 
priority list developed based on internal studies of success rates by 
sample type.  Selection of samples is dependent on case information 
provided and other samples that are present in the kit or already being 
tested. 
2.8.1.2.3.2.1. Breast swabs 
2.8.1.2.3.2.2. Dried secretions/bitemark swabs (including other body 

area swabs) 
2.8.1.2.3.2.3. Internal genital swabs 
2.8.1.2.3.2.4. Underwear 
2.8.1.2.3.2.5. Speculum swabs 
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2.8.1.2.3.2.6. Bra 
2.8.1.2.3.2.7. Oral swabs   

2.8.1.2.4. Differential extractions shall be performed on samples most likely to contain seminal 
material (e.g., internal genital swabs, oral swabs, or underwear). If a sample is selected 
that is likely targeting skin cells and not seminal material (e.g., dried secretions/bitemark 
swabs or fingernail scrapings), the analyst may choose to perform a regular extraction. 
2.8.1.2.4.1. The analyst may choose to perform a regular extraction for any 

samples tested as part of a second tier of analysis (as directed above), 
regardless of sample type. 

2.8.1.2.4.2. If a sperm fraction is amplified, the corresponding non-sperm 
fraction may be amplified regardless of the FTMR and amount of male 
DNA present; however, amplification of the non-sperm fraction is not 
required when the corresponding sperm fraction has sufficient male DNA.    

2.8.1.2.4.3. Swabs (up to 4) from each selected envelope/body area shall be 
combined for one extraction and evaluated for the presence of male 
DNA. The total sample must be completely covered by the specified 
reagent volume without needing to be adjusted/increased. Supervisor 
notification is required for multiple extractions of swabs from a single 
envelope/body area. 

2.8.1.2.4.4. Representative areas from underwear should be extracted as one 
extract.  Analyst discretion (based upon case scenario and visual 
examination) may be used to sample multiple areas (and perform 
multiple extractions) from a single pair of underwear.  

2.8.1.2.4.5. Smear slides, fingernail scrapings, debris, hairs, clothing other than 
undergarments and other items not listed above are never required 
but may be extracted at analyst’s discretion, depending on the 
contents and results of other items in a kit. 

2.8.1.2.4.6. Case results should be carefully evaluated to determine if additional 
testing or technologies could provide meaningful information.  For 
example, if only dried secretion samples demonstrate foreign alleles, 
any genital samples that qualify shall be submitted for Y-STR 
analysis.  

2.8.1.2.5. Underwear submitted outside of a kit shall be evaluated for stains as 
appropriate. No serological testing is required if no staining is observed; 
however, at a minimum, DNA analysis shall be performed on a sample of the 
crotch area. 

2.8.1.2.6. A quantification procedure shall be performed to estimate the quantity of 
extracted DNA, human and male. 

2.8.1.2.7. To be used in a comparison with evidentiary samples, any standard (primary, 
secondary, or trash pull standard) shall demonstrate a single source profile.  Any 
exception to this rule shall only be made with approval of the Technical Leader 
and documented in the case record. 

2.8.1.2.8. A portion of the amplified DNA is removed and used in the typing method.  The 
remaining amplified DNA, considered work product, shall be destroyed after the 
case has been administratively reviewed. 
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2.8.1.2.9. The amount of sample available for testing, the recoverability of DNA from the 
sample, and the quality of the DNA shall affect which tests are performed.  The 
conclusions reached are based upon the analysis performed.  

2.8.1.3. General Rules 
2.8.1.3.1. If one sample/cutting needs additional processing after quantitation (clean-up or 

concentration) and another sample/cutting from the same item has an 
appropriate quantity for analysis without additional processing; it shall be left to 
the analyst’s discretion as to whether or not both samples or just the one sample 
will be typed. 

2.8.1.3.2. Multiple reagent blanks (RB) may be extracted as part of a sample batch. Any 
samples proceeding for additional testing such as Y-STR analysis shall have 
more than one reagent blank if there are two or more samples associated with 
the blank. All reagent blanks shall at a minimum be carried through 
quantification. Amplification shall be performed on the reagent blank 
demonstrating the highest small autosomal quantification value.  If no small 
autosomal value is detected, the highest large autosomal or Y value shall be 
analyzed.  One reagent blank may be reserved without additional treatment to 
be used with those samples in the batch not requiring additional treatment. A 
batch is defined as all samples before a reagent blank(s) with no intervening 
reagent blanks. 

2.8.1.3.3. Any additional treatment to a sample shall be done to the corresponding reagent 
blank. This would include but not be limited to additional Microcon® 
purifications, use of Centri-sep columns, amplifying more than 5 µl, or increased 
injection parameters. Reagent blanks shall not be diluted unless performed 
during the Biomek robotic processing of samples. 

2.8.1.3.4. The extraction of unknown and reference samples shall be performed separately 
(separated by time and/or space).  This shall include a separate reagent blank 
for reference and unknown samples and, when practical, use of separate 
extraction worksheets, separate columns of the same extraction worksheet, or 
clear indication of which samples are unknown and which are references. 
Unknown and reference samples shall not be extracted in the same Maxwell® 
run.  

2.8.1.3.4.1. An assumed reference standard (for any type of case) may be 
included within the same extraction batch as the associated unknowns 
on the large scale (Beckman) automated platform only as long as: 

2.8.1.3.4.1.1. All pre-robot processing steps were performed 
separately (separated by time and/or space); AND 

2.8.1.3.4.1.2. There is no additional evidence within the batch where 
the reference cannot be assumed.  (For example: If 
sexual assault kit samples are submitted to the robot 
along with a penile swab from the suspect, the 
assumed victim standard cannot be included on that 
robot batch plate.) 

2.8.1.3.5. Extraction and typing of background samples is often not beneficial, and is 
therefore not required, but may be done at the discretion of the DNA analyst to 
aid in the interpretation of case sample results. If a background sample is 
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extracted, it shall be typed if DNA was detected during the quantification step. 
The background sample shall be concentrated only if the sample it is the 
background for is concentrated. 

2.8.1.3.6. If during sampling for extraction, an evidence swab or cutting is dropped on the 
floor or other unclean area, a background swab of the area the evidence 
touched shall be collected and processed. The DNA results obtained from the 
background swab shall be utilized to evaluate the results from the evidence.  
The Technical Leader shall provide guidance on interpreting the data if DNA 
results are obtained from the background swab.     

2.8.2. Crosslinker Procedure 
2.8.2.1. Consumables (pipette tips, microtubes, columns, etc.) may be exposed in the 

crosslinker for 2 to 15 minutes before use in casework.  Time in excess of 15 minutes 
shall have the approval of the Technical Leader documented in the case record. 

2.8.2.2. The use of the crosslinker may reduce the presence of amplifiable DNA. 
2.8.3. Sampling Protocols 

2.8.3.1. Sample size may vary from indicated values depending on many factors including but 
not limited to total sample available and serology test results.  

2.8.3.2. The analyst should consume only as much of the available sample as is 
needed.  Generally, not more than half of likely body fluid samples (e.g., cigarette butts, 
blood or semen) will be used for testing.  

2.8.3.3. In order to obtain usable results, epithelial cell swabs should be consumed. The 
Forensic Services Division shall receive permission to consume samples from the 
prosecutor or investigator prior to analysis of epithelial cell swabs or samples. This may 
be done at the time of submission, or the analyst may request it after sample evaluation. 
No analysis shall be performed on epithelial cell swabs or samples without permission to 
consume documented in the case record. 

2.8.3.4. Sampling Suggestions for Regular Extraction 
2.8.3.4.1. Blood:  Sample approximately 3 X 3 mm from a blood stain or 3 µl of whole blood. 
2.8.3.4.2. Envelope: Sample approximately 1 X 1 cm of a gummed envelope flap or stamp.  

Cut sample into smaller pieces before placing in extraction tube.  Alternatively, may 
swab gummed area or wash with three 50 µl rinses and place each rinse into the 
extraction tube. 

2.8.3.4.3. Cigarette: Sample ½ to all of paper approximately 5 mm down from end or ½ of 
the paper and filter approximately 5 mm down. Filter not to be used when 
extracting with Maxwell® 16.  Cut sample into smaller pieces before placing in 
extraction tube. 

2.8.3.4.4. Epithelial Swabs: The entire (swab/surface/area) used to collect epithelial cells 
should be consumed. The total sample must be completely covered by the 
specified reagent volume without needing to be adjusted/increased. 

2.8.3.4.5. Hair: Rinse root end of hair in 100% ethanol and then dH2O before sampling 1 cm 
of root end. If no microscopic examination was performed, 1 cm of both ends of the 
hair may be sampled and combined.  



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 22 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

2.8.3.4.6. Tissue:  Cut a piece of tissue approximately 3 X 3 mm. If tissue is immersed in 
liquid nitrogen, it shall also be crushed into a fine powder. Transfer the sample to a 
microcentrifuge tube. Larger samples than indicated may be used, as needed, with 
the amounts of stain extraction buffer with DTT and Pro K increased proportionally. 

2.8.3.4.7. Firearms:  Swab the grip, slide/sight, and trigger areas with separate swabs 
consumed for individual extractions.  If magazine is present, an additional single 
swab should be utilized to swab the loading area and end where the magazine is 
handled.  Additional areas may be sampled depending on the type of firearm. 

2.8.3.4.8. M-Vac filters:  For regular extraction (organic, Maxwell® and Biomek) and 
differential extraction for Biomek submission: Half of the filter should be used per 
extraction tube due to liquid volume. If not already cut, cut the filter in half. Cut that 
half in three strips, stack them (reduces static) and either 1) cut a few more times 
the other direction OR 2) roll the strips with tweezers. Place all of the pieces in a 
microcentrifuge tube (required for differential extraction) or lyse and spin basket for 
incubation. Use of tweezers and a static gun is recommended. For differential 
extraction on Maxwell® or organic:  Up to two thirds of the filter may be used due 
to greater liquid volume. If permission to consume the sample has been obtained, it 
is recommended to extract both halves of the filter as the DNA distribution across 
the filter may not be equal.   
If it is indicated that a funnel was used with the M-Vac concentration the sample 
should be only in the center of the filter. Cut out about 1.5 cm diameter circle from 
the center of the filter using static gun and tweezers. Further cut the center sample 
into smaller pieces and test as above. This will consume the sample.  

2.8.3.4.9. Combining extracts: 
2.8.3.4.9.1. Two or more swabs/samples may be extracted in separate extraction tubes, 

when using an organic extraction, combining at step 2.8.8.2. Multiple 
completed automation extracts may be combined before concentrating at 
step 2.8.8.2. The number and volume of the associated RBs shall be the 
same as the samples. 

2.8.3.5. Sampling for Semen (Differential Extraction)  
2.8.3.5.1. Swabs: A sample from at least one swab contained in an envelope shall be taken 

and combined into one tube.  Samples from multiple swabs may be placed in one 
tube.   The total sample addition must be covered by the specified reagent volume 
without needing to be adjusted/increased. 

2.8.3.5.2. Clothing: Sample approximately a 5 X 5 mm cutting. 
2.8.3.5.3. Smear Slides: Use a moistened swab and swab entire smear, including underside 

of coverslip.  Sample swab as above. 
2.8.3.5.4. Vaginal Wash: Spin down vaginal wash and collect pellet on one or more swabs.  

Sample swab(s) as above.   
2.8.3.6. Bone, Teeth and Fingernails 

2.8.3.6.1. Sample cleaning/preparation methods (e.g., scraping, heating, etc.) that best 
address the variability of sample quality may be used, as necessary. 
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2.8.3.6.1.1. Bone marrow and soft tissue may be extracted using the Maxwell® 
protocol, however bone powder is only suitable for organic, 
demineralization or QIAquick extractions. 

2.8.3.6.2. Remove and separate any soft tissue adhering to sample with a sterilized scalpel 
or other appropriate tool. 

2.8.3.6.3. Immerse and agitate at least 1 cubic inch of bone in cold distilled water.   
2.8.3.6.3.1. A small brush or toothbrush may be used to gently remove any dirt/debris 

from the outer surfaces and exposed inner surfaces of sample.  
2.8.3.6.3.2. Small bone samples with difficult-to-reach surfaces may be cleaned by 

sealing the sample in a 50 ml conical tube containing distilled water, then 
vortexing briefly, changing out the solution, and repeating, as necessary. 

2.8.3.6.3.3. If necessary, the specimen can be further cleaned by immersion in ethanol 
and ethyl ether for about 15 minutes each.   

2.8.3.6.3.4. If surface staining is present, it is recommended to remove the outer table 
of bone by scraping or sanding. 

2.8.3.6.4. Rinse sample in distilled water and allow the sample to dry.  
2.8.3.6.5. Pulverize sample into a fine powder by manual mechanical crushing or by use of a 

freezer/mill.  Bone samples may require multiple freezing/crushing steps.  Larger 
samples (e.g., bones and adult teeth) may need to be initially reduced in size to 
accommodate the method of pulverization.  Note: any medical/dental /restorative 
work on a bone or tooth sample shall be removed prior to pulverization.  

2.8.3.6.5.1. Manual Mechanical Crushing with Tissue Pulverizer 
2.8.3.6.5.1.1. Larger samples may initially need to be reduced to ~0.5 in. 

fragments or smaller to accommodate the physical size of the 
pulverizer. 

2.8.3.6.5.1.2. Crush bone sample using the pulverizer and mallet.  Optionally, 
sample may be immersed in liquid nitrogen for ~1–10 minutes to 
aid in crushing.   

2.8.3.6.5.2.  SPEX SamplePrep® 6770 Freezer/Mill 
2.8.3.6.5.2.1. Sample must initially be reduced to ~0.25 in. fragments (width of a 

pencil eraser) or smaller to accommodate the requirements of the 
mill.  Larger fragments will decrease pulverization efficiency and 
may damage the mill. 

2.8.3.6.5.2.2. Insert a sterilized blunt end cap into a sterilized grinding cylinder. 
2.8.3.6.5.2.3. Add the sample to the cylinder. Do not add sample in excess of 

1/3 total volume of the cylinder. 
2.8.3.6.5.2.4. Insert a steel impactor into the cylinder and seal the cylinder with 

a sterilized flanged end cap. 
2.8.3.6.5.2.5. Slowly add liquid nitrogen to the freezer/mill until it reaches the fill 

mark.  An initial amount of liquid nitrogen will quickly boil off as the 
tank cools.  When the liquid settles, add additional liquid nitrogen 
up to the fill mark.  Initial cooling of the instrument will consume 
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~4–5 L of liquid nitrogen, and each sample pulverization will 
require an additional ~1 L liquid nitrogen. 

2.8.3.6.5.2.5.1. Always handle liquid nitrogen containers or any item 
exposed to liquid nitrogen (including grinding cylinders) 
with cryogenic gloves. 

2.8.3.6.5.2.6. Load assembled sample vial into the freezer/mill chamber (blunt 
end first).  Optionally, up to two additional samples may also be 
prepared in vials and placed in the pre-cooling chamber above the 
freezer/mill chamber. 

2.8.3.6.5.2.7. Close the freezer/mill and pulverize the sample using the following 
protocol:  Cycles: 4, Pre-cooling: 10 min, Run: 2 min, Cool: 2 min, 
CPS (cycles per second): 10.  Regularly check the control panel 
on the freezer/mill to ensure that sufficient liquid nitrogen is 
remaining in the tank.  If “LOW LN LEVEL” is displayed, pause the 
protocol by pressing “PAUSE”, open the freezer/mill, and add 
liquid nitrogen to the fill mark, then close the freezer/mill and 
resume the protocol. 

2.8.3.6.5.2.8. When the program is complete, open freezer/mill and remove vial 
from freezer/mill chamber.  To conserve liquid nitrogen, any 
subsequent samples should be immediately loaded into the mill 
and pulverized as described above.  If additional samples were 
loaded in the pre-cooling chamber during the initial sample run, 
they may be pulverized with the following protocol (omitting the 
pre-cooling phase):  Cycles: 4, Pre-cooling: 0 min, Run: 2 min, 
Cool: 2 min, CPS: 10. 

2.8.3.6.5.2.9. Allow vial to warm up for ~5–10 minutes before using the cap 
extractor tool to open the vial.  If the sample was “sticky” or “tacky” 
prior to pulverization, it may be necessary to open the vial earlier 
to aid removal.  Transfer the contents of the vial into a sterilized 
weigh boat and separate the impactor from the sample.  A 
sterilized spatula may be used to aid sample removal. 

2.8.3.6.6. Transfer the pulverized sample into one or more tubes.  Manual mechanical 
crushing typically generates small sample fragments accompanied by some 
powder, while a freezer/mill typically converts an entire sample to a very fine 
powder.   

2.8.3.6.7. For a regular organic extraction, fill one or more microcentrifuge tubes 
approximately halfway with powder. The amounts of extraction reagents may be 
increased proportionately as needed for a regular organic extraction.  A sample 
size of approximately 0.5 grams of powder is recommended for the bone 
demineralization procedure.   

2.8.4. Regular Organic Extraction with Microcon® Concentration Of All Sample Types Including 
Blood, Hair, Tissue And Bone. (Microcon® 100 or Fast Flow) 

2.8.4.1. Place the sample in a 1.5 ml microcentrifuge tube.  Qiagen® Investigator® Lyse&Spin 
tubes shall not be used. Each group of samples being extracted shall include a reagent 
blank as the last sample in the batch. 
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2.8.4.2. To the sample add 300 µl of stain extraction buffer with DTT and 7.5 µl Proteinase K 
(Pro K) solution (10 mg/ml).  Vortex and spin briefly in a microcentrifuge or tap the tube 
to force the cutting into the extraction fluid.  Analyst may increase the amounts of stain 
extraction buffer with DTT and Pro K proportionally for larger samples.  The same 
treatment shall be performed to any associated reagent blanks. 

2.8.4.3. Incubate the tube at 56°C overnight (18 hours minimum/24 hours maximum). An 
extraction time of no less than 2 hours may be used for standards (blood or buccal 
swabs). A shortened extraction time may only be used with the approval of the Technical 
Leader (documented in case record) for any other sample types. 

2.8.4.4. Spin briefly in a microcentrifuge to force the condensate into the bottom of the tube. For 
hairs, bones, or tissue it may be preferable to transfer supernatant to a clean 
microcentrifuge tube before proceeding to 2.8.4.6.Using a wooden applicator stick, 
remove the cutting and proceed to 2.8.4.6 or 

2.8.4.5. Transfer the cutting into a spin basket insert.  Place the basket insert into the tube 
containing the stain extract.  Spin in a microcentrifuge at approximately 14,000 rcf 
(relative centrifugal force) for about 5 minutes.  Remove and discard the basket insert. 

2.8.4.6. In a fume hood, add 300 µl of phenol/chloroform/isoamyl alcohol to which buffer has 
been added (p/c/i) to the stain extract and vortex the mixture at low speed (in the fume 
hood) to attain a milky emulsion.  

2.8.4.7. Spin in a microcentrifuge until completely separated (for at least 3 minutes) at 
approximately 14,000 rcf.  Multiple p/c/i extractions may be performed to further clean up 
an extract if desired. If larger volumes are used in step 2.8.4.2, equivalent volumes of 
p/c/i shall be used. The same treatment shall be performed to any associated reagent 
blanks. 

2.8.4.8. See 2.8.8 for Microcon® procedure. 
2.8.5. Demineralization and Organic Extraction of Bone, Teeth and Fingernail Samples with 

Amicon® Ultra-4 30 kDa Concentration 
2.8.5.1. Place the sample in a 50 ml conical or other appropriately sized container.  Each group 

of samples being extracted shall include a reagent blank as the last sample in the batch. 
2.8.5.2. To the sample add 4.5 ml of bone extraction buffer and 300 µl Proteinase K (Pro K) 

solution (20 mg/ml).  Vortex and spin briefly to force the sample into the extraction fluid.  
The same treatment shall be performed to any associated reagent blanks. 

2.8.5.2.1. An alternative method including the addition of 2.0 ml Lysis Buffer containing 
Guanidinium Thiocyanate found in the Maxwell® DNA IQTM Casework Kit to the 
demineralization buffer may be considered at the analyst’s discretion. 

2.8.5.3. Incubate the samples in an orbital shaker at 56°C and 150 rpm overnight (18 hours 
minimum/24 hours maximum). with an addition of an extra 300 µl Proteinase K (Pro K) 
solution (20 mg/ml) during the last 1-8 hours of incubation.  A shortened extraction time 
may only be used with the approval of the Technical Leader (documented in case 
record). 

2.8.5.4. Spin samples briefly at high speed.  It may be preferable to transfer supernatant to a 
clean tube before proceeding to 2.8.5.5. 

2.8.5.5. In a fume hood, add an equal volume (e.g., 5.1 ml for the standard demineralization 
protocol or 7.1 ml for the alternative protocol) of phenol/chloroform/isoamyl alcohol to 
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which buffer has been added (p/c/i) to the extract and vortex the mixture (in the fume 
hood) to attain a milky emulsion.  

2.8.5.6. Spin in a centrifuge until completely separated (for about 5 minutes at maximum speed). 
2.8.5.7. In a fume hood, transfer approximately one-half to one-third of the aqueous layer to an 

Amicon® Ultra-4 30 kDa column (do not UV crosslink Amicon® Ultra-4 columns). 
2.8.5.8. Place the Amicon® Ultra-4 columns in the centrifuge with one filter facing the outer wall.  

Centrifuge samples at max speed (up to 7500 x g (rcf) on a fixed angle rotor).  Continue 
spinning until approximately 250 µl of sample remains. 

2.8.5.8.1. Note: Do not allow columns to become completely dry.  Spin times may be 
adjusted per sample to address variability. 

2.8.5.9. In a fume hood, discard the flow through and add the remaining aqueous layer to the 
column. 

2.8.5.10. Repeat 2.8.5.8 until approximately 250 µl of sample remains.  Discard the flow through. 
2.8.5.11. Wash sample with 2 ml of nuclease free water.  Spin (maintaining column orientation) at 

max speed until approximately 100 µl of sample remains. 
2.8.5.12. Transfer the sample to a clean microcentrifuge tube. 
2.8.5.13. Wash the column with an additional 100 µl of nuclease free water by pipetting up and 

down.  Combine with extract. 
2.8.5.14. Store refrigerated or proceed to QIAquick® purification. 

2.8.6. QIAquick® Purification for Bone, Teeth and Fingernail Samples 
2.8.6.1. QIAquick® purification may be performed at any time. The same treatment shall be 

performed on the associated reagent blank (or a portion of) for each sample batch. 
2.8.6.2. Optionally, UV crosslink columns for 15 minutes. 
2.8.6.3. Add 5 volumes of Buffer PB to 1 volume of sample (example for 200 µl of sample add 

1000 µl Buffer PB).  Place up to 750 µl into the spin column. 
2.8.6.4. Spin 30 seconds at 17,900 x g (rcf); 13,000 rpm.  If liquid remains in column, spin 

another 30 seconds. 
2.8.6.5. Discard the flow through. 
2.8.6.6. Repeat until all sample has been applied to the column.  
2.8.6.7. Wash the sample by adding 750 µl of Buffer PE. 
2.8.6.8. Spin 30 seconds at 17,900 x g (rcf); 13,000 rpm.  If liquid remains in column, spin 

another 30 seconds. 
2.8.6.9. Discard the flow through. 
2.8.6.10. Spin 1 minute at 17,900 x g (rcf); 13,000 rpm. 
2.8.6.11. Place the column into a clean microcentrifuge tube (not provided in kit).  To elute DNA, 

add 30-100 µl Buffer EB to the center of the membrane and let stand at least 1 minute.   
2.8.6.12. Spin 1 minute at 17,900 x g (rcf); 13,000 rpm.  Discard the column. 
2.8.6.13. Extracts can be stored refrigerated or frozen prior to quantification/amplification.  Prior to 

use after storage, the samples shall be vortexed and spun briefly in a microcentrifuge. 
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2.8.7. Differential Organic Extraction with Microcon® Concentration of Semen Stains 
(Microcon® 100 or Fast Flow)  

2.8.7.1. Place the sample in a 1.5 ml microcentrifuge tube. Qiagen® Investigator® Lyse&Spin 
baskets shall not be used for differential extractions. Each group of samples being 
extracted shall include reagent blanks (sperm and non-sperm fraction) as the last 
samples in the batch. 

2.8.7.2. To the sample add:   
400 µl Tris/EDTA/NaCl 
25 µl  20% Sarkosyl 
75 µl  NFH2O 
5 µl Pro K (10 mg/ml) 

2.8.7.3. Vortex and spin briefly in a microcentrifuge or tap the tube to force the cutting into the 
extraction fluid. 

2.8.7.4. Incubate at 37°C for 2 hours. 

2.8.7.5. Spin briefly in a microcentrifuge to force the condensate into the bottom of the tube. 
2.8.7.6. Using a wooden applicator stick, remove the cutting and spin in a microcentrifuge for 

about 5 minutes at approximately 14,000 rcf.  
2.8.7.7. Alternately transfer the cutting into a spin basket insert.  Place the basket insert into the 

tube containing the stain extract.  Spin in a microcentrifuge at approximately 14,000 rcf 
for about 5 minutes.  Remove and discard the basket insert. 

2.8.7.8. While being very careful to not disturb any pelleted material, remove the supernatant 
fluid from the extract and place it into a new, labeled tube.  This supernatant is the non-
sperm fraction.  Analysis of the non-sperm fraction resumes at 2.8.7.15.  The pellet 
remaining in the tube is the sperm fraction. 

2.8.7.9. Wash the sperm pellet by resuspending it in 500 µl digest/wash buffer, vortexing the 
suspension briefly, and spinning the tube in a microcentrifuge at approximately 14,000 
rcf for about 5 minutes.  Remove and discard the supernatant fluid, being careful not to 
disturb the pellet. 

2.8.7.10. Repeat 2.8.7.9 two additional times for a total of three washes of the sperm pellet.  
2.8.7.11. To the tube containing the washed pellet add: 

 150 µl  Tris/EDTA/NaCl 
 50 µl  20% Sarkosyl  
 150 µl  NFH2O 
 10 µl  Pro K (10 mg/ml) 
 40 µl  0.39M DTT 

2.8.7.12. Close the tube cap, vortex and spin briefly in a microcentrifuge to force all fluid and 
material to the bottom of the tube. 

2.8.7.13. Incubate at 37°C for 2 hours. 
2.8.7.14. Spin briefly in a microcentrifuge to force the condensate into the bottom of the tube. 
2.8.7.15. In the fume hood, add 400 µl phenol/chloroform/isoamyl alcohol (p/c/i) to which buffer 

has been added  to both the tube containing the sperm pellet and to the tube containing 
the non-sperm fraction.  Vortex the mixture briefly at low speed (in the fume hood) to 
attain a milky emulsion. 
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2.8.7.16. Spin in a microcentrifuge until completely separated (for at least 3 minutes) at 
approximately 14,000 rcf. Multiple p/c/i extractions may be performed to further clean up 
an extract if desired. The same treatment shall be performed to any associated reagent 
blanks.  

2.8.7.17. See 2.8.8 for Microcon® procedure.  
2.8.8. Microcon® Concentration of Extracted DNA (Microcon® 100 or Fast Flow) 

2.8.8.1. To a Microcon® Concentrator add 100 µl TE-4.   
2.8.8.2. For Microcon® concentration immediately after organic extraction, transfer the aqueous 

phase (top layer) to the concentrator in the fume hood.  Avoid pipetting organic solvent 
from the tube into the concentrator.  For Microcon® concentration of other DNA extracts, 
transfer the extract(s) to the concentrator.  

2.8.8.3. Close the cap on the concentrator and spin in a microcentrifuge at 500 rcf for at least 10 
minutes. Microcon® 100 may be spun up to 1,200 rcf. 

2.8.8.4. Optional Step: Carefully remove the concentrator unit from the assembly and discard the 
fluid from the filtrate cup.  Return the concentrator to the top of the filtrate cup.   

2.8.8.5. Remove the cap and add 200 µl TE-4 to the concentrator.  Replace the cap and spin the 
assembly in a microcentrifuge at 500 rcf for at least 10 minutes. Microcon® 100 may be 
spun up to 1,200 rcf. 

2.8.8.6. Remove the cap and add a measured volume of TE-4 (40 µl is the recommended amount 
however, varied amounts can be added in some circumstances) to the concentrator.  
Remove the concentrator from the filtrate cup and carefully invert the concentrator into a 
new, labeled retentate cup.  Discard the filtrate cup.     

2.8.8.7. Spin the concentrator in a microcentrifuge at 1,000 rcf for at least 3 minutes. The 
Microcon® 100 should be spun 500-1,200 rcf for at least 5 minutes. 

2.8.8.8. Discard the concentrator.  If desired, the sample can be brought up with additional water 
by adding it to the retentate cup.  Cap the retentate cup. 

2.8.8.9. Extracts can be stored refrigerated or frozen prior to quantification/amplification.  Prior to 
use after storage the samples shall be vortexed and spun briefly in a microcentrifuge. 

2.8.8.10. Multiple Microcon® concentration steps may be performed to further clean up or 
concentrate any extract.  The same treatment shall be performed on the associated 
reagent blank (or a portion of) for each sample batch. 

2.8.9. Centri-sep Clean-Up of Extracts 
2.8.9.1. Clean-up of extracts with Centri-sep columns may be performed at any time. The same 

treatment shall be performed on the associated reagent blank (or a portion of) for each 
sample batch. 

2.8.9.2. Remove the top column cap and reconstitute the column by adding 800 μl of nuclease 
free water (NFH2O).  Leave the column end stopper in place so the column can stand up 
by itself.  Replace the column cap and hydrate the gel by shaking and inverting the 
column or vortexing briefly.   

2.8.9.3. Allow the column to hydrate for at least 30 minutes at room temperature.  Reconstituted 
columns may be refrigerated overnight.  Allow to warm up to room temperature before 
proceeding. 
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2.8.9.4. Remove the air bubbles from the column gel by inverting the column and sharply tapping 
the column, allowing the gel to slurry to the opposite end of the column.  Stand the 
column up and allow the gel to settle while in a microtube rack. 

2.8.9.5. First remove the column cap, and then remove the column end stopper from the bottom. 
2.8.9.6. Allow the excess column fluid to drain into a 2 ml wash tube.  If the fluid does not begin 

to flow immediately through the column apply gentle pressure to the top of the column to 
force the fluid to start through the column filter. This can be accomplished by snapping 
the cap on briefly.  Discard this fluid. 

2.8.9.7. Spin the column and wash tube in a microcentrifuge at 750 rcf for 2 minutes.  NOTE: It is 
important to keep track of the position on the column using the orientation mark molded 
into the column. 

2.8.9.8. Optionally: discard eluate and rinse column with 150-200 µl NFH2O and spin for 2 
minutes at 750 rcf. 

2.8.9.9. Blot any drop at the end of the column.  Discard the wash tube.  Do not allow the gel 
material to dry excessively. 

2.8.9.10. Transfer the sample extract to the top of the column, without disturbing the gel surface.  
Keep track of amount of sample added to column (less than 50 µl is recommended). 

2.8.9.11. Place the column into the sample collection tube (1.5 ml) and place both into the 
microcentrifuge.  Maintain proper column orientation.  The highest point of the gel media 
in the column should always point toward the outside of the rotor.  Spin the column and 
the collection tube at 750 rcf for 2 minutes. 

2.8.9.12. Discard the spin column and cap the sample collection tube. 
2.8.9.13. Extracts can be stored refrigerated or frozen prior to quantification/amplification.  Prior to 

use after storage, the samples shall be vortexed and spun briefly in a microcentrifuge. 
2.8.10. Maxwell® Protocol  

2.8.10.1. Maxwell® Preparation of Samples for Any Cellular Material (except bone powder): 
2.8.10.1.1. For each sample, combine 350 µl Incubation Buffer with 10 µl Pro K (18 mg/ml) 

and 40 µl DTT (1M).  Alternatively, Stain Extraction Buffer for Automation (SEBA) 
may be substituted for Incubation Buffer.  Example: for 16 samples, combine 5,600 
µl Incubation Buffer (or SEBA) with 160 µl Pro K and 640 µl DTT.    

2.8.10.1.2. Place sample at the bottom of a 1.5 ml microcentrifuge tube or a Qiagen® 
Investigator® Lyse&Spin basket with 2 ml collection tube.  Each group of samples 
being extracted shall include a reagent blank as the last sample in the batch. A 
batch can be no larger than the capacity of the Maxwell Unit being utilized. For a 
Maxwell® 16 or FSC it is 15 samples (plus 1 reagent blank). For a Maxwell® 48 it 
is 47 samples (plus 1 reagent blank). The reagent blank associated with each 
batch shall be run in the same Maxwell® run as the associated samples.   

2.8.10.1.3. To the sample add 400 µl Master Mix.  Vortex and spin briefly in a microcentrifuge 
or tap the tube to force the cutting into the extraction fluid.    

2.8.10.1.4. Incubate the samples at 56°C for at least one hour. Alternatively, samples may be 
incubated overnight.  

2.8.10.1.5. For samples lysed in a 1.5 ml microcentrifuge tube: 
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2.8.10.1.5.1. Spin briefly in a microcentrifuge to force the condensate into the bottom of 
the tube. (For hairs it may be preferable to transfer supernatant to a clean 
microcentrifuge tube before proceeding). 

2.8.10.1.5.2. Optionally, 400 µl of a direct amp lysate may be placed in a 1.5 ml 
microcentrifuge tube. 

2.8.10.1.5.3. Add 200 µl of Lysis Buffer to each sample. 
2.8.10.1.5.4. Vortex samples briefly and spin down. 
2.8.10.1.5.5. Using a wooden applicator stick, remove the cutting and proceed to 

2.8.10.1.7 or   
2.8.10.1.5.6. Transfer the cutting into a spin basket insert.  Place the basket insert into 

the tube containing the stain extract.  Optionally, the Lysis Buffer may also 
be transferred to the spin basket.  Spin in a microcentrifuge at 
approximately 14,000 rcf for about 5 minutes.  Remove and discard the 
basket insert.   

2.8.10.1.6. For samples lysed in a Qiagen® Investigator® Lyse&Spin basket: 
2.8.10.1.6.1. Spin in a microcentrifuge at 10,000 – 14,000 rcf for at least 1 minute. 

Remove and discard the basket insert. 
2.8.10.1.6.2. Optionally, 400 µl of a direct amp lysate may be placed in a Qiagen® 

Investigator® Lyse&Spin tube. 
2.8.10.1.6.3. Add 200 µl of Lysis Buffer to each sample. 

2.8.10.1.7. Save the extract until ready for automated DNA extraction.  Do not refrigerate or 
freeze sample.  Leave processed sample at room temperature (~22-25°C) 
overnight, if necessary. 

2.8.10.1.8. Proceed to 2.8.10.3 or 2.8.10.4 for Maxwell® automated extraction. 
2.8.10.2. Maxwell® Preparation of Samples for Differential Extractions:   

2.8.10.2.1. For each sample, combine 400 µl  Tris/EDTA/NaCl, 10 µl 20% Sarkosyl, 90 µl  
NFH2O and 5 µl Proteinase K (10 mg/ml). 

2.8.10.2.2. Place the sample in a 1.5 ml microcentrifuge tube. Qiagen® Investigator® 
Lyse&Spin baskets shall not be used for differential extractions.  Each group of 
samples being extracted shall include reagent blanks (sperm and non-sperm 
fraction) as the last samples in the batch. A batch can be no larger than the 
capacity of the Maxwell Unit being utilized. For a Maxwell® 16 or FSC it is 15 
samples (plus 1 reagent blank). For a Maxwell® 48 it is 47 samples (plus 1 reagent 
blank).  The reagent blank associated with each batch shall be run in the same 
Maxwell® run as the associated samples. 

2.8.10.2.3. To the sample add 505 µl of the Master Mix.  Vortex and spin briefly in a 
microcentrifuge or tap the tube to force the cutting into the extraction fluid. 

2.8.10.2.4. Incubate the sample at 37°C for 2 hours. 
2.8.10.2.5. Spin briefly in a microcentrifuge to force the condensate into the bottom of the 

tube. 
2.8.10.2.6. Using a wooden applicator stick, remove the cutting and spin in a microcentrifuge 

for about 5 minutes at approximately 14,000 rcf.  
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2.8.10.2.7. Alternately transfer the cutting into a spin basket insert.  Place the basket insert 
into the tube containing the stain extract.  Spin in a microcentrifuge at 
approximately 14,000 rcf for about 5 minutes.  Remove and discard the basket 
insert. 

2.8.10.2.8. While being very careful to not disturb any pelleted material, remove the 
supernatant fluid from the extract and place it into a new, labeled tube.  This 
supernatant is the non-sperm fraction.  Analysis of the non-sperm fraction resumes 
at 2.8.10.2.11.  The pellet remaining in the tube is the sperm fraction. 

2.8.10.2.9. Wash the sperm pellet by resuspending it in 500 µl digest/wash buffer, vortexing 
the suspension briefly, and spinning the tube in a microcentrifuge at approximately 
14,000 rcf for about 5 minutes.  Remove and discard the supernatant fluid, being 
careful not to disturb the pellet. 

2.8.10.2.10. Repeat step 2.8.10.2.9 two times for a total of three washes of the sperm pellet.   
2.8.10.2.11. Lysis buffer step 

2.8.10.2.11.1. For each sample pair (sperm and non-sperm fraction) combine 600 
µl of Lysis Buffer with 6 µl of 1M DTT.   

2.8.10.2.11.2. Add 400 µl of the Lysis Buffer master mix to each sperm fraction 
sample and 200 µl to each non-sperm fraction sample. 

2.8.10.2.12. Vortex sample and spin down briefly. 
2.8.10.2.13. Save until ready for automated DNA extraction.  Do not refrigerate or freeze 

sample.  Leave processed sample at room temperature (~22-25°C) overnight, if 
necessary. 

2.8.10.2.14. Proceed to 2.8.10.3 or 2.8.10.4 Maxwell® automated extraction. 
2.8.10.3. Maxwell ® FSC Instrument Automated DNA Purification: 

2.8.10.3.1. Place the number of cartridges to be used into the cartridge preparation rack - one 
per sample.  Ensure front and back of each cartridge is pushed down and snapped 
in.  Remove the seals.  

2.8.10.3.2. Place one plunger into well #8 of each cartridge (closest well to elution tube).  
2.8.10.3.3. Transfer entire sample into well #1 of respective cartridge (furthest well from 

elution tube).  
2.8.10.3.4. Place an appropriately labeled 0.5ml elution tube into the elution tube slot 

associated with each sample, respectively.  Ensure the elution tube is pressed all 
the way down into the holding well.  Add 50µl of Elution Buffer to each elution tube.  

2.8.10.3.5. Gloves should not be worn when touching the tablet.  A stylus should be used 
while wearing gloves. Use the power button on the far left top edge of the tablet to 
wake up the tablet.  

2.8.10.3.6. Swipe up on the tablet screen to select “Analyst” account on the tablet.  Touch 
“Sign In” (no password necessary).  

2.8.10.3.7. Double tap the Maxwell® FSC icon on the tablet to open the instrument software.  
The instrument will perform a self-test and ask to start a sanitization cycle.  This 
will take approximately 1 minute.  Touch “Sanitize” to run the sanitization cycle.  
Each time the software is opened, the sanitization cycle needs to be run.  If you do 
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not run it upon opening of software it will force you to run before your samples are 
processed.  Optionally this sanitization cycle may be performed between sample 
runs.  After removing cartridge rack, from the home screen touch “Sanitize” then 
“Start”.  

2.8.10.3.8. To begin a sample run select “Start” from the Maxwell® software home screen.  
2.8.10.3.9. Using the barcode scanner attached to the instrument, scan the QR code at the top 

of the kit label of the Maxwell® FSC DNA IQTM Casework Kit.  Alternatively, you 
may touch the appropriate kit listed on the screen.  This will highlight the 
appropriate kit on the screen.  Touch “Proceed” on the right side of the highlighted 
line.  

2.8.10.3.10. Touch “Proceed” at the bottom center of the screen.  If the software window needs 
to be minimized to allow the proceed button to be visible, double tap the top center 
of the software window and move, as necessary.  

2.8.10.3.11. “The door will now open” box will appear.  Touch “OK”.  
2.8.10.3.12. Load cartridge rack with cartridges, plungers, samples and open elution tubes.  

Touch “Start”.  
2.8.10.3.13. If a run needs to be aborted, touch “Abort” then “Open Door”.  A report will 

populate the screen.  Touch the home icon in the upper left corner.  To remove 
plungers, run a clean-up as described in 2.8.10.4.16.   

2.8.10.3.13.1. If a run is aborted by the analyst or by the instrument, Technical Leader 
notification is required.     

2.8.10.3.14. When the run is complete touch “Open Door”.  A report will populate the screen.  
Wait for the report to populate, then touch the home icon in the upper left corner. 

2.8.10.3.15. If all plungers have been properly ejected from the bar into the cartridges, proceed 
to 2.8.10.4.17.  If plungers have not properly ejected from the bar, you MUST run a 
clean-up.  Do not remove cartridge rack from instrument. 

2.8.10.3.16. To run a clean-up, touch “Settings” from the home screen.  Then select “Clean Up” 
and touch “Start”.  A report will populate the screen when finished.  Touch the 
home icon in the upper left corner.  You will then need to open the instrument door 
with the door icon (rectangle) in the upper right corner next to the question mark.  

2.8.10.3.17. Remove cartridge rack from instrument.  
2.8.10.3.18. Touch the door icon in the upper right to close the instrument door.  
2.8.10.3.19. Close all elution tubes and remove from cartridge rack.  
2.8.10.3.20. Remove all plungers from cartridges and dispose.  
2.8.10.3.21. Remove all cartridges from cartridge rack and dispose.  
2.8.10.3.22. Clean Maxwell® instrument and cartridge rack with 70% ethanol – never bleach!  

Tablet screens may be wiped with microfiber screen cleaning cloths.  
2.8.10.3.23. Close out of the Maxwell® FSC software using the X icon in the upper left corner 

then touch “Yes”.  
2.8.10.3.24. Using the Windows icon in the lower left corner of the tablet, sign out of the tablet 

by touching the person icon in the circle then “Sign out”.  
2.8.10.3.25. DO NOT turn off the instrument. 
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2.8.10.4. Maxwell ® RSC 48 Instrument Automated DNA Purification:  
2.8.10.4.1. Place the number of cartridges to be used into the cartridge preparation rack - one 

per sample.  Ensure front and back of each cartridge is pushed down and snapped 
in.  Remove the seal.  

2.8.10.4.2. Place one plunger into well #8 of each cartridge (closest well to elution tube).  
2.8.10.4.3. Transfer entire sample into well #1 of respective cartridge (furthest well from 

elution tube).  
2.8.10.4.4. Place an appropriately labeled 0.5ml elution tube into the elution tube slot 

associated with each sample, respectively.  Ensure the elution tube is pressed all 
the way down into the holding well.  Add 50µl of Elution Buffer to each elution tube.  

2.8.10.4.5.  Gloves should not be worn when touching the tablet.  A stylus should be used 
while wearing gloves.  Use the power button on the far left top edge of the tablet to 
wake up the tablet.  

2.8.10.4.6. Swipe up on the tablet screen to select “Analyst” account on the tablet.  Touch 
“Sign In” (no password necessary).  

2.8.10.4.7. Double tap the Maxwell® RSC 48 icon on the tablet to open the instrument 
software.  The instrument will perform a self-test and ask to start a sanitization 
cycle.  This will take approximately 1 minute.  Touch “Sanitize” to run the 
sanitization cycle.  Each time the software is opened, the sanitization cycle needs 
to be run.  If you do not run it upon opening of software it will force you to run 
before your samples are processed.  Optionally this sanitization cycle may be 
performed between sample runs.  After removing cartridge racks, from the home 
screen touch “Sanitize” then “Start”.  

2.8.10.4.8. To begin a sample run, select “Start” from the Maxwell® software home screen.  
2.8.10.4.9. Using the barcode scanner attached to the instrument, scan the QR code at the top 

of the kit label of the Maxwell® FSC DNA IQTM Casework Kit.  Alternatively, you 
may touch the appropriate kit listed on the screen.  This will highlight the 
appropriate kit on the screen.  Touch “Proceed” on the right side of the highlighted 
line.  

2.8.10.4.10. “The door will now open” box will appear.  Touch “OK”.  
2.8.10.4.11. Load cartridge rack with cartridges, plungers, samples and elution tubes.  Rack 

labeled “Front” must go in the front and rack labeled “Back” must go in the back of 
the instrument.  Touch “Start”.  The instrument will automatically detect placement 
of the sample cartridges, if plungers are present, if elution tubes are present and if 
elution tubes are opened.  If anything is wrong an error will pop up and ask you to 
take a closer look at your sample preparation before proceeding.  

2.8.10.4.12. If a run needs to be aborted, touch “Abort” then “Open Door”.  A report will 
populate the screen.  Touch the home icon in the upper left corner.  To remove 
plungers, run a clean-up as described in 2.8.11.5.15.  

2.8.10.4.12.1. If a run is aborted by the analyst or by the instrument, Technical Leader 
notification is required.   

2.8.10.4.13. When the run is complete touch “Open Door”.  A report will populate the screen.  
Wait for the report to populate, then touch the home icon in the upper left corner.  
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2.8.10.4.14. If all plungers have been properly ejected from the bar into the cartridges, proceed 
to 2.8.10.5.16.  If plungers have not properly ejected from the bar, you MUST run a 
clean-up.  Do not remove cartridge rack from instrument.  

2.8.10.4.15. To run a clean-up, touch “Settings” from the home screen.  Then select “Clean Up” 
and touch “Start”.  A report will populate the screen when finished.  Touch the 
home icon in the upper left corner.  You will then need to open the instrument door 
with the door icon (rectangle) in the upper right corner next to the question mark.  

2.8.10.4.16. Remove cartridge rack from instrument. 
2.8.10.4.17. Touch the door icon in the upper right to close the instrument door.  
2.8.10.4.18. Close all elution tubes and remove from cartridge rack.  
2.8.10.4.19. Remove all plungers from cartridges and dispose. 
2.8.10.4.20. Remove all cartridges from cartridge rack and dispose.  
2.8.10.4.21. Clean Maxwell® instrument and cartridge rack with 70% ethanol – never bleach!  

Tablet screens may be wiped with a microfiber screen cleaning cloth.  
2.8.10.4.22. Close out of the Maxwell® RSC 48 software using the X icon in the upper left 

corner then touch “Yes”.  
2.8.10.4.23. Using the Windows icon in the lower left corner of the tablet, sign out of the tablet 

by touching the person icon in the circle then “Sign out”.  
2.8.10.4.24. DO NOT turn off the instrument. 

2.8.11. Rehydration of a Sample after Storage 
2.8.11.1. Evaluate the stored sample and associated reagent blank for approximate volume. 
2.8.11.2. If enough liquid is present in the sample and the reagent blank, they can be used for 

amplification.   
2.8.12.2.1The sample and reagent blank shall be quantified and treated as normal. 

2.8.11.3. If the volume is low or none, determine if the sample and/or the reagent blank extract 
was concentrated and consumed or almost consumed from the case record.  

2.8.11.3.1. If the reagent blank was concentrated and consumed after the issue of the 
2009 DNA QAS audit document no further testing should be done. 

2.8.11.3.2. If the case was completed before the issue of the 2009 DNA QAS audit 
document and the reagent blank was consumed consult with the Technical 
Leader about reagent blanks. 

2.8.12.4 If the volume is low and the loss of volume is from dehydration, the sample can be 
rehydrated. 

2.8.12.4.1 To the sample add 400 µl of TE-4. 
2.8.12.4.2 Add TE-4 to the reagent blank as needed. The volume added should not 

exceed the least amount added to any associated sample. 
2.8.12.4.3 The final volume of the reagent blank should not exceed the volume of any 

associated sample. 



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 35 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

2.8.12.4.4 If the reagent blank did not dehydrate, an additional reagent blank with the 
same volume of TE-4 as added to the sample shall be created and tested 
with the sample. 

2.8.12.4.5 Briefly vortex the samples. 
2.8.12.4.6 Incubate at least 2 hours to 24 hours at 4°C, vortexing periodically. 
2.8.12.4.7 Concentrate the sample and associated reagent blank(s) to approximately 

50 µl each with a Microcon®. 
2.8.12.4.8 Quantify the sample and reagent blank(s) after rehydration. 

2.8.13 Quantifiler® Trio DNA Quantification 
2.8.13.1 Introduction 
2.8.13.1.1 The Applied Biosystems® Quantifiler® Trio DNA Quantification Kit utilizes multi-

copy target loci to simultaneously quantify an 80 bp small autosomal target (sm. 
auto), a 214 bp large autosomal target (lg. auto), and a 75 bp male Y-chromosome 
target (Y) to enable estimation of the amount of human DNA, male DNA, and level 
of degradation. The Internal PCR Control (IPC) enables inhibitor detection in the 
sample extract prior to STR amplification. 

2.8.13.1.2 Each assay target consists of PCR primers and TaqMan® probes labeled with both 
a reporter dye and non-fluorescent quencher. During PCR, the TaqMan® probes 
anneal to a specific location between the targeted forward and reverse primers. 
Taq DNA polymerase cleaves the hybridized probes separating the reporter dye 
from the quencher, resulting in increased fluorescence. 

2.8.13.1.3 The 7500 Real-Time PCR System measures the fluorescent signal of all four target 
reporter signals (VIC®, ABY®, FAMTM, and JUN®) as well as a passive reference 
dye (Mustang Purple®) to help normalize the signal between samples. The signals 
for each sample are compared to that of a standard curve of known quantity to 
estimate DNA concentrations. 

2.8.13.1.4 The Quantifiler® Trio kit shall be stored at -15 to -25°C upon receipt. All kit 
components shall be maintained together in the kit sleeve. 

2.8.13.1.5 Allow the entire kit to thaw prior to first use after which all components shall be 
stored at 2 to 8°C. 

2.8.13.1.6 The Quantifiler® Trio Primer Mix and the Quantifiler® THP PCR Reaction Mix shall 
be protected from excessive exposure to light. 

2.8.13.1.7 The preparation of the quantification plate shall be performed in the PCR 
amplification set-up area. 

2.8.13.2 Standard Curve Preparation (may be set up in the PCR Amplification set-up area) 
2.8.13.2.1 Label four microcentrifuge tubes “Std 1” through “Std 4”. 
2.8.13.2.2 Dispense the appropriate volume of Quantifiler® THP Dilution Buffer to each tube 

using the appropriate option from the table below.  
2.8.13.2.3 Briefly vortex the Quantifiler® THP DNA Standard [100 ng/μl stock]. 
2.8.13.2.4 Add the calculated amount of Quantifiler® THP DNA Standard to the tube labeled 

“Std 1” and mix thoroughly. 
2.8.13.2.5 Using a new pipette tip, add 4 µl of “Std 1” to “Std 2” and mix thoroughly. 
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2.8.13.2.6 Complete the dilution series by adding 4 µl of “Std 2” to “Std 3” and “Std 3 to “Std 
4”, mix thoroughly and use a new pipette tip with each step. 

2.8.13.2.7 The standard curve is stable for up to 2 weeks when stored at 2 to 8°C. 

Standard Concentration 
(ng/µl) Dilution Buffer DNA Standard Dilution 

Factor 

Std 1 50 

15 µl dilution buffer (Option 1) 
25 µl dilution buffer (Option 2) 
35 µl dilution buffer (Option 3)  

15 µl DNA stock (Option 1) 
25 µl DNA stock (Option 2) 
35 µl DNA stock (Option 3) 

2X 

Std 2 2.0 96 µl dilution buffer 4 µl Std 1 25X 

Std 3 0.08 96 µl dilution buffer 4 µl Std 2 25X 

Std 4 0.0032 96 µl dilution buffer 4 µl Std 3 25X 

Note: Option 1 – sufficient volume for 6 quant plates; Option 2 – sufficient volume for 11 quant plates; 
Option 3 – Sufficient volume for 16 quant plates 

2.8.13.3 Quantification Reaction Preparation 
2.8.13.3.1 Each quantification plate shall contain a standard curve series run in duplicate in 

column 12 and a Non-Template Control (NTC) in well H11. 
2.8.13.3.2 Determine the number of samples to be quantified, including standards and NTC, 

and add ~3 reactions to compensate for the loss that occurs during pipetting. 
2.8.13.3.3 Using the Quantifiler® Trio Plate Record Worksheet, calculate the required amount 

of each component of the master mix. 
 
 

 PCR Master Mix Component Volume per 
Reaction (µl) 

Quantifiler® Trio Primer Mix 8 

Quantifiler® THP PCR Reaction Mix 10 

Total Volume 18 

2.8.13.3.4 Vortex the Primer Mix 3 to 5 seconds, then centrifuge briefly. 
2.8.13.3.5 Gently vortex the PCR Reaction Mix. 
2.8.13.3.6 Pipette the required volume of each component into a microcentrifuge tube. Total 

volumes exceeding 1300 µl may be split into 2 tubes equally. 
2.8.13.3.7 Vortex the Master Mix 3 to 5 seconds, then centrifuge briefly. 
2.8.13.3.8 Dispense 18 µl of the Master Mix into each reaction well of a 96-well optical plate. 
2.8.13.3.9 Add 2 µl of sample, standard, or Non-Template Control (water or dilution buffer) to 

the appropriate wells for a total reaction volume of 20 µl. 
2.8.13.3.10 Seal the reaction plate with an Optical Adhesive Cover using the cover applicator. 
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2.8.13.3.11 Centrifuge at 3000 rpm for approximately 10 seconds or spin using a salad spinner 
to remove any bubbles and force samples into the bottom of each well. 

2.8.13.3.12 Load the plate on the 7500 Real-Time PCR instrument ensuring proper orientation. 
2.8.13.4 Quantification Experiment Setup 

2.8.13.4.1 Turn on the computer. 
2.8.13.4.2 Turn on the 7500 Real-Time PCR instrument. 
2.8.13.4.3 Open the HID Real-Time PCR Analysis Software v1.2. 
2.8.13.4.4 Select the Quantifiler® Trio icon on the Home screen. 
2.8.13.4.5 Enter the experiment name: First case on plate_date_plate# (i.e., 

00A1234_01Jan16_01). 
2.8.13.4.6 Ensure the following experiment properties are selected:  

  Instrument:    7500 (96 Wells) 
  Experiment Type:   Quantitation – HID Standard Curve 
  Reagents:   TaqMan® Reagents 
  Ramp speed:  Standard (~1 hour to complete a run) 

2.8.13.4.7 Select Plate Setup from the left navigational panel. 
2.8.13.4.8 Sample names may be entered manually or imported from a DNA Workbook into 

the HID Software. All samples shall be uniquely identified by case number and 
sample identifier. 

2.8.13.4.8.1 Sample Name manual entry: 
2.8.13.4.8.1.1 Select Add New Sample to enter each sample name. 
2.8.13.4.8.1.2 Sample Type shall be designated as “Unknown” for casework 

samples. 
2.8.13.4.8.1.3 Select the Assign Targets and Samples tab to enter the sample 

information into each well. Unused wells shall be left blank. 
2.8.13.4.8.1.4 Verify that the standard curve and NTC information is correct. 

2.8.13.4.8.2 Sample Name import:  
2.8.13.4.8.2.1 In the DNA Workbook, navigate to the “Quant” tab, ensure that the 

sample information is filled out, and click Create Quant Import File. 
Copy the .txt file to the “IMPORT” folder on the 7500 Real-Time 
computer desktop.  

2.8.13.4.8.2.2 In the HID Software, select File → Import, navigate to and select 
the .txt file that was created by the workbook. 

2.8.13.4.8.2.3 The associated samples and standards will populate within their 
respective wells. Verify that the samples, standard curve, and NTC 
information is correct. 

2.8.13.4.9 Assay targets, standard curve quantities, assay parameters, and export criteria are 
automatically assigned when using the Quantifiler® Trio template. 

2.8.13.4.10 Save the plate document to the “CASEWORK” folder on the D: drive. 
2.8.13.4.11 Click 
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2.8.13.4.12 The Quantifiler® Trio assay will take ~1 hour. 
2.8.13.5 HID Real-Time PCR Analysis Software set-up See Appendix 2 
2.8.13.6 Experiment Analysis 

2.8.13.6.1 Analyze the experiment by clicking 
2.8.13.6.2 Evaluate the slope, Y-intercept, and R2 values of all three standard curves as 

described under 2.8.13.7 Interpretation Guidelines. 
2.8.13.6.2.1 Up to 2 points from each curve may be deleted by right-clicking on the well, 

selecting omit, and selecting the appropriate target(s) or well. The results 
must be reanalyzed to incorporate the changes.  

2.8.13.6.2.2 Omission of more than 2 points in any standard curve requires documented 
approval by a supervisor and notification to the Technical Leader. 

 
 

2.8.13.6.3 Export the .txt data file to the “CASEWORK” folder on the D: drive using the 
previously established export properties. 

2.8.13.6.4 Import the .txt data file to the DNA Workbook Quant tab.  
2.8.13.6.5 View and retain the Quant Results tab. The case notes shall contain the 

quantification values, IPC CT values, degradation indices, and all three standard 
curve slope, R2, and y-intercept values. 

2.8.13.6.6 The .eds run file and .txt data file shall be saved to each associated laboratory 
case number and request folder located in the analyst’s folders on the server. 

2.8.13.6.7 Quantification values from the small autosomal target shall be used for 
amplification of autosomal STRs. 
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2.8.13.6.8 Quantification values from the male target shall be used for amplification of Y-
STRs. 

2.8.13.6.9 The quantification plate shall be discarded after the analysis is complete. 
2.8.13.7 Interpretation Guidelines  

2.8.13.7.1 Standard Curve: Evaluate the Small Autosomal, Large Autosomal, and Y standard 
curves individually or simultaneously.   

2.8.13.7.1.1 Slope: Indicates the PCR amplification efficiency for the assay. A slope of -
3.3 indicates 100% amplification efficiency. The analyst shall obtain 
documented Technical Leader approval to use data when a slope is outside 
the acceptable range. Scientific rounding rules to one decimal place apply. 

Target Acceptable slope range Average slope 

Large Autosomal -3.1 to -3.7 -3.4 

Small Autosomal -3.0 to -3.6 -3.3 

Y -3.0 to -3.6 -3.3 

2.8.13.7.1.2 Y-intercept: The expected CT value for a 1 ng/µl sample. Y-intercept 
averages may vary by instrument, kit lot, and pipetting differences. The 
analyst shall obtain documented Technical Leader approval to use data 
when a Y-intercept value is outside the acceptable range. Scientific rounding 
rules to one decimal place apply. 

Target Acceptable Y-intercept range (CT) 

Large Autosomal 23.0 to 27.0 

Small Autosomal 25.0 to 29.0 

Y 25.0 to 29.0 

2.8.13.7.1.3 R2 value: A measure of the closeness of fit between the standard curve 
regression line and the individual CT data points of the standard curve. A 
value of 1.00 indicates a perfect fit between the regression line and the data 
points. This value shall be ≥ 0.980. If the R2 value is <0.98 the experiment is 
inconclusive and shall be repeated with notification to the Technical Leader 
documented in the case record.  Scientific rounding rules to two decimal 
places apply. 

2.8.13.7.2 Internal PCR Control (IPC): Differentiates between a sample containing no 
human DNA and reactions affected by the presence of PCR inhibitors, assay 
setup, and chemistry or instrument failure. 

2.8.13.7.2.1 An elevated IPC CT value (relative to quantitation standards) is an indication 
of the presence of an inhibitor or high concentration of human template 
DNA.  
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2.8.13.7.2.2 If inhibition is suspected, the analyst may re-Microcon® and/or Centri-sep 
the sample prior to amplification and typing of the sample. 

2.8.13.7.2.3 If high concentration of human DNA is present, the analyst may make 
dilutions of the sample and re-quantify. 

2.8.13.7.2.4 The analyst shall make reasonable efforts to rectify samples in which the 
IPC is undetected. If a DNA profile is not developed from a sample with an 
undetected IPC, it shall be reported as inconclusive. 

Autosomal or Y 
targets IPC Interpretation Suggestions / Options 

Undetected Detected Negative result; No 
human DNA  

No further analysis of 
sample 

Undetected Undetected Invalid result; 
possible inhibition 

Re-Microcon® and/or 
Centri-sep; Re-extract; or 

dilute and re-quantify 

Detected 
(Low CT) 

Undetected or 
Elevated 

Inconclusive IPC 
result 

Dilute and 
re-quantify (optional) 

Detected 
(High CT) 

Undetected or 
Elevated 

Partial PCR 
Inhibition 

Re-Microcon® and/or 
Centri-sep; Re-extract; or 

dilute and re-quantify 

2.8.13.7.3 Non-Template Control (NTC): Contains PCR reagents with water or dilution 
buffer in place of template DNA and is therefore expected to be undetected (i.e., 
value of 0.00) for all three quantification values. However, background 
fluorescence or contamination may occur resulting in quantification values with one 
or more targets. 

2.8.13.7.3.1 A NTC demonstrating quantification value(s) ≥0.001 ng/µl requires 
documented notification to the Technical Leader and shall be considered a 
failed control. The quantification shall be repeated. 

2.8.13.7.3.2 A NTC demonstrating quantification value(s) <0.001 ng/µl may be due to 
background fluorescence. The analyst may proceed with amplification and 
typing of the samples using caution with interpretation of any profiles 
obtained from the samples. 

2.8.13.7.4 Dynamic range: The quantitation standard curve ranges from 50 to 0.0032 ng/µl. 
Quantitation values are most reliable when they fall near the middle of the standard 
curve and less reliable as they approach the ends and beyond.  

2.8.13.7.4.1 If the quantity of small autosomal DNA in a sample is <0.01 ng/μl, no 
additional autosomal STR analysis of that sample shall be performed.   

2.8.13.7.4.2 If the quantity of male DNA in a sample is <0.006 ng/μl, no additional Y-STR 
analysis of that sample shall be performed. 

2.8.13.7.4.3 The analyst should make a reasonable effort to target <50 ng/μl during 
extraction. If a sample quantifies >50 ng/μl and is suitable for amplification, a 
dilution shall be made and quantified. 

2.8.13.7.5 Female To Male Ratio (FTMR): In instances where it is valuable to identify a male 
contributor from a female contributor (i.e., sexual assault cases), the FTMR can 
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assist in prioritizing samples and determining which are suitable for autosomal STR 
analysis and which are suitable for Y-STR analysis. The female DNA contribution 
is determined by subtracting the quantity of male DNA from the quantity of small 
autosomal DNA. The FTMR is determined by dividing the female contribution by 
the quantity of male DNA (equation: [(sm. auto-Y)/Y]).  The selection of samples to 
continue DNA analysis may be prioritized at analyst discretion by using the FTMR 
and quantity of male DNA input as described below. Priority 1 samples and Priority 
2 and 3 samples with male DNA concentrations greater than 0.006 ng/µl should be 
amplified if no other samples have provided informative results.  

2.8.13.7.5.1 Priority 1: Samples with FTMR ≤5:1 are generally expected to yield 
interpretable information from male contributor with autosomal STR analysis. 

2.8.13.7.5.2 Priority 2: Samples with FTMR between 5:1 and 20:1 may yield interpretable 
information from the minor male contributor with autosomal STR analysis if 
the concentration of male DNA is greater than 0.006 ng/µl. If the male DNA 
concentration is less than 0.006 ng/µl, no further analysis should be 
performed.  

2.8.13.7.5.3 Priority 3: Samples with FTMR between 20:1 and 50:1 are generally 
expected to yield minimal information from the minor male contributor with 
autosomal STR analysis if the concentration of male DNA is greater than 
0.006 ng/µl. If the male DNA concentration is less than 0.006 ng/µl, no 
further analysis should be performed. 

2.8.13.7.5.4 Priority 4: Samples with FTMR >50:1 are generally not expected to yield 
interpretable information from the minor male contributor with autosomal 
STR analysis, therefore no further autosomal analysis should be performed. 
Y-STR analysis may be recommended if the concentration of male DNA is 
greater than 0.006 ng/µl.  

2.8.13.7.6 Inference of Possible Spermatozoa: Quantitation results obtained from the two 
fractions in a differential extraction can be used to indicate the possible presence 
of sperm cells.  Two calculations will be used.  A positive result is obtained when 
one or both calculations meet the stated thresholds. This calculation shall only be 
done when the small autosomal target for the non-sperm fraction is > 0.01 ng/µl 
and the male target for the sperm fraction is >0.006.  Quantitation values should be 
used with four significant figures and no rounding.  Rounding should only occur for 
the final value scientifically rounded to one decimal place. Note that in order for the 
workbooks to detect a differential set and calculate automatically, sperm fractions 
shall be designated as “sf” or “sp” and non-sperm fractions designated as “ns” or 
“nsf”.     

2.8.13.7.6.1 Differential Ratio (DR):  This value is determined by dividing the FTMR of 
the non-sperm fraction by the FTMR of the sperm fraction.  If the male 
quantitation value is equal to or greater than the total human quantitation 
value, a value of 0.001 ng/µl for the female portion shall be used.  A value 
≥100 is a positive result.    

𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅 (𝐷𝐷𝐷𝐷) = 𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝑁𝑁𝑁𝑁𝑁𝑁
𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝑆𝑆𝑆𝑆

=  
�
�𝐷𝐷𝐷𝐷𝐷𝐷𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓�

[𝐷𝐷𝐷𝐷𝐷𝐷𝑦𝑦 𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡]�
𝑁𝑁𝑁𝑁𝑁𝑁

�
�𝐷𝐷𝐷𝐷𝐷𝐷𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓�

[𝐷𝐷𝐷𝐷𝐷𝐷𝑦𝑦 𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡]�
𝑆𝑆𝑆𝑆
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2.8.13.7.6.2 Fractionation Ratio (FR): This value is determined by calculating the percent 
of male DNA present in the sperm fraction.  A value >50% is a positive 
result. 
𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹 𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅 (𝐹𝐹𝐹𝐹) =  [𝐷𝐷𝐷𝐷𝐷𝐷𝑦𝑦 𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡]𝑆𝑆𝑆𝑆

[𝐷𝐷𝐷𝐷𝐷𝐷𝑦𝑦 𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡]𝑆𝑆𝑆𝑆+[𝐷𝐷𝐷𝐷𝐷𝐷𝑦𝑦 𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡]𝑁𝑁𝑁𝑁𝑁𝑁
 𝑥𝑥 100                           

                                            
2.8.13.7.7 Degradation Index: A value to assist in the identification of degradation prior to 

amplification. The degradation index is calculated by dividing the small autosomal 
by the large autosomal quant values. An index >1 may indicate that the analyst 
should increase the template DNA for autosomal STR amplification to generate 
interpretable data from the larger molecular weight loci. 

2.8.13.7.8 Reagent blank: Should not have associated DNA and is therefore expected to be 
undetected (i.e., value of 0.00) for all three quantification values. However, 
background fluorescence or contamination may occur resulting in quantification 
values with one or more targets. 

2.8.13.7.8.1 A reagent blank that demonstrates quantification value(s) ≥0.001 ng/µl 
requires documented notification to the Technical Leader. It shall be 
considered a failed control unless re-quantification and/or amplification 
demonstrate no contamination. It is recommended that the analyst evaluate 
the results for possible sample switching and requantify if that is suspected.  

2.8.13.7.8.1.1 If the reagent blank is amplified and no peaks above analytical 
threshold are observed in the electropherogram, the associated 
samples may be interpreted with caution. 

2.8.13.7.8.2 A reagent blank that demonstrates quantification value(s) <0.001 ng/µl may 
be due to background fluorescence or low level contamination. 

2.8.13.7.8.2.1 If all associated samples fail to demonstrate a sufficient quantity of 
DNA for amplification (i.e., <0.01 ng/µl for autosomal STRs; <0.006 
ng/µl for Y-STRs), they shall be reported as such. 

2.8.13.7.8.2.2 If the reagent blank is amplified and no peaks above analytical 
threshold are observed in the electropherogram, the associated 
samples may be interpreted normally. 

2.8.13.7.8.3 A reagent blank that demonstrates peaks in the electropherogram shall be 
considered a failed control.  

2.8.13.7.8.4 Any sample associated with a failed reagent blank, but not amplified due to 
an insufficient quantity of DNA (i.e., <0.01 ng/µl for autosomal STRs; <0.006 
ng/µl for Y-STRs) shall be reported as failed to demonstrate a sufficient 
quantity of (male) DNA for further/autosomal STR analysis. 

2.8.13.7.8.5 Samples associated with a failed reagent blank shall not be submitted for Y-
STR analysis.      

2.8.14 PowerPlex® Fusion 6C System (Applied Biosystems® 3500 Series Genetic Analyzer) 
2.8.14.1 Introduction 

2.8.14.1.1 The Promega PowerPlex® Fusion 6C System is a 27-locus multiplex that 
amplifies 23 autosomal short tandem repeat (STR) loci (CSF1PO, FGA, Penta D, 
Penta E, SE33, TH01, TPOX, vWA, D1S1656, D2S1338, D2S441, D3S1358, 
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D5S818, D7S820, D8S1179, D10S1248, D12S391, D13S317, D16S539, 
D18S51, D19S433, D21S11, and D22S1045), two gender determining loci 
(Amelogenin and DYS391), and two additional rapidly mutating Y-STR loci 
(DYS570 and DYS576) in a single reaction. Separation and detection occurs 
using capillary electrophoresis with overlapping loci visualized simultaneously by 
using PCR primers labeled with six different fluorescent tags (FL-6C, JOE-6C, 
TMR-6C, CXR-6C, TOM-6C, and WEN-6C). 

2.8.14.1.2 The Applied Biosystems® 3500 Series Genetic Analyzer utilizes electrokinetic 
injection of DNA molecules into polymer-filled capillaries which separates the 
DNA fragments by size. The fluorescent tag labeled primers incorporated into 
amplification products are responsive to the frequency of the 20mW solid state 
laser. Upon excitation, the fluorophores are raised to a higher energy level and 
when they return to their normal energy level a fluorescent signal is emitted. This 
signal is detected by a CCD (charge-coupled device) camera within the 3500 
Genetic Analyzer which converts the signal to a computer image where it is 
visualized as a peak on the electropherogram. 

2.8.14.1.3 The data produced by the 3500 Genetic Analyzer is analyzed with 
GeneMapperTM ID-X Software which results in peaks labeled with their allele 
designation. The allele designation for each sample is accomplished through the 
use of an internal lane standard (ILS). The ILS contains 21 fragments of known 
length and is injected with each sample. The sample DNA fragments are 
compared to the ILS to determine the base pair size and the software assigns the 
allele designation by comparing the sizes to an allelic ladder. 

2.8.14.1.4 The PowerPlex® Fusion 6C System locus-specific and allelic ladder information 
is available at www.promega.com/protocols/ in the PowerPlex® Fusion 6C 
System Technical Manual TMD045. 

2.8.14.1.5 All PowerPlex® Fusion 6C components should be stored at -10°C to -30°C upon 
receipt in the appropriate laboratory locations. The PowerPlex® Fusion 6C Allelic 
Ladder is packaged separately for shipping and should be stored in the post-
amplification kit. Once thawed all components are stable at 2-10°C for 6 months. 
Do not refreeze. 

2.8.14.1.6 The PowerPlex® Fusion 6C 5X Primer Pair Mix, PowerPlex® Fusion 6C Allelic 
Ladder Mix, and WEN ILS 500 shall be protected from excessive exposure to 
light. 

2.8.14.1.7 The preparation of the amplification reactions shall be performed in the PCR 
amplification set-up area. 

2.8.14.2 PowerPlex® Fusion 6C Amplification Set-Up 

2.8.14.2.1 For initial use, thaw the Amplification Grade Water, PowerPlex® Fusion 6C 5X 
Master Mix, and PowerPlex® Fusion 6C 5X Primer Pair Mix. Centrifuge briefly to 
bring contents to the bottom, then vortex to mix. Do not centrifuge after vortexing 
as this may cause the primers/dNTPs to be concentrated at the bottom of the 
tube. The Master Mix and Primer Pair Mix shall be stored at 2-10°C after first 
use. 

http://www.promega.com/protocols/
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2.8.14.2.2 Determine the number of samples to be amplified including controls.  Add ~3 
reactions to this number to compensate for the loss that occurs during reagent 
transfer. 

2.8.14.2.3 Place one 0.2 ml PCR reaction tube for each sample into a rack and label 
appropriately. A 96-well plate may be used. 

2.8.14.2.3.1 If utilizing a 96-well plate for amplification, well locations where allelic 
ladder will be utilized for capillary electrophoresis shall be left empty 
during amplification.   

2.8.14.2.4 The recommended amplification target range is 1.0 to 2.0 ng of template DNA. 
Amplification of greater than 2.0 ng of template DNA may result in increased 
artifacts and interfere with interpretation. Only samples with concentration less 
than 0.066 ng/µl may target less than 1.0 ng template DNA and shall be 
interpreted with caution. 

2.8.14.2.4.1 A higher template DNA amount (ex. 2.0 ng) should be 
considered for samples with an elevated degradation index 
(ex. >3).  

2.8.14.2.5 For samples that will amplify 5 µl of template DNA, use the current version of the 
DNA Analysis Workbook to calculate the required amount of each component 
of the PCR master mix. Multiply the volume per reaction by the total number of 
reactions to obtain the final volume. 

 

2.8.14.2.6 Combine the calculated volume of each component into a 1.5 ml tube and vortex 
~5 seconds. 

2.8.14.2.7 Pipette 20 µl of the PCR master mix to each sample tube or well. 
2.8.14.2.8 Add 5 µl of sample, reagent blank, positive amplification control, or negative 

amplification control to the appropriate tube or well. 
2.8.14.2.8.1 For the positive amplification control, dilute the 2800M DNA standard 

supplied with the PowerPlex® Fusion 6C kit, or other approved DNA 
standard, to 0.2-0.4 ng/µl and record the final concentration on the 
amplification worksheet. A positive control shall be included in each 
thermal cycler. The diluted positive control should be stored at 2-10°C. 

2.8.14.2.8.2 Amplification Grade H2O or NF H2O shall be used as a negative 
amplification control included with each thermal cycler and will be the last 
sample in the batch. 

2.8.14.2.9 For samples requiring more than 5 µl of template DNA, use the current version of 
the DNA Analysis Workbook worksheet to calculate the required amount of 
water and template DNA for individual samples. Prepare the PCR Master Mix 

PCR Master Mix Component Volume per 
Reaction (µl) 

Amplification Grade or Nuclease Free H2O 10 

PowerPlex® Fusion 6C 5X Master Mix 5 

PowerPlex® Fusion 6C 5X Primer Pair Mix 5 

Total Volume 20 
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without water. Multiply the volume per reaction by the total number of reactions to 
obtain the final volume. 

2.8.14.2.10 Combine the calculated volume of each component into a 1.5 ml tube and vortex 
~5 seconds. 

2.8.14.2.11 Pipette 10 µl of the PCR master mix to each sample tube or well. 
2.8.14.2.12 Add the calculated volume of Amplification Grade H2O or NF H2O (0-10 µl) to 

each sample tube or well.  
2.8.14.2.13 Add the calculated volume of sample, reagent blank, positive amplification 

control, or negative amplification control (5-15 µl) to each sample tube or well.   
2.8.14.2.14 For samples amplified in a 96-well plate, seal the plate with adhesive foil. Press 

the foil well using a roller tool.  
2.8.14.2.15 Centrifuge at 3000 rpm for approximately 10 seconds or spin using a salad 

spinner to remove any bubbles and force samples into the bottom of each well. 
2.8.14.3 PowerPlex® Fusion 6C Amplification  

2.8.14.3.1 Place the tubes or 96-well plate in a Veriti™ Thermal Cycler. 
2.8.14.3.2 Select the Fusion 6C protocol with the following amplification procedure. 

Approximately 1 hour cycling time. 
 

1 Cycle 29 Cycles 1 Cycle  Hold 

96°C 96°C      

1 minute 5 seconds  
 

    

  60°C 60°C   

   1 minute 10 minutes  
 

 

     4°C 

 (All ramp rates set to 100%)   ∞ 

 
2.8.14.3.3 Remove samples after the amplification process is completed and proceed with 

capillary electrophoresis or store the amplified samples at -10°C to -30°C. 

PCR Master Mix Component Volume per 
Reaction (µl) 

PowerPlex® Fusion 6C 5X Master Mix 5 

PowerPlex® Fusion 6C 5X Primer Pair Mix 5 

Total Volume 10 
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Alternatively, amplified samples may be stored at 2-10°C if they are to be used 
within 2 days. 

2.8.14.3.3.1 Any remaining amplification products shall be discarded after the case has 
been administratively reviewed. 

2.8.14.4 Instrument setup for Applied Biosystems® 3500 Genetic Analyzer - Data 
Collection Software version 2.0 see Appendix 3. 

2.8.15 Applied Biosystems® 3500 Series Genetic Analyzer - Data Collection Software version 
2.0 - PowerPlex® Fusion 6C Electrophoresis 

2.8.15.1 Sample Preparation 
2.8.15.1.1 Note:  The quality of formamide is critical for the successful detection of a DNA 

profile. Deionized formamide shall be used that has a conductivity of less than 
100µS/cm, such as Hi-Di™ Formamide. The formamide shall be frozen in 
aliquots at -20oC and the remainder of each aliquot shall be discarded after it is 
thawed. Multiple freeze-thaw cycles or long-term storage at 4oC may cause 
breakdown of the formamide which can create ions that compete with DNA 
during injection. This will cause lower peak heights and decreased sensitivity. 

2.8.15.1.2 Caution:  Formamide is an irritant and teratogen; therefore, universal 
precautions and a fume hood shall be utilized when manually working with 
formamide to avoid inhalation and contact with the skin. 

2.8.15.1.3 For initial use, thaw the WEN ILS 500, PowerPlex® Fusion 6C allelic ladder, and 
an aliquot of Hi-Di™ Formamide. When thawed, centrifuge briefly to bring 
contents to the bottom, then vortex to mix. The ILS and allelic ladder shall be 
stored at 2-10°C after first use. 

2.8.15.1.4 Determine the number of samples to be injected, including allelic ladders and 
controls (reagent blanks, positive control, and amplification blank). Add ~3 
reactions to compensate for the loss that occurs during pipetting. 

2.8.15.1.5 Prepare a loading cocktail by combining 0.5-1.0 µl ILS with 9.5-9.0 µl formamide 
for a total volume of 10 µl per sample. 

2.8.15.1.5.1 The volume of ILS used in the loading cocktail may be adjusted between 
0.5 to 1.0 µl per sample to optimize size standard peaks. The amount of 
formamide shall be adjusted so that the total amount of loading cocktail 
for each well is 10 µl.   

2.8.15.1.6 Vortex to mix. 
2.8.15.1.7 Pipette 10 µl of the formamide/ILS mixture into each well containing sample, 

allelic ladder, or control. Add formamide or formamide/ILS mixture into empty 
wells to complete an injection set. Liquid must be present in every well in which 
an injection will occur. 

2.8.15.1.8 Add 1 µl of amplified sample or allelic ladder to the appropriate wells. It is 
recommended that a minimum of one allelic ladder is present with every 24 
samples injected (i.e., every three injections on the 8-capillary 3500 and within 
every injection on the 24-capillary 3500xL). 

2.8.15.1.8.1 If amplified sample is in a 96-well plate, seal the amplification plate with a 
new aluminum foil seal for storage. 
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2.8.15.1.9 Cover the wells with the plate septa and briefly centrifuge to remove air bubbles. 
2.8.15.1.10 Denature the samples at 95oC for 3 minutes, then immediately chill on crushed 

ice or frozen plate block for ~3 minutes. Denature the samples just prior to 
loading the instrument. Avoid denaturing the samples for longer than 3 minutes 
as extended heat denaturing can lead to the appearance of artifacts.  

2.8.15.2 Create a Plate Record 
2.8.15.2.1 Open the 3500 Data Collection Software. The Dashboard screen will launch. 

Ensure that the Consumable Information and Maintenance Notifications are 
acceptable. The oven temperature should be set to 60ºC.   

2.8.15.2.2 Select Start Pre-Heat. This should be done at least 30 minutes prior to the first 
injection. 
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Dashboard: 

 
2.8.15.2.3 Select Create New Plate or Create Plate from Template. 

2.8.15.2.3.1 Assign the plate name with the laboratory case number of the first case on 
the plate, the date, and the injection number of the plate (ex. 
00A1234_01Jan16_01). 

2.8.15.2.3.1.1 If the plate is re-injected the “01” number shall increase sequentially 
(00A1234_01Jan16_02). 

2.8.15.2.3.1.2 If the plate is re-injected on a different day, the original date should still 
be used from when the plate was prepared.   

2.8.15.2.3.1.3 If a second preparation of a plate is made on the same date as the first, 
it shall be designated with a “-2” after the date (00A1234_01Jan16-
2_01). 

2.8.15.2.4 Select “96” for Number of Wells. 
2.8.15.2.5 Select “HID” for Plate Type. 
2.8.15.2.6 Select “36”cm for Capillary Length. 
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2.8.15.2.7 Select “POP4” for Polymer. 
Create A Plate: 

 
2.8.15.2.8 Click “Assign Plate Contents”. 
2.8.15.2.9 Enter sample information or import a plate record. 

2.8.15.2.9.1 The sample name shall include the sample item/sub-item as well as the 
laboratory case number (ex. 1A1_00A1234) if more than one case is 
included on the plate. If only one case is present on the plate, then only the 
item number is required. 

2.8.15.2.9.2 In order to aid in GeneMapperTM ID-X sample analysis, it is recommended 
to place a “z” in front of the sample name for known standards (ex.  
z1A1_00A1234”) here or in GeneMapperTM ID-X. 

2.8.15.2.10 Under Assays, click “Add from Library” and select the appropriate Fusion6C 
assay. Double-click or click “Add to Plate” then “Close”. 

2.8.15.2.11 Under File Name Convention, click “Add from Library” and select 
“Fusion6C_FNC”. Double-click or click “Add to Plate” then “Close”. 

2.8.15.2.12 Under Results Groups, click “Add from Library” and select “Fusion6C_RG”. 
Double-click or click “Add to Plate” then “Close”.   



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 50 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

Assign Plate Contents: 

 
2.8.15.2.13 On the bottom-right side of the screen expand the Customize Sample Info 

window so it appears as shown above. 
2.8.15.2.13.1 Use the drop-down box to select a sample type for each sample (ex. 

Ladder, Sample, Positive Control and Negative Control). For imported 
plates, this may be done automatically. 

2.8.15.2.14 Highlight the sample wells and then select the appropriate boxes under Assays, 
File Name Conventions, and Results Groups. 

2.8.15.2.15 Place the plate on the instrument in position A. Select “Link Plate for Run”. Click 
“OK”. The instrument automatically senses the plate and assigns the information 
to the Plate A field. Click “OK”. 

2.8.15.2.16 To add a second plate, follow steps 2.8.14.2.3 through 2.8.14.2.14.  Place the 
plate in position B. Select the “Link Plate for Run” and click “OK”. Assign the 
information to the Plate B field. Click “OK”.  

2.8.15.3 Start a Plate Run  
2.8.15.3.1 A unique run name is automatically generated by the instrument for each plate. 
2.8.15.3.2 To re-organize injections, click “Create Injection List” and use the arrows to 

arrange in the desired order. 
2.8.15.3.3 Click “Start Run”. 
2.8.15.3.4 After the run is complete, click “Unlink Plate” and remove it from the instrument. 

The plate may be discarded or labeled with the same title as the plate record and 
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stored at -10°C to -30°C. The plate shall be destroyed after the case has been 
administratively reviewed. 

2.8.15.3.4.1 If the CE plate requires re-injection after frozen storage, thaw, and centrifuge 
to remove any air bubbles. Denature the plate at 95oC for 3 minutes, then 
immediately chill on crushed ice or frozen plate block for ~3 minutes prior to 
loading on the 3500 Genetic Analyzer.  

2.8.15.3.5 The CE Plate Record Worksheet shall be maintained with each case record. 
2.8.16 Setting Up GeneMapperTM ID-X Version 1.6 Software User Accounts and Security System 

See Appendix 4. 
2.8.17 GeneMapperTM ID-X Version 1.6 Software - PowerPlex® Fusion 6C Data Analysis 

2.8.17.1 Processing Sample Data  
2.8.17.1.1 Import the sample files to be interpreted from a single run folder by selecting 

“Add Samples to Project”. 
2.8.17.1.2 Navigate to the run folder that contains the sample files. If the entire run folder is 

to be imported, click on the folder to highlight it, then click the “Add to List” button 
at the bottom of the window. If only a portion of samples need to be selected, 
expand the folder to view the samples. Highlight the appropriate samples, 
ensuring that the allelic ladder and all desired samples are selected. Once all the 
samples are selected click the “Add to List” button at the bottom of the window.  

2.8.17.1.2.1 A run folder shall not be created manually by manipulating sample files. 
2.8.17.1.3 Ensure that the necessary files are now located in the “Samples to Add” window 

by double-clicking on the folder in the right pane, then click “Add”. 
2.8.17.1.4 After the samples have been added to the project, first briefly scan the raw data 

to ensure that a bad injection did not occur.  
2.8.17.1.4.1 To check the raw data, first expand the project folder in the left navigation 

pane, click on a sample file, then click on the “Raw Data” tab in the right 
GeneMapperTM ID-X window. To return to the “Samples” window, click on 
the project folder at the top of the left navigation pane. 

2.8.17.1.5 The GeneMapperTM ID-X project shall contain at least one allelic ladder from 
each run folder included in the project for proper genotyping. Multiple allelic 
ladders within a run folder will be averaged by the software to calculate the allelic 
bins. If a ladder injection is of low quality, delete the ladder or change the sample 
type from “Allelic Ladder” to “Sample” to remove it from consideration in 
calculating the bins.  

2.8.17.1.6 Set the Table Setting at the top of the screen to “STRmix_Fusion6C”. 
2.8.17.1.7 In the Sample Type column, verify that the correct sample types are displayed 

(i.e., Allelic Ladder, Sample, Positive Control, and Negative Control). Should a 
sample type need altered, use the drop-down menu to select the appropriate 
type.  

2.8.17.1.8 In the Analysis Method column, 
2.8.17.1.8.1 For unknown profiles: select “STRmix_Fusion6C_v3” from the drop-down 

menu in row 1. Click the column header cell to highlight the entire column and 
press Ctrl+D or select Edit → Fill Down. 
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2.8.17.1.8.2 For reference profiles: select “Fusion 6C_v3” from the drop-down menu in 
row 1. Click the column header cell to highlight the entire column and press 
Ctrl+D or select Edit → Fill Down. 

2.8.17.1.8.2.1 If a reference profile is degraded and/or exhibits allelic dropout, 
either analysis method may be used. Stutter will need to be 
manually deleted. Notification of the Technical Leader 
documented in the case record is required if the STRmix analysis 
method is utilized. 

2.8.17.1.8.2.2 A standard that will be utilized for kinship comparisons that 
exhibits degradation and allelic drop-out may utilize the STRmix 
analysis method and may be deconvoluted in STRmix to address 
potential allelic drop-out.   

2.8.17.1.8.3 Positive controls can be analyzed with either analysis method; however, 
stutter will need to be manually deleted from positive control profiles.   

2.8.17.1.8.4 Negative controls shall be analyzed with the lowest or lower analytical 
threshold of any associated samples. 

2.8.17.1.8.5 A project may contain samples with different analysis methods.  The project 
shall contain a separate ladder for each analysis method used. 

2.8.17.1.8.6 A project does not need to be created for standards if no items of evidence in 
that case are amplified or demonstrate conclusive results. 

2.8.17.1.9 In the Panel column, 
2.8.17.1.9.1 For unknown profiles: select “STRmix_v3_Fusion_6C_ISP” from the drop-

down menu in row 1. Click the column header cell to highlight the entire 
column and press Ctrl+D or select Edit → Fill Down. 

2.8.17.1.9.2 For reference profiles: select “Fusion6C_v3_ISP” from the drop-down menu 
in row 1. Click the column header cell to highlight the entire column and press 
Ctrl+D or select Edit → Fill Down. 

2.8.17.1.9.3 Ladders, positive and negative controls shall utilize the panel that 
corresponds to the analysis method used.   

2.8.17.1.10 In the Size Standard column, select “WEN ILS 500” from the drop-down menu in 
row 1.  Click the column header cell to highlight the entire column and press 
Ctrl+D or select Edit → Fill Down. 

2.8.17.1.11 The Analysis Method, Size Standard, and Panel can be set as defaults when a 
GeneMapperTM ID-X project is opened. Select File → Project Options. Under 
the Add Samples tab select appropriate settings as the default in the drop-down 
menus for Analysis Method, Size Standard, and Panel. Click “OK”.  

2.8.17.1.12 Select the green Analyze arrow button to start data analysis. A pop-up window 
will ask for a project name to save. The project name shall contain the date the 
3500 plate was prepared so that it matches the run folder name.  See the DNA 
Server Instructions Appendix 9 for additional clarification. The case number is 
recommended but not required. Select the “ISP Casework Security Group”. Click 
“OK”. 

2.8.17.2 Evaluating Sample Data 
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2.8.17.2.1 The Sizing Quality for unknown samples and allelic ladders shall be at least 
0.75 for a sample to pass. The Sizing Quality for reference samples, negative 
controls and positive controls shall be at least 0.25 for a sample to pass. All 
appropriate ILS peaks shall be present and labeled correctly.     

2.8.17.2.2 Allelic Ladders and Samples 
2.8.17.2.2.1 Highlight the rows containing ladders or samples and click “Display Plots”. In 

the Samples Plot screen, change the “Plot Setting” drop-down box to 
“Fusion6C”. Magnify the area from about 50 to 500 bp ensuring that all ILS 
peaks are visible in the retained electropherogram.  

2.8.17.2.2.2 Verify that the correct allele calls are made for each ladder peak and evaluate 
all sample calls as described in 2.8.21.3.  

2.8.17.2.2.3 Retain the electropherograms.  
2.8.17.2.3 Negative Controls  

2.8.17.2.3.1 Highlight all sample rows containing negative controls and click “Display 
Plots”. Verify the Plot Setting is set to “Fusion6C”. 

2.8.17.2.3.2 Ensure that no peaks above analytical threshold are present.  
2.8.17.2.3.3 Retain the electropherograms ensuring that the primer peak is visible. 

2.8.17.2.4 After all analysis is complete, select the Genotypes tab. Click “File”, then select 
“Export Table”.  Export the genotypes table as a .txt file to be utilized for 
STRmix™ analysis and the generation of allele summary tables in the STRlite 
Excel program. The .txt file name shall be the same as the project name with the 
automatic extension “Genotypes Table” added during export.     

2.8.17.2.5 The 3500 Data Collection run folder containing the sample files, associated 
GeneMapperTM ID-X projects, and exported genotypes table .txt file shall be 
saved under each associated laboratory case number and request folder located 
in the analyst’s folders on the server. Batch data generated by the Automation 
team is an exception. Automation batch data shall be stored only in the 
zAutomation folder and not duplicated per individual case. Projects should be 
deleted monthly from the “GeneMapper Manager” to maintain database space. 

2.8.17.2.6 When exporting the GeneMapperTM ID-X project, ensure that the “Export with 
analysis settings” box is checked.  

2.8.18 General Rules for PowerPlex® Fusion 6C Analysis On The Applied Biosystems® 3500 
Genetic Analyzer 

2.8.18.1 At least one allelic ladder shall be present within each run folder. It is recommended that 
an allelic ladder be run within each set of 3 columns. This will help account for possible 
migration shifts due to external environmental factors.  If a single injection contains both 
unknown and reference samples, it is recommended that two allelic ladders are run for 
GeneMapperTM ID-X analysis.   

2.8.18.2 Samples in the 96-well plate should be oriented to allow for the injection of unknown 
samples prior to the injection of any reference samples for that case. 

2.8.18.3 A signal range of 5,000 to 20,000 RFU will produce optimal results.   
2.8.18.4 If multiple amplifications are analyzed for a sample, the analyst shall use the 

amplification which he or she determines sufficiently represents the sample based on 
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peak heights, artifacts, and noise levels. Analysts shall interpret data that most clearly 
represents the sample and try to achieve better resolution if a sample has peak heights 
that are too high (resulting in artifacts, increased instrument noise, and pull-up) or too 
low (resulting in allelic drop out and loss of data). 

2.8.18.5 Only the data used for interpretation needs to be published in the case record. However, 
other runs shall be noted in the case record and all data shall be saved under each 
associated laboratory case number and request folder located in the analyst’s folder on 
the server. 

2.8.19 Archiving Applied Biosystems® 3500 and GeneMapperTM ID-X Projects 
2.8.19.1 The 3500 run folders containing all sample files for a case as well as the GeneMapperTM 

ID-X project and export files shall be saved under each associated laboratory case 
number and request folder located in the analyst’s folder on the server and deleted from 
the hard drive of the instrument and/or analysis computer. The data stored on the server 
shall be routinely backed up to ensure security of data.  

2.8.19.2 All electropherograms used in interpretation as well as the plate record shall be placed in 
the case record.   
 

2.8.20 STRmix™ Installation and Set-up: See Appendix 5 
2.8.21 Interpretation Guidelines for PowerPlex® Fusion 6C and STRmix™ Deconvolutions  

2.8.21.1 Scope 
2.8.21.1.1 The following interpretation guidelines shall aid in peak/true allele determinations 

and profile interpretations.    
2.8.21.1.2 It shall be at the analyst’s discretion, based on experience and training, as to 

which peaks are suitable for interpretation and input into STRmix™.   
2.8.21.1.3 If an analyst has determined that a peak that has been labeled by the 

GeneMapperTM ID-X software is not a true allele peak, the analyst shall rename 
or delete the allele call label in GeneMapperTM ID-X. 

2.8.21.1.4 Final allele calls shall be documented on the STRlite pages retained in the case 
record. 

2.8.21.1.4.1 For unknown profiles, the STRlite Excel program utilizes a filter to display 
peaks in the allele table that fall below the mean + 3SD stutter value from the 
PowerPlex® Fusion 6C validation for backward (n-3/n-4/n-5) and forward 
(n+3/n+4/n+5) stutter and for n-2 stutter at SE33.  This is only to aid in the 
analyst’s ability to determine what are possibly true alleles for the 
determination of the number of contributors in the sample.  STRmix™ 
analysis will make the official interpretative evaluations of these peaks.     

2.8.21.1.5 STRmix™ is a probabilistic genotyping software program for the interpretation of 
autosomal STR DNA profiling results.  STRmix™ can deconvolute (break down 
into individual contributors) a DNA mixture and attach a statistical weighting to 
comparisons of evidence sample profiles to reference profiles. 

2.8.21.1.5.1  The ISP Forensic Services Division has validated STRmix™ v2.7.0 for 
casework.     

2.8.21.2 DNA Profile Interpretation 
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2.8.21.2.1 Assumptions used in the interpretation of mixtures and interpretation decisions 
shall be documented in the case record. 

2.8.21.2.2 Analysts shall consider the additive effects of allele sharing during interpretation.  
2.8.21.2.3 The flow of interpretation generally follows the steps listed below (Clayton, et al., 

1998): 
     Identify the presence of a mixture. 
     Designate the allele peaks. 
     Identify the number of contributors. 
     Estimate the relative ratio of the individual contributors to the mixture. 
     Consider all genotype combinations. 
     Compare reference samples. 
     Statistical analysis (if necessary). 

2.8.21.2.4 STRmix™ is utilized to perform the interpretation steps following the identification 
of the number of contributors.  The general approach to profile interpretation with 
STRmixTM is outlined here: 

 A DNA profile or mixture previously analyzed in GeneMapperTM ID-X is assessed 
for suitability for STRmix™ analysis. 
If suitable, the profile/mixture is interpreted/deconvoluted within STRmix™. 
Reference samples are compared to the completed interpretation/deconvolution, 
and statistical calculations are performed reflecting that comparison (if 
necessary). 
STRmix™ outputs are reviewed for quality and all appropriate results are 
reported. 

2.8.21.2.5 Identify If the Profile Is A Mixture 
2.8.21.2.5.1 Single Contributor DNA Profile Determination 

2.8.21.2.5.1.1 Generally, a single source profile should contain no more than two alleles 
at each autosomal locus and no more than one allele at each Y-STR 
locus. However, three-peak allele patterns have been reported at 
autosomal loci for single-source stains and two-peak patterns have been 
reported at Y-STR loci, but these instances are rare. A profile where only 
one autosomal locus demonstrates three alleles or one Y-STR locus 
demonstrates two alleles could be an indication of: 

2.8.21.2.5.1.1.1 A tri-allelic pattern for an autosomal locus. If a tri-allelic pattern is 
indicated, it should be confirmed by concordance to at least one 
additional sample contained within the case and/or re-
amplification. 

2.8.21.2.5.1.1.1.1 Any locus with a confirmed tri-allelic pattern shall not be 
used for statistical evaluation. 

2.8.21.2.5.1.1.2 A duplication event for a Y-STR locus. If a duplication is indicated, 
the profile should be confirmed by concordance to at least one 
additional sample contained within the case and/or re-
amplification and documented notification to the Technical Leader. 
Alternatively, the sample may be amplified with PowerPlex® Y23 
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to confirm the profile with documented approval from a Biology 
Unit supervisor and notification to the Technical Leader.   

2.8.21.2.5.1.2 For single source profiles, the peak height ratio (the smallest peak divided 
by the largest peak) of heterozygous individuals at a locus should be 
within 0.65.    

2.8.21.2.5.1.2.1 Samples may display peak height ratios less than expected when 
the sample is of poor quality or the amplification target is below 
the ideal input of template DNA. 

2.8.21.2.5.1.3 Conclusions shall be reported for all results in which the assumption of a 
single contributor is made. 

2.8.21.2.5.2 Mixed DNA Profile Determination 
2.8.21.2.5.2.1 A profile is defined as a mixture of two or more individuals when a locus 

demonstrates an additional allele, with the exception of a tri-allelic 
pattern at an autosomal locus or duplication event at a Y-STR locus. 

2.8.21.2.5.2.2 A peak height ratio less than 0.65 at a locus may indicate a mixed profile 
and that allele sharing may be occurring. 

2.8.21.2.5.2.2.1 Samples may display peak height ratios less than expected when 
the sample is of poor quality or the amplification target is below the 
ideal input of template DNA. 

2.8.21.2.5.2.3 Peaks in stutter position that exceed the mean +3 SD stutter percentage 
may indicate the presence of a mixture. 

2.8.21.2.5.2.4 All loci shall be considered when determining the presence of a mixture. 
2.8.21.2.5.3 Single Contributor Profiles in Which A Single Additional Allele is 

Detected (not tri-allelic) 
2.8.21.2.5.3.1 If the additional allele is present at Amelogenin or a Y-STR locus: 

2.8.21.2.5.3.1.1 If it is possible drop-in (≤200 RFU), the analyst shall document that 
they interpreted the peak as drop-in and shall utilize the single 
source report wording. 

2.8.21.2.5.3.1.2 If it is >200RFU, this shall be considered an indication of an 
additional contributor.  The profile shall be deconvoluted in 
STRmix™ with the assumed number of contributors increased to 
two contributors. 

2.8.21.2.5.3.1.2.1 If the peak is in stutter position, the expected stutter RFU 
(mean) does not count toward the 200 RFU cut-off to manually 
allow for the additive effect of stutter and drop-in. 

2.8.21.2.5.3.2 If the additional allele is present at an autosomal locus:  
2.8.21.2.5.3.2.1 If it is possible drop-in (≤200 RFU), the assumed number of 

contributors should not be increased to two contributors and 
STRmix™ shall be allowed to model the peak. 

2.8.21.2.5.3.2.1.1 If the sample is not being modeled in STRmix™ due to it being 
consistent with an assumed standard, the analyst shall 
document that they interpreted the peak as drop-in and shall 
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utilize the single source report wording.  If the peak is in stutter 
position, the expected stutter RFU (mean) does not count 
toward the 200 RFU cut-off to manually allow for the additive 
effect of stutter and drop-in.   

2.8.21.2.5.3.2.2 If it is >200 RFU, this shall be considered an indication of an 
additional contributor.  The profile shall be deconvoluted in 
STRmix™ with the assumed number of contributors increased to 
two contributors. 

2.8.21.3 Preliminary Evaluation of Allele Peaks 
2.8.21.3.1 An analyst is required to visually confirm that all allelic ladders used for allele 

designation performed correctly. 
2.8.21.3.2 The internally validated analytical threshold for Fusion 6C is 100 RFU for the 

Blue, Green, and Yellow dye channels, 120 RFU for the Red dye channel, and 
60 RFU for the Purple and Orange dye channels.  These values shall be used for 
interpretation of all unknown samples. 

2.8.21.3.2.1 Peaks below analytical threshold shall not be interpreted, but may be 
considered when deciding if the possible number of contributors can be 
reasonably assumed. 

2.8.21.3.2.2 For reference standards, 150 RFU shall be used as the analytical threshold 
for all Fusion 6C dye channels.  

2.8.21.3.3 There is no static stochastic threshold used for STRmix™ interpretation.  
However, a stochastic threshold value of 950 RFU will be utilized to evaluate 
reference samples for completeness when a single allele is detected at a locus. 

2.8.21.3.3.1 If a reference sample has a locus with a single peak present <950 RFU, the 
locus shall be ignored in the STRmix™ deconvolution (if the reference 
sample is being utilized for conditioning) or likelihood ratio calculation (if the 
reference sample is being utilized for comparison).  Technical Leader 
approval is not necessary for ignoring more than one locus due to possible 
allelic drop-out of reference sample.     

2.8.21.3.4 All interpretable autosomal peaks in unknown samples shall not exceed 28,000 
RFU.  Exceptions may be allowed with Technical Leader approval documented in 
the case record.   

2.8.21.3.4.1 Unknown profiles with autosomal peaks over 28,000 RFU should be 
interpreted with caution, as modeling parameters utilized in STRmix™ may 
not model profiles with saturated peaks optimally. 

2.8.21.3.4.2 Reference samples and positive control profiles may have up to two 
autosomal loci with peaks over 28,000 RFU.  These profiles should be 
interpreted with caution.  

2.8.21.3.5 An initial interpretation of the data shall be made to distinguish non-allelic artifact 
peaks (e.g., pull-up, spikes, dye blobs, etc.) from true allelic data. 

2.8.21.3.5.1 Artifacts have been observed and documented utilizing the PowerPlex® 
Fusion 6C amplification kit. Any artifact peaks called as alleles by the 
GeneMapperTM ID-X software shall be deleted or renamed in the software 
as an artifact. The case record electropherogram should indicate the 



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 58 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

reason for deletion, either manually or labeled in the software. Examples of 
documented artifacts are listed below. A complete list of artifacts, including 
nonhuman cross-reactivity, can be found in the PowerPlex® Fusion 6C 
Technical Manual. Some examples of artifacts that may be observed are:  
Amelogenin, D1S1656, DYS391, FGA – n-1 
D13S317, D18S51, vWA, D7S820, D5S818, D19S433, FGA – n-2 
Other DNA-independent artifacts have been documented in the following 
dyes: 

FL-6C (Blue) - ~65-75 bp, ~113 – 120 bp, ~137 – 145 bp  
JOE-6C (Green) - ~60 – 66 bp 
TMR-5C (Yellow) - ~57-62 bp  

2.8.21.3.5.2 Pull-up or bleed through peaks can occur if signal intensity of sample or ILS 
peaks are too high or if a new spectral calibration needs to be run. Any pull-
up peaks called as alleles by the GeneMapperTM ID-X software shall be 
deleted or renamed in the software as pull-up or artifact. The case record 
electropherogram should indicate the reason for deletion, either manually or 
labeled in the software. The sample should be re-run if a pull-up peak 
interferes with the analyst’s ability to evaluate the profile based on their 
experience and training. 

2.8.21.3.5.3 Spikes are peaks that generally appear in all colors and are sharper than 
regular peaks; however, they can occur predominantly in one color. Spikes 
are a natural consequence of capillary electrophoresis and can be caused 
by dust present in the system as well as urea crystals in the system. It is 
essential that the instrumentation be maintained and cleaned regularly to 
minimize the appearance of spikes. All spikes called as alleles by the 
GeneMapperTM ID-X software shall be deleted or renamed in the software 
as spikes or artifacts.  The case record electropherogram should indicate 
the reason for deletion, either manually or labeled in the software.  A 
sample should be re-injected when a spike interferes with the analyst’s 
ability to evaluate the profile based on their experience and training. 

2.8.21.3.6 Stutter peaks are artifacts of the amplification process and display less intensity 
than the true parent peak. Stutter peaks will typically be observed one repeat unit 
shorter than the parent peak (ex. n-4 at a tetranucleotide STR), but may also 
occur two repeats less (ex. n-8 at a tetranucleotide STR), or one repeat more 
(n+4 at a tetranucleotide STR). Additionally, n-2 artifact peaks have been 
reported at several loci amplified with PowerPlex® Fusion 6C. Mean and mean + 
3SD backward, forward, and double-backward stutter values can be found in 
Appendix 6.  

2.8.21.3.6.1 Stutter peaks in the backward (n-3/n-4/n-5) and forward (n+3/n+4/n+5) 
positions at the autosomal loci, as well as in the n-2 position for locus 
SE33, are modeled by STRmixTM and shall not be removed from 
GeneMapperTM ID-X data of unknown profiles destined for STRmix™ 
analysis. 

2.8.21.3.6.2 The stutter peaks listed below are not modeled by STRmixTM and shall be 
removed from GeneMapperTM ID-X data of unknown profiles destined for 
STRmix™ analysis.  GMID-X stutter filters can aid in the removal of these 
stutter peaks below the mean + 3SD values.  Peaks above the stutter filter, 
but determined to be stutter shall be deleted or renamed in the software as 
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stutter or artifact. The case record electropherogram should indicate the 
reason for deletion, either manually or labeled in the software.  Examples 
include: 

2.8.21.3.6.2.1 Stutter peaks in the double-backward position (n-6/n-8/n-10).  
2.8.21.3.6.2.2 Partial repeat (n-2/n+2) stutter peaks not included above (most common 

for D1S1656, D19S433, SE33 n+2 only and FGA). 
2.8.21.3.6.2.3 All stutter peaks at the Y-STR loci. 

2.8.21.3.6.3 For reference profiles, all stutter peaks shall be deleted.      
2.8.21.3.7 Rare variants (microvariants) have been described in the literature. These peaks 

will have a similar intensity to the other allelic peaks for that locus but will not 
line up with the allelic ladder and will fall outside of established bins. 

2.8.21.3.7.1 Any allele peak that is not present in the allelic ladder and does not have an 
associated “bin” in the GeneMapperTM ID-X analysis software is labeled 
“OL” (Off-Ladder) and shall be renamed by the analyst in the software. 

2.8.21.3.7.1.1 Alleles which are located between two alleles on the ladder shall be 
described as the short repeat followed by the number of base pairs it is 
larger (e.g., 0.1, 0.2, 0.3, or 0.4). Therefore, if a peak is 1 base pair 
larger than the 5 allele it shall be designated as 5.1. A microvariant 3 
base pairs larger for than an allele on the ladder for a tri-nucleotide, 4 
base pairs larger for a tetranucleotide, or 5 base pairs for a 
pentanucleotide may be designated with the full repeat number (e.g., A 
peak 4 base pairs larger than the 5 allele could be designated a 6; 5 
base pairs larger a 6.1). 

2.8.21.3.7.1.2 Alleles which are located outside the range of the ladder or bin set but 
within the designated marker range of the locus shall be evaluated to 
determine the appropriate repeat number that should be assigned to the 
allele. 

2.8.21.3.7.1.2.1 Any allele recognized by the CODIS software to fall outside of the 
allelic ladder shall be renamed during CODIS entry as “<” the 
smallest allele or “>” the largest allele for the locus.   

2.8.21.3.7.1.3 Alleles which are labeled “OMR” (Outside Marker Range) by the 
GeneMapperTM ID-X analysis software shall be evaluated to determine 
which locus the allele likely belongs to.  If the analyst can reasonably 
determine which locus the allele belongs to, the allele can be assigned 
to that locus in GeneMapperTM ID-X and the allele call can be made.  If 
the analyst cannot reasonably determine which locus the allele belongs 
to, both loci surrounding the allele shall be ignored from the STRmix™ 
deconvolution.   

2.8.21.3.7.1.4 In instances where non-numeric alleles (e.g., OL and/or OMR) are 
marked and retained in the GeneMapperTM ID-X data, the resulting 
STRmixTM run shall be analyzed with that locus ignored from analysis. 

2.8.21.3.7.2 Unresolved peaks may be observed with alleles and/or stutter peaks that 
are one bp apart.  Most often this is observed at loci that have partial repeat 
alleles (e.g., D1, D12) and it occurs if the allele peak is very large and the 
allele or stutter peak one bp away is small.  Sometimes in this situation, the 
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GeneMapper™ ID-X software does not recognize and call the smaller peak.  
It can typically be observed as a shoulder on the larger peak.  Unresolved 
peaks shall be closely evaluated using the following guidelines:   

• If the unresolved peak is estimated to be below the analytical 
threshold, no action is required, proceed with analysis. 

• If the unresolved peak is above the analytical threshold, determine if 
the peak is potentially allelic or likely stutter. If the peak is potentially 
allelic, the locus shall be ignored in deconvolution. 

• If the unresolved peak is likely stutter in a single source sample, the 
unlabeled stutter shall be documented in the notes and analysis can 
proceed as normal.  Careful evaluation of the STRmix™ 
deconvolution shall be done as the stutter variance will be affected. 

• If the unresolved peak is in a stutter position in a mixture, the 
estimated peak height shall be evaluated. If the estimated peak height 
is roughly equal or greater than the RFU height of minor alleles, the 
locus shall be omitted in the STRmix™ deconvolution.  The Technical 
Leader shall be notified. 

2.8.21.4 Evaluation of Controls 
2.8.21.4.1 Failed controls require documented notification to the Technical Leader with 

appropriate documentation in the case record. 
2.8.21.4.2 The appearance of pull-up or known artifact peaks does not render the following 

controls inconclusive.  
2.8.21.4.3 Reagent Blank:   

2.8.21.4.3.1 The purpose of the reagent blank is to determine if the reagents used to 
extract the associated samples were contaminated by human DNA. 
Therefore, no signal should be detected in this sample well other than the 
internal lane standard. If a signal is detected in the reagent blank, all results 
of samples associated with that reagent blank shall be considered 
inconclusive. 

2.8.21.4.3.2 A reagent blank with peaks below the analytical threshold shall not prevent 
associated samples from being interpreted.  

2.8.21.4.3.3 A reagent blank with peaks at or above the analytical threshold shall be 
considered a failed negative control.  

2.8.21.4.4 Positive Control: 
2.8.21.4.4.1 The 2800M DNA is used as a positive control to demonstrate that the kit is 

performing properly.  A positive control is considered a failed positive 
control if expected alleles are not detected, a single autosomal locus peak 
is < 950 RFU, or if extra alleles are detected. 

Positive Control 2800M (PowerPlex® Fusion 6C): 
 

X, Y 17, 18 12, 13 10, 14 13, 15 9, 11 7, 14 
Amelogenin D3S1358 D1S1656 D2S441 D10S1248 D13S317 Penta E 

  
9, 13 16, 18 22, 25 12 12, 13  
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D16S539 D18S51 D2S1338 CSF1PO Penta D 
  

6, 9.3 16, 19 29, 31.2 8, 11 12 11 
 

TH01 vWA D21S11 D7S820 D5S818 TPOX 
  

14, 15 18, 23 13, 14 15, 16 16 
 

D8S1179 D12S391 D19S433 SE33 D22S1045 
  

10 20, 23 18 17 
DYS391 FGA DYS576 DYS570 

2.8.21.4.5 Amplification Blank: 
2.8.21.4.5.1 The purpose of the amplification blank is to determine if human DNA 

contaminated the samples at the amplification step. Because no template 
DNA was placed in the reaction, the sample should be blank except for the 
internal lane standard peaks. 

2.8.21.4.5.2 An amplification blank with peaks below the analytical threshold shall not 
prevent associated samples from being interpreted. 

2.8.21.4.5.3 An amplification blank with peaks at or above the analytical threshold shall 
be considered a failed negative control.  

2.8.21.4.6 Interpreting, Comparing and Reporting DNA results associated with Failed 
Controls and Contamination Events 

2.8.21.4.6.1 The Technical Leader shall be notified if a positive or negative control fails 
and/or if sample contamination occurs. Sample contamination is defined as 
additional peaks present in an unknown or reference sample that can be 
conclusively identified to not have originated in the sample (e.g., case to 
case contamination or a mixture in a reference sample). 

2.8.21.4.6.2 Assessment of the integrity of the associated DNA results shall be done in 
consultation with the Technical Leader.  This shall include the possible 
cause and effect of the failed control or contamination.  Additionally, an 
assessment of the risk associated with moving forward with interpretation 
shall be documented, as well as the risks associated with retesting (e.g., 
unnecessary consumption of evidence). 

2.8.21.4.6.2.1 If retesting is performed, the reasons for doing so shall be 
documented.  

2.8.21.4.6.2.2 If results are determined to be suitable for interpretation without 
retesting, the appropriate interpretations, comparisons, and 
statistical results and a description of the failed control or 
contamination event shall be reported per the Report Writing 
Guidelines.  

2.8.21.4.6.2.3 If results are determined to not be suitable for interpretation and 
retesting cannot be performed, the results shall be reported as not 
suitable for comparison per the Report Writing Guidelines. 

2.8.21.4.6.3 Documentation in the case record shall include at a minimum: the forensic 
sample, reference, or control test result that failed or was contaminated, the 
likely or known cause of the failed control or contamination, the likely or 
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known source of the contamination, the impact on the integrity of the DNA 
results, and the determination if the test result is suitable or unsuitable for 
interpretation.   

2.8.21.5 Determination of the Assumed Number of Contributors 
2.8.21.5.1 The assignment of the number of contributors to a profile should be made by the 

analyst prior to the comparison of the profile to any reference samples.  
Reference sample profiles from individuals who are assumed to be present in a 
sample and will be used to condition on in the STRmix™ deconvolution may be 
used to aid in the determination of number of contributors for that sample. 

2.8.21.5.1.1 The profile from the corresponding fraction of a differential extraction may 
also be used to aid in the determination of the number of contributors.     

2.8.21.5.2 Determination of the number of contributors shall be done at the analyst’s 
discretion, based on experience and training, and should take into account peak 
height ratios and possible genotype pairings, as well as sub-analytical threshold 
and high stutter peaks.   

2.8.21.5.3 Depending on sample data, an analyst may assign the number of contributors to 
a sample as one, two, three, four, or at least five. 

2.8.21.5.4 In circumstances when the number of contributors cannot be determined, the 
profile is reported as too complex to interpret (inconclusive).  Such profiles 
include: 

• 5 person or greater mixtures 

• Sample results with data at less than two autosomal loci 

• Sample results with poor quality data in which peak number, peaks 
below analytical threshold, peak height ratios and other qualitative 
factors prevent the reasonable determination of the number of 
contributors   

2.8.21.5.5 The following steps should be followed in assigning the number of contributors to 
a profile: 

2.8.21.5.5.1 Review the profile as a whole, assessing the level of degradation, 
presence of low level peaks, noisy or clean baseline and the general 
quality of the profile. 

2.8.21.5.5.2 If replicate amplifications have been undertaken, all qualifying replicate 
profiles should be reviewed when determining the number of contributors. 

2.8.21.5.5.3 Identify possible stutter peaks (both forward and backward) by reference to 
stutter table (see Appendix 6). 

2.8.21.5.5.4 Find the locus with the highest number of unambiguous allelic peaks to 
determine the minimum number of contributors.  Peak height imbalance 
between alleles may mean the presence of an additional contributor(s) 
above that indicated by allele count alone. 

2.8.21.5.5.5 If one or more contributors at this locus is a clear major, check that this 
pattern is represented at other loci.  

2.8.21.5.5.6 Apply the general pattern of contributors (e.g., number of alleles, peak 
height ratios) to other loci in the profile.   
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2.8.21.5.5.7 Discriminating loci such as FGA and SE33 are likely to be the most 
informative when determining the number of likely contributors. 

2.8.21.5.5.8 The presence of a single minor peak or elevated stutter may indicate the 
presence of drop-in and not an additional contributor. 

2.8.21.5.5.8.1 If a single additional allele at a Y-STR locus that is <200 RFU is 
the only indication of an additional contributor, the peak shall be 
deleted and documented on the electropherogram as drop-in. The 
number of contributors shall not be increased.    

2.8.21.5.5.8.2 If the peak is in stutter position the expected stutter RFU (mean) 
does not count toward the 200 RFU cut-off to account for the 
potential for drop-in and stutter being additive.  

2.8.21.5.5.9 After initial assignment of the number of contributors and subsequent 
STRmix™ analysis, and prior to comparison with the person of interest 
reference profiles, the analyst may determine that the deconvolution did 
not conform to scientific expectation and may be re-run under a different 
number of contributors or with increased MCMC iteration accepts.  In this 
case, the course of action shall be detailed in the case notes and the 
electronic file of the first deconvolution shall be maintained in the case 
record. 

2.8.21.5.5.10 The Variable Number of Contributors (varNOC) function in STRmix™ may 
be utilized if the analyst is unable to determine a single number of 
contributors estimate, but feels the data quality is suitable for STRmix™ 
analysis. 

2.8.21.5.5.10.1 It is recommended that the analyst utilize other troubleshooting 
methods to resolve the number of contributors (such a 
reamplification) prior to utilization of varNOC.  

2.8.21.5.5.10.2 Technical Leader permission is required if varNOC is utilized. 
DBLR software shall not be used with varNOC. 

2.8.21.5.5.10.3 The range of contributors evaluated in varNOC shall not exceed a 
difference of one contributor.  

2.8.21.6 General Interpretation Considerations for STRmix™  
2.8.21.6.1 STRmix™ should be used to deconvolute all qualifying samples, where a 

qualifying sample is defined as:   
2.8.21.6.1.1 All evidence DNA samples where the number of contributors can be 

assumed (up to four contributors) unless the profile is completely 
accounted for by conditioning. 

2.8.21.6.1.1.1.1 A sample demonstrating a partial profile may be interpreted if the 
number of contributors can be reasonably assumed. STRmix™ 
requires a minimum of two autosomal loci for interpretation. 

2.8.21.6.2 Evidence samples with identical profiles shall be analyzed independently with 
STRmix™.  

2.8.21.6.3 Y-STR loci present in PowerPlex® Fusion 6C shall only be used for interpretation 
purposes and not for statistical evaluations.  The Y-STR loci are not evaluated 
within the STRmix™ software.   
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2.8.21.6.4 The basis of STRmix™ is that, given a set of mass parameters (e.g., DNA 
amount, degradation, and amplification efficiency), the software can determine 
the expected height of a peak of a certain size at a given locus.  If there are 
reasons for the expected peak height to be incorrect or for issues with allele 
designation, STRmix™ is unable to handle loci with these effects.  Examples 
include: 

2.8.21.6.4.1 Tri-allelic loci 
2.8.21.6.4.2 Somatic and primer binding site mutations 
2.8.21.6.4.3 Technical issues (saturated or poorly resolved 

GeneMapperTM ID-X data) 
2.8.21.6.5 If these effects are discovered after the original deconvolution (e.g. upon 

inclusion of a tri-allelic standard), a second deconvolution should be performed 
ignoring the affected locus. 

2.8.21.6.5.1 If the effect causes an analyst to change their original 
number of contributors decision, Technical Leader approval is 
required. 

2.8.21.6.6 Non-numeric values such as OL, <, or > are not permitted within the STRmix™ 
input files. 

2.8.21.6.7 The Ignore Locus function within STRmix™ may be used to ignore an affected 
locus within an interpretation.  A locus with this option selected will be removed 
from the subsequent deconvolution or LR from Previous calculation.  

2.8.21.6.7.1 Analyst discretion may be used to ignore a single locus within the 
STRmix™ deconvolution or LR from Previous calculation with reasoning 
documented in the case record.  Ignoring more than one locus requires 
Technical Leader approval with documentation in the case record, except 
in the situation where ignoring multiple loci is necessary due to possible 
allele drop-out in a reference sample. 

2.8.21.6.7.2 If a locus has been ignored due to the inability of STRmix™ to handle a 
biological effect (e.g., a tri-allelic locus), an analyst may document their 
manual interpretation for CODIS entry purposes only. 

2.8.21.6.8 A replicate is defined as a repeat amplification of the same extract and may be 
analyzed together in STRmix™ to aid sample interpretation, including 
determination of the number of contributors. 

2.8.21.6.8.1 Replicates may only be analyzed together through STRmix™ with 
Technical Leader approval documented in the case record. 

2.8.21.6.9 If it has been determined that a sample is unsuitable for interpretation, an 
explanation as to why the sample is un-interpretable should be given.  Examples 
include: 

2.8.21.6.9.1 No results:  No peaks were detected in the electropherogram. 
2.8.21.6.9.2 Inconclusive:  Peaks were observed at one or more loci; however, no 

conclusive results could be drawn due to an inability to reasonably 
determine the number of contributors.  
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2.8.21.6.10 Test results from an unknown sample that are suitable for comparison to a 
reference sample may have the following conclusions reported:   

2.8.21.6.10.1 Included: The STRmix™ calculated HPD (Highest Posterior Density) 
Likelihood Ratio favors inclusion.       

2.8.21.6.10.2 Excluded:  The profile obtained from the unknown stain had discrepant 
genotypes as compared to the profile of the reference sample (i.e., was 
not the same) and can be visually excluded or the STRmix™ calculated 
HPD Likelihood Ratio favors exclusion. 

2.8.21.6.10.3 Uninformative:  The profile obtained from the unknown stain has sufficient 
ambiguity when compared to the profile of the reference sample and the 
HPD Likelihood Ratio falls in the uninformative range.    

2.8.21.6.11 If conclusive results are obtained from a sample, appropriate CODIS eligible 
profiles which do not match the victim shall be entered into CODIS for searching.  
The analyst and technical reviewer shall evaluate CODIS eligibility before 
submitting profiles for entry. 

2.8.21.7 Setting Up Propositions for Calculating the Likelihood Ratio (LR) 
2.8.21.7.1 The Likelihood Ratio (LR) assesses the probability of the evidence given two 

alternate propositions or hypotheses; one that aligns with the prosecution (H1 or 
Hp) and one that aligns with the defense (H2 or Hd).  H1 is typically inclusionary of 
the person(s) of interest.  The defense proposition aligns with exclusion of the 
person(s) of interest. 

2.8.21.7.2 Analysts will need to review all case information in order to determine which 
likelihood ratio calculations should be calculated and reported.  Multiple 
propositions may need to be considered.    

2.8.21.7.2.1 Examples: 
2.8.21.7.2.1.1 Two-person mixture from intimate swab collected from victim.  The victim 

and the Person of Interest (POI) cannot be excluded as possible 
contributors to the sample. 

 H1: DNA originates from victim and POI 
 H2: DNA originates from victim and unknown contributor 
2.8.21.7.2.1.2 Three-person mixture from firearm located at scene.  The POI cannot be 

excluded as a possible contributor to the sample. 
 H1: DNA originates from POI and two unknown contributors 
 H2: DNA originates from three unknown contributors 
2.8.21.7.2.1.3 Three-person mixture from firearm located at scene.  POI1 and POI2 both 

cannot be excluded as possible contributors to the sample.  Three 
separate LRs may be calculated: 

 H1-1: DNA originates from POI1 and two unknown contributors 

 -Or- 

 H1-2: DNA originates from POI2 and two unknown contributors 

 -Or- 
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 H1-3: DNA originates from POI1, POI2 and one unknown contributor 
 H2: DNA originates from three unknown contributors   

2.8.21.7.3 Conditioning is defined as a DNA profile that is present in both propositions (H1 
and H2) because it is reasonable to concede the presence of the individual’s 
DNA.  Conditioning where appropriate provides a more accurate likelihood ratio 
for the person of interest’s possible contribution to that profile.    

2.8.21.7.3.1 At this time, only DNA reference samples may be used for conditioning, 
except as indicated for CODIS purposes only. 

2.8.21.7.3.2 The reference profiles shall have at least 20 complete autosomal loci (loci 
with no possible allelic drop-out).  In cases where degradation of the 
reference sample results in less than 20 complete autosomal loci and 
conditioning may be beneficial to the sample, consultation with the 
Technical Leader is required to determine the best course of action.    

2.8.21.7.3.3 If a reference profile being used for conditioning is a partial profile or has 
loci with possible allelic drop-out (a single allele ≤ 950 RFU), the loci with 
incomplete allelic information shall be omitted from the STRmix™ 
deconvolution. 

2.8.21.7.3.4 The determination for the use of a reference profile for conditioning 
should be based on the analyst’s visual determination if the individual is 
included in the evidence profile.  A likelihood ratio should not be 
performed to determine if a reference is included or excluded for this 
purpose.    

2.8.21.7.3.5 Intimate samples should be conditioned on the owner, unless a single 
source foreign profile is obtained (e.g., sperm fractions or blood of 
another on one’s person). 

2.8.21.7.3.5.1 Intimate samples should also be conditioned on an elimination 
standard from a consensual partner.     

2.8.21.7.3.6 Non-intimate samples may be conditioned on elimination standards, 
depending on the profile and case information (e.g., steering wheel profile 
conditioned on owner or clothing profile conditioned on wearer). 

2.8.21.8 Initial STRmix™ Analysis for Evidentiary Sample Data (Deconvolution) 
2.8.21.8.1 To start a new STRmix™ deconvolution, from the STRmix™ main menu select 

Interpretation. 
2.8.21.8.1.1 Alternately, Batch Mode for deconvolutions may be utilized for multiple 

samples, which is accessed from the main menu and functions as below. 
2.8.21.8.2 In the Interpretation window, enter the case number in the “Case Number” box.   

The deconvolution number should be entered after the item number in the 
“Sample ID” box.  For subsequent deconvolutions of the same item number, 
increase “Decon#” sequentially (e.g., 001A_Decon1, 001A_Decon2).  If 
additional characters are added to the “Sample ID” designation, those characters 
shall be added after the specified naming convention. 

2.8.21.8.3 Enter the proposed number of contributors for the sample (1, 2, 3, or 4), and 
select Confirm.   
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2.8.21.8.4 Ensure the Contributor Range box is not checked if varNOC is not being 
utilized. 

2.8.21.8.4.1 If varNOC is being utilized, check the Contributor Range box.  Enter the 
minimum and maximum number of contributors.  The range of contributor 
number shall be +/- 1.  Select NIST_2017_Combined as the population 
for the range.   

2.8.21.8.5 Select Run Settings and ensure that the number of burn-in accepts per chain is 
set to 10,000, and the number of post burn-in accepts per chain is set to 50,000, 
and click Apply, then Next.   

2.8.21.8.5.1 For troubleshooting purposes, an analyst may increase the number of 
burn-in accepts per chain to 100,000, and the number of post burn-in 
accepts per chain to 500,000 with notification to the Technical Leader 
documented in the case record.  

2.8.21.8.5.2 Aside from number of accepts, no other changes should be made in Run 
Settings without Technical Leader approval. 

2.8.21.8.6 Verify that ISP_Fusion6C_v3 is the selected DNA kit used. 
2.8.21.8.7 Add a new profile to the box marked Evidence Profile Data.  This may be done 

by selecting + and navigating the file tree, or by dragging and dropping the 
appropriate GeneMapperTM ID-X export file into the box.  If multiple samples are 
present in the file, select the desired sample for analysis. 

2.8.21.8.8 If conditioning on a reference sample, add a new profile to the box marked 
Reference Profile Data.  This may be done by selecting + and navigating the file 
tree, or by dragging and dropping the appropriate GeneMapperTM ID-X export file 
or previous STRmix Evidence file into the box.  Multiple reference profiles may 
be added if you are conditioning on multiple individuals. 

2.8.21.8.9 After the reference profile is added, check the Contributor to: Hd box to reflect 
that it is a conditioned sample.   

2.8.21.8.10 Ensure that the Perform Database Search box is checked. 
2.8.21.8.11 To ignore loci from deconvolution, select Kit Settings, then select Loci, then 

select Ignore? for appropriate loci, then select Apply. 
2.8.21.8.12 Select Start.  This will begin a deconvolution analysis of the chosen sample and 

search the results against the ISP QA DNA Database. 
2.8.21.8.13 When the deconvolution is complete, STRmix™ will generate several data files 

and save them to the STRmixTM Results folder on the C: drive. 
2.8.21.8.14 Save each deconvolution folder to the DNA server for the appropriate case.   

2.8.21.9 Review of Run Diagnostics  
2.8.21.9.1 Upon completion, the Deconvolution Report shall be reviewed for quality by 

assessing the deconvolution diagnostics.  Skewed diagnostics may indicate that 
the sample is in need to further scrutiny (e.g., inclusion of inappropriate artifacts 
in import file or incorrect contributor number), that the deconvolution has not 
reached the appropriate sample space and additional accepts may be needed, or 
that the sample is of poor quality.  
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2.8.21.9.1.1 The weights of the genotype combinations generated by STRmix™ 
should be assessed at each locus for their intuitiveness when compared 
visually to the accompanying sample electropherogram.  These may be 
found under the Weights section of the Deconvolution report (example 
below). 

2.8.21.9.1.1.1 Rarely, due to limitations in stutter modeling for loci with complex 
repeat structures, STRmix™ may not model stutter peaks as 
expected (ex. 13 stutter peak from 14 allele at vWA).  If an analyst 
finds that a peak has not modeled as expected, they may refer to 
the STRbase website (NIST STRBase) to investigate if the allele 
is one that may contain variations in the Longest Uninterrupted 
Sequence (LUS) value.  This would provide weight to the decision 
to ignore the locus in the STRmix™ deconvolution.      

 

 
2.8.21.9.1.2 Template (RFU) and Mixture Proportions 

2.8.21.9.1.2.1 Mixture proportions are calculated from the template mass parameter per 
contributor. The template amount in RFU should approximate the lowest 
molecular weight alleles/loci for a heterozygous peak (the value would 
need to be doubled for a homozygous genotype). The template and 
mixture proportions should be intuitive to the analyst’s interpretation of the 
profile. Significant deviations from the expected template and/or mixture 
proportions may require further scrutiny and additional rework. 

2.8.21.9.1.3 Degradation 
2.8.21.9.1.3.1 The degradation mass parameter per contributor is displayed in the 

STRmixTM report as two values. The first value is the Linear 
approximation (RFU/bp) which demonstrates the average decrease in 
RFU per base pair. The second value is the Degradation exponential 

https://strbase.nist.gov/
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curve which is the actual mass parameter utilized by STRmixTM for the 
calculation of Total Allelic Product. This value has a maximum threshold 
of 0.01 in the standard kit settings. For either value a larger value 
indicates a steeper curve and more degradation; however, a sample with 
significant degradation cannot exceed the 0.01 exponential curve 
threshold and may result in additional skewed diagnostics and/or 
unintuitive genotype weightings. If an elevated degradation value is 
observed (likely greater than 0.009) and potentially hindering the 
interpretation of the sample, consultation with the Technical Leader is 
recommended to consider increasing the threshold up to 0.02. 

2.8.21.9.1.4 Total Iterations and Acceptance Rate 
2.8.21.9.1.4.1 The Total Iterations value displayed in the Post Burn-In Summary 

indicates the total number of post burn-in MCMC iterations. This value, 
along with the number of accepts chosen for the analysis can inform the 
user as to how often a new proposed set of parameters was accepted. 
This is referred to as the acceptance rate. 

2.8.21.9.1.4.2 A very low acceptance rate (e.g., 1 in thousands to millions) may, in 
combination with the other diagnostics, indicate that the analysis may 
benefit from a run with additional iterations. On its own (and without any 
other indication of sub-optimal results) a low acceptance rate is not an 
indication that rework is required. 

 

 
2.8.21.9.1.5 The Effective Sample Size (ESS) value displayed in the Post Burn-In 

Summary is the number of independent samples the MCMC has taken 
from the posterior distribution of all parameters. A low ESS in relation to 
the total number of iterations suggests that the MCMC has not moved 
very far with each step or has had a low acceptance rate. A low absolute 
value of ESS (e.g., 10s or 100s) will mean that there is potential for a 
large difference in weights if the analysis was run again.  On its own (and 
without any other indication of sub-optimal results) a small ESS is not an 
indication that rework is required. 

2.8.21.9.1.6 The log(likelihood) value displayed in the Post Burn-In Summary is the 
log of the average likelihood (or probability) value created at each of the 
post burn-in MCMC iterations. The larger this value the better STRmix™ 
has been able to describe the observed data.  A negative value suggests 
that STRmix™ has not been able to describe the data very well given the 
information it has been provided. Reasons why this value may be low or 
negative are: 
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• The profile is simply very low level and there is very little data 
making up the likelihood. 

• The proposed number of contributors does not model well (and 
may be incorrect), forcing an interpretation of large stochastic 
events (e.g., large heterozygote peak imbalances or variation in 
mixture proportions across the profile) in the STRmix™ run. 

• Data has been removed that was real, (e.g., stutter peaks), forcing 
an interpretation of dropout by STRmix™. 

• Artifacts have been left labelled (not removed) in the imported 
data, forcing an interpretation of drop-in by STRmix™. 

2.8.21.9.1.6.1 A low or negative value for the average log(likelihood) may indicate to 
users that the analysis requires additional scrutiny. 

2.8.21.9.1.6.2 Good quality mixed DNA profiles are likely to give higher average 
log(likelihood) values than good quality single source profiles. 

2.8.21.9.1.6.3 Low average log(likelihood) values alone are not necessarily an indicator 
of an issue, especially if the profile is single source. 

2.8.21.9.1.7 The Gelman-Rubin Convergence Diagnostic (GR) value displayed in the 
Post Burn-In Summary informs the user whether the MCMC analysis 
has likely converged. STRmix™ uses multiple MCMC chains to carry out 
the deconvolution, and ideally each chain will be sampling in the same 
space after burn-in. Too few accepts may result in a failure to converge.  
If the chains spend their time in different spaces, then it is likely that the 
analysis has not run for sufficient iterations. Whether or not the chains 
have spent time in the same space can be gauged by the within-chain 
and between-chain variances. These two variances are used to calculate 
the variance of what is called the ‘stationary distribution’. If all chains have 
sampled the same space, then the within chain variance and the variance 
of the stationary distribution will be approximately equal. If chains have 
spent time in different spaces, then the variation between the chains is 
likely to be larger than the variation within the chains. The GR is the ratio 
of the stationary distribution and within-chain variances. For a perfectly 
converged analysis, GR = 1.  

2.8.21.9.1.7.1 If the GR is above 1.2 then there exists the possibility that the analysis 
hasn’t converged. If the GR value is above 1.2, STRmix™ will 
automatically run an additional 50,000 post burn-in accepts.  This may 
decrease the GR to below 1.2, yielding a clearer deconvolution. 

2.8.21.9.1.7.2 If the GR continues to remain above 1.2 after the additional post burn-in 
accepts, this may be an indicator that the sample requires rework. 

2.8.21.9.1.8 The allele, stutter, and Locus Specific Amplification Efficiency (LSAE) 
variance data depicted in the Variance Charts (see below for allele and 
back stutter variance only) can be used as a guide as to the level of 
stochastic variation in peak heights that is present in the profile. The 
values listed in the Post Burn-In Summary of the report include the 
average value for allele, stutter, and LSAE variance constants across the 
entire post burn-in MCMC analysis. 
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2.8.21.9.1.8.1 If the variance constant has increased markedly from the mode of the 

prior distribution, then this may indicate that the DNA profile is sub-
optimal or that the number of contributors is incorrect.  

2.8.21.9.1.8.2 Used in conjunction with the average log(likelihood), a large allele 
variance or stutter variance constant can indicate poor PCR.   

2.8.21.9.1.8.2.1 A low-level sample may result in a low average log(likelihood) and 
an average variance constant.   

2.8.21.9.1.8.2.2 Data with missing information, extra information (e.g., artifact 
peaks), or misinterpreted data may result in a low average 
log(likelihood) and high variances. 

2.8.21.10 Indiana State Police Forensic Services Division Quality Assurance DNA Database 
Search Review 

2.8.21.10.1 In the Database Search Report, verify that no positive associations with LR ≥ 
10,000 have occurred.   

2.8.21.10.2 Any database matches with a LR ≥ 10,000 should be evaluated for the likelihood 
of potential contamination.  The Technical Leader shall be consulted for 
evaluation of the match. If the match is determined to be a suspected 
contamination event a root cause analysis shall be performed to determine the 
possible cause.  Appropriate report wording shall be utilized if contamination is 
suspected.     

2.8.21.10.2.1 Database matches (LR ≥ 10,000) shall be interpreted with caution and 
acknowledged in the report wording. 

2.8.21.10.2.1.1 The database profile shall be utilized and conditioned upon in 
an additional STRmix™ deconvolution. 

2.8.21.10.2.1.2 The database Excel tool shall be used to convert the 
database profile into the correct STRmix™ reference profile 
format. 
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2.8.21.10.2.1.3 Any LRs calculated for the samples shall be performed on the 
deconvolution conditioned on the database profile.    

2.8.21.11 Evaluating Deconvolution Components for Comparison Suitability 
2.8.21.11.1 Any component of a mixture with STRmixTM determined template <50 RFU shall 

be considered unsuitable for comparisons. This does not apply to assumed 
individuals. 

2.8.21.11.2 All single-source profiles and STRmixTM determined template amounts for 2-
person mixture components >150 RFU, 3-Person mixture components >250 
RFU, and 4-Person mixture components >350 RFU shall be considered suitable 
for comparisons. 

2.8.21.11.3 DBLRTM v1.5 or currently approved version shall be used to evaluate individual 
contributor positions for the following components prior to comparison of 
reference standards, except assumed contributor(s), and calculation of LRs: 

• 2-Person mixture components with STRmixTM determined template 
amounts from 50-150 RFU. 

• 3-Person mixture components with STRmixTM determined template 
amounts from 50-250 RFU. 

• 4-Person mixture components with STRmixTM determined template 
amounts from 50-350 RFU. 

2.8.21.11.3.1 Monte Carlo estimates <0.01 for P(Log10LR >= 0 | H2) shall be 
considered suitable for comparison to reference profiles and LRs shall 
be calculated/reported. 

2.8.21.11.3.2 Contributor positions which demonstrate a Monte Carlo estimate ≥ 
0.01 for P(Log10LR >= 0 | H2) shall be considered unsuitable for 
comparison. 

2.8.21.11.3.2.1 Once a higher contributor has been identified as unsuitable 
for comparison, the lower contributors are automatically deemed 
unsuitable for comparison and DBLRTM shall not be run.  For 
example, in a 4 person mixture, if contributor 2 is determined to be 
unsuitable for comparison utilizing DBLRTM, contributors 3 and 4 
are also determined to be unsuitable without DBLRTM evaluation.   

2.8.21.11.3.2.2 Any reference standard in which an LR is calculated and the 
contributor order giving the highest LR aligns with a 
contributor position determined to be unsuitable for 
comparison shall be reported as an exclusion.  The LR shall 
be marked as not used or applicable in the notes.  The 
reference standard shall not be utilized for a combined LR 
proposition set. 

2.8.21.11.3.2.2.1 When running a combined LR with reference standards 
that have support for inclusion into the comparable 
portion of a mixture individually, and the combined LR 
statistic aligns one of the references into a contributor 
position determined to be unsuitable for comparison, 
the individual statistics shall be reported and the 
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reporting note indicating that they cannot be together in 
the interpretable portion of the mixture shall be utilized.   

2.8.21.11.3.2.3 An LR need not be calculated for a reference standard that 
can be unambiguously excluded from the interpretable 
portion(s) of the mixture. 

2.8.21.11.4 To start a new DBLRTM evaluation, from the DBLRTM main menu select Explore 
Deconvolution. 

2.8.21.11.4.1 Drag and drop the sample deconvolution file folder or select Browse 
to navigate to the sample deconvolution and open the config file. 

2.8.21.11.4.2 Expand the Simulation menu and mark an appropriate contributor 
position for evaluation. If more than one contributor position requires 
evaluation, they shall be simulated independently. 

2.8.21.11.4.3 Open the Population menu and select ISP_NIST_Combined w iSNP: 
ISP_NIST_combined w iSNP (100%, Fst=0.01). 

2.8.21.11.4.4 Ensure the remaining search configuration settings match below: 
2.8.21.11.4.4.1 H1 Relationship: Contributor; H2 Relationship: Unrelated 
2.8.21.11.4.4.2 Include loci: All loci marked 
2.8.21.11.4.4.3 Log10(LR) threshold: 0 (corresponds to LR threshold of 1) 
2.8.21.11.4.4.4 Extended Output: Unmarked 
2.8.21.11.4.4.5 Sample: H1 true and H2 true marked; Additional hypothesis 

(H3) unmarked. 
2.8.21.11.4.4.6 Seed: Random 
2.8.21.11.4.4.7 Number of samples: 100,000 

2.8.21.11.4.5 Select Sample Likelihood Ratios 
2.8.21.11.4.6 Select Save Simulation Results. Save the DBLR results folder to the 

DNA data drive and add the PDF report to the case file.  
2.8.21.12 Comparing Sample Deconvolutions to Reference Standards (LR from Previous) 

2.8.21.12.1 A reference standard may be visually excluded without STRmix™ analysis. 
2.8.21.12.2 To compare reference STR profiles to a previously run STRmix™ deconvolution, 

from the STRmix™ main menu, select Investigation, then LR from Previous. 
2.8.21.12.2.1 Alternately, a Batch Mode for LR from Previous may be utilized for 

multiple samples, which is accessed from the main menu.  In the Add 
to Batch drop down menu, select add LR from Previous and then 
follow the instructions below. 

2.8.21.12.3 In the Previous Interpretation box, select Browse and navigate to the 
config.xml file for the appropriate STRmix™ deconvolution or drag and drop the 
deconvolution folder into the window.  

2.8.21.12.4 Leave the Case Number as it is carried over.  In the “Sample ID” box the 
appropriate LR number should be added behind LRPrev (e.g., 
001A_Decon1_LRPrev1). Each LR calculated from a deconvolution shall have a 
unique identifier.  If additional characters are added to the “Sample ID” 
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designation at this step, those characters shall be added after the specified 
naming convention.  Select Next. 

2.8.21.12.4.1 The number of contributors, number of burn-in accepts per chain, and 
number of post burn-in accepts per chain will be grayed out and 
cannot be changed.  No changes should be made to Run Settings. 

2.8.21.12.5 Add a new profile to the box marked Reference Profile Data.  This may be done 
by selecting + and navigating the file tree, or by dragging and dropping the 
appropriate GeneMapper® ID-X export file or previous STRmix™ evidence file 
into the box.  Multiple reference profiles may be added, one at a time or highlight 
and add multiple profiles at one time. 

2.8.21.12.6 To ignore loci from deconvolution, select Kit Settings, then select Loci, then 
select Ignore? for appropriate loci, then select Apply. 

2.8.21.12.6.1 If a locus in the reference profile has potential allelic drop-out (a single 
allele ≤ 950 RFU), the locus shall be omitted from the LR from 
Previous calculation.   

2.8.21.12.7 If a varNOC deconvolution was performed, select LR Settings.  Under 
Contributor Range, select MLE for the priors method, then select Apply. 

2.8.21.12.7.1 Upon request by the submitting agency, Prosecuting or Defense 
attorney or with Technical Leader permission documented in the 
casefile, a User Defined LR may be performed.   

2.8.21.12.7.1.1 Select LR Settings.  Under Contributor Range, select User 
Defined for the priors method, enter the selected number of 
contributors for Hp and Hd, then select Apply. 

2.8.21.12.8 Select Start.  This will begin the LR calculation of the chosen sample. 
2.8.21.12.9 When the analysis is complete, STRmix™ will generate several data files and 

save them to the Results folder on the C: drive. 
2.8.21.12.10 Save the results folder for the LR calculation containing all appropriate STRmix™ 

files to the corresponding deconvolution master folder located on the DNA server 
for the appropriate case.    

2.8.21.13 LR Calculations 
2.8.21.13.1 Each analyzed proposition (and therefore each LR From Previous report) will 

contain a generated set of calculations including a Likelihood Ratio (LR) Total 
(sub-sub-source), Factor of N! (sub-source) LR, and a 99% 1-Sided Lower HPD 
Interval. 

2.8.21.13.2 The (sub-sub-source) LR Total is a ratio between the probability of the evidence 
given two competing propositions or hypotheses and forms the basis for 
subsequent statistical calculations. 

2.8.21.13.2.1 Calculations for (sub-sub-source) LR Total utilize the National Research 
Council recommendation 4.2, equations 4.10, more commonly referred to 
as the Balding & Nichols formulae. 

2.8.21.13.2.1.1 Homozygous   [2θ + (1-θ)p][3θ + (1-θ)p] 
               [1+θ][1+2θ] 
2.8.21.13.2.1.2 Heterozygous  2[θ + (1-θ)p][θ + (1-θ)q] 
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               [1+θ][1+2θ] 
2.8.21.13.2.1.3 Each locus LR shall be multiplied together to form the multi-

locus LR for the profile. 
2.8.21.13.3 The Factor of N! (sub-source) LR is a calculation that uses the (sub-sub-source) 

LR Total with additional consideration for the number of ways to combine the 
different contributor probabilities in a mixture. 

2.8.21.13.4 The HPD calculation uses the Factor of N! (sub-source) LR with additional 
consideration for the uncertainty in the allele frequencies and deconvolution 
process. HPD is the most conservative of the three calculations and will be used 
for reporting the significance of a comparison. 

2.8.21.13.5 Additionally, a Unified LR may be calculated under propositions that consider 
only a single person of interest. The unified LR takes into account that the 
unknown contributor(s) are made up of both unrelated people and relatives of the 
person of interest. These calculations may be most useful when the alternate 
proposition is that the true donor of the evidence sample is a relative of the 
person tested. 

2.8.21.13.6 The varNOC Maximum Likelihood Estimate LR (MLE) assigns an LR using the 
most probable number of contributors under H1 and H2. This means the number 
of contributors in the numerator and denominator may be the same or they may 
be different.  The number of contributors will depend on which number of 
contributor analysis has the highest likelihood given the proposition for each. 

2.8.21.14 Troubleshooting STRmix™ Results 
2.8.21.14.1 After a STRmix™ analysis has completed, the results are interpreted by 

examining the weightings of various genotypes and the DNA results observed. 
There are instances when the results obtained do not intuitively seem correct. 
Examples of this are: 

• Large LRs (greater than 1) are obtained for each locus, except one 
where the LR is 0. 

• The mixture proportions do not reflect what is observed. 

• The interpreted contributor genotypes are not intuitively correct. 
2.8.21.14.2 Possible causes for these issues include: 

• The MCMC has not run for enough iterations. 

• The number of contributors has not been correctly chosen. 

• An artifact was left in the GeneMapperTM ID-X interpretation. 
2.8.21.14.3 Should the weights and/or the diagnostics highlight to the user that further 

scrutiny is necessary then a number of rework options are available, if required. 
For example, a review of the proposed number of contributors could be 
considered. Further analytical work such as a re-electrophoresis, a re-
amplification, or a clean up to strengthen the number of contributors assumption 
or assist with allele designation/sub optimal PCR performance. Extended total 
iterations (x10) may be considered, if the acceptance rate is low, the ESS is low 
and/or the GR value is significantly above 1.2.  If extended iterations are 
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manually utilized, the Technical Leader shall be notified with documentation 
included in the case record. 

2.8.21.14.3.1 Additional troubleshooting options may be available after consultation 
with the Technical Leader (documented in the case record).  This may 
include utilizing informed priors to designate the mixture proportions 
utilized in the deconvolution. 

2.8.21.14.4 If after comparison to a reference sample from a person of interest, an analyst 
suspects an error was made during the interpretation of the sample (e.g., 
determining the wrong number of contributors or an artifact was not deleted), 
independent analysis and interpretation of the profile by the Technical Leader or 
their designee shall be performed.  A referee analysis is not required if the error 
determined after comparison to a reference profile of an individual who may be 
assumed present in the sample.  If the error is caught during technical review of 
the case, and the reviewer has not examined the profiles of the person(s) of 
interest, the referee analysis is not required.   

2.8.21.14.4.1 The analyst shall only provide the .hid files for the unknown sample of 
concern and the allelic ladder to the Technical Leader.  If a reference 
standard may be assumed, the .hid file for that reference may also be 
included.  If the analysis method and panels and bins in GMID-X are 
not current methods, the analyst shall notify the Technical Leader of 
the appropriate analysis methods and settings to utilize.  No additional 
case information or information regarding the interpretation issue shall 
be given.  The Technical Leader may request limited additional 
information only if it is needed for analysis. 

2.8.21.14.5 In a single source sample, if an error is discovered that did not affect the STRmix 
deconvolution of the sample (ex. a pull-up peak was not deleted, but it was 
modeled as drop-in), a second deconvolution does not need to be performed.  
The error shall be documented in the case record with an explanation why it did 
not affect the interpretation. 

2.8.21.14.5.1  An error of this type requires a new deconvolution in a mixed sample.      
2.8.21.15 CODIS Eligibility and Entry 

2.8.21.15.1 Casework profiles shall be carefully evaluated for CODIS eligibility in accordance 
with National DNA Index System (NDIS) Operational Procedures “DNA Records 
Accepted at NDIS” and the flowchart “A Guide to Determining What is Allowable 
in the Forensic Index at NDIS,”  both available on the CODISPortal. Refer to the 
CODIS Test Method for details. 

2.8.21.15.2 Each year, every qualified analyst shall complete the ‘Annual Review of DNA 
Data Accepted as NDIS’. The timing of this review is specified by NDIS and 
completion is documented within the CODIS learning management system. 
Appropriate extensions, if needed, will be maintained by the CODIS 
Administrator. 

2.8.21.15.3 If a casework profile is determined to be ineligible after CODIS entry and upload, 
that profile shall be deleted by a CODIS administrator. The case analyst shall 
issue a supplemental report stating that the profile was removed. 

2.8.21.16 Use of STRmix™ to aid in deconvolution of mixtures for CODIS entry 
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2.8.21.16.1 Additional STRmix™ deconvolutions utilizing conditioning may be performed to 
aid in the deconvolution of a mixture for improved CODIS entry.  

2.8.21.16.1.1 If a mixture includes support for inclusion of a reference profile (an LR 
has been calculated in support for H1), the mixture may be deconvoluted 
conditioning on that reference profile to provide improved genotype 
weightings of an additional contributor to be entered into the database. 

2.8.21.16.1.1.1 The case documentation of this deconvolution shall be clearly 
marked as for CODIS purposes only.   

2.8.21.16.1.1.2 The analyst shall ensure all alleles to be entered in CODIS are 
present in the original mixture. 

2.8.21.16.1.1.3 The original deconvolution should generally be utilized for 
comparison if an evidentiary reference standard is submitted at a 
later date. 

2.8.21.16.1.2 If a mixture indicates that an additional single source unknown profile in 
the case cannot be excluded as a contributor, that unknown profile may 
be utilized to improve genotype weightings of an additional contributor for 
CODIS entry.  

2.8.21.16.1.2.1 The single source unknown profile may be reanalyzed in 
GeneMapperTM ID-X utilizing reference profile settings. 

2.8.21.16.1.2.2 The mixture may be deconvoluted conditioning on the reanalyzed 
single source unknown profile. 

2.8.21.16.1.2.3 The analyst shall ensure all alleles to be entered in CODIS are 
present in the original mixture. 

2.8.21.16.1.2.4 The case documentation of the reanalysis and the deconvolution 
shall be clearly marked as for CODIS purposes only.   

2.8.21.16.1.2.5 The original deconvolution with no conditioning on the unknown 
profile shall be utilized for all LR calculations.  

2.8.21.17 Use of the STRlite Excel program 
2.8.21.17.1 The ISP STRlite Excel program shall be utilized to provide a summary of 

GeneMapperTM ID-X allele calls for reference and unknown samples; as well as 
information collated from the STRmix™ deconvolution, database search and LR 
from Previous reports for sample analysis utilized in the interpretation of the 
profile. 

2.8.21.17.1.1 STRlite v2.0 (or most current version as approved by the Technical 
Leader) shall be utilized.   

2.8.21.17.1.2 Worksheets, as appropriate, from the STRlite program shall be 
maintained in the case record.  These worksheets may include Pre-
STRmix, Deconvolution, Likelihood Ratios, Standards, CODIS, 1P 
Combo, and 2P Combo.  An electronic copy of STRlite containing results 
shall not be maintained on the DNA server to avoid duplication of items 
between LIMS and the server. 
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2.8.21.17.1.2.1 The STRlite Deconvolution page or a 1P/2P Combo worksheet 
shall be maintained for all deconvolutions that represent a valid 
interpretation of the profile.  

2.8.21.17.1.2.1.1 If an analyst error is made during a deconvolution run (e.g., An 
unintended number of contributors was entered, a pull-up peak 
was not deleted etc.), a deconvolution worksheet does not 
need to be generated for that run, but the STRmix™ 
deconvolution files shall be maintained electronically and the 
case record shall document why the run was not used. 

2.8.21.17.1.2.2 On STRlite Deconvolution pages, Combo worksheets, and CODIS 
pages, the use of “{ }” at a locus with one or two alleles clarifies 
that the 99% cumulative weighting contains more than one 
possible genotype (mixture or partial) and would be searched with 
moderate stringency in CODIS.   

2.8.21.17.1.2.3 For single source profiles, the analyst shall manually add results 
for Amelogenin to the CODIS worksheet.   

2.8.21.17.1.2.4 For mixed profiles, the analyst may manually add results for 
Amelogenin to the CODIS worksheet if they feel the data supports 
the determination. 

2.8.21.17.1.3 The electronic STRmix™ reports saved to the case folder on the DNA 
server shall be referenced for further troubleshooting as needed.           

2.9 Records: 
2.9.1 The appropriate worksheets as contained in the Worksheet Manual, STRlite, or the equivalent 

workbooks shall be used to record all procedures. 
2.9.2 All data sheets, notes, photographs, and other information generated from the laboratory 

examination shall be kept in the case record. 
2.9.3 The technical review of the case record shall be recorded on the technical review worksheet. 
2.9.4 Electronic records shall be retained as indicated in Appendix 9. 

2.10 Interpretations of Results: 
2.10.1 Interpretation guidelines are located within the Procedures Section 2.8. 

2.11 References: 
2.11.1 Federal Bureau of Investigation. Procedures for the Detection of Restriction Fragment Length 

Polymorphisms in Human DNA. FBI Laboratory. 1990.  
2.11.2 Federal Bureau of Investigation. PCR-Based Typing Protocols. FBI Laboratory. 1994.  
2.11.3 Applied Biosystems. 3500/3500xL Genetic Analyzer 3500 Series Software 2 User’s Manual.  

P/N 4476988, rev. A. 5/2012. 
2.11.4 Applied Biosystems. VeritiTM Thermal Cycler User Guide.  P/N 4375799, Rev. E. 2010 
2.11.5 Promega Corporation. PowerPlex® Fusion 6C System Technical Manual. Part No. TMD045. 

Most current issue. 
2.11.6 Promega Corporation.  PowerPlex® Matrix Standards, 3100/3130 Technical Bulletin.  Part No.  

TBD022.  1/06 or most current issue. 
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2.11.7 Promega Corporation. Maxwell® 16 Instrument Operation Manual. Part No. TM295. 2008 or 
most current issue 

2.11.8 Promega Corporation. DNA IQ™ Casework Sample Kit for Maxwell® 16. Part No. TB 354. 
2009 or most current issue. 

2.11.9 Promega Corporation. Tissue and Hair Extraction Kit (for use with the DNA IQ™). Part No. 
TB307. 2006 or most current issue. 

2.11.10 Promega Corporation. DNA IQ™ Reference Sample Kit for Maxwell® 16.  Part No. TB347. 
2009 or most current issue. 

2.11.11 Applied Biosystems. GeneMapperTM ID-X Software Version 1.0 Getting Started Guide. Part 
No. 4375574 Rev. A. 10/2007 

2.11.12 Applied Biosystems. GeneMapperTM ID-X Software Version 1.2 Reference Guide. Part No. 
4426481 Rev. A. 10/2009 

2.11.13 Applied Biosystems. GeneMapperTM ID-X Software Version 1.0 Administrator’s Guide. Part 
No. 4376327 Rev A. 09/2007. 

2.11.14 Applied Biosystems. GeneMapperTM ID-X Software Version 1.4 User Bulletin. Part No. 77684 
Rev. A. 08/2012 

2.11.15 Applied Biosystems. GeneMapperTM ID-X Software Version 1.6 User Bulletin. Pub. No. 
100073905 Rev. B. 02/2019. 

2.11.16 Smith, J., Budowle, B. Source Identification of Body Fluid Stains Using DNA Profiling.  
Proceedings of the Second European Symposium, Innsbruck, Austria.  6/98 

2.11.17 Applied Biosystems. Quantifiler® HP and Trio DNA Quantification Kit User Guide. P/N 
4485354 most current version. 

2.11.18 Bär, W. et al. DNA recommendations: Further report of the DNA Commission of the ISFH 
regarding the use of short tandem repeat systems. Int. J. Legal Med. (1997) 110, 175-176. 

2.11.19 Gill, P. et al. Considerations from the European DNA profiling group (EDNAP) concerning 
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3. Forensic Relationship Comparison Methods: 
3.1. Scope: 

3.1.1. Forensic relationship comparisons may be requested as part of some criminal investigation 
cases. Types of relationship comparisons that can be performed include paternity, maternity, 
reverse paternity, sibling relationship (sibship), etc. These comparisons may establish potential 
relationships among individuals and/or aid in the identification of human remains and missing 
persons.  Samples for forensic relationship testing shall be processed in accordance with the 
test methods outlined in the DNA methods section of this document. 

3.2. Precautions/Limitations: 
3.2.1. Cases submitted for relationship comparisons should be evaluated by a member of the 

relationship comparison team before any testing is performed. It may be necessary to outsource 
some types of cases to a vendor laboratory for analysis. Cases shall be refused when they do 
not meet the requirements of forensic relationship comparison analysis. 

3.2.1.1. Cousin comparisons should not be performed unless it is part of a pedigree.  
3.3. Related Information: 

3.3.1. See Relationship Comparison Statistical Reference Sheet (Appendix 10) 
3.4. Instruments: 

3.4.1. See DNA Test Methods Section 2.4 
3.5. Reagents/Materials: 

3.5.1. See DNA Test Methods Section 2.5 
3.6. Hazards/Safety: 

3.6.1. See DNA Test Methods Section 2.6 
3.7. Reference Materials/Controls/Calibration Checks: 

3.7.1. See DNA Test Methods Section 2.7 
3.8. Procedures/Instructions: 

3.8.1. See DNA Test Methods Section 2.8 
3.9. Interpretation of Relationship Testing Results: 

3.9.1. Possible Outcomes of Relationship Comparisons 
3.9.1.1. The genetic profiles from standards and samples are compared to evaluate relationship. 

The following conclusions may be reported: 
3.9.1.2. For relationship cases using DBLR™: 
• [Limited/moderate/strong/very strong] support for the alleged relationship:    

CRI > 1. 
• Uninformative:  CRI = 1 
• Limited support for unrelatedness:  2 ≤ 1/CRI < 100 
• Unrelated:  1/CRI ≥ 100 or visual exclusion for parentage cases 

3.9.2. Inconsistent Profiles in Parentage Relationship Cases 
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3.9.2.1. If the alleged father’s profile is inconsistent with the child’s obligate paternal alleles at more 
than three loci with PowerPlex® Fusion 6C, then no relationship/exclusion shall be 
concluded. 

3.9.2.2. If the alleged father’s profile is inconsistent with the child’s obligate paternal alleles at 
fewer than four loci with PowerPlex® Fusion 6C, then other alternatives may be evaluated 
for these inconsistencies. Other alternatives may include possible mutation, null allele, first 
degree relative, or true exclusion. If it is determined that a possible mutation or a null/silent 
allele could account for the inconsistencies, then the mutation or null allele shall be 
included into the statistical calculations. 

3.9.2.2.1 A mutation is typically observed to be a 1-step (repeat unit) smaller or larger from the 
parental allele (family study estimates ~90%). 2-step (~9%) or 3-step (~1%) 
mutations are possible, but very uncommon. 

3.9.2.2.2 A null/silent allele may be observed when both the child and either parent appear 
homozygous at a locus without a concordant allele and the overall peak height of the 
homozygous allele is approximately half expectation based on the peak heights of 
other loci in the same dye channel. Additional indicators may include a possible peak 
below AT that would be concordant between the parent and child and/or requiring 
more than a 1-step mutation to explain the discordant locus. The Technical Leader 
shall be consulted for incorporation of a null allele into the statistical calculation.  

3.9.3. Mixtures 
3.9.3.1. With product of conception/fetal samples, it may be necessary to have a standard from the 

mother. Using the biological mother’s standard, a deconvolution may be performed to 
determine the genotype of the child.  

3.9.3.2. Secondary standards, including personal effects believed to belong to a missing person, 
may be suitable for comparison. Additional standards may be requested to aid in 
interpretation or to be conditioned upon, if appropriate. 

3.10. Guidelines for Additional Testing 
3.10.1. Y-STR testing for kinship comparisons should only be done in the following circumstances: 

3.10.1.1. Kinship analysis involving male individuals proposed to be paternally related that 
demonstrate limited support for H1 or H2 or an uninformative result shall have additional 
Y-STR analysis performed to provide further information regarding a potential 
relationship. 

3.10.1.2. Kinship analysis involving male individuals proposed to be paternally related that 
demonstrate moderate support for H1 may have additional Y-STR analysis performed to 
provide further information regarding a potential relationship. 

3.10.1.3. If a mutation is suspected at one or two Y-STR loci with PowerPlex® Fusion 6C, 
additional genetic testing should be performed to evaluate additional Y-STR loci.   

3.10.2. If there are additional Y-STR discordances that do not support an alleged relationship (such as 
full siblings), the analyst shall attempt to confirm with the contributing agency if there is 
potential for a different relationship (such as half-siblings).  If the agency is unable to confirm a 
different relationship is possible, the results shall be reported as no support for the originally 
designated relationship and additional family standards should be requested.  If confirmation of 
a potential relationship in which Y-STR profiles are not expected to match is obtained, the new 
relationship statistic should be performed along with a report statement indicating that the Y-
STR results do not demonstrate support for the original relationship. 
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3.11. Rules for Relationship Statistical Calculations using DBLR™: 
3.11.1. Calculations shall be performed using DBLR™ version 1.5 or currently approved version. 
3.11.2. Statistical calculations shall be performed and reported in forensic relationship comparison 

cases where Results/Opinions/Interpretations are being given in regards to relationship.   
3.11.3. A minimum of eight autosomal loci with no indication of allelic drop-out are required for 

comparison and statistical calculations.  STRmixTM deconvolutions may be utilized for 
degraded standards or for standards demonstrating mixtures as allowed in 3.9.3.   For 
STRmixTM deconvolutions, the 99% contributor designation shall be utilized for this 
purpose.   

3.11.4. Statistical calculations shall not be performed in parentage cases with more than three 
genetic inconsistencies. 

3.11.5. Linkage shall be enabled for all calculations, regardless of the type of relationship under 
evaluation. 

3.11.6. The addition of Y-STR loci (DYS391, DYS576, and DYS570) into the PowerPlex® Fusion 
6C system is intended to assist with interpretation of the number of male contributors in a 
sample and with samples demonstrating a possible null Y allele at Amelogenin. Therefore, 
statistical evaluation of the Y-STR loci shall not be performed or incorporated in the 
Combined Relationship Index unless a mutation is suspected. 

3.11.7. See Relationship Comparison Statistical Reference Sheet (Appendix 10) for a list of 
formulas for calculations. 

3.11.8. If more than one standard/sample is available for comparison, the most representative 
standard/sample or the standard/sample where the most obligate paternal alleles can be 
determined shall be used for statistical calculations.  

3.11.9. Relationship statistical calculations utilize the race of the alleged individual.  The 
calculations shall be performed with the appropriate NIST 2017 population data using the 
racial information provided by the contributing agency. If racial information is unknown or 
reported as multi-racial, calculations shall be performed using the Combined population 
data. 

3.11.10. Manual calculations performed by an analyst shall be verified by a qualified technical 
reviewer and/or a qualified unit supervisor. 

3.11.11. Mutations shall only be enabled in DBLR™ when necessary. 
3.11.11.1. The appropriate Maternal or Paternal mutation rate file shall be selected in DBLR™ 

based on the suspected mutation source. 
3.11.11.2. In the event that a mutation is suspected at one Y-STR locus other than DYS570, 

DYS576, DYS612, and DYF387S1, a mutation factor of 0.001 shall be used as a 
haplotype Relationship Index and incorporated through manual calculation into the 
Combined Relationship Index derived from DBLR™. DYS570, DYS576, DYS612, 
and DYF387S1 are generally regarded as rapidly mutating Y-STR loci. The 
mutation factor for a single discordant Y-STR locus defined as rapidly mutating will 
be incorporated as a haplotype Relationship Index and incorporated manually into 
the CRI by multiplying by 0.01. TL consultation is required for two suspected Y-
STR mutations.   

3.11.12. Mutation rates for historical loci (PowerPlex® 16 HS and SE33) have been reported in the 
AABB Annual Report Summary. For any locus without a published mutation rate, the rate 
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shall be calculated by averaging the available tetranucleotide STR mutation rates 
(excluding SE33). 

3.11.13. For parentage calculations utilizing a mother’s standard and an alleged father’s standard in 
which a null allele from the alleged father is suspected, the Paternity Index (PI) for a locus 
demonstrating a possible null allele should be manually calculated using the formula 
described in Appendix 10. The frequency of a silent allele(s) is 0.001 based on the typical 
observation of a null allele in modern STR typing kit loci is less than 1 in 1,000. The 
Technical Leader shall be consulted if a null allele is suspected.   

3.11.14. The FST Coancestry Coefficient shall be enabled for all calculations.  An FST of 0.01 shall be 
utilized for all populations. 

3.12. Relationship Calculations using DBLR™ 
3.12.1. To start a new DBLR™ relationship calculation, from the DBLR™ main menu select 

Kinship. 
3.12.2. In the H1 screen, construct the pedigree.   

3.12.2.1. The symbols used should reflect the sex of the corresponding sample, with 
squares for males and circles for females. 

3.12.2.2. A template may be chosen from the drop-down menu. 
3.12.2.3. A custom pedigree may be constructed by right clicking on the symbol for 

Individual A and adding parents or offspring as required. 
3.12.2.4. The default sample names may be edited to reflect case information by highlighting 

the assigned letter and typing the desired label. 
3.12.3. Add H2 by clicking the “+” symbol next to H1. 

3.12.3.1. Add the unknown, unrelated individual by choosing the male or female symbol from 
the toolbar, as appropriate. 

3.12.4.  Verify that all symbols and labels are visible and adjust spacing as needed. 
3.12.4.1. The pedigrees can be rearranged by clicking and dragging symbols.  

3.12.5. Choose Numeric Kinship in the bottom, right corner. 
3.12.6. Add the profiles to the box marked Load Samples.  This may be done by dragging and 

dropping the appropriate files, or by selecting Browse and navigating the file tree. 
3.12.6.1. If a Genotypes Table file is used, ensure that all samples in the project have 

unique names. 
3.12.6.2. If necessary, a locus may be omitted in DBLR™ in instances of tri-allele, null allele, 

or a single autosomal locus with only one allele detected below the Analytical 
Threshold (i.e., 950 RFU). Alternatively, when multiple loci demonstrate one allele 
below the AT a STRmix™ deconvolution should be performed. 

3.12.6.3. When loading samples, select the pencil icon next to Ignored loci for the 
appropriate sample and mark the necessary loci to be omitted. 

3.12.7. Under Configuration, add the appropriate Analysis Name.  At a minimum, the name shall 
include the case number, followed by an underscore and the DBLR run number, increasing 
sequentially (e.g., 23L1234_DBLR1, 23L1234_DBLR2).  If additional characters are added 
to the “Analysis Name” designation, those characters shall be added after the specified 
naming convention. 
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3.12.8. Under Parameters, Verify the Population Stratification is set to “No stratification” and 
choose the appropriate Allele Frequencies file.  Verify that “Model mutations” is unchecked 
unless a mutation is suspected.  Verify that “Model Fst” is checked and set to 0.01.  Verify 
that “Model linkage” is checked and the appropriate Linkage map is selected. 

3.12.9. Select Confirm Inputs once all profiles are loaded and settings are verified. 
3.12.10. Link all loaded profiles to the appropriate positions in H1 and H2.  This may be 

accomplished by dragging the sample name to the appropriate position in the pedigree, or 
by clicking Add Relationship and selecting the person in the pedigree and its 
corresponding sample from the drop-down menus. 

3.12.10.1. Verify that the correct Contributor Position is selected if a STRmix deconvolution is 
used as a sample input. 

3.12.10.2. When FST is enabled, a warning message will show that there are unexplained 
contributor positions until all loaded samples are linked to the pedigree.  This must 
be resolved before a likelihood ratio can be calculated. 

3.12.10.3. The Locus Exclusion Precheck Warning shows either an information or warning 
symbol under H1 and H2 based on how the genotypes fit the pedigree.  A warning 
symbol occurs when at least one genotype cannot occur with the chosen 
relationship.  Clicking on the symbol opens a pop-up window to review the inputs 
and pedigree for troubleshooting purposes.  This does not need to be resolved for 
a calculation to progress. 

3.12.11. Click Compute Likelihood Ratios and review the data. 
3.12.12. Save a copy of the Kinship Report in the casefile and the run folder on the DNA server 

(See Appendix 9). 
3.12.12.1. The report will list linked loci together whenever Linkage is enabled.  However, the 

model is only applied when needed based on the pedigree and sample profiles. 
3.13. Report Writing for Relationship Comparisons Using DBLR™ General Guidelines: 

3.13.1. The Combined Paternity Index shall be reported in the Results/Opinions/Interpretations area 
of the Certificate of Analysis when applicable as detailed in the report wording section 
(Appendix 7).   

3.13.1.1. No statistical calculations shall be reported for exclusions determined from greater 
than three inconsistencies in parentage comparisons.  

3.13.2. All reports associated with a Paternity/Relationship Comparison Request shall include an 
Appendix (Appendix 7).  Each profile development statement in the report shall contain the 
citation for the appropriate kit utilized statement in the Appendix. 

3.13.3. The items used for comparison will be reported in the format listed in the report wording 
section (Appendix 7). 

3.13.4. Alternate report wording may be used depending on the type of relationship and calculation 
performed. 

3.13.5. Terminology of Parentage, Paternity, Maternity, Relationship, Kinship, and Sibling 
Relationship (Sibship) may be used interchangeably where applicable. 

3.13.6. The Combined Paternity Index shall be reported to two significant figures.  
3.13.6.1. Combined Relationship/Paternity Index values supporting the relationship (H1) 

shall be rounded down. 
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3.13.6.2. Combined Relationship/Paternity Index values supporting exclusion (H2) shall be 
inverted (1/CRI) and rounded up. 

3.13.6.3. Combined Relationship/Paternity Index values less than 2 shall be rounded down 
to 1.0 (uninformative). 

3.13.7. Wording of Relationship Comparisons for Results/Opinions/Interpretations are located in 
Appendix 7. 

3.14. Support for Investigative Genetic Genealogy 
3.14.1. Y-STR testing may be utilized to aid in paternal lineage identification. 
3.14.2. At a minimum, 12 Y-STR loci are required to draw a conclusion on paternal lineage. 
3.14.3. Interpretations will be based on the number of loci evaluated and mismatches observed. 

3.14.3.1. When at least 20 Y-STR loci are available for comparison the following 
interpretation guidelines shall apply: 

• 0-1 mismatches: support the donors of the Y-STR profiles are related 

• 2 mismatches: support the donors of the Y-STR profiles are probably related 

• 3 mismatches: support the donors of the Y-STR profiles are possibly related 

• 4+ mismatches: support the donors of the Y-STR profiles are not related within 
four generational steps 

3.14.3.2. When 12-19 Y-STR loci are available for comparison the following interpretation 
guidelines shall apply: 

• 0-1 mismatches: support the donors of the Y-STR profiles are probably related 

• 2 mismatches: support the donors of the Y-STR profiles are possibly related 

• 3+ mismatches: support the donors of the Y-STR profiles are not related within 
four generational steps 

3.14.4. Interpretations of Y-STR testing for paternal lineage identification shall be issued to the 
interested parties via a memo as shown in Appendix 7. 

3.15. Definitions: 
3.15.1. Random Man Not Excluded (RMNE) – The frequency of selecting a random man from the 

population that could not be excluded as the biological father. 
3.15.2. Probability of Exclusion/Power of Exclusion (PE) – The probability of excluding a 

random man from the population as being the biological father; is dependent on the 
genotypes of the child and mother and the race of the alleged father. 

3.15.3. Parentage Index (PI)/Relationship Index (RI) – A likelihood ratio based on two different 
conditional probabilities; PI/RI is calculated for each locus in a system. 

3.15.4. Combined Parentage Index (CPI)/Combined Relationship Index (CRI) – CPI/CRI is the 
product of all PIs/RIs for the loci in a system; a measure of the strength of the genetic 
evidence. 

3.15.5. Probability of Parentage (W) – Also known as the probability of relatedness.  It is the 
measure of the strength of the genetic evidence and the non-genetic evidence that an 
individual is a biological relative as compared to an unrelated, random individual in the same 
population. 
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3.15.6. Prior Probability (Pr) – The strength of the non-genetic evidence that the alleged individual 
is a biological relative.  
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4. Y-STR Test Methods: 
4.1. Scope: Y-STR analysis may be performed in situations where male DNA needs to be differentiated 

from female DNA.  DNA analysis performed prior to Y-STR analysis shall be in accordance with the 
test methods outlined in the DNA Methods section of this document.  

4.2. Precautions/Limitations: Samples that may be suitable for Y-STR analysis should be evaluated by 
a member of the Y-STR team to determine the most appropriate sample(s) to analyze in a case.  
The following should be considered: 

4.2.1. Cases from sexual assault/misconduct should be considered for analysis. 
4.2.1.1. Due to the limitations of the technology, only body swabs or body fluid stains from 

crimes against a person shall be considered for Y-STR analysis. In general, suspected 
epithelial cell samples shall not be tested from areas other than body area samples. 
Exceptions require supervisor approval. 

4.2.1.2. Special consideration shall be given for cold case sexual assaults and homicides where 
Forensic Investigative Genetic Genealogy or additional investigative techniques may be 
pursued.  Supervisor notification of Y-STR analysis in these cases is required.    

4.2.2. Cases that have not provided meaningful autosomal results shall be submitted for Y-STR 
analysis considering the following:  

4.2.2.1. If a sample or samples from more intimate/informative areas qualify for Y-STR analysis, 
those samples shall be submitted. 

4.2.2.1.1. i.e., if the autosomal result is from a non-genital swab, all genital swabs that 
qualify for Y-STR analysis shall be submitted.  

4.2.2.2. If the LR associated with the autosomal result is in the lower moderate to limited verbal 
scale, samples shall be submitted for Y-STR analysis. 

4.2.2.3. Due to the high probability of extraneous transfer and non-probative DNA results, 
clothing, hand swabs and fingernail scrapings shall not be submitted for Y-STR analysis 
if the victim and suspect live in the same household. Exceptions require supervisor  
approval. 

4.2.2.4. In general, male-on-male sexual assaults shall not be submitted for Y-STR analysis. 
Exceptions require supervisor approval. 

4.3. Related Information: 
4.3.1. Worksheet Manual 
4.3.2. Appendix 13 PowerPlex® Y23 Stutter Table 

4.4. Instruments: 
4.4.1. See DNA Test Methods Section 2.4 

4.5. Reagents/Materials: 
4.5.1. See DNA Test Methods Section 2.5 

4.6. Hazards/Safety: 
4.6.1. See DNA Test Methods Section 2.6 

4.7. Reference Materials/Controls/Calibration Checks: 
4.7.1. See DNA Test Methods Section 2.7 
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4.8. Procedures/Instructions: 
4.8.1. See DNA Test Methods Section 2.8 for extraction procedures 

4.8.1.1. Performing Y-STR analysis before or after autosomal STR analysis will be evaluated on 
a case by case basis.  

4.8.1.2. Y-STR analysis should be performed on extracts previously used for autosomal STR 
testing. Some instances may require re-extraction of a sample. 

4.8.1.3. The male quantification value using Quantifiler® Trio shall be used for amplification of 
the sample.  

4.8.2. PowerPlex® Y23 (Applied Biosystems® 3500 Genetic Analyzer) 
4.8.2.1. Introduction 

4.8.2.1.1. Short tandem repeat (STR) markers on the Y chromosome (Y-STR) have qualities 
that are distinct from autosomal markers and are useful for human male 
identification.  The Promega PowerPlex® Y23 System allows co-amplification of 
twenty-three loci (DYS576, DYS389 I, DYS448, DYS389 II, DYS19, DYS391, 
DYS481, DYS549, DYS533, DYS438, DYS437, DYS570, DYS635, DYS390, 
DYS439, DYS392, DYS643, DYS393, DYS458, DYS385 a/b, DYS456, and 
YGATAH4) in a single reaction.  Separation and detection occur using capillary 
electrophoresis with overlapping loci visualized simultaneously by using PCR 
primers labeled with four different fluorescent tags (Fluorescein, JOE, TMR-ET, 
and CXR-ET).  

4.8.2.1.2. The Applied Biosystems® 3500 Genetic Analyzer utilizes electrokinetic injection of 
DNA molecules into polymer-filled capillaries which separates the DNA fragments 
by size.  The fluorescent tag labeled primers incorporated into the PowerPlex® 
Y23 amplification products are responsive to the frequency of the 20 mW solid-
state laser.  Upon excitation, the fluorophores are raised to a higher energy level.  
When the fluorophores return to their normal energy level, a fluorescent signal is 
emitted.  This signal is then detected by a camera within the 3500 capillary 
electrophoresis instrument which converts the signal to a computer image where it 
is visualized in an electropherogram as a peak. 

4.8.2.1.3. The data produced by the Applied Biosystems® 3500 Genetic Analyzer is analyzed 
with GeneMapperTM ID-X Software which results in peaks labeled with their allele 
designation.  The Internal Lane Standard (WEN ILS 500) is injected with each 
sample and it contains 21 fragments of 60, 65, 80, 100, 120, 140, 160, 180, 200, 
225, 250, 275, 300, 325, 350, 375, 400, 425, 450, 475, and 500 bases in length.  
Each fragment is labeled with WEN dye and can be detected separately (as a fifth 
color) in the presence of PowerPlex® Y23 amplified material.  The Internal Lane 
Standard determines the base pair size of the fragments in the sample and the 
software compares the sizes to an allelic ladder to determine the allele designation. 

4.8.2.1.4. The PowerPlex® Y23 locus-specific and allelic ladder information is available at 
www.promega.com/protocols/ in the PowerPlex® Y23 System Technical Manual 
TMD035. 

4.8.2.1.5. All PowerPlex® Y23 components should be stored at -10°C to -30°C upon receipt 
in the appropriate laboratory locations.  The PowerPlex® Y23 Allelic Ladder is 
packaged separately for shipping and should be stored in the post-amplification kit.  
Once thawed, the pre-amplification kit may be stored at 2°C to 10°C for up to one 

http://www.promega.com/protocols/
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year or refrozen at -10°C to 30°C.  The post-amplification kit, including the WEN 
Internal Lane Standard (WEN ILS) 500 Y23, should be stored at 2°C to 10°C after 
thawing.  Do not refreeze.  

4.8.2.1.6. The PowerPlex® Y23 Primer Pair Mix, PowerPlex® Y23 Allelic Ladder Mix, and 
the WEN ILS 500 Y23 shall be protected from excessive exposure to light.  

4.8.2.1.7. The preparation of the amplification reactions shall be performed in the PCR 
amplification set-up area.  
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4.8.2.2. PowerPlex® Y23 Amplification Set-Up  

4.8.2.2.1. Thaw the Amplification Grade Water, PowerPlex® Y23 5X Master Mix, and 
PowerPlex® Y23 10X Primer Pair Mix.  Centrifuge briefly to bring contents to the 
bottom, then vortex to mix.  Do not centrifuge after vortexing as this may cause the 
primers/dNTPs to be concentrated at the bottom of the tube.  Once thawed, the 
PowerPlex® Y23 kit may be stored at 2-10oC for up to one year or refrozen.   

4.8.2.2.2. Determine the number of samples to be amplified, including controls.  Add 2 to 4 
reactions to this number to compensate for the loss that occurs during reagent 
transfers. 

4.8.2.2.3. Place one 0.2 ml PCR reaction tube for each sample into a rack and label 
appropriately. A 96-well plate may be used. 

4.8.2.2.3.1. If utilizing a 96-well plate for amplification, well locations where allelic ladder 
will be utilized for capillary electrophoresis shall be left empty during 
amplification. 

4.8.2.2.4. 0.1 ng to 0.5 ng of template DNA is recommended.  Amplification of greater than 
0.5 ng of template DNA should not be used due to off-scale peak heights and may 
result in increased artifacts and interfere with interpretation.  Targeting less than 
0.5 ng of template DNA should be used only with samples whose concentration 
falls between 0.006 ng/µl and 0.029 ng/µl.  Such samples shall be interpreted with 
caution.  Samples with concentrations greater than 0.029 ng/µl should target 0.5 
ng but shall not exceed 1.0 ng for amplification. 

4.8.2.2.4.1. A higher template DNA amount (ex. 1.0 ng) should be considered for 
samples with an elevated degradation index (ex. >3).    

4.8.2.2.5. For samples that will amplify 5 µl of template DNA, use the PowerPlex Y23® 
Amplification Worksheet – 5 µl Input to calculate the required amount of each 
component of the PCR master mix.  Multiply the volume per reaction by the total 
number of reactions to obtain the final volume.  

4.8.2.2.6. Add the calculated volume of each component to a 1.5 ml tube.  Mix gently. 
4.8.2.2.7. Add 20 µl of PCR master mix to each sample tube or well. 
4.8.2.2.8. Pipette 5 µl of sample, reagent blank, positive amplification control, or negative 

amplification control into the respective tube or well.   
4.8.2.2.8.1. For the positive amplification control, dilute the 2800M or other approved 

positive DNA standard supplied with the PowerPlex® Y23 kit to 0.02 ng/µl 
to 0.1 ng/µl and record the final concentration on the amplification 

PCR Master Mix Component Volume per 
Reaction (µl) 

Amplification Grade or Nuclease Free H2O 12.5 

PowerPlex® Y23 5X Master Mix 5 

PowerPlex® Y23 10X Primer Pair Mix 2.5 

Total Volume 20 
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worksheet.  A positive control shall be included in each thermal cycler.  The 
diluted positive control should be stored at 2-10°C. 

4.8.2.2.8.2. Amplification grade H2O or NF H2O shall be used as a negative 
amplification control included with each thermal cycler as the last sample in 
the batch. 

4.8.2.2.9. For samples requiring more than 5 µl of sample volume, use the PPY23® 
Amplification Worksheet – Variable Input to calculate the required amount of 
water and template DNA for individual samples.  Prepare the PCR Master Mix 
without water.  Multiply the volume per reaction by the total number of reactions to 
obtain the final volume.   

4.8.2.2.10. Add the calculated volume of each component to a 1.5 ml tube.  Mix gently. 
4.8.2.2.11. Add 7.5 µl of PCR master mix to each sample tube or well. 
4.8.2.2.12. Add the calculated volume of Amplification Grade H2O or NF H2O to each sample 

tube or well.  
4.8.2.2.13. Pipette the appropriate amount of each sample, reagent blank, positive 

amplification control into the respective tube or well containing master mix.   
4.8.2.2.14. For samples amplified in a 96-well plate, seal the plate with adhesive foil.  Press 

the foil well using a roller tool. 
4.8.2.3. PowerPlex® Y23 Amplification  

4.8.2.3.1. Place the tubes or 96-well plate in a Veriti™ thermal cycler. 
4.8.2.3.2. Select and run the thermal cycling protocol below: 
4.8.2.3.3. Y23 Veriti™ Thermal Cycler Protocol  

1 Cycle 30 Cycles 1 Cycle Hold 

96°C 94°C         

2 minutes 10 sec    72°C     

  61°C  30 sec  60°C   

   1 minute    20 minutes  
 

 

        4°C 

 (All ramp rates set at 100%)    ∞ 

4.8.2.3.3.1. Select 25 µl for the volume in the amp tubes. 

PCR Master Mix Component Volume per 
Reaction (µl) 

PowerPlex® Y23 5X Master Mix 5 

PowerPlex® Y23 10X Primer Pair Mix 2.5 

Total Volume 7.5 



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 93 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

4.8.2.3.4. Remove samples after the amplification process is completed and proceed with 
capillary electrophoresis or store the amplified samples at -10°C to -30°C.  Alternatively, 
amplified samples may be stored at 2-10°C if they are to be used within 2 days. 

4.8.2.3.4.1. Any remaining amplified products shall be discarded after the case is 
administratively reviewed. 

4.8.2.4. PowerPlex® Y23 Direct Amplification Set-Up for Databasing Lysates   
4.8.2.4.1. Thaw the Amplification Grade Water, PowerPlex® Y23 5X Master Mix, and 

PowerPlex® Y23 10X Primer Pair Mix.  Centrifuge briefly to bring contents to the 
bottom, then vortex to mix.  Do not centrifuge after vortexing as this may cause the 
primers/dNTPs to be concentrated at the bottom of the tube. Once thawed, the 
PowerPlex® Y23 kit may be stored at 2-10oC for up to one year or refrozen.   

4.8.2.4.2. Determine the number of samples to be amplified, including controls.  Add 2 to 4 
reactions to this number to compensate for the loss that occurs during reagent 
transfers. 

4.8.2.4.3. Place one 0.2 ml PCR reaction tube for each sample into a rack and label 
appropriately.  A 96-well plate may be used. 

4.8.2.4.3.1. If utilizing a 96-well plate for amplification, well locations where allelic ladder 
will be utilized for capillary electrophoresis shall be left empty during 
amplification. 

4.8.2.4.4. For samples and controls, use the PowerPlex® Y23 Direct Amplification 
Worksheet to calculate the required amount of each component of the PCR 
master mix.  Multiply the volume per reaction by the total number of reactions to 
obtain the final volume .  

4.8.2.4.5. Add the calculated volume of each component to a 1.5 ml tube.  Mix gently. 
4.8.2.4.6. Add 23 µl of PCR master mix to each sample tube/well. 
4.8.2.4.7. Pipette 2 µl of sample, reagent blank, positive amplification control, or negative 

amplification control into the respective tube or well containing Master Mix.   
4.8.2.4.7.1. For the positive amplification control, dilute the 2800M or other approved 

positive DNA standard supplied with the PowerPlex® Y23 kit to 1 ng/µl to 
1.5 ng/µl and record the final concentration on the amplification worksheet.  
A positive control shall be included in each thermal cycler.  The diluted 
positive control should be stored at 2-10°C. 

4.8.2.4.7.2. Amplification grade H2O or NF H2O shall be used as a negative 
amplification control included with each thermal cycler as the last sample in 
the batch. 

PCR Master Mix Component Volume per 
Reaction (µl) 

Amplification Grade or Nuclease Free H2O 15.5 

PowerPlex® Y23 5X Master Mix 5 

PowerPlex® Y23 10X Primer Pair Mix 2.5 

Total Volume 23 
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4.8.2.4.8. For samples amplified in a 96-well plate, seal the plate with adhesive foil. Press 
the foil well using a roller tool. 

4.8.2.5. PowerPlex® Y23 Direct Amplification for Standards 
4.8.2.5.1. Place the tubes or 96-well plate in a VeritiTM thermal cycler. 
4.8.2.5.2. Select and run the thermal cycling protocol below: 
4.8.2.5.3. Y23direct VeritiTM Thermal Cycler Protocol  

1 Cycle 25 Cycles 1 Cycle Hold 

96°C 94°C         

2 minutes 10 sec    72°C     

  61°C  30 sec  60°C   

   1 minute    20 minutes  
 

 

        4°C 

 (All ramp rates set at 100%)    ∞ 

4.8.2.5.3.1. Select 25 µl for the volume in the amp tubes. 
4.8.2.5.4. Remove samples after the amplification process is completed and proceed with 

capillary electrophoresis or store the amplified samples at -10°C to -30°C.  Alternatively, 
amplified samples may be stored at 2-10°C if they are to be used within 2 days. 

4.8.2.5.4.1. Any remaining amplified products shall be discarded after the case is 
administratively reviewed. 

4.8.3. Applied Biosystems® 3500 Genetic Analyzer - Data Collection Software version 2.0 – 
Instrument Set-up.  See Appendix 11 

4.8.4. Applied Biosystems® 3500 Genetic Analyzer - Data Collection Software version 2.0 - 
PowerPlex® Y23 Electrophoresis 

4.8.4.1. Sample Preparation 
4.8.4.1.1. Note:  The quality of formamide is critical for the successful detection of a DNA 

profile.  Deionized formamide shall be used that has a conductivity of less than 
100µS/cm, such as Hi-Di™ Formamide.  The formamide shall be frozen in aliquots 
at -20oC and the remainder of each aliquot shall be discarded after it is thawed.  
Multiple freeze-thaw cycles or long-term storage at 4oC may cause breakdown of 
the formamide which can create ions that compete with DNA during injection.  This 
will cause lower peak heights and decreased sensitivity. 

4.8.4.1.2. Caution:  Formamide is an irritant and teratogen; therefore, universal precautions 
and a fume hood shall be utilized when manually working with formamide to avoid 
inhalation and contact with the skin. 

4.8.4.1.3. Thaw the ILS (WEN ILS 500 Y23), the allelic ladder, and an aliquot of Hi-Di™ 
Formamide.  Once thawed initially, the ILS shall not be refrozen and should be 
stored at 2-10oC.  When all components are thawed, centrifuge briefly then vortex 
to mix.  Do not centrifuge the ILS after vortexing. 
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4.8.4.1.4. Determine the number of samples to be injected, including controls and allelic 
ladders.  Add 2 to 4 reactions to this number to compensate for the loss that occurs 
during reagent transfers. 

4.8.4.1.5. Prepare a loading cocktail by combining 0.5-1.0 µl ILS with 9.5-9.0 µl Hi-Di™ 
Formamide for a total volume of 10 µl. 

4.8.4.1.5.1. The volume of ILS used in the loading cocktail may be adjusted between 
0.5 to 1.0 µl per sample to optimize size standard peaks.  The amount of 
formamide shall be adjusted so that the total amount of loading cocktail 
for each well is 10 µl.  

4.8.4.1.6. Vortex to mix. 
4.8.4.1.7. Pipette 10 µl of the formamide/ILS mixture into each well.  Add formamide or 

formamide/ILS mixture into empty wells to complete an injection set of eight.  Every 
well in which an injection is occurring must contain liquid. 

4.8.4.1.8. Add 1 µl of amplified sample or allelic ladder to the appropriate wells. It is 
recommended that a minimum of one allelic ladder is present with every 24 
samples injected (i.e., every three injections on the 8-capillary 3500). .  At least one 
allelic ladder is required within each run folder.   

4.8.4.1.8.1. If the amplified sample is in a 96-well plate, seal the amplification plate 
with a new aluminum foil seal for storage.  

4.8.4.1.9. Cover the wells with the plate septa and briefly spin down to remove air bubbles. 
4.8.4.1.10. Denature the samples at 95oC for ~3 minutes, then immediately chill on crushed 

ice or a frozen plate block for ~3 minutes.  Denature the samples just prior to 
loading the instrument.  Avoid denaturing the samples for longer than 3 minutes as 
extended heat denaturing can lead to the appearance of artifacts. 
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4.8.4.2. Creating a Plate Record 
4.8.4.2.1. Open the 3500 Data Collection Software.  The Dashboard screen will launch.  

Ensure that the Consumable Information and Maintenance Notifications are 
acceptable.  The oven temperature should be set to 60ºC.   

4.8.4.2.2. Select Start Pre-Heat.  This should be done at least 30 minutes prior to the first 
injection. 

Dashboard: 

 
 

4.8.4.2.3. Select Create New Plate.  Alternatively, Create Plate from Template may be 
used. 

4.8.4.2.3.1. Assign the plate name with the laboratory case number, the date and the 
injection number of the plate (ex. 00A1234_01Jan13_01). 

4.8.4.2.3.1.1. If the plate is re-injected the “01” number shall increase 
sequentially (00A1234_01Jan13_02). 

4.8.4.2.3.1.2. If the plate is re-injected on a different day, the original date 
should still be used from when the plate was prepared.   

4.8.4.2.3.1.3. If a second preparation of a plate is made on the same date as the 
first, it shall be designated with a “-2” after the date 
(00A1234_01Jan13-2_01). 
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4.8.4.2.4. Select “96” for Number of Wells. 
4.8.4.2.5. Select “HID” for Plate Type. 
4.8.4.2.6. Select “36” for Capillary Length. 
4.8.4.2.7. Select “POP4” for Polymer. 

Create A Plate: 

 
 

4.8.4.2.8. Click on “Assign Plate Contents”. 
4.8.4.2.9. Enter sample information or import a plate record. 

4.8.4.2.9.1. The sample name shall include the sample item/subitem as well as the 
laboratory case number (ex. 1A1_00A1234) if more than one case is 
included on the plate.  If only one case is present on the plate, then only the 
item/subitem number is required. 

4.8.4.2.9.2. In order to aid in GeneMapperTM ID-X sample analysis, it is recommended 
to place a “z” in front of the sample name for reference standards (ex.  
z1A1_00A1234”) here or in GeneMapperTM ID-X under sample name. 

4.8.4.2.10. Under Assays click “Add from Library” and select “PPY23_1.2kV15s”.  Click “Add 
to Plate” then “Close”. 
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4.8.4.2.11. Under File Name Convention, click “Add from Library” and select “PPY23_FNC”.  
Click “Add to Plate” then “Close”. 

4.8.4.2.12. Under Results Groups, click “Add from Library” and select “PPY_ResultsGroup”.  
Click “Add to Plate” then “Close”.  

Assign Plate Contents: 

 
  

4.8.4.2.13. On the bottom-right side of the screen expand the Customize Sample Info 
window so it appears as shown above. 

4.8.4.2.13.1. Use the drop-down box to select a sample type for each sample (e.g., 
Ladder, Sample, Positive Control and Negative Control).  For imported 
plates, this will be done automatically. 

4.8.4.2.13.2. Minimize the “Customize Sample Info” window. 
4.8.4.2.14. Highlight the sample wells and then select the boxes in the Assays, File Name 

Conventions, and Results Groups that pertain to those samples. 
4.8.4.2.15. Place plate on instrument in position A.  Select “Link Plate for Run”.  Click “OK”.  

The instrument automatically senses the plate and puts the information in the Plate 
A field.  Click “OK”. 

4.8.4.2.16. To add a second plate, follow steps 4.8.4.2.3 through 4.8.4.2.15.  Place the plate in 
position B.  Select the “Link Plate for Run” and click “OK”.  Assign the information 
to the Plate B field.  Click “OK”.  

4.8.4.3. Start a Plate Run  
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4.8.4.3.1. A unique run name is automatically generated by the instrument for each plate.  
4.8.4.3.2. To re-organize injections, click “Create Injection List” and use the arrows to re-order 

the injections. 
4.8.4.3.3. Click “Start Run”. 
4.8.4.3.4. After the run is complete, click “Unlink Plate” and remove it from the instrument.  

The plate may be discarded or labeled with the same title as the plate record and 
stored at -10°C to -30°C. The plate shall be destroyed after the case has been 
administratively reviewed. 

4.8.4.3.4.1. If the CE plate requires re-injection after frozen storage, thaw and 
centrifuge to remove any air bubbles.  Denature the plate at 95oC for 3 
minutes, then immediately chill on crushed ice or frozen plate block for ~3 
minutes prior to loading on the 3500 Genetic Analyzer.  

4.8.4.3.5. The CE Plate Record Worksheet shall be maintained with each case record. 
4.8.5. See Casework Test Methods Appendix 4 for GeneMapperTM ID-X Version 1.6 Software 

User Accounts and Security Setting Procedures. GeneMapperTM ID-X Version 1.6 
Software - PowerPlex® Y23 Software Settings.  See Appendix 12 

4.8.7. GeneMapperTM ID-X Version 1.6 Software - PowerPlex® Y23 Data Analysis 
4.8.7.1. Processing Sample Data  

4.8.7.1.1. Import the sample files from a single run folder by “Edit”, then selecting “Add 
Samples to Project”. 

4.8.7.1.2. In the “Add Samples to Project” screen, navigate to the run folder that contains the 
sample files.  If the entire run folder is to be imported, click on the folder to highlight 
it; then click the “Add to List” button at the bottom of the window.  If the run folder 
was shared between multiple cases, expand the folder to view the samples.  
Highlight the appropriate samples, ensuring that the allelic ladder and all the 
desired samples are selected.  Once all the samples are selected click the “Add to 
List” button at the bottom of the window.  

4.8.7.1.2.1. A run folder shall not be created manually by manipulating sample files.  
4.8.7.1.3. Ensure that the necessary files are now located in the “Samples to Add” window by 

double-clicking on the folder in the right pane, then click “Add”. 
4.8.7.1.4. After the samples have been added to the project, first briefly scan the raw data to 

ensure that a bad injection did not occur.  To check the raw data, first expand the 
project folder in the left navigation pane, then click on a sample file, then click on 
the “Raw Data” tab in the right GeneMapperTM ID-X window.  To return to the 
“Samples” window, click on the project folder at the top of the left navigation pane. 

4.8.7.1.5. The GeneMapperTM ID-X project shall contain at least one allelic ladder from each 
run folder included in the project for proper genotyping.  Multiple allelic ladders 
within a run folder will be averaged by the software to calculate the allelic bins.  If a 
ladder injection is of low quality, delete the ladder or change the sample type from 
“Allelic Ladder” to “Sample” to remove it from consideration in calculating the bins.  

4.8.7.1.6. Ensure that the Table Setting at the top of the screen is set to “PPY23”. 
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4.8.7.1.7. In the Sample Type column, verify that the correct sample types are displayed 
(e.g., Allelic Ladder, Sample, Positive Control, and Negative Control). Should a 
sample type need altered, use the drop-down menu to select the appropriate type.  

4.8.7.1.8. In the Analysis Method column, select the appropriate method from the drop-
down menu: “PowerPlex Y23 WEN”.  Click the column header cell to highlight the 
entire column, then select “Edit”, then “Fill Down” (or the shortcut Ctrl + D). 

4.8.7.1.9. In the Panel column, select the appropriate panel file: Open the 
“PowerPlexY23_Panels_IDX_v2.0” folder then select “PowerPlexY23_IDX_v2.0”.  
Click the column header cell to highlight the entire column, then select “Edit”, then 
“Fill Down” (or the shortcut Ctrl + D). 

4.8.7.1.10. In the Size Standard column, select the appropriate ILS from the drop-down 
menu: “WEN ILS 500”.  Click the column header cell to highlight the entire column, 
then select “Edit”, then “Fill Down” (or the shortcut Ctrl + D). 

4.8.7.1.11. The Analysis Method, Size Standard, and Panel can be set as defaults when a 
GeneMapperTM ID-X project is opened.  Select File → Project Options.  Under the 
“Add Samples” tab select the above settings as the default in the drop-down 
menus for Analysis Method, Size Standard and Panel. Click “OK”.  

4.8.7.1.12. Select the green Analyze arrow button to start the data analysis.  At the Project 
name prompt, save the project. The project name shall contain the date the 3500 
plate was prepared so that it matches the run folder name. See the DNA Server 
Instructions Appendix 9 for additional clarification.  The case number is 
recommended but not required.  Select the “ISP Casework Security Group”. 

4.8.7.2. Evaluating Sample Data 
4.8.7.2.1. The Sizing Quality for unknown samples and allelic ladders shall be at least 0.75 

for a sample to pass.  The Sizing Quality for reference samples, negative controls, 
and positive controls shall be at least 0.25 for a sample to pass.  All appropriate 
ILS peaks shall be present and labeled correctly. 

4.8.7.2.2. Allelic Ladders and Samples   
4.8.7.2.2.1. Highlight all sample rows containing ladders or samples and click “View”, 

then “Display Plots”.  In the Samples Plot screen, change the “Plot 
Setting” drop-down box to “PPY23”.  Magnify the area from approximately 
50 bp to 500 bp ensuring that all ILS peaks are visible in the retained 
electropherogram. 

4.8.7.2.2.2. Verify the correct allele calls are made for each ladder peak and evaluate 
all allele calls as described in 4.8.10.   

4.8.7.2.2.3. Retain the electropherograms. 
4.8.7.2.3. Negative Controls (e.g., amplification blanks and reagent blanks).   

4.8.7.2.3.1. Highlight all sample rows containing negative controls and click “View”, 
then “Display Plots”.  In the Samples Plot screen, change the “Plot 
Setting” drop-down box to “PPY23”.   

4.8.7.2.3.2. Ensure that no peaks above analytical threshold are present.   
4.8.7.2.3.3. Retain the electropherograms ensuring that the primer peak is visible. 
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4.8.7.2.4. After all analysis is complete, save the 3500 Data Collection Run Folder and 
associated GeneMapperTM ID-X projects under each associated laboratory case 
number and request folder located in the analysts’ folders on the server.  Projects 
should be deleted monthly from the “GeneMapper Manager” to maintain database 
space. 

4.8.7.2.4.1. When exporting the GeneMapperTM ID-X project, ensure that the “Export 
with analysis settings” box is checked.  

4.8.8. General Rules for PowerPlex® Y23 Analysis On The Applied Biosystems® 3500 Genetic 
Analyzer 

4.8.8.1. It is required that at least one allelic ladder is present within a run folder.  However, it is 
recommended that an allelic ladder is run within each set of 3 injections on the 8 capillary 
3500 (one ladder per 24 capillaries). External environmental factors during a plate run can 
cause a shift in the migration of DNA fragments within the capillary which may cause a 
small difference in the base pair length determined for an allele.  If an allelic ladder sample 
was not run within a reasonable time as the sample, this may cause an allele to be called 
off ladder. 

4.8.8.2. The placement of unknown samples in the 96-well plate should be done so that the 
orientation allows for the injection of unknown samples prior to the injection of any 
reference samples for that case. 

4.8.8.3. Peak heights of analyzed samples should not exceed 28,000 RFU.  This level of peak 
height is approaching saturation and will lead to the appearance of artifacts.  Use of data 
with more than two peaks >28,000 RFU may be allowed with the approval of a supervisor 
and notification to the Technical Leader documented in the case record. 

4.8.8.4. If multiple amplifications are analyzed for a sample, the analyst shall use the amplification 
which he or she determines sufficiently represents the sample based on peak heights, 
artifacts, and noise levels.  Analysts shall interpret data that most clearly represents the 
sample and try to achieve better resolution if a sample has peak heights that are too high 
(resulting in artifacts, increased instrument noise, and pull-up) or too low (resulting in 
allelic drop out and loss of data). 

4.8.8.5. Only the data used for interpretation needs to be published in the case record.  However, 
other runs shall be noted in the case record and all data shall be saved under each 
associated laboratory case number and request folder located in the analysts’ folders on 
the server. 

4.8.9. Archiving Applied Biosystems® 3500 and GeneMapperTM ID-X Projects 
4.8.9.1. The 3500 run folders containing all sample files for a case as well as the GeneMapperTM 

ID-X project file shall be saved under each associated laboratory case number and 
request folder located in the analysts’ folders on the server and deleted from the hard drive 
of the instrument and/or analysis computer.  The data stored on the server shall be 
routinely backed up to ensure security of data.   

4.8.9.2. All electropherograms used in interpretation as well as the plate record shall be placed in 
the case record.   

4.8.10. Interpretation Guidelines for PowerPlex® Y23 
4.8.10.1.1. An analyst is required to visually confirm all allelic ladders used for allele 

designation.   
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4.8.10.1.2. The internally validated analytical threshold for data interpretation is 100 RFU for 
all dye channels.   

4.8.10.1.2.1. Peaks below 100 RFU shall not be interpreted or marked on the STR 
summary sheet but may be considered when determining suitability for 
interpretation and/or number of contributors for a sample. 

4.8.10.1.3. The stochastic threshold for data interpretation of the DYS385 a/b locus is 225 
RFU.  There is no stochastic threshold for the remaining loci.  

4.8.10.1.3.1. Peaks between 100 and 225 RFU at the DYS385 a/b locus shall be reported 
with a bracket (e.g., [13]) on the Y-STR summary sheet.  

4.8.10.1.3.2. Interpretation of peaks with RFU from 100 to 225 RFU at the DYS385 a/b 
locus is a qualitative assessment.  If the DYS385 a/b locus demonstrates a 
single allele that is above 100 RFU and below 225 RFU, true homozygosity 
cannot be determined due to possible stochastic effects. 

4.8.10.1.4. An initial interpretation of the data shall be made to distinguish non-allelic artifact 
peaks (e.g., pull-up, spikes, dye blobs, etc.) from true allelic data.  

4.8.10.1.4.1. Artifacts have been observed and documented utilizing the PowerPlex® Y23 
amplification kit.  Any artifact peaks called as alleles by the GeneMapperTM 
ID-X software shall be deleted or renamed on the electropherogram as an 
artifact.  Many DNA-independent and DNA-dependent artifacts have been 
observed.  A complete list of artifacts can be found in the PowerPlex® Y23 
Technical Manual.   

4.8.10.1.4.2. Pull-up or bleed through peaks can occur if signal intensity of sample or ILS 
peaks is too high or if a new spectral calibration needs to be run.  Any pull-up 
peaks called as alleles by the GeneMapperTM ID-X software shall be labeled 
on the electropherogram as pull-up or artifact.  The sample should be re-run if 
a pull-up peak interferes with the analyst’s ability to evaluate the profile based 
on their experience and training.  

4.8.10.1.4.3. Spikes are peaks that generally appear in all colors and are sharper than 
regular peaks; however, they can occur predominantly in one color.  Spikes 
are a natural consequence of capillary electrophoresis and can be caused by 
dust present in the system as well as urea crystals in the system.  It is 
essential that the instrumentation be maintained and cleaned regularly to 
minimize the appearance of spikes.  All spikes called as alleles by the 
GeneMapperTM ID-X software shall be clearly labeled as spikes or artifacts on 
the electropherogram.  A sample should be re-injected when a spike 
interferes with the analyst’s ability to evaluate the profile based on their 
experience and training.  

4.8.10.1.5. Stutter peaks are artifacts of the amplification process.  The peak heights of stutter 
peaks will be less intense than that of the major peak.  Stutter peaks will typically 
be observed one repeat unit shorter than the parent peak (e.g., n-4 position at a 
tetranucleotide repeat locus) but may also occur two repeat units less (e.g., n-8 at 
a tetranucleotide repeat locus) or one repeat unit more (e.g., n+4 at a 
tetranucleotide repeat locus).  Additionally, n-2 and n+2 artifact peaks have been 
observed.  Any peaks determined to be stutter that were not filtered out by the 
GeneMapperTM ID-X software shall be labeled at stutter or artifact on the 
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electropherogram.  Mean and mean + 3SD stutter values can be found in Appendix 
13.   

4.8.10.1.6. Rare variants have been described in the literature.  The causes of these rare 
variants are microvariants or chromosomal mutations (duplication or deletion). 

4.8.10.1.6.1. Microvariants represent a partial repeat for a given allele. These peaks have 
a similar intensity to other allelic peaks but will not line up with the allelic 
ladder and will fall outside established bins.   

4.8.10.1.6.1.1.  Any allele peak that is not present in the allelic ladder and does not have 
an associated “bin” in the GeneMapperTM ID-X analysis software is 
labeled “OL” (Off-Ladder) and shall be renamed by the analyst on the 
electropherogram. 

4.8.10.1.6.1.2. Alleles which are located between two alleles on the ladder shall be 
described as the short repeat followed by the number of base pairs it is 
larger (e.g., 0.1, 0.2, 0.3, 0.4, or 0.5).  Therefore, if a peak is 1 base pair 
larger than the 5 allele it shall be designated as 5.1.  A microvariant 3 
base pairs larger than an allele on the ladder for a trinucleotide, 4 base 
pairs larger for a tetranucleotide, 5 base pairs larger for a 
pentanucleotide, or 6 base pairs larger for a hexanucleotide may be 
designated with the full repeat number (A peak 4 base pairs larger than 
the 5 allele could be designated a 6; 5 base pairs larger a 6.1).   

4.8.10.1.6.1.3. Alleles which are located outside the range of the ladder or bin set but 
within the designated marker range of the locus shall be evaluated to 
determine the appropriate repeat number that should be assigned to the 
allele.  The allele may also be described as “<” or “>” the largest or 
smallest allele for that locus with a set of ( ) placed around the off ladder 
allele.  For example, if a peak is located above the largest allele for the 
DYS19 locus, it would be designated as “(>19)”. 

4.8.10.1.6.1.4. Alleles which are labeled “OMR” (Outside Marker Range) by the 
GeneMapperTM ID-X analysis software shall be evaluated to determine 
which locus the allele likely belongs to.  If the analyst can reasonably 
determine which locus the allele belongs to, the allele can be assigned to 
that locus in GeneMapperTM ID-X and the allele call can be made. If the 
analyst cannot reasonably determine which locus the allele belongs to, 
both loci surrounding the loci shall be marked inconclusive.    

4.8.10.1.6.2. A duplication occurs a when a DNA sequence on the Y-chromosome is 
duplicated and results in more than one allele at a locus.  Duplications have 
been documented with the PowerPlex® Y23 amplification kit.  Instances of 
multiple duplications within a sample have been documented as well.  Most 
duplications have a one repeat difference; however, two, three, and four 
repeat unit differences has been observed.   

4.8.10.1.6.2.1. If a locus other than DYS385 a/b demonstrates more than one allele, 
evaluate the sample to distinguish between a mixture and a duplication. 

4.8.10.1.6.2.1.1. Determine the number of loci containing more than one peak and 
consider the position on the Y-chromosome if multiple loci have 
two peaks. 

4.8.10.1.6.2.1.2. Determine if the repeat spread is >1 repeat unit.  
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4.8.10.1.6.2.1.3. Evaluate the peak height ratio of the two peaks present at the 
locus. 

4.8.10.1.6.2.1.4. Examine DYS385 a/b for the presence of >2 peaks. 
4.8.10.1.6.2.2. If a two-peak pattern is observed for a single-source unknown sample 

and is believed to be a duplication, the profile should be confirmed by 
concordance to at least one additional sample contained within the case 
and/or re-amplification and documented notification to the Technical 
Leader. 

4.8.10.1.6.3. Null alleles can occur due to a deletion of a portion of the Y chromosome or a 
mutation to the primer binding site for a particular locus. The result is a lack of 
a peak at a single locus or multiple loci.  

4.8.10.1.6.3.1. The lack of an allele at a locus that is believed to be a null allele may be 
distinguished from an undetected allele due to allelic drop out by 
evaluating the overall quality of the sample, including peak heights and 
degradation.  The location of the missing allele may also be considered.  
Documented notification of the null allele to the Technical Leader is 
required.  

4.8.10.1.6.3.1.1. A deletion has been reported at the DYS448 locus.  Samples with 
this deletion will show two peaks (duplication) in DYS576 and a 
null allele in DYS448. 

4.8.10.2. Evaluation of Controls 
4.8.10.2.1. Failed controls require documented notification to the Technical Leader with 

appropriate documentation in the case record.  
4.8.10.2.2. The appearance of pull-up or known artifact peaks does not render the following 

controls inconclusive.  
4.8.10.2.3. Reagent Blank:   

4.8.10.2.3.1. The purpose of the reagent blank is to determine if the reagents used to 
extract the associated samples were contaminated by male DNA.  Therefore, 
no signal should be detected in this sample well other than the internal lane 
standard.  If a signal is detected in the reagent blank, all results of samples 
associated with that reagent blank shall be considered inconclusive.      

4.8.10.2.3.2. A reagent blank with peaks below analytical threshold shall not prevent 
associated samples from being interpreted.   

4.8.10.2.3.3. A reagent blank with peaks at or above the analytical threshold shall be 
considered a failed negative control.   

4.8.10.2.4. Positive Control:   
4.8.10.2.4.1. The 2800M or other appropriate male DNA standard supplied with the 

PowerPlex® Y23 kit is used as a positive control to demonstrate that the kit 
is performing properly.  A positive control is considered a failed positive 
control if expected alleles are not detected or if extra alleles are detected.     

Y-STR 
Locus 

2800M 

DYS576 18 
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DYS389 I 14 
DYS448 19 

DYS389 II 31 
DYS19 14 

DYS391 10 
DYS481 22 
DYS549 13 
DYS533 12 
DYS438 9 
DYS437 14 
DYS570 17 
DYS635 21 
DYS390 24 
DYS439 12 
DYS392 13 
DYS643 10 
DYS393 13 
DYS458 17 

DYS385 a/b 13,16 
DYS456 17 

Y-GATA-H4 11 
 

4.8.10.2.5. Amplification Blank:   
4.8.10.2.5.1. The purpose of the amplification blank is to determine if male DNA 

contaminated the samples at the amplification step.  Because no template 
DNA was placed in the reaction, the sample well should be blank except for 
the internal lane standard peaks.   

4.8.10.2.5.2. An amplification blank with peaks below analytical threshold shall not 
prevent associated samples from being interpreted. 

4.8.10.2.5.3. An amplification blank with at or above analytical threshold shall be 
considered a failed negative control. 

4.8.10.2.6. Interpreting, Comparing and Reporting DNA Results Associated with Failed 
Controls and Contamination Events 

4.8.10.2.6.1. The Technical Leader shall be notified if a positive or negative control fails 
and/or if sample contamination occurs.  Sample contamination is defined as 
additional peaks present in an unknown or reference sample that can be 
conclusively identified to not have originated in the sample (e.g., case to case 
contamination or a mixture in a reference sample).  

4.8.10.2.6.2. Assessment of the integrity of the associated DNA results shall be done in 
consultation with the Technical Leader.  This shall include the possible cause 
and effect of the failed control or contamination.  Additionally, an assessment 
of the risk associated with moving forward with interpretation shall be 
documented, as well as the risks associated with retesting (e.g., unnecessary 
consumption of evidence).  
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4.8.10.2.6.2.1. If retesting is performed, the reasons for doing so shall be 
documented.  

4.8.10.2.6.2.2. If results are determined to be suitable for interpretation without 
retesting, the appropriate interpretations, comparisons, and 
statistical results and a description of the failed control or 
contamination event shall be reported per the Report Writing 
Guidelines.  

4.8.10.2.6.2.3. If results are determined to be not suitable for interpretation and 
retesting cannot be performed, the results shall be reported as not 
suitable for comparison per the Report Writing Guidelines. 

4.8.10.2.6.3. Documentation in the case record shall include at a minimum: the forensic 
sample, reference or control test results that failed or was contaminated, the 
likely or known cause of the failed control or contamination, the likely or 
known source of the contamination, the impact on the integrity of the DNA 
results, and the determination if the test result is suitable or unsuitable for 
interpretation.  

4.8.10.3. Y-STR DNA Profile Interpretation 
4.8.10.3.1. All interpretation decisions shall be documented prior to comparison of reference 

profiles.  If an interpretation error is discovered after comparison to a reference 
profile, the Technical Leader shall be consulted to determine the appropriate 
action.  The error and Technical Leader consultation shall be documented in the 
case record. 

4.8.10.3.2. If available, a reference profile from a male victim who is not paternally related to 
the person of interest may be assumed for single source and major Y-STR profiles 
and no statistical analysis is required.  

4.8.10.3.3. During interpretation, the analyst and technical reviewer shall each compare all 
single source and major Y-STR profiles to available staff profiles to ensure that 
samples have not been contaminated.  All instances of profiles consistent with a 
staff member shall be reported to the Technical Leader. If the match is determined 
to be a suspected contamination event, a root cause analysis shall be performed to 
determine the possible cause.   

4.8.10.3.4. There are four possible outcomes of Y-STR analysis: 
4.8.10.3.4.1. No results:  No peaks were detected on the electropherogram. 
4.8.10.3.4.2. Inconclusive:  Peaks were observed at one or more loci; however, no 

conclusive results can be drawn from them.  
4.8.10.3.4.3. Inclusion:  The profile obtained from the unknown sample had no 

discrepant alleles as compared to the profile of the reference standard.  
Allelic drop-out may occur in low concentrations or mixtures.   

4.8.10.3.4.4. Exclusion:  The profile obtained from the unknown sample was not the 
same as the reference sample.  

4.8.10.3.5. Single Source Profile Interpretation 
4.8.10.3.5.1. Generally, a single source profile should contain no more than one allele at 

each locus except for DYS385 a/b, which may demonstrate up to two 
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alleles.  A profile where only one locus demonstrates two alleles could be 
an indication of: 

4.8.10.3.5.1.1. A mixture where only one allele from a minor contributor is 
detected above the analytical threshold.   

4.8.10.3.5.1.2. Extraneous DNA. 
4.8.10.3.5.1.3. A duplication. 
4.8.10.3.5.1.4. In situations 1 and 2, the sample shall be reported with the 

additional allele wording outlined in the Report Wording Guidelines 
(Appendix 7).  In situation 3, no mention is required in the 
Certificate of Analysis.  

4.8.10.3.5.2. At least twelve loci eligible for statistical calculations are required for 
interpretation of a single source profile.  Profiles demonstrating fewer than 
twelve loci shall be reported as inconclusive. Interpretation of single source 
profiles with fewer than twelve loci shall require consultation and 
documented approval from the technical leader. 

4.8.10.3.5.3. If DYS385 a/b demonstrates two alleles, the two peaks should have a peak 
height ratio of 65%. If the peak height ratio is less than 65%, evaluate the 
sample quality to determine if the locus should be used in statistical 
analysis.   

4.8.10.3.5.4. If DYS385 a/b  demonstrates two alleles in which one or both alleles are 
above 100 RFU and below 225 RFU, both alleles are interpretable and may 
be used for statistical analysis.  

4.8.10.3.5.5. If only one allele is present at DYS385 a/b and is below 225 RFU, the locus 
shall not be used for statistical analysis.  

4.8.10.3.6. Mixture Interpretation  
4.8.10.3.6.1. A profile is defined as a mixture between two or more males when two or 

more loci demonstrate two or more alleles, with the exception of two alleles 
at DYS385 a/b or a duplication event.   

4.8.10.3.6.2. If the profile is determined to be a mixture, each locus should be evaluated 
and classified as below: 

4.8.10.3.6.2.1. Indistinguishable mixture between two or more males  
4.8.10.3.6.2.2. Mixture demonstrating a major contributor. 
4.8.10.3.6.2.3. Demonstrates the potential for allelic drop-out. 

4.8.10.3.6.3. For mixtures of two male individuals, a major single source profile shall be 
calculated based on the following criteria: 

4.8.10.3.6.3.1. If the peak height ratio between the peaks is less than 20%, then 
the highest peak can be called a major at that locus. 

4.8.10.3.6.3.2. If there is only one peak at a particular locus (and a major can be 
determined at one or more loci with more than one peak), this 
peak can be called a major.  All loci must be considered in making 
this determination. 
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4.8.10.3.6.3.3. A mixture threshold of 500 RFU shall be used to interpret single 
peaks and major peaks at a locus.  Peaks below 500 RFU shall 
not be used for interpretation of the mixture. 

4.8.10.3.6.3.4. When evaluating DYS385 a/b, a major consisting of two peaks 
should have a peak height ratio of 65% and the tallest of the minor 
peak shall have a peak height ratio of less than 20% of the 
shortest major peak. 

4.8.10.3.6.3.5. If the sample does not meet these criteria at 12 or more loci, a 
major profile cannot be determined for the sample. 

4.8.10.3.6.4. Mixtures of three males which meet the above criteria should be interpreted 
with caution. 

4.8.10.3.6.5. Mixtures of four or more males shall be evaluated based on the following 
criteria.  These samples should be interpreted with caution and only with 
approval of the Technical Leader. 

4.8.10.3.6.5.1. If the peak height ratio between the highest peak and tallest minor 
peak is less than 15%, the highest peak can be called a major at 
that locus. 

4.8.10.3.6.5.2. A mixture threshold of 1000 RFU shall be used to interpret single 
peaks and major peaks at a locus. 

4.8.10.3.6.5.3. When evaluating DYS385 a/b, a major consisting of two peaks 
should have a peak height ratio of 65% and the tallest of the minor 
peaks shall have a peak height ratio of less than 15% of the 
shortest major peak. 

4.8.10.3.6.5.4. If the sample does not meet these criteria at 12 or more loci, a 
major profile cannot be determined for the sample.  

4.8.10.3.6.6. If a major profile cannot be determined in a mixture of two or more males, the 
mixture is considered indistinguishable. In this case, since no statistical 
interpretations can be made, the sample shall be reported as inconclusive.  

4.8.10.4. Y-STR Statistical Analysis and Database Searching  
4.8.10.4.1. A Y-STR profile is treated as a single locus because it is a haplotype. 
4.8.10.4.2. Once a comparison between a reference sample(s) and an unknown sample is 

completed and an inclusion for a single source or major Y-STR profile is 
reported, the significance of that inclusion shall be estimated.  It shall be reported 
that all paternally related males will share the same Y-STR profile.   

4.8.10.4.3. The unknown haplotype developed for the evidence profile shall be searched 
against the Y-Chromosome Haplotype Reference Database (YHRD), found 
online at http://yhrd.org.  

4.8.10.4.4. The unknown haplotype shall be searched by selecting the PowerPlex® Y23 Kit 
and the Y17 Dataset.  Loci from the PowerPlex® Y23 kit include DYS576, 
DYS389 I, DYS448, DYS389 II, DYS19, DYS391, DYS481, DYS549, DYS533, 
DYS438, DYS437, DYS570, DYS635, DYS390, DYS439, DYS392, DYS643, 
DYS393, DYS458, DYS385 a/b, DYS456, and Y-GATA-H4. 

http://yhrd.org/
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4.8.10.4.4.1. If the Y-STR profile contains a locus with a duplication, the duplication can 
be entered in the format of “X, Y”.  

4.8.10.4.4.2. If the Y-STR profile contains a locus with a null allele, a “0” will be entered.  
4.8.10.4.5. The counting method with the application of a 95% upper confidence interval 

using the Clopper and Pearson method along with a theta-corrected match 
probability are used for statistical calculations.  

4.8.10.4.5.1. The feature National Database (with Subpopulations, 2014 SWGDAM- 
compliant) shall be added to the statistical report after the Y-STR profile 
has been searched.  

4.8.10.4.6. A statistic result sheet from YHRD shall be generated for every unique Y-STR 
haplotype/profile searched.  The applicable sample ID(s) shall be clearly 
documented on the sheet. 

4.8.10.4.7. A likelihood ratio that incorporates the Theta-corrected Match Probability (without 
Native American) shall be included in the Certificate of Analysis.  The likelihood 
ratio is the inverse of the match probability.  A verbal scale shall accompany the 
likelihood ratio result in an effort to provide additional explanation of the weight of 
the evidence. 

Likelihood Ratio Support for Inclusion 
1 Uninformative 
2 ≤ LR < 100 Provides limited support 
100 ≤ LR < 10,000 Provides moderate support 
10,000 ≤ LR < 1,000,000 Provides strong support 
1,000,000 ≤ LR Provides very strong support 

4.8.10.4.8. The Certificate of Analysis shall acknowledge the date of the search and the 
release number of YHRD at the time of the search. 

4.8.10.4.8.1. Statistics from a previous database search will not be recalculated. 
Exceptions require permission from the Technical Leader.   

4.9. Records: 
4.9.1. The appropriate worksheets or the equivalent workbooks shall be used to record all procedures.  
4.9.2. All data sheets, notes and other information generated from the laboratory examination shall be 

kept in the case record. 
4.9.3. The technical review of the case record shall be recorded on the technical review worksheet.  
4.9.4. Electronic records shall be retained as indicated in Appendix 9. 

4.10. Interpretation of Results: 
4.10.1. Interpretation guidelines are located with the Procedures Section 4.8. 

4.11. Reporting of Y-STR Analysis: 

4.11.1. See Appendix 7 for formatting and Y-STR reporting for specific examples 

 
4.12. References: 
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4.12.1. Promega Corporation, (2014 or most current version).  PowerPlex® Y23 System Technical 
Manual. Part No. TMD035. Madison, WI. 

4.12.2. Butler, J.M.  2011.  Y Chromosome DNA Testing.  Advanced Topics in Forensic DNA Typing:  
Methodology. pp 371-403.  Elsevier Academic Press. Burlington, MA. 

4.12.3. Butler, J.M.  2010. Lineage Markers: Y Chromosome and mtDNA testing. Fundamentals of 
Forensic DNA Typing. pp 363-374. Academic Press. Burlington, MA.  

4.12.4. Butler, J.M.  2005.  Y Chromosome DNA Testing.  Forensic DNA Typing:   Biology, Technology, 
and Genetics of STR Markers.  Second Edition. pp 201-239.  Elsevier Academic Press. 
Burlington, MA. 

4.12.5. SWGDAM (2022).  SWGDAM Interpretation Guidelines for Y-Chromosome STR Testing.  
Available at http://www.swgdam.org/publications SWGDAM (2022). Supplemental Information 
for the SWGDAM Interpretation Guidelines for Y-Chromosome STR Typing by Forensic DNA 
Laboratories. Available at http://www.swgdam.org/publications 

4.12.6. Ballantyne, J. and Fatolitis, L. The U.S. Y-STR database. Profiles in DNA. 2008. 11(1): 13 – 14. 
4.12.7. Y-Chromosome Haplotype Reference Database (YHRD).  http://yhrd.org  

  

http://yhrd.org/
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5. DNA Sample Processing using the Biomek i5 Automated Workstations: 

5.1. Scope: This test method is designed for the direction of Biology Section personnel who will operate 
the and Biomek i5 automation workstations to process DNA samples from extraction/purification 
through CE (capillary electrophoresis) setup.  The Biomek i5 workstation is capable of extracting up 
to 87 samples and blanks in two hours, setting up quantification plates, normalizing samples and 
setting up amplification.  This test method may be expanded or altered as techniques and/or new 
genetic analyses are found applicable and validated. 

5.2. Precautions/Limitations: 

5.2.1. Due to the hands-off nature of automated processing, it is vital that submitted samples be 
prepared following procedures determined by the automation validation and that the ordered 
flow of data throughout the process be maintained.   

5.2.2. Customization or modification of sample processing procedures will not be allowed without 
consultation with the automation team and documented approval of the Technical Leader.  

5.3. Related Information: 

5.3.1. N/A 

5.4. Instruments: 

5.4.1. Biomek i5 Automated Laboratory Workstation— robotic DNA processing system. 

5.5. Reagents/Materials: 

5.5.1. Digest/Wash Buffer 
5.5.2. Isopropyl Alcohol 
5.5.3. Nuclease Free Water (NFH2O) 
5.5.4. DTT 1M 
5.5.5. Proteinase K (10 mg/ml) 
5.5.6. Proteinase K (18 mg/ml) 
5.5.7. Ethanol 
5.5.8. Sarkosyl 20% w/v 
5.5.9. Stain Extraction Buffer for Automation 
5.5.10. TRIS/EDTA/NaCl Solution 
5.5.11. DNA IQ™ Extraction Kit 

5.5.11.1. Lysis Buffer 
5.5.11.2. Elution Buffer 
5.5.11.3. Magnetic Resin 
5.5.11.4. Wash Buffer 

 
 

5.6. Hazards/Safety: 

5.6.1. All chemicals shall be handled in a safe method as referenced in the specific Safety Data 
Sheets (SDS). 

5.6.2. Universal Precautions shall be observed whenever biological materials are being handled. 
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5.6.3. Biological waste shall be disposed of in the appropriate waste receptacle. 

5.6.4. On the Biomek i5, a light curtain prevents interaction with the deck or the robotic arm while a 
procedure is running. 

 

5.7. Reference Materials/Calibration Checks: 

5.7.1. DNA processing using the automated workstation does not require any additional controls to 
those used in manual DNA processing. 

5.7.2. Annual calibration of the pipetting accuracy will be performed by Beckman Coulter Operational 
Qualification 3 (OQ3). 

5.8. Procedures/Instructions: 

5.8.1. General Rules 

5.8.1.1. Batch ID numbers shall be named sequentially “year-run number” (ex. 2011-001). 

5.8.1.2. Each case shall contain at least one reagent blank for unknowns when processed on the 
automated workstation. 

5.8.1.3. Each group of reference samples (per analyst) processed on the automated workstation 
shall contain at least one reagent blank.  On the pre-extraction worksheet (submission 
form), the case number for the grouped reagent blank shall be the first case number in the 
batch it is associated with. 

5.8.1.4. A submitting analyst may request that an assumed reference standard (for any type of 
case) be included within the same extraction batch as the associated unknowns as 
long as: 

5.8.1.4.1. All pre-robot processing steps were performed separately (separated by time 
and/or space); AND 

5.8.1.4.2. There is no additional evidence within the batch where the reference cannot be 
assumed.  (For example: If sexual assault kit samples are submitted to the robot 
along with a penile swab from the suspect, the assumed victim standard cannot 
be included on that robot batch plate.)   

5.8.1.5. Reagent blanks shall contain “RB” in the name on the pre-extraction worksheet. 

5.8.1.6. At the Indianapolis Lab: Within 24 hours of incubation, analysts shall deliver samples to be 
processed to the automation room. An e-mail shall be sent to the automation team at 
DAutomation@ISP.IN.gov with the completed pre-extraction worksheet attached. The 
worksheet filename shall include the analyst’s initials, PE number, and the date the 
samples were submitted (ex. AB1234_01Jan11). The tube rack containing the samples 
shall be labeled to include the same information.  See Section 5.9 for more information 
regarding retention of records for chain of custody. 

5.8.1.6.1. Samples from Evansville, Fort Wayne, and Lowell shall be delivered to 
their designated transfer location within 72 hours of incubation. Tubes 
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shall be placed in a rack with a lid, and the lid shall be secured with tape.  
The covered rack shall be placed in a convenience package and labeled 
with the worksheet filename.  An email with the completed pre-extraction 
worksheet attached shall be sent on the day of incubation to 
DAutomation@ISP.IN.gov.   

5.8.1.7. To maximize efficiency of each run, the automation team may process samples up to 14 
days from their submission date. 

5.8.1.8. In addition to the documentation of data as described in the Forensic Biology Section Test 
Method (DNA Test Methods, section 2), the associated automation documents to be 
retained in the case record are: emails documenting submission of samples and return of 
samples to the analyst, the pre-extraction worksheet, the extraction/quantification plate 
record, the Samples Not Amplified summary and/or the Normalization/Amplification 
summary sheet as appropriate, and the amplification/capillary electrophoresis plate record 
if case samples are amplified.  

5.8.2. Sample Triage with Automated Sample Processing 

5.8.2.1. General Triage Rules 

5.8.2.1.1. The Automation Workbook will triage samples based on their quantification data, 
their letter code(s) as assigned on the “Samples” tab (initially provided by the 
analyst on the Pre-Extraction Worksheet), and their context within a case as 
defined by their case number. 

5.8.2.1.2. No samples containing less than 0.01 ng/uL small autosomal DNA will be 
amplified, regardless of sample code or “locked” status. 

5.8.2.1.3. Whenever comparisons between code M samples are made (Differential Triage 
or Priority System Triage), the “better” or “winning” sample is defined as the one 
with more actual male DNA input into the amplification reaction. 

5.8.2.1.3.1. This calculation prioritizes maximum male DNA input rather than only the 
F:M ratio or only the Y quantification value. 

5.8.2.1.3.2. The calculation takes into account the normalization of the small 
autosomal DNA amount (i.e., normalizing a high autosomal value requires 
dilution, which also lowers the amount of total male DNA input). 

5.8.2.1.3.3. Example: SampleA has 0.018 ng/uL of autosomal DNA and 0.008 ng/uL 
of male DNA, for an F:M ratio of 1.25 and 0.12 ng of total male input in a 
15 uL reaction.  SampleB has 0.072 ng/uL of autosomal DNA and 0.02 
ng/uL of male DNA, for an F:M ratio of 2.6 and 0.3 ng of total male input 
in a 15 uL reaction.  SampleB “wins” despite having a higher F:M ratio 
than sample A. 

5.8.2.1.4. Case numbers, item numbers, and sample codes will be read as-is. Typos in any 
of these may result in extra samples being amplified beyond the triage process. 

5.8.2.2. Sample Codes 
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5.8.2.2.1. Sample codes are specific letters or combinations of letters entered by the 
analyst in the “Code” column of the Pre-Extraction Worksheet.  These codes 
determine certain properties of the sample and how it will be processed on the 
Automation platform. Code letters may be entered in any order and are case-
insensitive. 

5.8.2.2.2. Code T (Tube):  Code T merely indicates that the extract will be returned to a 
tube after processing; it does not affect any other analysis. It can be combined 
with other codes. 

5.8.2.2.3. Code S (Standard): Code S indicates that the sample is a standard, or a reagent 
blank associated with a standard. Standards are “freed” from their case numbers; 
they do not undergo case-level triage and are assigned to extraction sets 
differently. If a sample is marked S, an M or L code will not affect it. 

5.8.2.2.3.1. This allows one reagent blank to be associated with standards from 
multiple cases. 

5.8.2.2.4. Code M (Male DNA): Code M is the equivalent of “stop if low male,” used 
formerly.  It indicates that the sample must be Priority 3 or greater to amplify. The 
sample will also undergo case-level triage, which includes the Priority system 
ratings, comparison between differential fractions (Differential Triage), and 
selection of the five best samples to amplify based on total male DNA input 
(Priority System Triage). The function of code M is not affected by code T, but 
code S will cancel the functionality of code M. 

5.8.2.2.4.1. Code M samples will not be amplified if the F:M ratio is greater than 50, 
regardless of whether they are locked. 

5.8.2.2.5. Code L (Locked):  Code L is combined with code M to “lock” a sample for 
amplification.  It is a way of bypassing the case-level triage while still requiring 
sufficient male DNA for amplification (i.e., Priority 3 or greater, and sufficient 
autosomal DNA). Code L does not affect any other code except M. 

5.8.2.2.5.1. Locked samples will not affect the triage of other samples within the same 
case. In other words, locking samples that turn out to be poorer quality 
will not prevent better quality, “unlocked” samples from being amplified. 
Locked samples will be amplified in addition to better quality unlocked 
samples. 

5.8.2.3. Differential Triage 

5.8.2.3.1. This section only applies to code M samples designated as sperm or non-sperm 
fractions as described below. 

5.8.2.3.1.1. Non-sperm fraction samples are designated by the presence of “ns” in the 
item name. Note that this includes either “ns” or “nsf” (e.g., “1C1_nsf” or 
“1C1_ns”). 

5.8.2.3.1.2. Sperm fraction samples are designated by the presence of “sf” or “sp” 
and not “ns” in the item name (e.g., “1C1-sf” or “1F2sf_2”). 
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5.8.2.3.2. A pair of samples with identical case numbers and item numbers, except for the 
“ns/sf” designations, will be detected as a differential set. 

5.8.2.3.2.1. Example: “99F9999_1Cnsf” and “99F9999_1Csf” will be detected as a 
differential set. 

5.8.2.3.2.2. Example: “99F9999_1C-ns” and “99F9999_1Csf” will not be detected as 
a differential set because of the dash in the non-sperm sample name. 

5.8.2.3.3. If a differential set is detected, the two fractions will be compared to each other 
and only the better fraction (see General Triage Rules, above) will proceed to 
Priority System Triage. 

5.8.2.3.3.1. The “losing” fraction will not be amplified unless it is locked. 

5.8.2.4. Priority System Triage 

5.8.2.4.1. This section only applies to code M samples. 

5.8.2.4.2. Non-differential samples and the “winning” fractions of differential sets (see 
Differential Triage section) are sorted by their F:M ratio into Priority 1, 2, or 3 
categories (P1, P2, or P3). 

5.8.2.4.3. The best five samples within a case will be amplified. 

5.8.2.4.3.1. These samples are chosen by Priority level (P1>P2>P3) and then by total 
male DNA amplified (see General Triage Rules, above). 

5.8.2.4.3.2. Example: A case contains seven samples marked code M. Of these, one 
is P1, five are P2, and one is P3. The P1 sample is amplified, and the P2 
samples are compared to find the best four. The remaining P2 sample 
and the P3 sample are not amplified. 

5.8.2.4.4. After the best five samples are chosen, any remaining locked (code L) samples 
will also be amplified if eligible. 

5.8.3. Sample Preparation 

5.8.3.1. Preparation of Samples for Blood, Hair, Saliva, Epithelial Cell Samples And Blood 
Or Buccal Swab Standards 

5.8.3.1.1. For each sample, combine 350 µl Stain Extraction Buffer for Automation (SEBA) 
with 10 µl Pro K (18 mg/ml) and 40 µl DTT (1M).  Example: for 16 samples, 
combine 5,600 µl Incubation Buffer (or SEBA) with 160 µl Pro K and 640 µl DTT.    

5.8.3.1.2. Place sample at the bottom of a Qiagen® Investigator® Lyse&Spin basket with 2 
ml collection tube.  Do not use “dolphin-style” or other microcentrifuge tubes.  
Each group of samples being extracted shall include a reagent blank as the last 
sample in the batch. 
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5.8.3.1.3. To the sample add 400 µl Buffer/Pro K/DTT Master Mix.  Vortex and spin briefly 
in a microcentrifuge or tap the tube to force the cutting into the extraction fluid. 

5.8.3.1.3.1.  Do NOT add more than 400 µl of liquid per sample. 

5.8.3.1.4. Incubate the sample at 56°C for at least one hour. Alternatively, samples may be 
incubated overnight. 

5.8.3.1.5. Spin in a microcentrifuge at 10,000 – 14,000 rcf for at least 1 minute. Remove 
and discard the basket insert. 

5.8.3.1.6. Close the lid of the sample tube and cut the hinge. 

5.8.3.1.7. Save the extract until ready for automated DNA extraction.  Do not refrigerate or 
freeze sample.  Prior to submission to the automation team, processed samples 
may be left at room temperature (22-25°C) up to 24 hours, if necessary. 

5.8.3.2. Preparation of Samples for Differential Extraction 

5.8.3.2.1. For each sample, combine 240 µl Tris/EDTA/NaCl, 6 µl  20% Sarkosyl, 54 
µl NFH2O and 3 µl Proteinase K (10 mg/ml). Example: for 16 samples, combine 
3840 µl Tris/EDTA/NaCl, 96 µl 20% Sarkosyl, 864 µl NFH2O, and 48 µl Pro K. 

5.8.3.2.2. Place the sample in 1.5 ml microcentrifuge tube or 2 ml Qiagen® Investigator® 
Lyse&Spin collection tube. Qiagen® Investigator® Lyse&Spin baskets shall not 
be used for differential extractions.  Each group of samples being extracted shall 
include reagent blanks (sperm and non-sperm fraction) as the last samples in the 
batch. 

5.8.3.2.2.1. For extraction on the Biomek i5 workstation, samples shall be loaded 
specifically into Qiagen® Investigator® Lyse&Spin 2 ml collection tubes. 
Do not use “dolphin-style” or other microcentrifuge tubes. If the differential 
steps are performed with an alternate 1.5 ml tube the sample extract shall 
be transferred to a Lyse&Spin 2 ml collection tube prior to submission. 

5.8.3.2.2.2. A differential set shall be named as “sp” or “sf” for sperm fractions and 
“ns” or “nsf” for non-sperm fractions.  This nomenclature is required to 
ensure the samples are detected as a set for automated calculation for 
the inference of possible sperm cells.   

5.8.3.2.3. To the sample add 300 µl of the Master Mix.  Vortex and spin briefly in a 
microcentrifuge or tap the tube to force the cutting into the extraction fluid.  

5.8.3.2.4. Incubate the sample at 37°C for 2 hours. 

5.8.3.2.5. Spin briefly in a microcentrifuge to force the condensate into the bottom of the 
tube. 

5.8.3.2.6. Using a wooden applicator stick, remove the cutting and spin in a microcentrifuge 
for about 5 minutes at approximately 14,000 rcf. 
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5.8.3.2.7. Alternately transfer the cutting into a spin basket insert.  Place the basket insert 
into the tube containing the stain extract.  Spin in a microcentrifuge at 
approximately 14,000 rcf for about 5 minutes.  Remove and discard the basket 
insert. 

5.8.3.2.8. While being very careful to not disturb any pelleted material, remove the 
supernatant to a clean, labeled Qiagen® Investigator® Lyse&Spin 2 ml collection 
tube.  This is the non-sperm fraction.  Analysis of the non-sperm fraction 
resumes at 5.8.2.2.11.  The pellet remaining in the tube is the sperm fraction. 

5.8.3.2.9. Wash the sperm fraction by resuspending it in 500 µl digest/wash buffer, 
vortexing the suspension briefly, and spinning the tube in a microcentrifuge at 
approximately 14,000 rcf for about 5 minutes.  Remove and discard the 
supernatant fluid, being careful not to disturb the cell pellet. 

5.8.3.2.10. Repeat step 5.8.3.2.9 two times for a total of three washes.   

5.8.3.2.11. Lysis buffer step: 

5.8.3.2.11.1. For each sample pair (sperm and non-sperm fraction) combine 600 µl of 
Lysis Buffer with 6 µl of 1M DTT.   

5.8.3.2.11.2. Add 400 µl of the Lysis Buffer master mix to each sperm fraction sample 
and 200 µl to each non-sperm fraction sample. 

5.8.3.2.12. Vortex sample and spin down briefly. Cut the hinge of the sample tube. 

5.8.3.2.13. Save until ready for automated DNA extraction.  Do not refrigerate or freeze 
sample.  Prior to submission to the automation team, processed samples may be 
left at room temperature (22–25°C) overnight, if necessary. 

5.8.3.2.13.1.  

5.8.4. Biomek i5 Preparation 

5.8.4.1. Wipe down the deck with 70% ethanol, 3-6% hydrogen peroxide (with 70% 
ethanol rinse) or 10% bleach. 

5.8.4.2. Ensure that the workstation trash is not full. 

5.8.4.3. Ensure that the waste carboy is not full. 

5.8.4.4. Ensure that there is enough distilled water in the intake carboy (the valve must be 
underwater). 

5.8.4.5. Ensure that the software is connected to the instrument and not in Simulate 
mode: 

5.8.4.5.1. “Utilities” tab  “Hardware Setup”. 
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5.8.4.5.2. Set “Name” to “Biomek”. 

5.8.4.5.3. Click “Accept”. 

5.8.4.6. Run “Home All Axes” under the “Method” tab. 

5.8.4.6.1. Let the tips flush until there are no bubbles created when the pistons move. 

5.8.4.6.2. There may be a large bubble stationary at the tops of the syringes; this is 
normal. 

5.8.4.7. Ensure that ethanol and isopropyl alcohol have been added to the alcohol wash 
buffer in the DNA IQ™ kit (35 mL of each). 

5.8.5. Initial Tube Transfer 

5.8.5.1. Place sample tubes in the tube racks (4x6 with white adapters), arranging the 
tubes according to the order shown in the Automation Workbook.  Do not skip 
columns or spaces between samples. 

5.8.5.2. Ensure that the sample tube lid hinges have been cut.  

5.8.5.3. Spin down the tube racks (containing the sample tubes) in the centrifuge. 
Carefully remove the sample tube lids and discard. 

5.8.5.3.1. CAUTION: Once the lids are removed, the Automation Workbook is the only 
record of the order and identity of each sample. 

5.8.5.4. Arrange the deck layout as shown in the figure below: 

5.8.5.4.1. Place sample tube racks on positions P8, P9, P11, and P12, again paying 
attention to sample order according to the Automation Workbook. 

5.8.5.4.2. Place a new Promega (Madison, WI) 2.2 ml Square-Well Deep Well Plate 
(Cat. no. V6781) on position P5. Orient the plate so that the clipped corner is 
on the bottom left. 

5.8.5.4.3. Place a new box of Beckman Coulter (Fullerton, CA) Biomek i-Series 190 µl 
Barrier tips (Cat. no. B85911) on the Rapid-Shuck module (top right). 
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5.8.5.5. Open the “Initial Tube Transfer LyseSpin” method contained in the Promega 
project. 

5.8.5.6. Click the green “Run” button at the top of the screen. 

5.8.5.7. The method will prompt for two values: 

5.8.5.7.1. SampleColumns = the number of full or partial columns of sample on the 
extraction plate. 

5.8.5.7.1.1. Example:  20 samples/blanks will use two full columns and half of a third.  
Enter “SampleColumns” as 3. 

5.8.5.7.2. SampleVolume = the approximate volume of liquid in the sample tubes, in 
microliters. Round to the next highest hundred microliters, to a maximum of 
400 µl. 

5.8.5.7.2.1. Example:  Most of the sample tubes contain 300 µl, but one tube 
contains 340 µl.  Enter “SampleVolume” as 400. 

5.8.5.8. When the instrument has finished transferring sample from the tubes to the 
sample plate, remove the tube racks from the deck and discard the empty sample 
tubes. 

5.8.5.9. Leave the used Biomek i-Series 190 µl Barrier Tips on the Rapid-Shuck module 
for subsequent use in DNA IQ™ automated extraction.  Each tip is now 
associated with a single sample and will only be used to pipet that sample. 
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5.8.6. DNA IQ™ Automated Extraction Procedure 

5.8.6.1. Instrument Deck Setup 

5.8.6.1.1. Turn on the heating block and ensure that temperature is set to 850C. 

5.8.6.1.2. Place the 2.2 ml Square-Well Deep Well Plate sample plate [containing 
sample transferred during Initial Tube Transfer (5.8.4)] on position P5. 

5.8.6.1.3. The box of Biomek 190 µl Barrier Tips used in the Initial Tube Transfer (5.8.4) 
should be unchanged on the Rapid-Shuck module.  DO NOT change the 
orientation of this box. 

5.8.6.1.4. Place the following labware on the deck as shown in the figure below: 

5.8.6.1.4.1. Box of Beckman Coulter Biomek i-Series 1025 µl Barrier tips (Cat. no. 
B85955) on position P1. If there are fewer than five columns of tips 
available, the program will prompt for a full box of 1025 µL tips on 
position P3, otherwise, a partial box may be used. 

5.8.6.1.4.2. Box of new i-Series 190 µl Barrier tips on position P10. 

5.8.6.1.4.3. Promega 1.2 ml Round-Bottom Deep Well Plates (Cat. no. V6771) on 
positions P6 and P4 (aligned on top of the MagnaBot module in P4). 
Orient each plate so that the clipped corner is on the bottom left. 

5.8.6.1.4.4. Promega 1.1 ml Square-Well V-Bottom Deep Well Plate (Cat. no. 
V6821) on position P15.  Orient the plate so that the clipped corner is on 
the bottom left. 
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5.8.6.2. Reagent Setup 

5.8.6.2.1. Open the Automation Workbook from the “Robot Team” network folder. 

5.8.6.2.2. The “Samples” tab has a description of the reagents and supplies needed to 
run automated DNA IQ™ extraction. 

5.8.6.2.2.1. Enter the number of samples on the plate, including reagent blanks. 

5.8.6.2.2.2. Enter the desired elution volume (between 50-100 µl per sample). 

5.8.6.2.2.3. Do not count the No Template Control (NTC) or quantification standards. 

5.8.6.2.2.4. Do not add extra samples for excess volume; it is already calculated into 
the program. 

5.8.6.2.3. In a reservoir holder, place the following clean reservoirs in order from left to 
right: one Quarter Module reservoir (Beckman Coulter, Fullerton CA, cat. no. 
372790) divided by length, one additional Quarter Module reservoir, and one 
Half Module reservoir (Beckman Coulter, cat. no 372786). 

5.8.6.2.4. Load reagents in each reservoir as indicated in the “Samples” tab, adding 
elution buffer last. 

5.8.6.2.5. Place the reservoir holder on deck position P2. 
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5.8.6.3. Running the DNA IQ™ Method 

5.8.6.3.1. Open the “Extraction_v2.1.0.ISP” method, contained in the Promega project. 

5.8.6.3.2. Click the “Run” button at the top of the screen. 

5.8.6.3.3. The method will prompt for three values: 

5.8.6.3.3.1. UsedP1000TipCols = the number of used full or partial columns in the 
1000 µl tip box on position P1. For a new box, enter 0. 

5.8.6.3.3.1.1. Example: If two and a half columns of P1000 tips have been used, 
enter “UsedP1000TipCols” as 3. 

5.8.6.3.3.2. UsedP200TipCols = the number of used full or partial columns in the 
190 µl tip box on the Rapid-Shuck module. Assuming a new box was 
used during the Initial Tube Transfer (5.8.4), the value should be 0. 

5.8.6.3.3.3. SampleCount = the number of total samples to be extracted, up to 87. 
Wells may not be skipped; this number corresponds to the last well of 
the plate containing a sample, counting down columns then across rows 
(e.g., well G11 = 87th well) 

5.8.6.3.3.3.1. For a default (aqueous) extraction, simply enter the sample count 
number (e.g., “87”). This extraction type accommodates a 400 µL 
starting sample volume and 75 µL elution volume. 

5.8.6.3.3.3.2. To re-extract/purify a previously extracted lysate plate (lysis 
extraction), enter the sample count number followed by the word 
“Lysate” (e.g., “87Lysate”). This extraction type accommodates an 800 
µL starting sample volume and 75 µL elution volume. 

5.8.6.3.4. The protocol will run for approximately 1 hour 45 minutes, depending on how 
many samples are being processed. 

5.8.6.3.5. When the run is finished, reservoirs may be carefully rinsed, labeled, and 
reused. Discard partial tip box from position P10. Remaining partial tip boxes 
may be used again. Discard processing plates (both 1.2 ml Round-Bottom 
Deep Well Plates).  Turn off the heating block. 

5.8.6.3.6. Label and retain the original sample plate (2.2 ml Square-Well Deep Well 
Plate) containing the lysate, as back-up until the samples have been 
completely processed. Cover and store at room temperature. 

5.8.6.3.7. Cover the elution plate (1.1 ml Square-Well V-Bottom Deep Well Plate) 
containing the extracted samples with a temporary seal and refrigerate if the 
plate is not to be quantified immediately. 
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5.8.7. Combined Initial Tube Transfer/DNA IQ™ Extraction 

5.8.7.1. If desired, the Initial Tube Transfer and Extraction steps may be completed 
in a single method. 

5.8.7.2. Instrument Deck Setup 

5.8.7.2.1. In the Biomek Software, open the “TubeTransfer_And_Extraction” method 
contained in Promega projects. 

5.8.7.2.2. Follow the deck setup for both the Initial Tube Transfer and Extraction 
methods described above. Both will fit concurrently on the deck.  

 

 

5.8.7.2.3. Click the “Run” button at the top of the screen.  

  

 

 

5.8.8. REAL-TIME PCR QUANTIFICATION USING QUANTIFILER® TRIO Prepared on the 
Biomek i5 Laboratory Automation Workstation 

5.8.8.1. Instrument Deck Setup 

5.8.8.1.1. In the Biomek Software, open the “Trio Quant” method contained in the ABI 
projects. 
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5.8.8.1.2. Click on the “User Interface” line within the method.   

5.8.8.1.2.1. To the right, check that “Quantifiler Trio” is selected.   

5.8.8.1.2.2. Enter the number of samples to process (equal to the number of elution 
plate wells that contain extract). 

5.8.8.1.2.3. Do not count the NTC or quantification standards. 

5.8.8.1.2.4. Do not add extra samples for excess volume; it is already calculated into 
the program. 

5.8.8.1.3. Place the following labware on the deck as shown in the figure below: 

5.8.8.1.3.1. New box of Beckman Coulter Biomek i-Series 50 µl Barrier tips (Cat. no. 
B85888) on position P2.  Alternatively, a partial box may be used by 
selecting the number and position of remaining tips in the box under the 
“Properties” tab of the “Instrument Setup” step. 

5.8.8.1.3.2. Box of i-Series 190 µl Barrier tips on position P1.  A partial box may be 
used (as above) if at least one column is available. 

5.8.8.1.3.3. New Applied Biosystems (Foster City, CA) MicroAmp® Optical 96-Well 
reaction plate (Cat. no. N801-0560) on position P11. 

5.8.8.1.3.4. The elution plate containing extracted samples on position P12. This 
plate must be centrifuged prior to quantification to prevent bubbles in the 
sample wells. 
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5.8.8.2. Reagent Preparation 

5.8.8.2.1. Open the Automation Workbook from the “Robot Team” network folder. 

5.8.8.2.2. The “Samples” tab has a description of the reagents and supplies needed to 
run automated quantification setup.   

5.8.8.2.2.1. Enter the number of samples on the plate, the same as entered into the 
“User Interface” above. 

5.8.8.2.3. When a new Quantifiler® Trio kit is opened, Quantification Enhancer may be 
added to the reaction mix as follows: 

5.8.8.2.3.1. Using a 2.5 µl pipettor, carefully add 1 µl of Quantification Enhancer to 
each fresh tube of reaction mix. Vortex each reaction mix tube briefly. 

5.8.8.2.3.2. Mark each tube of reaction mix with “QE” to indicate that Quantification 
Enhancer has been added. 

5.8.8.2.3.3. Record the lot number of the Quantification Enhancer on the Automated 
Extraction/Quantification Worksheet. 

5.8.8.2.3.4. Quantification Enhancer shall be stored at room temperature. 

5.8.8.2.4. Prepare the master mix as described in section 2 of the Forensic Biology 
Section Casework Test Method, using the volumes indicated on the 
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Reagents tab.  Note that for 40 or more samples, the master mix must be 
divided evenly into two tubes.  Vortex the Master Mix 3 to 5 seconds, then 
centrifuge briefly. 

5.8.8.2.5. Place the master mix tube(s) in wells A6 (and B6) of the Reagent Tube Rack 
as indicated below. 

5.8.8.2.6. Prepare the standard dilution series as described in Quantifiler® Trio section 
of the Biology Section Casework Test Method or use a previously prepared 
dilution series.  Each tube must contain at least 20 µl of standard. 

5.8.8.2.7. Place the standard tubes in column 2 of the Reagent Tube Rack as 
indicated below. 

5.8.8.2.8. Open and fold back all tube caps and place the Reagent Tube Rack on deck 
position P8. 

 

5.8.8.3. Running the Automated Quant Trio Setup Method 

5.8.8.3.1. With the “Trio Quant” method open and the number of samples specified, 
click the “Run” button at the top of the screen. 

5.8.8.3.2. A window will appear to confirm the amount and placement of the master 
mix tubes. Click “OK”. 

5.8.8.3.3. A window will appear to confirm the deck layout as shown by the software. 
Click “OK”. 
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5.8.8.3.4. A window will appear to confirm the total amount of master mix, the amount 
of standard in each of the standard tubes, the sample count, and the 
quantification kit. Click “OK”. 

5.8.8.3.5. The protocol will begin. When the run is finished, remove the elution plate 
with extracts and cover with a temporary seal until ready to proceed with 
amplification. 

5.8.8.3.6. Seal the optical plate with an optical adhesive cover. Run the edge of the 
cover applicator between the rows and columns of the wells to ensure that 
all wells are sealed properly. 

5.8.8.3.7. Spin the plate using either a centrifuge or a salad spinner to remove any 
bubbles and force samples into the bottom of each well. 

5.8.8.3.8. Place the plate in the real-time PCR instrument, turn on the instrument, and 
open the 7500 System software. 

5.8.8.4. Create A Plate Document 

5.8.8.4.1. Open the Automation Workbook file containing the batch of samples being 
run, and click on the “Extraction-Quant” tab.  Ensure that the corresponding 
plate document contains sample information, otherwise, add and save that 
information now. Also ensure that the batch number has been entered into 
the yellow box on the “Samples” tab. 

5.8.8.4.2. Press the “Create Quant Setup File” button.  A new text file named 
“Batch#_QuantSetup_Date” will appear in the same folder that contains the 
Automation Workbook.  Click “OK” to proceed. 

5.8.8.4.2.1. If there are duplicate sample names in the batch, an error message 
will list them and the Quant Setup file will not be created until the 
duplicate names are fixed. 

5.8.8.4.3. On the computer connected to the real-time PCR instrument, create a new 
plate document as described in the Quantifiler® Trio section of the Biology 
Section Casework Test Method.  

5.8.8.4.4. Import the text file you just created. The wells should populate with the 
names of the samples and standards. 

5.8.8.4.5. Enter the plate name under “Experiment”.  Save the plate document and 
proceed with real-time PCR analysis as described in the Quantifiler® Trio 
section of the Biology Section Casework Test Method. 

5.8.9. PowerPlex® Fusion 6C Amplification 
Prepared on the Biomek i5 Laboratory Automation Workstation 
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5.8.9.1. Vortexing Extracts 

5.8.9.1.1. Prior to amplification, the extract plate (the elution plate from the DNA IQ™ 
procedure) shall be vortexed briefly at low speed to ensure uniform pipetting 
of sample. 

5.8.9.1.2. Spin down the extract plate again before proceeding to amplification set-up. 
(CAUTION: Ensure that there are no bubbles in the wells.) Remove 
temporary seal.  

5.8.9.2. Normalization Data Setup 

5.8.9.2.1. Open the Automation Workbook file containing the batch to be amplified. 

5.8.9.2.2. On the “Extraction-Quant” tab, click the “Import & Analyze Quant Results” 
button. 

5.8.9.2.3. Browse for the appropriate text import file containing quantification data for 
this batch. Click “Open”. 

5.8.9.2.4. The Automation Workbook will analyze the batch, create the 
Quantification Results and Standard Curve worksheets, create the 
Amplified Samples summary, create the Samples Not Amplified summary, 
and fill the samples on the Amplification Setup/CE Plate Record.  

5.8.9.2.4.1. If any standard curve parameter fails, or if the NTC contains a 
value, or if a standard curve well has an undetected IPC, an error 
message will appear and the batch will not be analyzed until the 
standard curve is fixed. Points should be omitted in the Real-Time 
PCR software and a new results file exported. 

5.8.9.2.5. A new .csv file named “Batch#_AmpSetup” (the AmpSetup file) will appear 
in the same folder that contains the Automation Workbook.  Click “OK” to 
proceed. 

5.8.9.2.6. Move or copy this AmpSetup file to the folder //IN PROGRESS/Amp 
Setups on the “Robot Team” drive. 

5.8.9.3. Instrument Deck Setup 

5.8.9.3.1. In the Biomek Software, open the “Normalize-Amp_Fusion6C” method 
contained in the Promega project. 

5.8.9.3.2. Place the following labware on the deck as shown in the figure below: 

5.8.9.3.2.1. Box of i-Series 190 µl Barrier tips on the Rapid-Shuck module. 
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5.8.9.3.2.2. Box of i-Series 50 µl Barrier tips on position P1. A second box of P50 
Barrier tips may be required on position P3. 

5.8.9.3.2.3. 1.1 ml square-bottom deepwell plate on position P5. A second 1.1 ml 
square-bottom deepwell plate may be required on position P8. 

5.8.9.3.2.4. New 96-well optical amplification plate on position P6. 

5.8.9.3.2.5. Extract plate containing samples on position P4.  

5.8.9.3.2.5.1. CAUTION: ensure that the MagnaBot module has been 
removed. 

 

 

5.8.9.3.3. Click “Run”. 

5.8.9.3.4. The program will prompt for three values: 

5.8.9.3.4.1. BatchNumber = The batch number being amplified, in the format Year-
XXX.  This directs the Biomek software to import the correct Amp Setup 
file from the //IN PROGRESS/Amp Setups folder. 

5.8.9.3.4.2. First_P250_Tip = the number of the first unused tip in the 190 µL tip box 
on the Rapid-Shuck module, numbering down columns and then across. 
For a new box, enter 1. 
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5.8.9.3.4.2.1. Example: If two and a half columns (twenty tips) of P250 tips 
have been used, enter “First_P250_Tip” as 21. 

5.8.9.3.4.3. First_P50_Tip = the number of the first unused tip in the 50 µl tip box on 
position P1, numbering down columns and then across.  For a new box, 
enter 1. 

5.8.9.4. Reagent Preparation 

5.8.9.4.1. Follow the prompts within the Biomek Software.  Note that depending on the 
dilution of samples within the batch, the protocol may require an additional 
1.1 ml square-bottom deepwell plate on position P8. 

5.8.9.4.2. Place the STR Master Mix tube in position 4 (front-most) of the Left Tube 
Holder on the reagent rack. 

5.8.9.4.3. Place the tube containing diluted positive control (at least 20 µl) in position 1 
(rear-most) of the Right Tube Holder on the reagent rack. Click “OK”. 

5.8.9.4.4. Pipet the indicated amount of amplification-grade water or nuclease-free 
water into the center trough of the reagent rack. Place the reagent rack on 
deck position P2. 

5.8.9.5. Running the Normalization/Amp Set-up Method 

5.8.9.5.1. Check that the deck layout matches the layout indicated in the next prompt. 
Click “OK”. 

5.8.9.5.2. The run will begin, performing normalization and amplification setup in one 
step. 

5.8.9.5.3. When the run is finished, remove the amplification plate and cover with 
adhesive foil. Press the foil well using a roller tool. 

5.8.9.5.4. Remove the elution plate containing extracted samples and cover with a 
temporary seal and refrigerate. 

5.8.9.6. Create CE Plate Record 

5.8.9.6.1. The Amp-CE Plate Record in the Automation Workbook is automatically 
populated with the amplified samples when the batch is analyzed with 
quantification results. 

5.8.9.6.2. Open the Automation Workbook containing the batch of interest and click on 
the “Amp-CE” tab.  
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5.8.9.6.3. Click the “Export CE Setup File” button. A new text file named 
“Batch#_CESetup_Date” will appear in the same folder that contains the 
Automation Workbook.  Click “OK” to proceed. 

5.8.9.6.3.1. If no plate name has been filled in, the file will contain a default 
plate name in the format “Batch#_Date_01”. This can be changed 
on the “Amp-CE” tab or in the genetic analyzer software. 

5.8.9.6.4. Samples may be added manually to the CE plate record and “CE Setup” 
tab, as needed, before clicking the “Export CE Setup File” button. Only 
samples listed on the “CE Setup” tab will be included in the exported CE 
Setup file. 

5.8.9.6.5. Fill out the rest of the worksheet as designated, including dates, reagent lot 
numbers, amplification reaction type, and injection protocols. 

5.8.10. PowerPlex® Y23 Amplification 
Prepared on the Biomek i5 Laboratory Automation Workstation 

5.8.10.1. NOTE: PowerPlex® Y23 amplification via Biomek automation is not validated for 
casework unknowns and shall only be performed on known samples. 

5.8.10.2. Normalization Data Setup 

5.8.10.2.1. Open the Automation Workbook file containing the batch to be amplified. 

5.8.10.2.2. Assuming the quantitation data for the batch has already been imported 
and processed (see preceding section for Fusion 6C amplification), go to 
the Data Extract tab. 

5.8.10.2.2.1. The “Amp YSTR” column on the right contains TRUE/FALSE 
designations for each sample. This controls whether a sample will 
be included in a Y-STR amplification. Samples are automatically 
marked “TRUE” for Y-STR amplification if they both: 
 
1) Have a F:M ratio ≤ 5 
2) Are marked as a standard (Code S) 

5.8.10.2.2.2. Y-STR amplification may be manually turned on/off per sample by 
editing the Amp YSTR column values. 

5.8.10.2.2.3. If the Amp YSTR column reflects the samples that should be 
amplified, click the "Amp Y-STR” button above it. 

5.8.10.2.3. The Automation Workbook will analyze the batch according to the Y quant 
values and create a Y-STR version of the following worksheets: Amplified 
Samples Summary, Amplification Setup/CE Plate Record, and CE Setup. 
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These worksheets are normally hidden in the Workbook but will appear as 
blue tabs. 

5.8.10.2.4. A new .csv file named “Batch#_YSTR_AmpSetup” (the AmpSetup file) will 
appear in the same folder that contains the Automation Workbook.  Click 
“OK” to proceed. 

5.8.10.2.5. Move or copy this YSTR_AmpSetup file to the folder //IN 
PROGRESS/Amp Setups on the “Robot Team” drive. 

5.8.10.2.6. Proceed with Instrument Deck Setup, Reagent Preparation, Running the 
Normalization/Amp Setup Method, and Create CE Plate Record as 
described in the previous section, except: 

5.8.10.2.6.1. For Instrument Deck Setup, open the “Normalize-Amp_PPY23” 
method contained in the Promega project. 

5.8.10.2.6.2. For Reagent Preparation, be sure to use the PowerPlex® Y23 
amplification kit. Follow the master mix preparation recipe as 
prompted in the Biomek software. 

For Create CE Plate Record, click on the “Export CE Setup File” on the “Y-Amp-CE” worksheet. 
5.8.11. Final Tube Transfer 

5.8.11.1. The Automation Workbook consolidates samples that are to be returned to tubes and 
creates an output for the robot to cherry-pick those samples. The remaining samples will 
remain in the elution plate. Samples returned to tubes will include those given code “T” 
by the case analyst, samples with more than 50 ng/uL of small autosomal DNA, and any 
samples that meet ALL of the following criteria: 

5.8.11.1.1. The sample is code “M”. 

5.8.11.1.2. The sample is not a standard. 

5.8.11.1.3. The sample contains male DNA >0.006 ng/uL. 

5.8.11.1.4. The sample contains <0.01 ng/uL of small autosomal DNA or has a female:male 
ratio >50. 

5.8.11.2. Open the Automation Workbook containing the set of samples that have been run, and 
click on the “FTT Layout” tab.  Click the “Consolidate Samples” button on the upper right.  

5.8.11.2.1. The layout worksheet will tell you how many tubes/labels you will need. If you 
wish to print labels on a partially used sheet, you may designate how many 
labels are missing from the sheet in the “# of used labels” box.  A map of a label 
sheet is included on the right for reference. 

5.8.11.2.1.1. You cannot use a partial sheet if the # of used labels + # of tubes required 
is greater than 80. 
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5.8.11.3. Click the “Export FTT File” button.  A new .csv file named “<batch ID>_FTT Setup” will 
appear in the same folder that contains the Automation Workbook.  Click “OK” to 
proceed. 

5.8.11.4. Move or copy the .csv file to the folder //IN PROGRESS/FTT Setups on the “Robot 
Team” drive. 

5.8.11.5. Place new, empty, labeled Molecular BioProducts (San Diego, CA) 1.5 ml screw-top 
tubes (Cat. no. 3474) in the tube racks (4x6 with white adapters), arranging the tubes 
according to the order shown in the “Consolidated Extracts in Tubes” layout on the “FTT 
Layout” tab of the Automation Workbook.  Do not skip columns or spaces between 
samples. 

5.8.11.6. Arrange the deck layout as shown in the figure below: 

5.8.11.6.1. Place sample tube racks on positions P5, P6, P8, and P9, again paying attention to 
sample order according to the FTT Layout. 

5.8.11.6.2. Place the plate containing extracted samples on position P4. 

5.8.11.6.3. Place a new box of Biomek i-series 190 µl Barrier Tips on position P1. 

 

Biomek NX-p 
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Biomek i5 

5.8.11.7. Open the “Final Plate to Tube Transfer” method contained in the Promega project. 

5.8.11.8. Click the green “Run” button at the top of the screen. 

5.8.11.8.1. The method will prompt for the Batch ID.  Type the Batch ID in the format “Year-
000” (e.g., “2017-001”). This tells the software which .csv file to use in the folder 
“FTT Setups” mentioned above. 

5.8.11.9. When the instrument has finished transferring sample from the extraction plate to the 
tubes, remove the tube racks from the deck and cap the screw-top tubes. 

5.8.11.9.1. The extraction plate, which now contains only extracts of reference samples and 
property crime samples, shall be covered with a temporary seal, refrigerated, and 
saved for a minimum of 60 days, after which it may be discarded. 

5.8.12. When processing is completed, the submitting analyst will be notified by e-mail that the data is 
available on the DNA server and the extracted DNA samples can be retrieved from a 
designated location. 

5.9. Records: 

5.9.1. Sample Tracking for Automated Processing of Casework Samples 

5.9.1.1. The below documentation steps are unnecessary if an automation analyst is processing 
their own case samples throughout the entire automation process.   

5.9.1.2. As part of the process of preparing samples for automated processing, the analyst shall 
complete the most current version of the Robot Submission Form, then email the form to 
DAutomation@isp.in.gov. 

mailto:DAutomation@isp.in.gov
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5.9.1.3. This form, as well as the email that included it, shall be retained by the analyst in the 
case record. 

5.9.1.4. This documents a step in the chain of custody and denotes the point of divergence of 
extracts from their associated parent samples’ chain of custody if the extract is later 
requested to be retained as a subitem.  The extracts leave the analyst’s custody and are 
transferred to a storage area where they will be retrieved for automated processing. 

5.9.1.5. At IRL - Within the same workday that the Robot Submission Form is submitted, the 
analyst shall deliver all associated samples to the IRL S201A robot room storage area. 
At ERL, LRL, and FWRL - Samples will be delivered by an FSD employee at the earliest 
available transfer. 

5.9.1.6. The robot operator shall collect samples from the storage area for automated 
processing.  The transfer shall be documented for the case record on the Biomek NX 
Automated Extraction/Quantitation Worksheet. 

5.9.1.7. The name (or initials) of robot operator receiving custody of samples, as well as the date 
of transfer, shall be marked on the worksheet.  

5.9.1.8. Following extraction, the lysis portion of the samples shall be retained (sealed in plate) in 
the IRL S201 robot room storage area.  The lysis plate shall be retained for 
approximately 60 days.   

5.9.1.9. If the lysis plate is required for reprocessing, the robot operator shall assume custody of 
the lysis plate and associated samples.  This transfer shall be documented in the case 
record to illustrate a clear, linear chain of custody and shall include, at a minimum, the 
name (or initials) of robot operator and date of transfer. 

5.9.1.10. After approximately 60 days post-processing, the lysis plate shall be discarded. 

5.9.1.11. Each subsequent step of automated processing (quantitation, amplification, and CE 
Injection) may be performed by the initial operator, or by another robot operator.  For 
each step, name (or initials) of the robot operator, as well as the date of the step 
performed, shall be documented in the case record on the corresponding automation 
worksheets.   

5.9.1.12. When different operators perform downstream steps of automated processing, the 
worksheets serve to document the dates of transfer from operator to operator at each 
point of automated processing.  

5.9.1.13. If processing requires repeating steps or changes that result in additional transfers 
between operators and/or analysts, this shall be documented in the case record to 
illustrate a clear, linear chain of custody and shall include, at a minimum, the name (or 
initials) of individuals and date of transfer. 

5.9.1.14. Following CE data generation, the robot operator shall send an email to the analyst 
informing them that data (and, if applicable, extracts) are available for collection.   

5.9.1.15. If any associated extracts are designated to be retained for preservation or additional 
manual processing (e.g., Y-STR), a robot operator shall transfer those extracts into 
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individual tubes and return these extracts to the IRL S201A robot room storage area 
within the same workday that the notification email is delivered. 

5.9.1.16. This email shall be retained by the analyst in the case record.  This documents a step in 
the chain of custody and denotes the point where the extract is transferred from the 
operator’s custody to the storage location. 

5.9.1.17. An analyst may transfer extracts destined for additional manual processing from the 
plate into individual tubes.  This shall be clearly documented by the analyst in the case 
record.  This documents a step in the chain of custody from robot operator to analyst, 
and shall include, at a minimum, the name (or initials) of analyst and the date of transfer. 

5.9.1.18. If an extract designated to be retained is completely consumed (or if the extract has 
completely evaporated prior to tube transfer), this shall be clearly documented by the 
robot operator in the automation case worksheets, and no tube shall be generated. 

5.9.1.19. The extracts not designated to be retained (i.e., remaining in the sample plate) shall be 
transferred (sealed in plate) to the IRL S201A robot room storage area.  These samples 
will be retained for approximately 60 days, in the event that the samples are required for 
retention or retesting (see above).   

5.9.1.20. After approximately 60 days post-processing, any remaining extracts not designated for 
retention shall be discarded. 

5.9.1.21. The analyst shall retrieve any retained extracts from the robot room storage area to 
return them to their custody.  The date of the transfer shall be recorded by the analyst in 
the case record.   

5.9.1.22. This documents a step in the chain of custody and denotes the point where the extract 
re-enters the analysts’ custody and adopts the associated parent samples’ chain of 
custody. 

5.10. Interpretation of Results: 

5.10.1. N/A 

5.11. Report Wording: 

5.11.1. N/A 

5.12. References: 

5.12.1. N/A 
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APPENDIX 1
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APPENDIX 2 
HID Real-Time PCR Analysis Software v1.2 and Quantifiler® 

Trio template set-up 
1.1 Create a “CASEWORK” folder on the AB_SW&DATA D: drive and a shortcut on the 

desktop. 
1.2 Create an “IMPORT” folder on the desktop. 
1.3 Open the HID Real-Time PCR Analysis Software v1.2. 
1.4 Select Tools → Preferences and select the “Defaults” tab.  

1.4.1 Change the default Data Folder and Export Folder destinations to the 
“CASEWORK” folder found on the D: drive. Change the default Import 
Folder destination to the “IMPORT” folder on the desktop. 

1.4.2 Select the “Startup” tab and deselect “User name required”. Mark only 
“FAM” and “VIC” for calibration status. 
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1.5 Select the Quantifiler® Trio icon on the Home screen. 
1.6 Select Analysis → Analysis Settings to remove all flags from the “HID Settings” and “Flag 

Settings” tabs. 
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1.7 Verify the CT Settings in the image below. 

 
1.8 Select Plate Setup from the left navigation pane and assign the 4 standard curve points to 

column 12 in duplicate. 
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1.8.1 The task for the Lg. Auto, Sm. Auto, and Y targets for each standard 
curve point shall be designated as “Standard”. The task for the IPC target 
shall be designated as “Unknown”. 

1.8.2 Enter the appropriate quantity for each Lg. Auto, Sm. Auto, and Y targets. 
(See the Standard Curve Prep Table above)  

1.9 Assign the NTC to well H11 and mark the task for the Lg. Auto, Sm. Auto, and Y targets as 
“Negative control”. The task for the IPC target shall be designated as “Unknown”. 

1.10 All remaining wells shall be left blank. 

 
1.11 Verify the Run Method.  

Holding Stage: 95.0°C for 2.00 minutes.  
Cycling stage: 40 cycles of 95°C for 9 seconds, 60.0°C for 30 seconds. 



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 142 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

 
1.12 Select Export and change the options to match the following two images. Ensure the 

Results Export are in the following order: Well, Sample Name, Task, Target Name, CT, and 
Quantity. Select Save as default at the bottom and Start Export. 
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1.13 Overwrite the QuantifilerTrio.edt template by selecting Save → Save changes as 

template. Navigate to AB_SW&DATA (D:) → Applied Biosystems folder → 7500 folder 
→ config folder → templates folder and select QuantifilerTrio.edt. 
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APPENDIX 3 
Instrument setup for Applied Biosystems® 3500 Genetic 

Analyzer - Data Collection Software version 2.0 
(only necessary the first time PowerPlex® Fusion 6C samples are run or if the 

parameters change) 
1.0 Configure the Security Settings 

1.1 Navigate to Tools and select “Security”. 
1.2 Change Screen settings to those depicted below. 
1.3 Click “Save Settings”. 

Security Screen: 
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2.0 Edit User Roles 
2.1 Click the “Users” button in the left navigation pane. 
2.2 Open the “Roles” tab. 
2.3 Set preferences to those depicted below. 
2.4 Select “Scientist” and click “Edit”. 
2.5 Click “Save Role”. 

Scientist User Role:  
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3.0 Create User Accounts 
3.1 Click on the “Users” tab. 
3.2 Click “Create” to access a New User window. 
3.3 Enter a unique User Name (ex. jdoe8251), set “Password” to lowercase “password” 

and re-enter.  Enter user’s first and last name and change settings to those depicted 
below.  Ensure the “User Role” is either set as an “Administrator” or “Scientist”. 

3.4 Click Save. 
New User Window: 
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4.0 Manage Audit Settings 
4.1 Navigate to Tools and Select “Audit”. 
4.2 Turn Auditing off by ensuring the “Disable Audit” is grayed out and the “Enable 

Audit” appears black as depicted below. 
4.3 Audit settings may be altered depending on current need. 

Disable Audit Settings: 
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5.0 Manage Electronic Signature Settings 
5.1 Navigate to Tools and Select “E-Signature”. 
5.2 Turn E-Signature off by ensuring that the “Disable E-Sig” is grayed out and the 

“Enable E-sig” is black as depicted below. 
5.3 E-Signature settings may be altered depending on need. 

Disable E-Signature Settings: 
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6.0 Create an Instrument Protocol  
6.1 Navigate to the Library and select “Instrument Protocols”. 
6.2 Select “Create”. 
6.3 Select “HID” for the Application Type. 
6.4 Select “36” for the Capillary Length. 
6.5 Select “POP4” for the Polymer. 
6.6 Select “Promega_J6” for the Dye Set. 
6.7 Select “HID36_POP4” for the Run Module on the 8-capillary 3500. Select 

“HID36_POP4xl” on the 24-capillary 3500xl. 
6.8 Enter “13.0” for the Run Voltage (kVolts). 
6.9 Enter “1.2” for Injection Voltage (kVolts). 
6.10 Enter “15” seconds for the Injection Time on the 8-capillary 3500. Enter “20” 

seconds on the 24-capillary 3500xl. 
6.11 Change the Run Time (sec) to “1500”. 
6.12 Name the protocol with the kit name and the injection voltage and time (i.e., 

Fusion6C_1.2kv15s). 
6.13 Mark “Locked” and click “Save”. 

Instrument Protocol: 
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7.0 Create a Size Standard 
7.1 Navigate to the Library and select “Size Standard”. 
7.2 Select “Create”.   
7.3 Assign the name “WEN ILS 500”. 
7.4 Select “Orange” for the Dye Color. 
7.5 Type the following into the left column: 60, 65, 80, 100, 120, 140, 160, 180, 200, 

225, 250, 275, 300, 325, 350, 375, 400, 425, 450, 475, and 500.  Click “Add Size(s) 
>>”. 

7.6 Mark “Locked” and click “Save”. 
Size Standard: 
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8.0 Create a QC Protocol  
8.1 Navigate to the Library and select “QC Protocols”. 
8.2 Select “Create”. 
8.3 Assign the name “WEN ILS 500”. 
8.4 Change settings to match the figure below. 
8.5 Mark “Locked” and click “Save”. 

QC Protocol: 
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9.0 Create an Assay 
9.1 Navigate to the Library and Select “Assays”. 
9.2 Select “Create”. 
9.3 Title the assay name “Fusion6C_1.2kv15s” on the 8-capillary 3500, and 

“Fusion6C_1.2kv20s” on the 24-capillary 3500xl. 
9.4 Select “HID” for the Application Type. 
9.5 Select “Fusion6C (WEN ILS 500)” as the QC Protocol. 
9.6 Select the appropriate instrument protocol. 
9.7 Mark “Locked” and click “Save”. 

Assay: 
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10.0 Create a Naming Convention 
10.1 Navigate to the Library and Select “File Name Convention”. 
10.2 Select “Create”. 
10.3 Title the name convention “Fusion6C_FNC”. 
10.4 Select the attributes and delimiters in the image below, click “Add”. The order of 

the attributes and delimiters can be changed using the “Move Up” and “Move 
Down” buttons. 

10.5 Leave file location as the default. 
10.6 Look at the “Preview of File Name” field for accuracy. 
10.7 Mark “Locked”, and Click “Save”. 

File Name Convention: 

  
  



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 155 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

11.0 Create a Results Group 
11.1 Navigate to the Library and Select “Results Group”. 
11.2 Select “Create”. 
11.3 Title the results group “Fusion6C_RG”. 
11.4 Select the attributes and delimiters in the image below, click “Add”. The order of 

the attributes and delimiters can be changed using the “Move Up” and “Move 
Down” buttons. 

11.5 Ensure that “Store reinjection sample file with original sample files (same level)” is 
selected. 

11.6 Leave file location as the default. 
11.7 Click so the “Include a Result Group Name folder” box is selected. 
11.8 Look at the “Preview of Results Group Name” field for accuracy. 
11.9 Mark “Locked” and click “Save”. 

Results Group: 
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APPENDIX 4 
GeneMapperTM ID-X 

1. Setting Up GeneMapperTM ID-X Version 1.6 Software User Accounts and Security System 
1.1 Setting Up Password Policies 

1.1.1 Open the GeneMapperTM ID-X version 1.6 software. 
1.1.2 Login using an administrator user account. 
1.1.3 Select “Admin” then “Security Manager”. 
1.1.4 Login with the same administrator user account. 
1.1.5 Select “Settings” then “Password Policies”. 
1.1.6 Change the settings to match the figure below. 

Password Policies: 

 
1.1.7 Save changes. 

1.2 Creating a User Group 
1.2.1 Open the Security Manager. 
1.2.2 Select the appropriate default user group in the left navigation pane (e.g., 

“Casework User Group”). 
1.2.3 Select “Edit” then “Duplicate”. 
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1.2.4 In the “General” section, enter a name for the user group (e.g., “ISP Casework 
User Group”). 

1.2.5 In the “Default Rights” section, make sure the “Read” and “Update” options are 
checked. 

1.2.6 Select the “Security Groups” tab. Ensure all associated security groups are 
checked, including the “GeneMapper ID-X” security group. 

1.3 Creating a Security Group 
1.3.1 Open the Security Manager. 
1.3.2 Select the appropriate default security group in the left navigation pane (e.g., 

“Casework Security Group”). 
1.3.3 Select “Edit” then “Duplicate”. 
1.3.4 In the “General” section, enter a name for the security group (e.g., “ISP 

Casework Security Group”). 
1.3.5 In the “Associate” column, select the appropriate user groups to associate with 

that security group (e.g., “ISP Casework User Group”).  Make sure the “Read” 
and “Update” options are checked for the selected user groups. 

1.4 Creating a Profile 
1.4.1 Open the Security Manager. 
1.4.2 Select the appropriate default profile in the left navigation pane (e.g., “Analyst”). 
1.4.3 Select “Edit” then “Duplicate”. 
1.4.4 In the “General” section, enter a name for the profile (e.g., “ISP Analyst”). 
1.4.5 In the “Installed Elements” table, select allowed actions for that particular profile.  

Allowed actions are not automatically inherited from the default profile and have to 
be manually entered.  For the “ISP Analyst” profile, check the same allowed 
actions as those for the default GeneMapperTM ID-X “Analyst” profile, with the 
exception of the “Update Panel” and “Update Size Standard” actions.  Change 
those actions to match the selections in the image below. 
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Allowed Actions of the “ISP Analyst” Profile: 

 
1.5 Setting Up a User Account 

1.5.1 Open the Security Manager. 
1.5.2 Select the appropriate default user type in the left navigation pane for that 

particular user (e.g., “Casework Analyst”). 
1.5.3 Select “Edit” then “Duplicate”. 
1.5.4 In the “General” section, enter a name.  This will be the login name. 
1.5.5 In the “User Details” section, enter a full name.  Leave the status set to “Active.”  

Uncheck “Show EULA”. 
1.5.6 Select a profile (e.g., “ISP Analyst”). 
1.5.7 Select one or more user groups (e.g., “ISP Casework User Group”). 
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1.5.8 In the “Password” section, select “Set Password”.  Enter the same password 
twice and click “OK”.  Check “Pre-Expire”. 

2.0 GeneMapperTM ID-X Version 1.6 Software Settings - PowerPlex® Fusion 6C 
2.1 Import Panel and Bin Files 

2.1.1 Open the GeneMapperTM ID-X version 1.6 software. 
2.1.2 Select Tools → Panel Manager. 
2.1.3 Highlight the “Panel Manager” icon in the navigation pane. 
2.1.4 Select File → Import Panels. 
2.1.5 Navigate to the saved panel, bin, and stutter files. Select “Fusion6C_v3 

_ISP_Panels” and click “Import”. 
2.1.6 Select the “ISP Casework Security Group”.  Click “OK”.   
2.1.7 In the navigation pane, highlight the “Fusion6C_v3_ISP” folder. 
2.1.8 Select File → Import Bin Set. 
2.1.9 Select “Fusion6C_v3_ ISP_Bins” and click “Import”. 
2.1.10 In the navigation pane, highlight the “Fusion6C_v3_ISP” folder. 
2.1.11 Select File → Import Marker Stutter.  A warning box will appear asking to 

overwrite the current values. Select “Yes”.   
2.1.12 Select “Fusion6C_v3_ISP_stutter” and click “Import”.  
2.1.13 In the Panel Manager window, select “Apply”, then “OK”. 
2.1.14 Repeat this process with the panels, bins and marker stutter files for analysis of 

unknowns to be run in STRmix™. 
2.1.14.1 Panels: “STRmix_v3_Fusion_6C_ISP_Panels”. 
2.1.14.2 Bins: “STRmix_v3_Fusion6C_ISP_Bins”. 
2.1.14.3 Marker Stutter: “STRmix_v3_Fusion6C_ISP_stutter”.  

2.2 Create a Casework Analysis Method 
2.2.1 Select Tools → GeneMapper Manager. 
2.2.2 Select the Analysis Methods tab. 
2.2.3 Enter the name “Fusion6C_v3”. 
2.2.4 Select the “ISP Casework Security Group”. 
2.2.5 Enter “3500” as the instrument. 
2.2.6 Select the Allele tab. In the “Bin Set” drop-down menu select 

“Fusion6C_ISP_Bins”. Verify that the “Use marker-specific stutter ratio and 
distance if available” box is checked. All values shall be “0.0”. 

2.2.7 Select the Peak Detector tab. Change the settings to match those shown in the 
following figure. 
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Peak Detector Tab:  
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2.2.8 Select the Peak Quality tab. Change the settings to match the following figure. 

Peak Quality Tab:   
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2.2.9 Select the SQ and GQ Settings tab. Change the settings to match the following 
figure. 

SQ and GQ Settings:  

 
2.2.10 Select “Save”. 
2.2.11 Repeat these steps to create the “STRmix_Fusion6C_v3” analysis method used 

to analyze unknown profiles for STRmix™ interpretation. All steps are identical 
except the following: 
2.2.11.1 Enter the name “STRmix_Fusion6C_v3”. 
2.2.11.2 Select the Allele tab. In the “Bin Set” drop-down menu select 

“STRmix_Fusion6C_ISP_Bins”.   
2.2.11.3 Select the Peak Detector tab.  Ensure that the dye channel peak 

amplitude thresholds are set to the values in the following figure (100 
for Blue, Green, and Yellow, 120 for Red, and 60 for Purple and 
Orange).  
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Peak Detector Tab: 

 
 
2.2.11.4 Select the Peak Quality tab. Change the settings to match the following 

figure. 
 

Peak Quality Tab:   
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2.3 Create a Size Standard 

2.3.1 Select Tools → GeneMapper Manager. 
2.3.2 Select the Size Standard tab and click “New”. 
2.3.3 Name the size standard “WEN ILS 500” in the “Size Standard Editor” screen, 

choose the “ISP Casework Security Group”, and choose “Orange” as the color 
for the size standard dye.  If “WEN ILS 500” is being utilized for both casework 
and databasing analysis methods on the same GMID-X database, the 
“GeneMapper ID-X Security Group” should be chosen to allow both the ISP 
Casework and Database security groups access.  

2.3.4 Enter the sizes of the 21 allelic ladder fragments: 60, 65, 80, 100, 120, 140, 160, 
180, 200, 225, 250, 275, 300, 325, 350, 375, 400, 425, 450, 475, and 500. 

2.3.5 Select “OK”. 
2.4 Create a Table Setting 

2.4.1 Select Tools → GeneMapper Manager. 
2.4.2 Select the Table Setting tab and click “New”. 



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 165 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

2.4.3    Under the General tab name the Table Setting “STRmix_Fusion6C” and select 
the “ISP Casework Security Group”. 

2.4.4 Under the Samples tab ensure that check marks are located next to only the 
following: Status, Sample File, Sample Name, Sample Type, Analysis Method, 
Panel, Size Standard, Sizing Quality Overridden, Sample File Not Found, 
Sample Off-Scale, and Sizing Quality.  
2.4.4.1 Sort by “Sample Type” and then by “Sample Name”. Select the 

“Ascending” option for both, and leave the final sort option to “None”. 
2.4.4.2 Leave the font “Arial” and the size “11”. 

2.4.5 Under the Genotypes tab ensure that check marks are located next to only the 
following: Sample Name, Marker, Allele, Size, and Height.   
2.4.5.1 Sort by “Sample File”, then by “Sample Name”, and then by “Marker”. 

Select the “Ascending” option for all three.  
2.4.5.2 Change the “Show number of alleles” to 20 and ensure that “Keep Allele, 

Size, Height, Area, Data Point, Mutation and Comment together” is NOT 
checked. (If the option to “Keep Allele, Size, Height…” is not visible in the 
window, expand the window size until the option appears.)   

2.4.5.3 Leave the font “Arial” and the size “11”. 
2.4.6 Select “OK”. 

2.5 Create a Plot Setting – Samples, Controls, and Ladders 
2.5.1 Select Tools → GeneMapper Manager. 
2.5.2 Select the Plot Settings tab and click “New”. 
2.5.3 Under the General tab name the Plot Setting “Fusion6C” and select the “ISP 

Casework Security Group”. 
2.5.4 Under the Sample Header tab ensure that check marks are located next to the 

following:  Sample File, Sample Name, Panel, Sizing Quality Overridden, Sample 
Off-Scale, and Sizing Quality.  

2.5.5 Under the Genotype Header tab ensure that check marks are located next to the 
following:  Sample File, Sample Name, Panel, Marker, Sample Off-Scale, Out of 
Bin Allele, Peak Height Ratio, Control Concordance, and Genotype Quality. 

2.5.6 Under the Sizing Table tab ensure that check marks are located next to the 
following:  Dye/Sample Peak, Sample File Name, Marker, Allele, Size, Height, 
Area, and Data Point.  Leave the font “Arial” and the size “11”.  

2.5.7 Select the Labels tab.  Change the settings to match the following figure.  
Alternatively, if the “allele edit comment” function is not being used, “Label 4” for 
“Assigned Allele”, “Custom Allele” and “Artifact” can be changed to “NONE”. 
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Labels Tab: 

 
  



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 167 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

2.5.8 Under the Display Settings tab, change the display settings so that they match 
the following figure and select “OK”. 

Display Settings Tab: 

 
2.6 GeneMapperTM ID-X Maintenance 

2.6.1 The number of audit records on the GeneMapperTM ID-X database should be 
routinely checked. Audit records should be backed-up, saved to the DNA server, 
and then deleted from the GeneMapperTM ID-X database routinely or if the 
number of records exceeds 40,000.  If the number of audit records exceeds 
60,000, the performance of the software may be affected. 

2.6.2  The amount of database space in the GeneMapperTM ID-X software should be 
routinely checked. If the occupied space exceeds 80%, additional disk space 
should be allocated.  
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APPENDIX 5 
STRmix™ SETTINGS 

 
1.0 STRmix™ Installation and Set-up 

1.1 Install the current version of STRmixTM (v2.7.0). 
1.2 Copy and Replace the following files from the BiologyQA drive to the STRmix™ Program 

files located on the (C:) drive: 
1.2.1 AlleleFreq folder, config folder, Databases folder, jre folder, Kits folder, logs folder, 

Populations folder, Results folder, stutters folder, Default Configuration settings, ISP 
Lab Logo, and Report Defaults XML document. 

1.3 Update to the floating license: 
1.3.1 After opening STRmix™, if no prompt comes up with the ability to install a 

license/validate license server, select About, and then select Remove License. It 
will tell you that you won’t be able to use STRmixTM again until a license is installed 
and will close the program. 

1.3.2 Reopen the program and follow the prompt to validate the license server. 
1.3.3 In the Host name, put the following IP address – 10.16.105.102 and the port# 16090. 
1.3.4 Select Validate.  It should then connect via the floating license server and access a 

license. 

1.4 Kit Parameters 
1.4.1 To access the run parameter settings from the STRmixTM main menu, select 

Administration (an administrator password shall be required), then select Profiling 
Kits. 

1.4.2 Navigating the General, Stutters, and Loci tabs, ensure that the correct kit settings 
are established.  The following settings shall be used for the interpretation of profiles:  
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1.4.3 In the “Gender?” column, AMEL, DYS391, DYS576, and DYS570 shall be checked. 
1.4.5 The Detection Threshold for shall be set at 100, 120, or 60, depending on the 

associated dye.   
1.4.6 In the “Back Stutter” and “Forward Stutter” columns, all autosomal loci shall be 

checked. 
1.4.7 In the “SE33 -2” column, SE33 shall be checked. 

1.5 Default Settings 
1.5.1 To access the default settings, from the STRmixTM main menu, select Administration 

(an administrator password shall be required), then select STRmix Defaults. 
1.5.1.1 Navigating the General, Likelihood Ratio, and User Interface tabs, ensure that 

the correct kit settings are established.  The following default analysis settings 
shall be used for the interpretation of profiles: 
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1.6 Population Settings 
1.6.1 The NIST_2017_Combined population database shall be used to perform 

statistical calculations. 
1.6.2 To access the population parameter settings, from the STRmix™ main menu, 

select Administration, then select Populations. 
1.6.3 The following population settings shall be used for the interpretation of profiles. 

1.6.3.1 FST Coancestry Coefficient, Theta (θ): corrects for two alleles identical by 
descent in different individuals.  An FST of 0.01 was selected for the four 
populations.  
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1.7 Report Settings 
1.7.1 To access the Summary Report settings, from the STRmix™ main menu, select 

Administration, then select Report Defaults, and then select Summary 
Report. 

1.7.2 Navigating the Per Report Settings and General Settings tabs, ensure that the 
correct settings are established.  The following report settings shall be used.  
Drag the individual Included Components to arrange their reporting order. 
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1.7.5 You may need to browse to your local STRmixTM folder to correctly path to the 

lab logo. 
1.7.6 Select Save. 
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Appendix 6 
PowerPlex® Fusion 6C Mean and Mean + 3SD Stutter 

The average observed percent stutter for each locus and mean +3SD (99.7% confidence level) of stutter 
observed in the PowerPlex® Fusion 6C validation are listed in the table below. Stutter exception files utilized in 
STRmix™ analysis are determined through different methods outlined and documented in the STRmix™ 
validation. 

 Backward Double Backward Forward 
 n-3/n-4/n-5 bp n-6/n-8/n-10 bp n+3/n+4/n+5 bp 

 Mean % 
Mean  

+ 3SD % Mean % 
Mean  

+ 3SD % Mean % 
Mean  

+ 3SD % 
D3S1358 9.13 14.1 0.74 1.43 0.64 1.39 
D1S1656 8.51 14.3 0.91 1.87 0.97 1.84 
D2S441 5.03 8.55 0.38 0.69 0.78 1.49 
D10S1248 8.31 13.8 0.73 1.46 0.35 1.04 
D13S317 5.05 10.9 0.39 0.65 0.87 2.01 
Penta E 2.75 6.99 0.41 0.92 0.37 0.84 
D16S539 7.04 12.6 0.61 1.27 1.07 2.37 
D18S51 8.08 14.9 0.80 1.59 1.07 3.11 
D2S1338 8.23 13.8 0.78 1.49 0.80 1.54 
CSF1PO 6.50 12.1 0.51 0.81 1.08 2.49 
Penta D 1.90 3.91 0.43 1.10 0.56 1.37 
TH01 2.07 4.60 0.34 0.82 0.38 0.79 
vWA 7.43 16.8 0.75 1.57 0.66 1.74 
D21S11 8.51 12.3 0.72 1.42 1.07 1.90 
D7S820 5.38 11.1 0.53 1.12 0.76 1.76 
D5S818 6.53 11.1 0.55 1.12 1.00 1.88 
TPOX 3.01 6.42 0.31 0.50 0.23 0.31 
D8S1179 6.96 10.7 0.60 1.08 0.70 1.28 
D12S391 9.68 17.9 1.01 2.40 0.81 2.38 
D19S433 7.85 12.5 0.81 2.37 1.06 2.58 
SE33 10.5 18.1 1.05 2.02 1.04 2.25 
D22S1045 7.55 18.1 1.01 1.86 4.50 9.48 
DYS391 6.79 8.71 0.77 1.64 0.73 2.02 
FGA 7.21 12.4 0.81 1.86 0.77 2.21 
DYS576 8.89 12.1 0.89 2.27 1.28 2.83 
DYS570 8.96 12.9 0.97 1.62 1.07 1.82 
 

 Half Backward   Half Forward 
 n-2 bp   n+2 bp 

  Mean % 
Mean + 3SD 

%    Mean % 
Mean + 3SD 

% 
D1S1656 1.68 2.97  SE33 1.26 2.25 
SE33 4.46 5.53   
FGA 0.47 0.97  
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APPENDIX 7  
REPORT WORDING 

REPORT WORDING RULES 
 
These are general wording guidelines for commonly occurring test results. Alterations 
must be approved by a supervisor.  Many of the words in these guidelines that are in 
uppercase should be changed to reflect your results (e.g. PERSON, ITEM X, etc.).  Words 
or phrases in [ ] are optional.  
 
In this appendix, the word “subitem” refers to a part of a submitted item of evidence 
that is considered distinctly separate and would not be combined with other subitems for 
DNA testing (due to case circumstances, sample purpose, serological results, etc.), 
regardless of whether or not a sample is retained. (E.g., vaginal/cervical swabs and 
external genital swabs are subitems within a kit item; a belt and a shirt may be 
subitems within a whole item; two submitted swabs with different serology results are 
considered separate subitems.) 
 
REPORT FORMATTING 
 

1. Reports shall be typed into a Word document with specific formatting. 

2. The Word document shall have no indents, tabs, special formatting, or font/size 
changes. The report shall be written in default Normal style.  

3. Original items and their descriptions shall be bolded and underlined.  Multiple 
original items shall be separated with a horizontal line of underscores. 

o If related, original items shall be addressed in additional reports such as 
additional standard comparisons, Y-STR and paternity requests (see example 
10) 

4. Subitems and their descriptions (if applicable) may be bolded (see examples 2,3 
and 4). 

o Subitem headers and required formatting (bold, underlined, or italicized) are 
required when you have different tiers in the same report (e.g. in SAK’s). 
Headers are not required for simple items, especially if nothing is retained or 
amplified (see example 9).  

o When a subitem is reported it shall be bolded and underlined if the original 
item is not present and was previously reported (as in additional 
submissions). 

5. Sub-subitems may be grouped by results under underlined headings (see 
example 6). 
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6. Sperm and Non-sperm fractions, where DNA results are different, shall be 
separated under italicized headings (see item 001C in example 1). 

7. Sub-sub-subitems, if needed, are listed under italicized headings. 

8. Line breaks: At least one blank line shall separate all items, subitems, and other 
individual results. Multiple blank lines may be used to enhance clarity or 
readability. 

9. Exclusions and comparisons without LRs (inclusions of unknown individuals) shall 
be listed with the contributor assumption before the bullets (see item 002A in 
example 6). The word excluded shall be bolded, except when including an 
individual (i.e., cannot be excluded). 

10. Likelihood ratios: 

o Each likelihood ratio paragraph shall be preceded by a triangle text bullet: ► 

o The word inclusion/exclusion/uninformative in the LR paragraph shall be 
bolded. 

 
GENERAL REPORT RULES 
 

1. Report wording may be altered with the approval of a Biology Unit Supervisor. 

2. The appropriate appendix with appropriate definitions and explanations shall be 
attached to the end of each report.  Reports in which the entire request has been 
withdrawn do not require an appendix.  

3. Serology results shall be reported prior to any DNA results for each item. 

4. No serology statement is needed if no serological testing is performed. 

5. Item numbers shall include all leading zeroes. 

6. Items shall be reported by item in numerical order. 

7. Item descriptions in the results section: 

o The description of each item shall be similar to but need not be identical to 
the item description in the submission section. 

o The description shall not include the packaging. 

o The description shall include the number of swabs/samples in parentheses 
when it is not otherwise apparent. 

8. If subitems created for DNA sampling are retained by the Forensic Services 
Division, this shall be reported (see examples).  When multiple swabs/samples 
within an item are being tested, the number of items tested shall be reported 
(see examples). 

9. Retention statements generally will be in the opening paragraph for an item.  
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10. The significant contents of an item shall be listed in the results section. 

11. At a minimum, the first and last name of any individuals being compared shall be 
used throughout the entire report. The item number of the standard shall not 
follow the name in the results unless individuals cannot otherwise be 
distinguished. 

12. Individual items from another case should not be listed in the item descriptions 
or as separate items in the body of the report.  

13. Similar results within an item may be grouped together. 

14. Swabs utilized for DNA sampling, shall be reported as a “sample” of the item 
being tested or the sample itself.  When multiple samples of an item are 
extracted separately, they are considered separate samples and the number of 
samples shall be reported.   

15. All submitted samples in an item (excluding standards) not tested shall be 
described as not tested in the report using the appropriate wording.  

16. When two or more samples are combined at any point in the analysis process, 
the report shall refer to the samples as “combined”. The analyst’s notes shall 
clearly describe which samples and at which stage of the process the samples 
were combined. 

o If all subitems or samples within the item (not collected by the analyst) are 
not combined into one extract, the report shall indicate how many 
subitems/samples were combined and how many were not tested.  

17. If multiple swabs are collected by the analyst and treated as one sample, the use 
of “combined” is not required. In a sample with insufficient (male) DNA for 
amplification, where it is valuable to identify a male contributor from a female 
contributor (i.e., sexual assault cases), results shall be reported based on the 
Quantifiler® Trio Y target.  

18. When differential extractions are employed, the terminology “sperm [cell] 
fraction” and “non-sperm [cell] fraction” shall be used in the report any time a 
portion of the sample is amplified or qualifies for autosomal amplification.  The 
results shall be reported as single result not referring to the fractions in the 
following situations: 

o When both fractions of a differential extraction exhibit the same quantitation 
testing result and are not amplified, the results shall be reported as a single 
result referring to the item only and not the individual fractions. 

o If fractions of the same extract have different results regarding insufficient 
male DNA for autosomal analysis, insufficient male DNA for further analysis, 
and/or no male DNA, the results shall be reported as a single result using 
the appropriate insufficient male DNA wording that indicates the largest 
amount of male DNA present between the two fractions. 
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DNA PROFILE COMPARISONS 
 

1. When reporting a mixture, the assumed number of contributors shall be stated.     

2. When a person or a group of people are visually excluded from a sample, their 
exclusion shall be reported.  Exceptions for complex cases require 
supervisor/technical leader consultation. 

3. A unique unknown individual may be determined and reported if there are twelve 
or more complete autosomal loci with > 99% weighting in a single source sample 
or a single profile determined from a mixture. 

o A unique individual shall be identified in the report as male or female if an 
unambiguous determination can be made from Amelogenin and the Y-STR 
loci results.   

o A unique unknown individual can be included/excluded from any additional 
single source or mixed sample (including samples with fewer than 12 loci) at 
the analyst’s discretion. Care should be taken to ensure that this conclusion 
is unambiguous as the comparison within STRmix™ will not take place until 
a standard is submitted. 

4. For each report detailing a new evidentiary DNA profile, the appropriate CODIS 
statement shall be included. The CODIS statement shall be with the closing 
statements at the end of the report. 

5. All positive associations shall utilize a STRmix™ deconvolution and have a 
statistical evaluation applied and reported. The only exceptions being the 
following: 

o The owner on an intimate sample or an elimination standard reasonably 
assumed to be present on an item. Report wording shall include a statement 
indicating that the assumption was made.  

 A profile may be reported as being consistent with an assumed 
individual with no conclusions drawn on the remainder of the sample 
due to the inability to determine a number of contributors. 

o A profile from one fraction of a differential extraction that is consistent with 
a conditioned individual and a profile from the corresponding fraction. 

 The profile from the corresponding fraction may be utilized if it is 
single source or a single source profile determined by conditioning. 

 

STATISTICAL EVALUATIONS 
 

1. When reporting out the Likelihood Ratio, it can be reported numerically or in word 
form, (i.e., 1,000,000 versus 1 million). 
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2. A reporting ceiling of 1 trillion will be utilized. When a calculated LR is more than 
1 trillion times the phrase “at least 1 trillion” shall be utilized in place of the 
calculated LR number. 

o A verbal scale shall accompany the LR result in an effort to provide 
additional explanation of the weight of the evidence. 

Likelihood Ratio Support Level Support for: 
LR ≥ 1,000,000 Very strong Inclusion 

10,000 ≤ LR < 1,000,000 Strong Inclusion 
100 ≤ LR < 10,000 Moderate Inclusion 

2 ≤ LR < 100 Limited Inclusion 
1 Uninformative Uninformative 

2 ≤ (1/LR) < 100 Limited Exclusion 
100 ≤ (1/LR) -- Exclusion 

3. Analysts have the discretion to report unambiguous exclusions without using 
STRmix™ to calculate a LR. 

4. DNA mixtures in which multiple reference profiles indicate inclusion (LR support 
for H1) shall have multiple LR propositions calculated.  The reference profile LRs 
shall be run individually to indicate individual weight in the mixture.  Additionally, 
LRs shall be calculated to indicate the weight of all included individuals combined 
together in the mixture. 

o There may be scenarios when multiple individuals (possibly even more 
individuals than present in the mixture) have a LR supporting H1 when 
compared to an evidence profile in isolation; however, the LR could favor 
exclusion when the individuals are compared to the evidence profile in 
combination with each other.  In this scenario, the evidence profile could not 
have come from that combination of individuals. Such groups are termed 
‘incompatible’ as, combined, they are incompatible with the evidence profile. 
This scenario is not unexpected when related individuals are compared to 
minor or low level DNA profiles.  When appropriate, an analyst can attempt 
to test different combinations to provide further information.  However, it is 
not always possible to test or list all incompatible groups.    

5. When multiple LR propositions are calculated, it is recommended that the analyst 
report the single proposition that most reasonably explains the evidence based 
on the case information available, if possible.  Case circumstances will dictate 
which of these calculations are most appropriate for the report and multiple 
propositions may need to be reported. 

o Reporting individual LRs is required when the LR favoring inclusion of one 
individual falls in a different level of the verbal scale than the other 
individual.  However, if each individual LR falls in the same level of the 
verbal scale (i.e., all individuals indicate very strong support for H1), it is 
appropriate to only report the combined LR. 
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o The combined LR shall be reported when the calculated LR of all individuals 
combined equals 0 (no support for the individuals making up the mixture 
together). 

 The appropriate inclusionary individual LRs shall be reported along 
with the additional report wording statement indicating the individuals 
cannot make up the mixture together. 

6. If the analyst cannot clearly exclude an individual, STRmix™ may be used to 
assist in the comparison.   If STRmix™ is used to determine an exclusion, the 
appropriate exclusion statement shall be included in the report for that individual.   

o LR values less than 1 favor the defense proposition (H2).  LR values less 
than 1 will be evaluated for the verbal equivalent as 1/LR.   

 1/LR values between 2 and 99 will be reported as limited support for 
exclusion and will include the hypotheses and calculated 1/LR value in 
the report as stated in the report wording guidelines.   

 1/LR values above 99 shall use the general exclusion statement as 
stated in the report wording guidelines.   

 An LR value of zero indicates no scientific support for the prosecution 
proposition (H1) and shall use the general exclusion statement as 
stated in the report wording guidelines. 

7. The 99% 1-sided lower HPD LR values shall be reported using the 
ISP_NIST_Combined allele frequencies. 

o LR values in the support of H1 will be rounded down to two significant 
figures for reporting. 

 If the LR in support of H1 is less than 2, it shall be rounded down to 
1.0 (uninformative).  

o If the LR value is in support of H2, the 1/LR value will be rounded up to two 
significant figures for reporting. 

 If the LR in support of H2 is less than 2, it shall be rounded up to 2.0 
(limited support for exclusion). 

8. Additional LR calculations performed by request after the initial report has been 
released shall be reported in a Supplemental Certificate of Analysis. 

9. Reports issued with a verbal equivalent statement prior to September 24, 2018 
shall not be reissued unless new statistical comparisons are made.  If new 
comparisons are made, the verbal equivalents shall be updated as appropriate 
and appropriate wording shall be added to the report to indicate the change.     

10. Any statistical result for analysis reported prior to July 13, 2015 shall be 
recalculated with the original statistical method used and appropriate updated 
allele frequencies utilizing IndySTR v2.2_04-01-2016 if:  



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 185 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

o Additional evidence is submitted in the case;  

o The case is going to court; or 

o Upon request; 

o If the reported statistical results change, a new (additional evidence 
submitted) or amended (for court or upon request) Certificate of Analysis 
shall be issued with notification included in the report and the statistical 
worksheets uploaded under the associated request number.  If the reported 
statistical results do not change and there is an active new request, the new 
statistical worksheets shall be uploaded under the active request number.  If 
the reported statistical results do not change and there is no active request, 
the new statistical worksheets shall be uploaded under the original request 
as V2.  

11. Previously calculated statistics and comparisons should utilize the appropriate 
report writing statements approved at the date the calculations were originally 
performed.  Supervisor approval shall be obtained.  
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SEROLOGY STATEMENTS 
Citations shall refer to the Report Appendix to reflect the test(s) supporting the result.  
 
 
NEGATIVE RESULT 
No blood was detected.¹ 
No seminal material was detected.² 
No sperm cells were indicated by quantitation results [on the combined swabs]. 
 
 
POSITIVE CONFIRMATORY RESULT 
Human blood was confirmed.³  [DNA analysis was performed on X samples.] 
 
Seminal material was confirmed.⁴ [DNA analysis was performed on X samples.] 
 
 
POSITIVE PRESUMPTIVE RESULT 
Blood was indicated by presumptive testing.¹ [DNA analysis was performed on X 
samples.] 
Seminal material was indicated by presumptive testing.² [DNA analysis was performed 
on X samples.] 
The possible presence of sperm cells was indicated by quantitation results [on the 
combined swabs]. 
 
 
NEGATIVE CONFIRMATORY RESULT 
In addition to positive presumptive result. 
 
Confirmatory testing was negative [for human blood/seminal material].³/⁴ 
 
SEXUAL ASSAULT KIT 
Could apply to any item containing multiple subitems which need to be addressed. 
 
Item 00X: Evidence Collection Kit – PERSON 
Items 00XA through 00XX were present [or prepared from items] in the kit.   
 
 
NO SEROLOGICAL TESTING PERFORMED 
For cases where it is important to note a lack of staining to test; not for routine use. 
 
No stains were observed for serological testing. 
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SEROLOGY ONLY REPORTS 
For use in reports where a qualified DNA analyst has performed serological testing, but 
DNA analysis will be reported by another analyst.  
[Automated] DNA processing was performed on [# samples/the combined 
swabs]. 
 
 
 
TRACE EVIDENCE 
Potential trace evidence was observed.⁶ 
 
 
HAIR STATEMENTS 
 
Hair demonstrating characteristics of human hair with the potential for nuclear DNA 
analysis was observed/tested as item XA.⁵ 
 
When no microscopic analysis is performed. Ends sampled for DNA. 
 
DNA analysis was performed on # hair-like fiber(s). 
 
Human hair without roots, or other hairs may be considered trace evidence when not 
significant.  The wording below is to be used when hair is of evidentiary value. 
 
Hair demonstrating characteristics of human hair but without the potential for nuclear 
DNA analysis was observed.⁵ 
 
Hair demonstrating characteristics not consistent with human hair was observed.⁵ 
 
 
ITEMS OR SUBITEMS NOT EXAMINED 
For subitems not examined, the statement is placed at the end of the item. 
 
The ITEMDESCRIPTION, ITEMDESCRIPTION, and ITEMDESCRIPTION (items XA-XZ) were 
not examined. 
 
 
AUTOSOMAL DNA STATEMENTS 
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EXCLUSION 
Excluded visually or with an individual STRmix™ calculated LR=0, 1/LR ≥100, or falling 
into an unsuitable contributor position when there are available positions for inclusion.  
To be placed with the appropriate interpretation statement, before the LR bullet points. 
 
PERSON is excluded. 
 
 
 
IDENTICAL TWINS 
To be placed at the beginning of the results section. 
 
The DNA profiles obtained from TWIN1 and TWIN2 demonstrated the same DNA profile.  
This is typically associated with identical twins.  The conclusions reflect the comparisons 
with the provided standards. 
 
 
SINGLE SOURCE STATEMENTS 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as originating from a single 
individual. 
 
PERSON was considered as a contributor: 
► The DNA profile is at least 1 trillion/LR times more likely if it originated from PERSON 
than if it originated from an unknown, unrelated individual. 
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON is included.  
 
 
UNKNOWN PROFILE 
STRmix™ deconvolution performed, but no LR calculated. [(Unknown #) Statement 
allowed if a designated unknown is determined at 12 or more loci in a single source 
profile or in a two-person mixture in which the other individual is assumed (i.e. only one 
foreign individual).  Utilized at analyst discretion.] 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as originating from a single 
male/female/individual [(Unknown Male/Female/Individual #)]. 
 
The DNA profile from the combined swabs was interpreted as a mixture of two 
individuals.  Assuming PERSON as a contributor, the mixture contains a single [male] 
individual (Unknown Male #1).  
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CONSISTENT WITH ELIMINATION STANDARD 
No deconvolution performed. 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as originating from a single 
individual.  Assuming PERSON as a contributor, no additional alleles were detected. 
 
 
 
MIXTURE STATEMENTS 
 
GENERAL MIXTURE STATEMENT 
LR ≥ 2, result supports H1, inclusion of one person of interest. 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of N individuals. 
 
PERSON was considered as a contributor: 
► The DNA profile is at least 1 trillion/LR times more likely if it originated from PERSON 
and N-1 unknown individual[s] than if it originated from N unknown, unrelated 
individuals.  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON is included.   
 
GENERAL MIXTURE STATEMENT WITH UNSUITABLE PORTION(S) 
LR ≥ 2, result supports H1, inclusion of one person of interest, exclusion of another. 
DBLR or template determined portion that is unsuitable for comparison. 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of N individuals. 
A portion of the profile was determined to be unsuitable for comparison. All conclusions 
are based on the remaining portion. PERSON2 is excluded. 
 
PERSON was considered as a contributor: 
► The DNA profile is at least 1 trillion/LR times more likely if it originated from PERSON 
and N-1 unknown individual[s] than if it originated from N unknown, unrelated 
individuals.  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON is included.   
 
 
DESIGNATED UNKNOWN INDIVIDUAL IN A MIXTURE 
Statement utilized any time a designated unknown is either determined at 12 or more 
loci OR not excluded from the mixture.  Utilized at analyst discretion (‘excluded’ is not 
bolded). This is the only option if there is more than one foreign individual in a profile. 
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Unknown [Female/Male/Individual] #1 cannot be excluded. 
 
MIXTURE WITH CONDITIONING 
LR ≥ 2, result supports H1, inclusion of one person of interest. 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of two 
individuals. PERSON2 was assumed as a contributor. 
 
PERSON was considered as a contributor: 
► The DNA profile is at least 1 trillion/LR times more likely if it originated from PERSON2 
and PERSON1 than if it originated from PERSON2 and an unknown, unrelated individual.  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON1 is included. 
 
 
MIXTURE WITH CONDITIONING AND UNSUITABLE PORTION(S) 
DBLR/template unsuitable for remaining portion of profile. 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of N individuals, 
[including at least one male]. PERSON2 was assumed as a contributor. The remaining 
portion of the profile was determined to be unsuitable for comparison.  
 
 
MIXTURE WITH CONDITIONING 
LR ≥ 2, result supports H1, inclusion of one person of interest with DBLR/template 
unsuitable for portion of profile. 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of N individuals. 
PERSON2 was assumed as a contributor. A portion of the profile was determined to be 
unsuitable for comparison.  All conclusions are based on the remaining portion.  
[Unknown Female/Male/Individual #1 cannot be excluded.] 
 
PERSON1 was considered as a contributor: 
► The DNA profile is at least 1 trillion/LR times more likely if it originated from 
PERSON2, PERSON1, and N-2 unknowns individual[s] than if it originated from PERSON2 
and N-1 unknown, unrelated individual[s].  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON1 is included. 
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PROFILES ONLY WHEN VARNOC UTILIZED 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of N or N+1 
individuals [, including at least one male]. [LR or exclusion wording, as needed] 
 
 
 
 
CONSISTENT WITH MULTIPLE ELIMINATION STANDARDS 
No deconvolution performed. No other inclusions or exclusions made from the profile. 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of two 
individuals.  Assuming PERSON1 and PERSON2 as contributors, no additional alleles 
were detected. 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of three 
individuals.  PERSON1 and PERSON2 were assumed as contributors. The remaining 
portion of the profile was determined to be unsuitable for comparison.  
 
 
CONSISTENT WITH ELIMINATION STANDARD + DIFFERENTIAL FRACTION 
In one differential fraction, may assume corresponding differential fraction. No 
deconvolution performed. 
 
The DNA profile from the non-sperm/sperm fraction [of ITEMDESCRIPTION] was 
interpreted as a mixture of two individuals. Assuming PERSON and the corresponding 
sperm/non-sperm fraction as contributors, no additional alleles were detected. 
 
 
LIMITED EXCLUSIONARY LR 
STRmix™ LR calculated, 2≤1/LR<100, result supports H2. [DBLR/template unsuitable 
for portion of profile.] 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of N individuals. 
[A portion of the profile was determined to be unsuitable for comparison. All conclusions 
are based on the remaining portion.] 
 
PERSON was considered as a contributor: 
► The DNA profile is LR times more likely if it originated from N unknown, unrelated 
individuals than if it originated from PERSON and N-1 unknown individual[s].  
► This statistical analysis provides limited support for the proposition that PERSON is 
excluded. 
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INDIVIDUAL INCLUSIONS, BUT EXCLUDED TOGETHER 
To be placed after the appropriate individual inclusionary statements. 
 
Note:  
Given the interpretation that the mixture originated from N individuals, there is support 
for the propositions that the [comparable portion of the] DNA profile originated from 
PERSON1 or PERSON2 individually.  However, there is no scientific support for the 
proposition that the [comparable portion of the] DNA profile originated from PERSON1 
and PERSON2 together.  Refer to the independent inclusionary statistics reported above. 
 
 
INCONCLUSIVE LR 
STRmix™ LR calculated, LR rounds to 1.0. [DBLR/template unsuitable for portion of 
profile.] 
 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of N individuals. 
[A portion of the profile was determined to be unsuitable for comparison. All conclusions 
are based on the remaining portion.] 
 
PERSON was considered as a contributor: 
► A likelihood ratio of 1.0 was obtained. The DNA profile is equally as likely if it 
originated from PERSON and N-1 unknown individual[s] or if it originated from N 
unknown, unrelated individuals.  
► This result is considered uninformative. 
 
 
ALTERNATE PROPOSITIONS 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of N individuals. 
[A portion of the profile was determined to be unsuitable for comparison. All conclusions 
are based on the remaining portion.] [Exclusions, if needed] The probability of the 
evidence has been calculated by considering multiple propositions.  
 
PERSON1 and PERSON2 were considered as contributors: 
► The DNA profile is at least 1 trillion/LR times more likely if it originated from 
PERSON1, PERSON2, and N-2 unknown individual[s] than if it originated from N 
unknown, unrelated individuals.  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that both PERSON1 and PERSON2 are included. 
 
Assuming PERSON2 as a contributor, PERSON1 was considered [as a contributor]: 
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► The DNA profile is at least 1 trillion/LR times more likely if it originated from 
PERSON2, PERSON1, and N-2 unknown individuals[s] than if it originated from PERSON2 
and N unknown, unrelated individual[s].  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON1 is included. 
 
 
VARIABLE NUMBER OF CONTRIBUTORS  
The appropriate mixture wording should be adjusted to accurately reflect results.  One 
example below.  
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of N or N+1 
individuals. 
 
PERSON was considered as a contributor: 
► The DNA profile is at least 1 trillion/LR times more likely if it originated from PERSON 
and N unknown individual[s] than if it originated from N+1/N-1 unknown, unrelated 
individuals. 
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON is included. 
 
 
 
INCONCLUSIVE SAMPLES 
 
NO ALLELES DETECTED 
 
ITEMDESCRIPTION failed to demonstrate a DNA profile. 
 
 
INCONCLUSIVE NUMBER OF CONTRIBUTORS 
 
The DNA profile [from ITEMDESCRIPTION] has limited data/is a mixture.  No further 
conclusions can be drawn due to the uncertainty in the number of contributors. 
 
 
CONSISTENT WITH ELIMINATION STANDARD + INCONCLUSIVE NOC 
Consistent with elimination standard but no conclusion being drawn from additional 
alleles. 
 
The DNA profile [from ITEMDESCRIPTION] is a mixture. Assuming PERSON as a 
contributor, no further conclusions can be drawn due to the uncertainty in the number of 
contributors. 
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ALL CONTRIBUTORS UNSUITABLE FOR COMPARISON 
STRmix™ deconvolution performed, but no LR calculated. DBLR/template unsuitable for 
all portions of profile. 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as a mixture of 
two/three/four individuals. The profile was determined to be unsuitable for comparison.  
 
 
>4 CONTRIBUTORS 
 
No conclusion can be drawn [from ITEMDESCRIPTION] because the DNA profile is a 
mixture of more than four individuals. 
 
 
FAILED CONTROL 
Statement to be placed before listed results for an item.  Not all possible combinations 
are given; consultation with the Technical Leader and/or Supervisor is required for 
situations not covered below. 
 
During analysis [of ITEMDESCRIPTION], a positive/negative test control failed. Data was 
evaluated and determined to be suitable for interpretation.  
 
During analysis [of ITEMDESCRIPTION], a positive/negative test control failed. Data was 
evaluated and determined to be unsuitable for interpretation; therefore, no conclusions 
can be drawn. 
 
 
CONTAMINATION 
When Database Search LR ≥ 10,000. Not all possible combinations are given; 
consultation with the Technical Leader and/or Supervisor is required. 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as originating from a single 
identified individual from the Indiana State Police Forensic Services Division Quality 
Assurance DNA Database.  Assuming this individual as a contributor, no additional 
alleles were detected. 
 
 
The DNA profile was interpreted as a mixture of N individuals. An identified individual 
from the Indiana State Police Forensic Services Division Quality Assurance DNA 
Database was present and assumed as a contributor. 
 
PERSON was considered as a contributor: 
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► The DNA profile is at least 1 trillion/LR times more likely if it originated from the 
Database individual and PERSON than if it originated from the Database individual and 
an unknown, unrelated individual.  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON is included. 
 
 
 
SAMPLES NOT AMPLIFIED / QUANT-OUTS 
In a sample with insufficient (male) DNA for amplification, where it is valuable to identify 
a male contributor from a female contributor (i.e. sexual assault cases), the reported 
results shall be based on the Quantifiler® Trio Y target. 
 
INSUFFICIENT HUMAN DNA 
 
ITEMDESCRIPTION demonstrated an insufficient quantity of DNA for further analysis. 
 
 
INSUFFICIENT MALE DNA for AUTOSOMAL ANALYSIS 
Not eligible for autosomal, but male DNA is greater than 0.006 ng/µl 
 
ITEMDESCRIPTION demonstrated an insufficient quantity of male DNA for autosomal 
STR analysis. 
 
 
INSUFFICIENT MALE DNA OR UNDETECTED MALE DNA 
Not eligible for either autosomal or Y-STR analysis, or undetected male DNA  
 
No male DNA or an insufficient quantity of male DNA for further analysis was detected 
[on ITEMDESCRIPTION]. 
 
 
 
SAMPLE TRIAGED 
Eligible for autosomal analysis, but not amplified 
 
ITEMDESCRIPTION was/were extracted and quantified; however, no additional DNA 
analysis was performed [due to the development of DNA profiles on other items]. 
 
 
SAMPLE/SUBITEM NOT TESTED FOR DNA 
May modify as shown if permission to consume is required. 
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No DNA analysis was performed. [If further DNA analysis is desired, permission to 
consume the sample is required. Please contact the reporting analyst.] 
 
 
STANDARD ITEMS 
 
Item X: DNA Standard – PERSON 
 
STAIN CARD 
 
A stain card was prepared [and returned to the original packaging]. 
 
  
PROFILE DEVELOPED/NOT DEVELOPED 
  
The DNA profile [of PERSON] was [previously] developed. 
 
No DNA profile [of PERSON] was developed [at this time]. 
 
 
SEXUAL ASSAULT KIT ORAL SWAB DEVELOPED AS STANDARD 
  
If female victim: 
Appropriate male quantitation statement.  The DNA profile was developed as a standard 
for PERSON. 
 
If male victim: 
The DNA profile [from ITEMDESCRIPTION] was interpreted as originating from a single 
individual.  This profile will be used as a DNA standard for PERSON. 
 
 
PROFILE DEVELOPED BUT NOT INTERPRETED 
 
The sample was processed but not interpreted due to a lack of evidence for comparison. 
 
 
STANDARD DEVELOPED WITH UPDATED CHEMISTRY 
 
The DNA profile was updated with the current DNA chemistry. 
 
 
MIXED PROFILE OBTAINED 
To be used only with Technical Leader consultation and approval. 
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The DNA profile was interpreted as a mixture of N individuals. A distinct female/male 
profile was determined to be used as the assumed standard for PERSON. 
 
 
MULTIPLE STANDARDS 
 
The standard was not examined due to the presence of multiple standards. 
 
 
STANDARD COMPARED TO EVIDENCE IN OTHER CASE 
For the case that contains the standard 
 
The DNA profile of PERSON (item XXA) was compared to the evidence in Indiana State 
Police Forensic Services Division Case XXX-XXXXX, Other Police Department Case 
XXXXX. 
 
 
EVIDENCE COMPARED TO STANDARD FROM OTHER CASE 
For the case that contains the evidence but not the standard. Placed at the beginning of 
the report. 
 
Evidence was compared to the DNA profile of PERSON (item XA) developed in Indiana 
State Police Forensic Services Division Case XXX-XXXXX, Other Police Department Case 
XXXXX. 
 
 
CODIS STATEMENTS 
All placed in the end section of the report. 
 
[The] DNA profile[s] from [list item numbers] [was/were] entered into the Combined 
DNA Index System (CODIS) and will be searched on a routine basis. In the event of a 
database match, additional information will be provided separately. 
 
 
PENDING STANDARD SUBMISSION 
 
Upon submission of an appropriate DNA standard from PERSON, the DNA profile from 
item number will be re-evaluated for possible entry into the Combined DNA Index 
System (CODIS). 
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PENDING ADDITIONAL INFORMATION 
 
Additional information is required [regarding ITEM] before it can be determined if any 
DNA profiles are eligible for the Combined DNA Index System (CODIS).  Please contact 
the reporting analyst if a database search is desired. 
 
 
NO CODIS ENTRIES 
To be used when profiles are developed but none are suitable for entry. 
 
No DNA profiles were entered into the Combined DNA Index System (CODIS). 
 
 
REMOVAL FROM CODIS 
To be used in supplemental reports when profiles are deleted from the database. 
 
[The] DNA profile[s] from [list item numbers] [was/were] removed from the Combined 
DNA Index System (CODIS). 
 
 
OTHER STATEMENTS 
All wording in this section placed at the end of the report unless otherwise indicated. 
 
ALTERNATE CALCULATIONS 
To be used additional/alternate LRs were calculated but not included in report.  
 
Alternate calculations have been performed for item(s) XA, XB and XC and are available 
upon request. 
 
 
STATISTICS STATEMENT WHEN FREQUENCY REPORTED 
To be placed prior to the appropriate SWGDAM statement.   
 
The data in this report was interpreted and evaluated prior to the implementation of 
Likelihood Ratios at the Indiana State Police Forensic Services Division.  The statistical 
estimates are presented in the form of a frequency. 
 
 
POWERPLEX® FUSION 6C DATA WITH RMP/CPI 
To be used when Fusion 6C data was reported with a frequency prior to November 1, 
2017. 
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Statistical estimates were performed based on the recommended concepts endorsed by 
the Scientific Working Group on DNA Analysis Methods (1/12/17). Y-STR loci included 
with the PowerPlex® Fusion 6C System were used for interpretations but were not 
included in statistical estimates. Calculations for the Caucasian, African American, and 
Hispanic populations have been performed. The most common frequency has been 
reported unless all calculated frequencies exceed 1 in 8 trillion. 
 
 
RE-EVALUATING DATA WITH NEW FBI ALLELE FREQUENCIES 
Stats calculated prior to July 13, 2015 and re-calculated with updated allele frequencies. 
 
The statistical calculations were adjusted to reflect the amended allele frequencies 
published by the FBI.  Moretti, T.R., Budowle, B. and Buckleton, J. S., Erratum, Journal 
of Forensic Sciences 2015; 60(4). 
 
 
RE-EVALUATING DATA WITH NEW INTERPRETATION GUIDELINES 
Requires Supervisor’s approval and shall be placed at the beginning of the results 
section. 
 
In the DNA analysis detailed below, sample data was re-evaluated using methods 
implemented after the original report was issued. Accordingly, the following conclusions 
may differ from the original report. 
 
 
UPDATING STATISTICS WITH VERBAL EQUIVALENT 
Shall be placed at the beginning of the results section. Applies to reports issued with a 
verbal equivalent statement prior to September 24, 2018. 
 
In the DNA analysis detailed below, sample conclusions were updated utilizing a verbal 
qualifying statement recommended by the Scientific Working Group on DNA Analysis 
Methods. Accordingly, the following conclusions may differ from the original report.  
 
 
RE-ANALYSIS OF SAMPLE FOR ADDITIONAL DATA 
Requires Supervisor’s approval and shall be placed at the beginning of the results 
section. Other situations may be listed as needed with supervisor approval. 
 
Additional analysis of the ITEMDESCRIPTION was performed.  The resulting profile was 
suitable/not suitable for familial searching/entry/updating in the Combined DNA Index 
System (CODIS).  In the event of a database match, additional information will be 
provided separately. 
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REQUEST FOR STANDARDS 
 
If additional comparisons are desired, please submit an appropriate DNA standard (such 
as an oral/buccal swab standard) from [victim/consensual partner/named suspect or] 
any [additional] suspect(s). 
 
 
Autosomal DNA/Y-STR/SNP ANALYSIS PENDING 
 
When completed, results from the [DNA/Y-STR/SNP] analysis will be provided 
separately. 
 
 
PATERNITY/KINSHIP ANALYSIS PENDING 
 
When completed, Paternity/Kinship analysis of the DNA profiles determined for 
PERSON1, PERSON2, and PERSON3 will be provided separately. 
 
SAMPLES PROCESSED BY ANOTHER ANALYST 
For use in reports where a forensic technician or DNA analyst has prepared or processed 
samples, but DNA results will be reported by another analyst. 
 
Original items of evidence were processed by NAME at the [Evansville/Fort 
Wayne/Indianapolis/Lowell] Laboratory. 
 
SAMPLES PROCESSED AT MULTIPLE LABORATORIES 
Applies to robot samples sent from regional labs and to technician cases that were 
processed at one lab and sent to another for reporting.  
 
Laboratory activities were performed at the [Evansville/Fort Wayne/Indianapolis/Lowell] 
and [Evansville/Fort Wayne/Indianapolis/Lowell] Laboratories.XV   
 
 
SAMPLES SENT TO AN OUTSOURCE LABORATORY 
 
Item(s) XA [were/was] sent to XYZ Laboratory, city, state for [additional] analysis as 
per the authority of John Smith, Police Department. 
 
 
WITHDRAWAL STATEMENTS 
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The request for DNA analysis was withdrawn by John Smith, Police Department, on 
Date.  The items will be returned to the submitting agency. 
 
The request for DNA analysis was withdrawn. The evidence is not eligible for entry into 
the Combined DNA Index System (CODIS). Submission of appropriate DNA standard(s) 
(such as an oral/buccal swab standard) is required before analysis can be completed. 
The evidence will be returned to the submitting agency. 
 
The request for DNA analysis was withdrawn in order to preserve the sampling area for 
Latent Print examination. The items will be returned to the submitting agency. 
 
The request for laboratory examination was withdrawn per information found in MyCase, 
Cause Number: CAUSE NO, DATE.  The items will be returned to the submitting agency.  
If analysis is needed, please re-submit the item(s) to the Forensic Services Division. 
 
 
EXAMPLES 
 
Example 1:  Homicide with Kit 
 
Item 001: Evidence Collection Kit – Jane Smith 
Items 001A through 001K were present or prepared from items in the kit.  
 
 
Item 001A: Blood standard 
A stain card was prepared. The DNA profile was developed. 
 
 
Item 001B: Vaginal wash 
The vaginal wash demonstrated an insufficient quantity of male DNA for autosomal STR 
analysis. 
 
 
Item 001C: Vaginal/cervical swabs (2) 
The possible presence of sperm cells was indicated by quantitation results on the 
combined swabs. 
 
Sperm fraction 
The DNA profile from the combined swabs was interpreted as a mixture of two 
individuals. Jane Smith was assumed as a contributor. 
 
John Doe was considered as a contributor: 
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► The DNA profile is at least 1 trillion times more likely if it originated from Jane Smith 
and John Doe than if it originated from Jane Smith and an unknown, unrelated 
individual.  
► This statistical analysis provides very strong support for the proposition that John Doe 
is included. 
  
Non-sperm fraction 
The DNA profile from the combined swabs was interpreted as a mixture of two 
individuals. Assuming Jane Smith and the corresponding sperm fraction as contributors, 
no additional alleles were detected. 
 
 
Item 001D: Neck swabs (2) 
The DNA profile from the combined swabs was interpreted as a mixture of two 
individuals, including at least one male. Jane Smith was assumed as a contributor. 
Unknown Male #1 cannot be excluded. 
 
 
Item 001E: External genital swab 
The swab demonstrated an insufficient quantity of male DNA for autosomal STR 
analysis. 
 
 
Item 001F: Anal swabs (6) 
Four combined swabs demonstrated an insufficient quantity of male DNA for autosomal 
STR analysis.  No DNA analysis was performed on two remaining swabs. 
 
 
Item 001G: Underwear 
DNA analysis was performed on one sample and one hair-like fiber. 
 
Item 001G1  
Sperm fraction 
The DNA profile from the sample was interpreted as originating from a single individual. 
 
John Doe was considered as a contributor: 
► The DNA profile is at least 1 trillion times more likely if it originated from John Doe 
than if it originated from an unknown, unrelated individual.  
► This statistical analysis provides very strong support for the proposition that John Doe 
is included. 
 
Non-sperm fraction 
The sample demonstrated an insufficient quantity of male DNA for further analysis. 
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Item 001G2 
The hair-like fiber demonstrated an insufficient quantity of male DNA for further 
analysis. 
 
The pubic hair combings, head hair combings, foreign material collection, and underwear 
(items 001H through 001K) were not examined. 
______________________________________________________________________ 
 
Item 002: DNA standard – John Doe 
The DNA profile was developed. 
______________________________________________________________________ 
 
Item 003: Knife 
Human blood was confirmed.³ DNA analysis was performed on two samples.  
 
 
Item 003A: Knife blade 
The DNA profile from the knife blade was interpreted as a mixture of two individuals. 
John Doe is excluded. Unknown Male #1 cannot be excluded. 
 
Jane Smith was considered as a contributor: 
► The DNA profile is 200 times more likely if it originated from Jane Smith and one 
unknown individual than if it originated from two unknown, unrelated individuals.  
► This statistical analysis provides moderate support for the proposition that Jane Smith 
is included. 
  
Item 003B: Knife handle 
The DNA profile from the knife handle was interpreted as originating from a single male. 
______________________________________________________________________ 
 
Item 004: Shirt 
Human blood was confirmed.³ Seminal material was indicated by presumptive testing.²  
DNA analysis was performed on four samples. 
 
Item 004A  
Sperm Fraction 
The DNA profile was interpreted as originating from a single male. 
 
Non-Sperm Fraction 
The DNA profile was interpreted as originating from a single individual.  Assuming John 
Doe as a contributor, no additional alleles were detected. 
 
Items 004B and 004C 
The DNA profiles were each interpreted as originating from a single individual. 
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Jane Smith was considered as a contributor: 
► Each DNA profile is at least 1 trillion times more likely if it originated from Jane Smith 
than if it originated from an unknown, unrelated individual. 
► Each statistical analysis provides very strong support for the proposition that Jane 
Smith is included. 
 
Item 004D 
The sample demonstrated an insufficient quantity of DNA for further analysis. 
______________________________________________________________________ 
 
DNA profiles from items 001D and 004A were entered into the Combined DNA Index 
System (CODIS) and will be searched on a routine basis. In the event of a database 
match, additional information will be provided separately. 
 
 
 
Example 2: Crime against person – single item multiple components 
Use the kit format for a collection of different objects within one evidence item.  
 
Item 005: Bag of trash 
Items 005A-005D were present in the bag of trash. 
 
 
Item 005A: Condom wrapper 
The DNA profile was interpreted as originating from a single female individual. Bob 
Roberts is excluded. 
 
Jane Smith was considered as a contributor: 
► The DNA profile is 17 times more likely if it originated from Jane Smith than if it 
originated from an unknown, unrelated individual. 
► This statistical analysis provides limited support for the proposition that Jane Smith is 
included. 
 
 
Item 005B: Piece of gum 
Seminal material was indicated by presumptive testing.² 
 
Sperm Fraction 
The DNA profile was interpreted as originating from a single male individual. 
 
Bob Roberts was considered as a contributor: 
► The DNA profile is 17 times more likely if it originated from Bob Roberts than if it 
originated from an unknown, unrelated individual. 
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► This statistical analysis provides limited support for the proposition that Bob Roberts 
is included. 
 
Non-Sperm Fraction 
The DNA profile was interpreted as originating from a single female individual. 
 
Jane Smith was considered as a contributor: 
► The DNA profile is at least one trillion times more likely if it originated from Jane 
Smith than if it originated from an unknown, unrelated individual. 
► This statistical analysis provides very strong support for the proposition that Jane 
Smith is included. 
______________________________________________________________________ 
 
The banana peel and apple core (items 005C and 005D) were not examined. 
 
 
 
Example 3: Crime against person – single item multiple components - clothing 
Use the kit format for a collection of different objects within one evidence item. 
 
Item 001: Bag of clothing 
A shirt (item 001A), jeans (item 001B) and a pair of socks (item 001C) and a pair of 
shoes (item 001D) were present. 
 
Item 001A: Shirt 
Human blood was confirmed.³  DNA analysis was performed on two samples. 
 
Item 001A1 
The DNA profile from sample was interpreted as originating from a single individual 
(Unknown Male #1). 
 
Item 001A2 
The DNA profile was interpreted as originating from a single individual.  Assuming Jane 
Doe as a contributor, no additional alleles were detected. 
 
 
Item 001B: Jeans 
Seminal material was indicated by presumptive testing.² 
 
Sperm Fraction 
The DNA profile was interpreted as originating from a single individual (Unknown Male 
#2). 
 
Non-Sperm Fraction 
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The DNA profile was interpreted as originating from a single individual.  Assuming Jane 
Doe as a contributor, no additional alleles were detected. 
 
 
Item 001C: Socks 
Blood was indicated by presumptive testing on each sock.¹ DNA analysis was performed 
on three samples. 
 
Item 001C1 
Item 001C1a 
The DNA profile from sample was interpreted as originating from a single individual 
(Unknown Male #1). 
 
Item 001C1b 
The sample demonstrated an insufficient quantity of DNA for further analysis. 
 
Item 001C2 
The DNA profile was interpreted as originating from a single individual.  Assuming Jane 
Doe as a contributor, no additional alleles were detected. 
 
 
Item 001D: Shoes 
The DNA profile was interpreted as originating from a single individual.  Assuming Jane 
Doe as a contributor, no additional alleles were detected. 
______________________________________________________________________ 
 
Item 002: DNA standard – Jane Doe 
The DNA profile was developed. 
______________________________________________________________________ 
 
DNA profiles from items 001A1 and the sperm fraction of 001B were entered into the 
Combined DNA Index System (CODIS) and will be searched on a routine basis. In the 
event of a database match, additional information will be provided separately. 
 
 
 
Example 4:  Property crime with serological testing 
Submitted swabs that are considered distinctly separate (due to case circumstances, 
sample purpose, serology results, etc.) get separate (subitem) designations. Item 001 in 
the following example contains swabs that are distinct because of serological results and 
may have different DNA treatment. Item 002 contains swabs that have no reason to be 
considered separately. 
 
Item 001: Swabs of window (2) 
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Item 001A 
Blood was indicated by presumptive testing.¹ Confirmatory testing was negative.³ 
  
The DNA profile was interpreted as originating from a single female individual. 
  
Item 001B 
No blood was detected on the remaining swab.¹ No DNA analysis was performed. 
______________________________________________________________________ 
 
Item 002: Swabs of floor (2) 
Blood was indicated by presumptive testing on the two swabs.¹ Human blood was 
confirmed on one swab.³ No confirmatory testing was performed on the remaining swab. 
 
The DNA profile from the combined swabs was interpreted as originating from a single 
individual (unknown male #1). 
______________________________________________________________________ 
 
Item 003: Buccal swab standard – Robert Jones 
The DNA profile was developed. 
 
 
 
Example 5:  Property crime – no serological testing 
 
Item 001: Crowbar 
A sample of the crowbar demonstrated an insufficient quantity of DNA for further 
analysis. 
______________________________________________________________________ 
 
Item 002: Swabs of dresser drawer (2) 
The DNA profile from the combined swabs was interpreted as originating from a single 
individual. Assuming Sally Smith as a contributor, no additional alleles were detected. 
______________________________________________________________________ 
 
Item 003: DNA standard – Sally Smith 
The DNA profile was developed.  
 
 
Example 6: Crime against person – many areas on one item 
 
Item 001: Victim’s Blanket 
Human blood was confirmed.³  DNA analysis was performed on six samples.  
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Items 001A and 001B 
Each sample demonstrated an insufficient quantity of DNA for further analysis. 
 
Items 001C and 001D 
Each DNA profile was interpreted as originating from a single individual.  Assuming Mary 
Doe as a contributor, no additional alleles were detected. 
 
Items 001E and 001F 
The DNA profiles were each interpreted as mixtures of two individuals, including at least 
one male. Mary Doe and Bob Doe are excluded. 
 
John Doe was considered as a contributor: 
► Each DNA profile is at least 1 trillion times more likely if it originated from John Doe 
and an unknown individual than if it originated from two unknown, unrelated individuals. 
► Each statistical analysis provides very strong support for the proposition that John 
Doe is included. 
 
______________________________________________________________________ 
 
Item 002: Shirt 
Human blood was confirmed.³   
 
The DNA profile was interpreted as a mixture of two individuals, including at least one 
male. The probability of the evidence has been calculated by considering multiple 
propositions. Bob Doe is excluded. 
 
Mary Doe was considered as a contributor: 
► The DNA profile is 40,000 times more likely if it originated from Mary Doe and one 
unknown individual than if it originated from two unknown, unrelated individuals.  
► This statistical analysis provides strong support for the proposition that Mary Doe is 
included. 
  
John Doe was considered as a contributor: 
► The DNA profile is 8,500 times more likely if it originated from John Doe and one 
unknown individual than if it originated from two unknown, unrelated individuals.  
► This statistical analysis provides moderate support for the proposition that John Doe is 
included. 
 
Note:  
Given the interpretation that the mixture originated from two individuals, there is 
support for the propositions that the DNA profile originated from Mary Doe or John Doe 
individually. However, there is no scientific support for the proposition that the DNA 
profile originated from Mary Doe and John Doe together. Refer to the independent 
inclusionary statistics reported above. 
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Example 7: Possession of firearm (swabs submitted) 
 
Item 001: Swabs of Firearm (3) 
 
Items 001A1 and 001A3 
The DNA profiles from the swabs were each interpreted as originating from a single 
individual (Unknown Male #1). 
 
Item 001A2 
The swab demonstrated an insufficient quantity of DNA for further analysis. 
 

Example 8: Possession of firearm (firearm submitted) 
 
Item 001: Firearm 
DNA analysis was performed on three samples. 
 
Items 001A1 and 001A3 
The DNA profiles from two samples were each interpreted as originating from a single 
individual (Unknown Male #1). 
 
Item 001A2 
The swab demonstrated an insufficient quantity of DNA for further analysis. 
 
 
Example 9: Simple items (swabs distinguished by description, headers not 
required) 
 
Item 001: Swabs from Chevy (2) 
The swabs each demonstrated an insufficient quantity of DNA for further analysis. 
______________________________________________________________________ 
 
 
Item 002: Swabs from Ford (2) 
The DNA profile from the steering wheel swab was interpreted as originating from a 
single individual (Unknown Male #1). 
 
The swab of the gear shift demonstrated an insufficient quantity of DNA for further 
analysis. 
______________________________________________________________________ 
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Example 10: Additional reports without subitems in which the original parent item 
is related in LIMS (new comparisons, Y-STR, paternity testing, etc) 
 
Item 001: Evidence Collection Kit – Jane Smith 
 
Item 001A: DNA standard – Jane Smith 
The DNA profile was previously developed. 
______________________________________________________________________ 
 
 
 
 
Example 11: Serology only. If serology is required on any item in the initial 
request, all items must be addressed in the report. In this example, a firearm was 
swabbed, a shirt was tested for blood and sampled for wearer, and swabs were 
combined and consumed for DNA with no serology. 
 
 
Item 001: Firearm 
Automated DNA processing was performed on four samples. 
 
______________________________________________________________________ 
 
Item 002: Shirt 
Human blood was confirmed.³  Automated DNA processing was performed on two 
samples. 
 
______________________________________________________________________ 
 
Item 003: DNA standard – Jane Doe 
Automated DNA processing was performed. 
 
____________________________________________________________________ 
 
Item 004: Steering wheel swabs (2) 
Automated DNA processing was performed on the combined swabs. 
 
______________________________________________________________________ 
 
When completed, results from the DNA analysis will be provided separately. 
 
______________________________________________________________________ 
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The Appendix below will be added to all Biology and Y-STR Requests in Justice Trax after the 
analyst’s signature, formatted as a stand-alone page.  
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Biology Report Appendix 
The following includes supplemental information on biological analysis performed at the Indiana State Police Forensic Services 
Division (FSD) and definitions of some commonly used terms.  Not all terms referenced in the appendix may apply to the testing in 
the associated case report.  Please contact the reporting analyst with specific questions regarding the DNA analysis in this case. 
 

Serological testing:  Citations in the report refer to the test(s) listed below. 
Presumptive testing indicates the possible presence of the substance in question. 

1. Blood: Kastle-Meyer/phenolphthalein chemical test 
2. Seminal material: Acid Phosphatase chemical test 

Confirmatory testing identifies the substance in question. 
3. Human blood: HemDirect™ immunological test + Kastle-Meyer/phenolphthalein test 
4. Seminal material: microscopic sperm search + Acid Phosphatase test 

Other examinations: 
5. A macroscopic and microscopic examination of a potential hair is performed to determine if it is consistent with 

human hair and if root material may be present. 
6. Trace evidence may include but is not limited to paint, glass, hair, and fibers. 

 
I. This report and evaluation only provide information that helps address who may be the source of the DNA - not how or when the 

DNA was deposited. This report cannot contribute any information regarding the mechanisms, timings, or actions that led to the 
deposition of the recovered biological material. 
 

II. Biological (DNA-based) sex information reported here is based solely on the detection of X and Y chromosome markers. 
Reference to male and female in the report should not be misinterpreted to mean that an individual must appear as male or 
female based upon this indication alone. 

III. The terms “sperm fraction” and “non-sperm fraction” refer to the two portions of the extract generated during a differential 
extraction procedure. The presence of DNA in the “sperm fraction” does not confirm the presence of seminal material and may 
or may not indicate the type of cells from which the DNA originated. 

 
IV. Following differential extraction and quantitation, calculations are applied to quantitation values to evaluate if spermatozoa may 

be indicated by an increased presence of male DNA in the sperm fraction.  These calculations are a presumptive test and are 
dependent on the differential technique and sensitivity of the quantitation system.  Additionally, false negatives can occur when 
multiple males or male body fluids other than seminal material are present.   Confirmation of spermatozoa can only be done 
with visual observation of sperm cells.   
 

V. Insufficient DNA:  Following extraction and quantitation, DNA profiles are not developed from samples which do not yield 
enough DNA based on the FSD’s established threshold.  
 

VI. Insufficient Male DNA:  In cases where male DNA is of interest, autosomal DNA profiles are not developed from samples 
which did not yield enough male DNA based on the  FSD’s established threshold. These samples may still be eligible for Y-STR 
analysis. Male DNA quantitation at low levels can be unreliable and does not confirm the presence of male DNA. 

 
VII. An unknown individual may be given a designation (e.g., “Unknown Male #1”) to distinguish between multiple unknown 

profiles within a case or to indicate multiple samples consistent with the same unknown profile. 
 

VIII. A mixture is a sample that contains DNA from more than one person. Samples in which the number of contributors cannot be 
determined, mixtures of more than four contributors, and portions of mixtures with an increased risk of false inclusions or 
exclusions are not suitable for comparison by the FSD’s current methods. 
  

IX. An individual is assumed to be a contributor when their contribution to a DNA sample is reasonably expected based upon the 
context of the sample and the presence of their DNA is not in question. This may include samples recovered from the individual’s 
own body or from an item they regularly use. Using the DNA profile of the assumed individual allows for a more accurate 
interpretation and representative statistic for the portion of the profile that is in question. 
 

X. Statistics are presented in the form of a likelihood ratio (LR), which is a comparison between two competing hypotheses to 
explain the evidence profile. If all parties agree that the DNA profile originated from the same individual(s), the LR would equal 
1. An LR of 0 is an exclusion. Calculations are performed using a combined dataset of Caucasian, African American, Hispanic, 
and Asian populations. The maximum reported LR is 1 trillion. The LR is based upon the case information provided. If additional 
information should be considered, please contact the reporting analyst.  
 

XI. In some DNA mixtures, false inclusions of other closely related family members (such as parents, offspring, and siblings) can 
occur due to the elevated sharing of genetic information between relatives. When first order relatives share many alleles with a 
person of interest, an adventitious likelihood ratio can give strong support for inclusion. The rate of adventitious support with 
related individuals increases with increasing mixture complexity.  If a case involves potential related individuals, the best course 
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of action is to submit known DNA standards for direct comparison and statistical evaluation. 
 

XII. The statistical calculations are reported with a verbal qualifying statement to express the strength of statistical support. 
These statements follow the verbal scale recommended by the Scientific Working Group on DNA Analysis Methods (7/12/18). 
The scale reflects stronger degrees of support as the likelihood ratio increases. Reported exclusion(s) may include statistical 
calculations to support the verbal qualifying statement. 
  

Likelihood Ratio Support Level Support for: 
LR ≥ 1,000,000 Very strong Inclusion 

10,000 ≤ LR < 1,000,000 Strong Inclusion 
100 ≤ LR < 10,000 Moderate Inclusion 

2 ≤ LR < 100 Limited Inclusion 
1 Uninformative Uninformative 

2 ≤ (1/LR) < 100 Limited Exclusion 
100 ≤ (1/LR) -- Exclusion 

 
XIII. Evidence disposition: Unless otherwise noted, all portions of the evidence not consumed during analysis will be returned to 

the submitting agency. Retained items will remain at the Indiana State Police Forensic Services Division. The remainder of the 
evidence or the original packaging will be returned. 
 

XIV. DNA chemistry: Unless otherwise noted, DNA profiles are developed using Polymerase Chain Reaction (PCR) with the 
PowerPlex® Fusion 6C System by Promega Corporation. Y-STR loci may be used for interpretations but are not included in 
statistical estimates. 

 
XV. Laboratory Locations 

a. Evansville: 19411 Highway 41 North, Evansville, IN 47725 
b. Fort Wayne: 5811 Ellison Road, Fort Wayne, IN 46804 
c. Indianapolis: 550 West 16th Street, Indianapolis, IN 46202 
d. Lowell:  1550 East 181st Street, Lowell, IN 46356  
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Relationship Testing Wording 
 

INCONCLUSIVE  
 
The DNA profile [from ITEMDESCRIPTION] has [limited data/is a mixture]. ¹/²/³  No 
further conclusions can be drawn due to insufficient quality of the data. 
 
DNA STANDARD RESULT STATEMENTS 
Citations shall refer to the Report Appendix to reflect the technology and amplification 
kit used to generate the profile. 

 
MIXTURE - PRODUCTS OF CONCEPTION 
 
The DNA profile was interpreted as a mixture of two individuals. Assuming BIOMOTHER 
as a contributor, a distinct male/female profile was determined to be used as the 
standard for the product of conception. ¹/²/³ 
 
 
MIXTURE - SECONDARY STANDARDS 
 
The DNA profile was interpreted as a mixture of two/three individuals. A distinct 
male/female profile was determined to be used as the secondary standard for PERSON. 
¹/²/³ 
 
 
TRASH PULL – PROFILE TO BE USED FOR STATISTICAL CALCULATIONS 
 
The DNA profile [from ITEMDESCRIPTION] was interpreted as [a mixture / originating 
from a single individual]. A [distinct] male/female profile was determined from the 
sample and was purported to belong to PERSON. ¹/²/³ 
 
 
MULTIPLE EVIDENTIARY OR STANDARD SAMPLES  
For varied mixture results 
 
DNA profiles were developed for # additional samples of ITEMDESCRIPTION; however, 
these profiles were not used for statistical purposes. ¹/²/³ 
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PARENTAGE RESULTS 
 
ALLEGED INDIVIDUAL CANNOT BE EXCLUDED 
 
STANDARD TRIO AND SINGLE PARENTAGE 
 
PERSON1 and CHILD were evaluated as biological father and child by considering the 
following propositions:  
 
► H1: [PERSON2 is the mother and] PERSON1 is the father of CHILD. 
► H2: [PERSON2 is the mother and] A[a]n unknown, unrelated man is the father of 
CHILD. 
 
►The genetic results are CPI times more likely if PERSON1 is the father of CHILD than if 
an unknown, unrelated man is the father of CHILD.  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON1 and CHILD are related as biological father and child. 
 
 
INCESTUOUS PARENTAGE 
 
PERSON1 and CHILD were evaluated as biological father and child by considering the 
following propositions:  
 
► H1: PERSON2 is the mother of CHILD; PERSON1 is the father of PERSON2 and CHILD. 
► H2: PERSON2 is the mother of CHILD; PERSON 1 is the father of PERSON2; and an 
unknown, unrelated man is the father of CHILD. 
 
►The genetic results are CPI times more likely if PERSON1 is the father of CHILD than if 
an unknown, unrelated man is the father of CHILD.  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON1 and CHILD are related as biological father and child. 
 
 
REVERSE PARENTAGE  
 
PERSON1 and PERSON2 were evaluated as the biological parents of CHILD by 
considering the following propositions:  
 
► H1: PERSON1 and PERSON2 are the parents of CHILD. 
► H2: Two unknown, unrelated individuals are the parents of CHILD. 
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►The genetic results are CPI times more likely if PERSON1 and PERSON2 are the 
parents of CHILD than if two unknown, unrelated individuals are the parents of CHILD.  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON1 and PERSON2 are the biological parents of CHILD. 
 
 
ALLEGED INDIVIDUAL CAN BE VISUALLY EXCLUDED  
 
Given the lack of genetic markers that must be contributed to the child by the biological 
father in the genetic results, PERSON can be excluded as the biological father of CHILD. 
 
OTHER RELATIONSHIPS 
 
SIBSHIP (LR SUPPORT FOR RELATIONSHIP) 
 
CHILD1 and CHILD2 were evaluated as full siblings by considering the following 
propositions:  
 
► H1: CHILD1 and CHILD2 are related as full siblings.  
► H2: CHILD1 and CHILD2 are unrelated. 
 
►The genetic results are CPI times more likely if CHILD1 and CHILD2 are related as full 
siblings than if CHILD1 and CHILD2 are unrelated.  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that CHILD1 and CHILD2 are related as full siblings. 
 
PEDIGREE OPTION 1  
 
PERSON1, PERSON2, and PERSON3 were evaluated for relatedness by considering the 
following propositions:  
 
► H1: PERSON1 is the X of PERSON2 and [and the Y of] PERSON3. 
► H2: PERSON1 is the X of PERSON2; PERSON3 is unrelated. 
 
►The genetic results are CPI times more likely if PERSON1, PERSON2, and PERSON3 are 
related as alleged (H1) than if PERSON3 is unrelated to PERSON1 and PERSON2 (H2).  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that includes the alleged relationship (H1). 
 
PEDIGREE OPTION 2 
 
PERSON1, PERSON2, and PERSON3 were evaluated for relatedness by considering the 
following propositions:  
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► H1: PERSON1 is the X of PERSON2 and [and the Y of] PERSON3. 
► H2: PERSON1 is the X of PERSON2; PERSON3 is unrelated. 
 
►The genetic results are CPI times more likely if PERSON1, PERSON2, and PERSON3 are 
related as X [and Y] than if PERSON3 is unrelated to PERSON1 and PERSON2.  
► This statistical analysis provides limited/moderate/strong/very strong support for the 
proposition that PERSON3 is a X [and Y] of PERSON1 and PERSON2. 
 
 
ADDITIONAL STATEMENT FOR LIMITED SUPPORT FOR H1  
 
The statistical results for RELATIONSHIP are in a range where adventitious support with 
unrelated individuals can occur.  These results should be considered in the context of 
other information known in the case when making determinations of the identity of the 
individual.  Additional genetic testing is recommended if further information is needed.  
Please contact the reporting analyst if desired.  
 
 
UNINFORMATIVE RESULTS  
 
CHILD1 and CHILD2 were evaluated as full siblings by considering the following 
propositions:  
 
► H1: CHILD1 and CHILD2 are related as full siblings.  
► H2: CHILD1 and CHILD2 are unrelated. 
 
►The genetic results are equally as likely if CHILD1 and CHILD2 are related as full 
siblings or if CHILD1 and CHILD2 are unrelated.  
► This result is considered uninformative.   
 
 
LR SUPPORT FOR LIMITED EXCLUSION  
 
CHILD1 and CHILD2 were evaluated as full siblings by considering the following 
propositions:  
 
► H1: CHILD1 and CHILD2 are related as full siblings.  
► H2: CHILD1 and CHILD2 are unrelated. 
 
► The genetic results are CPI times more likely if CHILD1 and CHILD2 are unrelated 
than if CHILD1 and CHILD2 are related as full siblings.  
► This statistical analysis provides limited support for the proposition that CHILD1 and 
CHILD2 are unrelated. 
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The statistical results for full siblings are in a range where the alleged relationship is not 
supported despite there being a potential biological relationship.  These results should 
be considered in the context of other information known in the case when making 
determinations of the identity of the individual. Additional genetic testing is 
recommended if further information is needed.  Please contact the reporting analyst if 
desired.  
 
 
ALLEGED INDIVIDUAL IS EXCLUDED BY CPI (1/CPI≥100) 
 
CHILD1 and CHILD2 were evaluated as full siblings by considering the following 
propositions:  
 
► H1: CHILD1 and CHILD2 are related as full siblings.  
► H2: CHILD1 and CHILD2 are unrelated. 
 
► The genetic results are CPI times more likely if CHILD1 and CHILD2 are unrelated 
than if CHILD1 and CHILD2 are related as full siblings.  
► This statistical analysis supports the proposition that CHILD1 and CHILD2 are 
unrelated individuals. 
 
 
ALLEGED INDIVIDUAL IS EXCLUDED BY FULL Y-STR ANALYSIS 
 
Given the inconsistencies between the Y-STR genetic markers, CHILD1 can be excluded 
as the biological full sibling of CHILD2.  
 
 
ALLEGED INDIVIDUAL IS INCLUDED BY FULL Y-STR ANALYSIS (NO 
INCONSISTENCIES)  
 
The Y-STR profile from PERSON 1 was compared to the Y-STR profile developed from 
PERSON 2. No mismatches were observed out of # evaluated Y-STR loci. Based on this 
comparison, it is likely that the donors of the Y-STR profiles are paternally related. These 
results are based only on the Y-STR data developed at the time of reporting and do not 
supersede any additional genetic testing that may be performed.  They should be 
evaluated in context with the autosomal kinship statistical results reported above. 
 
 
STATEMENTS LOCATED AT THE END OF THE REPORT 
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OBSERVED MUTATION or NULL ALLELE 
Incorporating a null allele into kinship calculations requires Technical Leader permission.   
 
A single genetic inconsistency between CHILD and ALLEGED FATHER was observed at 
LOCUS. This has been incorporated into the calculation as a [mutation/null allele]. 
 
OBSERVED MUTATION AT A Y-STR LOCUS WITH FULL Y-STR ANALYSIS 
 
A single genetic inconsistency between the decedent and JOHN DOE was observed at 
LOCUS. This has been incorporated into the calculation as a mutation.  The remaining 22 
Y-STR loci were not evaluated statistically; however, these Y-STR results support the 
proposition that John DOE and the decedent are paternally related.   
 
 
BODY IDENTIFICATION WITH CODIS ENTRY 
 
If a positive identification is made, notify the reporting analyst such that associated 
family reference standards may be removed from CODIS as required. 
 
 
 
 
The Appendix below will be added to all Paternity and Missing Person Requests in Justice Trax after 
the analyst’s signature, formatted as a stand-alone page.  
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Relationship Comparison Report Appendix 
The following includes supplemental information on relationship comparisons performed at the Indiana State Police Forensic Services 
Division (FSD) and definitions of some commonly used terms.  Not all terms referenced in the appendix may apply to the testing in 
the associated case report.  Please contact the reporting analyst with specific questions regarding the DNA analysis in this case. 
 

DNA Kit Chemistry and Technology:  Citations in the report refer to the test(s) listed below. 
1. PowerPlex® Fusion 6C: DNA profiles are developed using Polymerase Chain Reaction (PCR) and capillary 

electrophoresis with the PowerPlex® Fusion 6C System by Promega Corporation. Y-STR loci may be used for 
interpretations but are not included in statistical estimates. 

2. ForenSeq™ DNA Signature Prep, Primer Set B: DNA profiles are developed using Polymerase Chain Reaction (PCR) 
and Next-Generation Sequencing (NGS) with the ForenSeq™ DNA Signature Prep Kit, Primer Set B. Y-STR and 
identity informative SNP loci may be used for interpretations but may not be included in statistical estimates. X-
STR loci may be used for interpretations but are not included in statistical estimates. Phenotype informative SNP 
loci and ancestry informative SNP loci may be used for investigative purposes only. 

3. PowerPlex® Y23: Y-STR profiles were developed using Polymerase Chain Reaction (PCR) and capillary 
electrophoresis with the PowerPlex® Y23 System by Promega Corporation.  Y-STR loci may be used for 
interpretations but are not included in statistical estimates for relationship comparisons unless a mutation is 
suspected.  

 
I. Insufficient DNA:  Following extraction and quantitation, DNA profiles are not developed from samples which do not yield 

enough DNA based on the FSD’s established threshold.  
 

II. An unknown individual may be given a designation (e.g., “Unknown Male #1”) to distinguish between multiple unknown 
profiles within a case or to indicate multiple samples consistent with the same unknown profile. 
 

III. A mixture is a sample that contains DNA from more than one person. Mixtures with limited or low quality data and mixtures of 
more than four contributors are not interpretable by the FSD’s current methods. 
 

IV. An individual is assumed to be a contributor when their contribution to a DNA sample is reasonably expected based upon the 
context of the sample and the presence of their DNA is not in question. This may include samples recovered from the individual’s 
own body or from an item they regularly use. Using the DNA profile of the assumed individual allows for a more accurate 
interpretation and representative statistic for the portion of the profile that is in question. 
 

V. Statistics are presented in the form of a likelihood ratio (LR), which is a comparison between two competing hypotheses to 
explain the profiles. If all parties agree that the alleged relationship is true, the LR would equal 1. An LR of 0 indicates no 
support for the relationship. Calculations are only reflective of the relationship(s) tested.  If an alternate relationship should be 
considered, please contact the reporting analyst.   
 

VI. Calculations are performed utilizing the population data associated with the racial information provided for the alleged individual 
and is documented in the case record.  Population data from the Caucasian, African American, Hispanic, and Asian populations 
are available for calculation.  If an individual is multi-racial or if racial information is unknown the Combined population data is 
utilized.  If additional information should be considered for this case, please contact the reporting analyst. 
 

VII. Closely related family members (such as parents, offspring, and siblings) share genetic information. If a case involves a 
related individual as an additional person of interest, the best course of action is to submit known DNA standards for direct 
comparison and statistical evaluation. 
 

VIII. The statistical calculations are reported with a verbal qualifying statement to express the strength of statistical support. 
These statements follow the verbal scale recommended by the Scientific Working Group on DNA Analysis Methods (7/12/18). 
The scale reflects stronger degrees of support as the likelihood ratio increases.  
 

Likelihood Ratio Support Level Support for: 
LR ≥ 1,000,000 Very strong Alleged Relationship 

10,000 ≤ LR < 1,000,000 Strong Alleged Relationship 
100 ≤ LR < 10,000 Moderate Alleged Relationship 

2 ≤ LR < 100 Limited Alleged Relationship 
1 Uninformative Uninformative 

2 ≤ (1/LR) < 100 Limited Unrelated 
100 ≤ (1/LR) -- Unrelated 

 
IX. Evidence disposition: Unless otherwise noted, all portions of the evidence not consumed during analysis will be returned to 

the submitting agency. Retained items will remain at the Indiana State Police Forensic Services Division. The remainder of the 
evidence or the original packaging will be returned. 
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RELATIONSHIP TESTING EXAMPLES 
 
Example 1: Standard paternity trio 
 
Item 001: DNA standard - John Smith 
The DNA profile was developed.¹ 
_____________________________________________________________ 
 
Item 002: Product of conception 
The DNA profile was interpreted as a mixture of two individuals. Assuming Sally Smith 
as a contributor, a distinct male profile was determined to be used as the standard for 
the product of conception.¹ 
_____________________________________________________________ 
 
Item 003: DNA standard - Sally Smith 
The DNA profile was developed.¹ 
_____________________________________________________________ 
 
John Smith and the product of conception were evaluated as biological father and child 
by considering the following propositions:  
 
► H1: Sally Smith is the mother and John Smith is the father of the product of 
conception. 
► H2: Sally Smith is the mother and an unknown, unrelated man is the father of the 
product of conception. 
 
►The genetic results are 1,000,000 times more likely if John Smith is the father of the 
product of conception than if an unknown, unrelated man is the father of the product of 
conception.  
► This statistical analysis provides very strong support for the proposition that John 
Smith and the product of conception are related as biological father and child. 
 
 
Example 2: Direct comparison of remains to secondary standard  
 

Item 001: DNA standard - Decedent 
The DNA profile was interpreted as originating from a single individual.¹ 
 
► The DNA profile is at least 1 trillion times more likely if it originated from Ron Smith 
than if it originated from an unknown, unrelated individual. 
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► This statistical analysis provides very strong support for the proposition that Ron 
Smith is included.  
_____________________________________________________________ 
 
Item 002: Toothbrush (secondary standard) - Ron Smith 
The DNA profile was interpreted as a mixture of two individuals. A distinct male profile 
was determined to be used as the secondary standard for Ron Smith.¹ 
 
 
Example 3: Sibship with limited support for exclusion  
 
Item 001: DNA standard – John Smith 
The DNA profile was developed.¹ 
______________________________________________________________________ 
 
Item 002: DNA standard – Sally Smith 
The DNA profile was developed.¹ 
______________________________________________________________________ 
 
John Smith and Sally Smith were evaluated as full siblings by considering the following 
propositions:  
 
► H1: John Smith and Sally Smith are related as full siblings.  
► H2: John Smith and Sally Smith are unrelated. 
 
► The genetic results are 10 times more likely if John Smith and Sally Smith are 
unrelated than if John Smith and Sally Smith are related as full siblings.  
► This statistical analysis provides limited support for the proposition that John Smith 
and Sally Smith are unrelated. 
 
The statistical results for sibship are in a range where the alleged relationship is not 
supported despite there being a potential biological relationship.  These results should 
be considered in the context of other information known in the case when making 
determinations of the identity of the individual. Additional genetic testing is 
recommended if further information is needed.  Please contact the reporting analyst if 
desired.  
 
 
Example 4: Pedigree, same nuclear family 
 
Item 001: DNA standard – John Smith 
The DNA profile was developed.¹ 
______________________________________________________________________ 
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Item 002: DNA standard – Sally Smith 
The DNA profile was developed.¹ 
______________________________________________________________________ 
 
Item 003: DNA standard – Jane Smith 
The DNA profile was developed.¹ 
______________________________________________________________________ 
 
John Smith, Sally Smith, and Jane Smith were evaluated for relatedness by considering 
the following propositions:  
 
► H1: John Smith is the father of Sally Smith and Jane Smith; Sally Smith is the full 
sibling of Jane Smith. 
► H2: John Smith is the father of Sally Smith; Jane Smith is unrelated. 
 
►The genetic results are 1,000,000 times more likely if John Smith, Sally Smith, and 
Jane Smith are related as alleged (H1) than if Jane Smith is unrelated to John Smith and 
Sally Smith (H2).  
► This statistical analysis provides very strong support for the proposition that includes 
the alleged relationship (H1). 
 
 
Example 5: Pedigree, extended family 
 
Item 001: DNA standard – John Smith 
The DNA profile was developed.¹ 
______________________________________________________________________ 
 
Item 002: DNA standard – Sally Smith 
The DNA profile was developed.¹ 
______________________________________________________________________ 
 
Item 003: DNA standard – Jane Smith 
The DNA profile was developed.¹ 
______________________________________________________________________ 
 
John Smith, Sally Smith, and Jane Smith were evaluated for relatedness by considering 
the following propositions:  
 
► H1: John Smith is the grandfather of Sally Smith and Jane Smith; Sally Smith is the 
cousin of Jane Smith. 
► H2: John Smith is the grandfather of Sally Smith; Jane Smith is unrelated. 
 



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 224 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

►The genetic results are 99 times more likely if John Smith is the grandfather of Sally 
Smith and Jane Smith, and Sally Smith is the cousin of Jane Smith, than if Jane Smith is 
unrelated to John Smith and Sally Smith.  
► This statistical analysis provides limited support for the proposition that John Smith is 
the grandfather of Sally Smith, and Jane Smith and Sally Smith is the cousin of Jane 
Smith. 
 
The statistical results for the familial relationships are in a range where adventitious 
support with unrelated individuals can occur.  These results should be considered in the 
context of other information known in the case when making determinations of the 
identity of the individual.  Additional genetic testing is recommended if further 
information is needed.  Please contact the reporting analyst if desired.  
 
Example 6: Trash pull, single parentage  
 
Item 001: DNA standard – Sally Smith 
The DNA profile was developed.¹ 
______________________________________________________________________ 
 
Item 002: Water bottle 
The DNA profile [from the water bottle] was interpreted as originating from a single 
individual. A male profile was determined from the sample and was purported to belong 
to Ron Smith.¹ 
______________________________________________________________________ 
 
The contributor of the DNA profile from item 002A and Sally Smith were evaluated as 
biological father and child by considering the following propositions:  
 
► H1: The contributor of the DNA profile from item 002A is the father of Sally Smith. 
► H2: An unknown, unrelated man is the father of Sally Smith. 
 
►The genetic results are 1,000,000 times more likely if the contributor of the DNA 
profile from item 002A is the father of Sally Smith than if an unknown, unrelated man is 
the father of Sally Smith.  
► This statistical analysis provides very strong support for the proposition that the 
contributor of the DNA profile from item 002A and Sally Smith are related as biological 
father and child. 
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MEMO FOR Y-STR TESTING TO SUPPORT INVESTIGATIVE GENETIC GENEALOGY: 
 
Investigator Name 
Agency 
Address 
City, IN  Zip 
 
Date 
Agency Case Number:   
ISP Forensic Services Division Case Number:   
 
This notice is to inform you of potential investigative information.  Y-STR testing utilizing PowerPlex® Y23 
has been performed to aid in the genealogical investigation for the above referenced case.   
  
This information is for investigative purposes only.  No statistical analysis has been performed to give statistical 
weight to any potential familial relationships or the frequency of the Y-STR profile(s) in the population and is 
therefore not appropriate to support criminal prosecution.  It is recommended that standards of any persons of 
interest be submitted for direct comparison to the profile in question.   

The genetic results are based only on the data developed at the time of reporting and do not supersede any 
additional genetic testing that may be performed.  Male individuals in the same paternal line are expected to 
share the same Y-STR profile.  Differences in Y-STR profiles may indicate distantly related male individuals 
due to mutations or it may indicate a non-relationship.  As the differences accumulate, this indicates more 
distant relationships or provides more support for a non-relationship.  A variety of factors, including the number 
of Y-STR loci analyzed and mutation rate estimates, currently impede the ability to make specific conclusions 
on suspected familial relationships.  Additional kinship analysis may provide more information.  

DNA results for these items have been described in ISP issued Certificate of Analysis Request XXX.  The Y-
STR profile from sample description (item #) was compared to the Y-STR profile developed from John Doe 
(item #).  # mismatches were observed out of # evaluated Y-STR loci. Based on this comparison, it is likely that 
the donors of the Y-STR profiles are paternally related/probably paternally related/possibly paternally 
related/not related by a recent common paternal ancestor. These results should be utilized with caution. 
 

 
 
Analyst 
Biology Section 
Indiana State Police Forensic Services Division 

 
 
 
Year/Lab/Memo# 
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Y-STR Report Wording 
 

EXCLUSION 
 
PERSON is excluded. 
 
 
 
SINGLE SOURCE STATEMENTS 
 
UNKNOWN PROFILE 
Standard is excluded or no standard is present 
 
The Y-STR profile [from ITEMDESCRIPTION] was interpreted as originating from an 
unknown male or male lineage. 
 
 
CONSISTENT STATEMENT 
Profile obtained from sample; no differences from standard 
 
The Y-STR profile [from ITEMDESCRIPTION] was interpreted as originating from a single 
male or male lineage. 
 
► The [Y-STR] profile is LR times more likely if it originated from PERSON or any of his 
male paternal relatives than if it originated from an unknown, unrelated male individual. 
► This statistical analysis provides limited/moderate support for the proposition that 
PERSON is included. 
 
 
CONSISTENT STATEMENT + ADDITIONAL ALLELE 
Profile obtained from sample; no differences from standard with additional allele 
 
The Y-STR profile [from ITEMDESCRIPTION] was interpreted as originating from a single 
male or male lineage. However, one additional allele was detected from which no 
conclusion can be drawn. 
 
► The [Y-STR] profile is LR times more likely if it originated from PERSON or any of his 
male paternal relatives than if it originated from an unknown, unrelated male individual. 
► This statistical analysis provides limited/moderate support for the proposition that 
PERSON is included. 
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CONSISTENT WITH MALE VICTIM 
 
The Y-STR profile [from ITEMDESCRIPTION] was interpreted as originating from a single 
male or male lineage. Assuming PERSON as a contributor, no additional [Y-STR] alleles 
were detected. 
 
 
 
MIXTURE STATEMENTS  
 
INDISTINGUISHABLE MIXTURE 
 
The Y-STR profile is a mixture in which a major profile could not be determined. The 
results do not qualify for statistical calculations; therefore, no further conclusions can be 
drawn. 
 
 
MAJOR/MINOR COMPONENTS 
 
The Y-STR profile [from ITEMDESCRIPTION] demonstrated the presence of a mixture 
with a major profile assumed to be a single male or male lineage. No conclusion can be 
drawn regarding the additional [Y-STR] alleles. 
 
► The major [Y-STR] profile is LR times more likely if it originated from PERSON or any 
of his male paternal relatives than if it originated from an unknown, unrelated male 
individual. 
► This statistical analysis provides limited/moderate support for the proposition that 
PERSON is included.  
 
 
MAJOR/MINOR COMPONENTS, NO STANDARD: 
 
The Y-STR profile [from ITEMDESCRIPTION] demonstrated the presence of a mixture 
with a major profile assumed to be a single unknown male or male lineage. No 
conclusion can be drawn regarding the additional [Y-STR] alleles. 
 
 
MAJOR CONSISTENT WITH MALE VICTIM 
 
The Y-STR profile [from ITEMDESCRIPTION] demonstrated the presence of a mixture 
with a major profile assumed to be a single male or male lineage. Assuming PERSON as 
a contributor, no conclusion can be drawn regarding the additional [Y-STR] alleles. 
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INCONCLUSIVE/NOT EXAMINED 
 
LIMITED DATA 
 
The Y-STR profile has limited data; therefore, no further conclusions can be drawn. 
 
 
NO PROFILE 
 
ITEMDESCRIPTION failed to demonstrate a Y-STR profile. 
 
 
FAILED CONTROL 
 
No conclusion can be drawn regarding ITEMDESCRIPTION because the/a test control[s] 
did not meet required parameters. 
 
 
SAMPLE NOT EXAMINED 
 
No Y-STR analysis was performed on # additional samples at this time. 
 
 
SAMPLE NOT SUITABLE 
 
Upon evaluation, no samples were determined to be suitable for Y-STR analysis. 
 
 
 
STANDARDS 
 
STANDARD PROFILE DEVELOPED 
 
The [autosomal and] Y-STR profile [of PERSON] [was/were] developed. 
 
 
STANDARD NOT EXAMINED 
 
No Y-STR analysis was performed [on the DNA standard of PERSON] due to a lack of 
evidence for comparison. 
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CONTAMINATION FROM LABORATORY PERSONNEL  
Not all possible situations are given, consultation with the Technical Leader and/or 
Supervisor is recommended 
 
SINGLE SOURCE 
 
No Y-STR profile of apparent value was identified on ITEMDESCRIPTION. The Y-STR 
profile of an individual from the Indiana State Police Forensic Services Division Quality 
Assurance DNA Database was identified. 
 
 
MIXTURE 
 
The Y-STR profile obtained from ITEMDESCRIPTION demonstrated the presence of a 
mixture with a major profile. The major [Y-STR] profile is consistent with the Y-STR 
profile of an individual from the Indiana State Police Laboratory Forensic Services 
Quality Assurance DNA Database. No conclusion can be drawn regarding the additional 
[Y-STR] alleles. 
 
 
REQUIRED STATEMENTS (PLACED AFTER RESULTS): 
 
PROFILES GENERATED USING POWERPLEX® Y23 
 
In the DNA analysis detailed above, Y-STR profiles were developed using Polymerase 
Chain Reaction (PCR) with the PowerPlex® Y23 System by Promega Corporation. 
 
OR 
 
NO SAMPLES AMPLIFIED 
 
Extraction and quantification were performed in the Y-STR analysis of the sample(s) 
detailed above. 
 
 
REQUESTS FOR STANDARDS 
 
If [additional] Y-STR comparisons are desired, please submit an appropriate male DNA 
standard (such as an oral/buccal standard) from any suspects. 
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WORDING OF STATISTICAL ANALYSIS 
 
Statistical estimates were performed based on the recommended concepts endorsed by 
the Scientific Working Group on DNA Analysis Methods (3/2/22). Y-STR results for 
item[s] XA have been searched using the Y Chromosome Haplotype Reference Database 
(https://yhrd.org), Release R# on date.  Calculations for the Caucasian, African 
American, Hispanic, and Asian populations have been performed and a likelihood ratio 
has been reported for the combined populations.  
 
 
CODIS STATEMENT  
Placed at the end of any report detailing new profiles 
  
No Y-STR profiles were entered into the Combined DNA Index System (CODIS). 
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APPENDIX 8  
DEFINITIONS 

 
 

1. 99% 1-Sided Lower HPD – A confidence interval is applied to the point estimate to account for 
uncertainty.  The interval gives a range of where the true allele probabilities lie.  The lower end of the 
HPD is reported to be the most conservative to the person of interest for an inclusionary LR. 

2. Acid Phosphatase – a chemical component of semen; also found in other body fluids at significantly 
lower concentrations. 

3. Allele – the alternative form of a gene. 
4. Allele Frequency – the proportion of a particular allele found in a population. 
5. Allelic Ladder – a set of DNA fragments of the commonly known alleles for each locus.  By comparing 

the samples to the allelic ladder, the correct allele designation may be assigned. 
6.     
7. Amelogenin – the marker for determining the biological sex of the individual contributor to a DNA 

profile. 
8. Amplification – using the PCR process to create many copies of a specific DNA sequence(s). An 

increase in the number of copies of a specific DNA fragment. 
9. Analyst Discretion - the use of individual judgment, based on an analyst’s training and experience to 

determine the optimum modes of analysis for an item of evidence.   
10. Artifact – non-allelic product of the amplification process, an anomaly of the detection process, or a by-

product of primer synthesis.  A data peak that does not represent a true allele. 
11. Assumed reference – A standard from an individual whose DNA is reasonably expected based upon 

the context of the sample and the presence of their DNA is not in question. This may include samples 
recovered from the individual’s own body or from an item they regularly use. It may also include a 
consensual partner of an individual.   

12. Base Pairs – paired nucleotides which make up the DNA molecule. Two complementary nucleotides 
joined by a hydrogen bond.  

13. Blood – the fluid that circulates through the body, containing red and white blood cells carrying oxygen 
and nutrients to cells throughout the body; and carrying away waste and carbon dioxide. 

14. Burn-in – The initial 10,000 accepts during the MCMC process that allow the chains to converge on a 
“good space”.  These iterations are discarded. 

15. Capillary Electrophoresis – a method to separate DNA fragments based on size using electrical current. 
The DNA sample is placed in a thin tube (capillary) containing polymer and subjected to high voltage 
current allowing the DNA fragments to migrate through the tube. 

16. Chromosome – the structure on which genes are naturally arranged and how DNA is organized. 
17. Combined DNA Index System (CODIS) – refers to the DNA database and its software. It is composed 

of National (NDIS), State (SDIS), and Local (LDIS) components.  It contains DNA profiles from 
offenders, crime scenes and includes a missing person database. 

18. Conditioning – A likelihood ratio in which an individual is included in both 𝐻𝐻1 and 𝐻𝐻2. 
19. Contamination – When DNA is present in a sample that is not endogenous to the sample.   
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20. DBLRTM (Database Likelihood Ratios) – Software designed for the calculation of LRs, performing any 
conceivable kinship calculation, rapidly searching databases, evaluating the value of individual mixture 
components, and assessing samples for a common donor. 

21. Deconvolution – Process to determine the potential contributor genotypes to a mixed DNA profile. 
22. Degradation – the breaking down of the DNA molecule into smaller fragments. 
23. Denaturation – the separation of the double stranded DNA molecule into two single strands. 
24. Deoxyribonucleic Acid (DNA) - the genetic material present in the nucleus of most cells.  Also located in 

cell mitochondria. 
25. DNA Sequence - a specific order of base pairs. 
26. Electropherogram – the visual representation of the DNA fragments contained in each sample; 

generated by the analysis software of the Capillary Electrophoresis Instrument. 
27. Electrophoresis – the method to separate molecules based on their size by placing them in a medium 

and applying an electrical current.  The molecules will travel through the medium at different rates, the 
smaller molecules traveling through the medium more quickly than the larger ones. 

28. Enzyme – a protein which acts as a catalyst, speeding up a specific chemical reaction without being 
changed or consumed in the process. 

29. Epithelial Cells – skin cells and other surface cells such as from the mouth (buccal cells) or the vaginal 
cavity. 

30. Sub-Source LR – Likelihood ratio which compares the person of interest to the total mixture 
independent of contributor order. Formerly known as the Factor of N! LR.  

31. Gelman-Rubin – A value which informs the user whether the MCMC chains have converged. 
32. Gene – the basic functional unit of heredity. Most genes determine the structure and function of 

proteins. 
33. Genotype – the specific genetic sequence of a person’s DNA. 
34. Genotype Probability Distribution – A summary of the genotype combinations accepted at each locus 

and the percentage of accepts per genotype. 
35. 𝐻𝐻1/𝐻𝐻𝑝𝑝 – Interchangable terms for the most likely proposition that includes a person of interest. 
36. 𝐻𝐻2/𝐻𝐻𝑑𝑑 – Interchangable terms for the most likely proposition that excludes a person of interest. 
37. Hair – a slender outgrowth from the skin of mammals. 
38. Heme – the iron containing complex of the hemoglobin molecule. 
39. Hemin – the oxidized heme molecule. 
40. Hemoglobin - the iron containing protein in blood. 
41. Heterozygous – having different alleles at a particular locus. 
42. Homozygous – having two of the same allele at a particular locus. 
43. Internal Lane Standard (ILS) – a set of DNA fragments of known length(s). The ILS is simultaneously 

injected with all DNA samples during electrophoresis.  This allows accurate measurement of the length 
of each allele in a DNA sample.  

44. Iteration – A proposed genotype combination and mass parameters that are either accepted or rejected 
during the MCMC process. 

45. Likelihood Ratio – A ratio of the probability of the evidence given two different propositions (𝐻𝐻1and 𝐻𝐻2). 
46. Locus (loci) – the physical location of a gene on a chromosome. 
47. LUS – Longest uninterrupted stretch for an allele variation.   
48. Marker – a gene of known location and phenotype used as a point of reference. 
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49. Mass Parameters – Collection of parameters (degradation rate per contributor, amplification efficiencies 
per locus, replicate amplification strength, template per contributor, and kit efficiency), that are used to 
determine expected peak heights during deconvolution.  Collectively referred to as DARTB. 

50. Maximum Likelihood Estimate (MLE) LR – A likelihood ratio calculated when a variable number of 
contributors deconvolution was utilized.  The MLE assigns an LR using the most probable number of 
contributors under H1 and H2. This means the number of contributors in the numerator and denominator 
may be the same or they may be different.  The number of contributors will depend on which number of 
contributor analysis has the highest likelihood given the proposition for each.  

51. MCMC (Markov Chain Monte Carlo) – A mathematical method that uses a process of random re-
sampling to give the best explanation of observed data. 

52. Meaningful profile – a profile that is developed from an item or location where the individual’s profile 
would not reasonably be expected. A person’s profile may be expected on an item or sample from their 
own body, their own clothing, or their property such as their house or vehicle.  All other samples will 
generally be considered meaningful. 

53. Minimum allele frequency - a conservative frequency correction for alleles observed less than 5 times in 
the STR population frequency tables.   

54. Mitochondria - a part of a cell used in energy production.  Contains circular DNA inherited from the 
mother only. 

55. Nucleus - the part of a cell that contains the double stranded DNA inherited from both parents. 
 
 

56. Phenotype – the expressed genotype. 
57. Polymerase – an enzyme that initiates the duplication of a DNA molecule. 
58. Polymerase Chain Reaction (PCR) – a process for amplifying (copying) the DNA molecule. 
59. Polymorphism – the presence of more than one possible allele set for a specific gene. 
60. Population – a stable group of random individuals, chosen for genetic analysis. 
61. Primer – a short nucleotide fragment of known sequence used to locate its complementary sequence 

on the DNA molecule for the initiation of PCR. Primers target the specific loci to be amplified. 
62. Proficiency Testing – a test to evaluate the competency of an analyst in a specific procedure.  
63. Property crime – a category of crime that includes, among other crimes, burglary, theft, arson, drug 

offenses, vandalism, and criminal mischief.  Property crimes do not involve force or threat of force.   
64. Proposition – A proposed explanation of the data.  Interchangeable with “hypothesis”. 
65. Post Burn-in – The iterations after burn-in from which the deconvolution is determined. 
66. Replicate – A reamplification of the same extract.   
67. Saliva – digestive fluid from the mouth.  
68. Semen/Seminal Fluid – the male ejaculate.  In a dried state may be referred to as seminal material. 

Semen normally contains spermatozoa. 
69. Short Tandem Repeat (STR) – small sections of DNA that contain short segments (2, 3, 4 or more base 

pairs) which repeat several times. The number of repeat units may vary between individuals.  STRs are 
located between specific genes and are considered non-functional. 

70. Spermatozoa – the male reproductive cell, sperm cell. 
71. Stochastic effect – peak imbalance observed in a locus and/or allele drop-out due to random, 

disproportionate amplification of alleles in low quality/quantity template samples. 



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 234 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

72. STRmix™ - A fully continuous probabilistic genotyping software which combines biological modeling 
with mathematical processes to deconvolute DNA profiles and then compare them to reference 
standards and provide statistical weight in the form of a likelihood ratio. 

73. Stutter – an artifact that occurs as a by-product of the PCR process. It is observed as a minor peak 
typically observed one repeat unit smaller than a primary STR allele caused by strand slippage during 
amplification. Stutter has been observed and documented in other positions.  

74. Substrate – the material on which a biological sample is deposited such as at a crime scene. 
75. SWGDAM – Scientific Working Group on DNA Analysis Methods. 
76. Unified Likelihood Ratio – LR that takes into account that the unknown contributors are made up of both 

relatives and unrelated people. 
77. Validation – a study to assess whether a particular procedure (or instrument) can obtain a desired 

result reliably and reproducibly. The study includes looking at the conditions necessary to obtain those 
results and the limitations of the procedure/instrument. All DNA analysis methods shall be validated 
prior to implementation. 

78. Verbal Scale – A verbal representation of the relative strength of the likelihood ratio results. 
79. Work Product – the material that is generated as a function of analysis, which may include extracts and 

amplified product, in tubes or plates, and any aliquots thereof. 
80. X chromosome – a sex chromosome, present twice in female cells and once in male cells. 
81. Y chromosome – a sex chromosome, present once in male cells (and absent in female cells), paired 

with the X chromosome. 
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APPENDIX 9  
DNA SERVER INSTRUCTIONS 

 
The DNA data drive (“DNA Data”) will be used for storage and archiving of case data and photos.  Real Time 
PCR files, 3500 run folders, GeneMapperTM ID-X projects, genotypes table .txt files, STRmix™ files, DBLRTM 
files, photos, and NGS files shall be saved to DNA Data.  Any worksheets, statistic sheets, typed notes pages, 
or workbooks shall NOT be saved to DNA Data.  The completed case record in LIMS will be the official, 
tracked copy.  We want to avoid duplication of items between LIMS and the server.  
 
In DNA Data, each analyst will have a folder to organize and store their data files.  Other analysts will have 
access to the items in the folder for purposes of review (read-only), but they shall not change, delete, or add 
items within the folder.   
 
Within the analyst’s folder there will be one folder for each year of the analyst’s casework. The analyst will 
create one folder for each case number and request, which will contain all associated electronic data for that 
request. If no electronic data is generated for a request, the analyst does not need to create a case folder.  It is 
recommended to organize each case folder within the year folder that matches the case number, not the year 
the case was completed. 
 
Batched data: 
Any projects, quant data, or run folders that contain multiple cases shall be saved individually within each of 
the associated case folders. Batch data generated by the Automation team is an exception.  Automation batch 
data shall be stored only in the zAutomation folder and not duplicated per individual case.  
 
The following nomenclature should be used: 

• Laboratory case and request folder – “case number_request number” – ex. “10I1234_1” – the request 
number corresponds to the laboratory request number assigned in LIMS. 

o RT-PCR projects: “1st case on the plate_date_plate#” – ex. “10I1234_01Jan11_01” 
o 3500 run folder: “1st case on the plate_date_plateinjection#” – ex. “10I1234_01Jan11_01” – 

plate injection number indicates how many times that plate preparation has been put in the 
instrument for injection; if the same plate preparation is run on a different date, the original date 
should still be used from when the plate was prepared.  If a second preparation of a plate is 
made on the same date as the first, it shall be designated with a “-2” after the date.  Ex. 
“10I1234_01Jan11-2_01” 

o GeneMapperTM ID-X project name: must contain the date the 3500 plate was prepared, so the 
project matches the run folder.  If there were multiple injections of the plate or multiple 
preparations of the plate on the same date, a number shall be added to clarify which run folder 
the data was pulled from. - ex. “01Jan11”, “10I1234_01Jan11”, “Controls_01Jan11” or 
“10I1234_01Jan11 (02)”.  The exported genotypes table .txt file will maintain the same name as 
the project with the automatic extension “Genotypes Table” added during export.    

o STRmix™ results folders: The deconvolution results folder should include “case number_item 
number_Decon number”.  The LR from previous results folder should include “case 
number_item number_Decon number-LRPrev number”.   If additional characters are added to 
the name of the either the deconvolution results folder or the LR from previous results folder, 
those characters shall be added after the specified naming convention. 
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o DBLR™ Kinship analysis name: At a minimum, the name shall include the case number, 
followed by an underscore and the DBLR run number, increasing sequentially (e.g., 
23L1234_DBLR1, 23L1234_DBLR2).  If additional characters are added to the “Analysis Name” 
designation, those characters shall be added after the specified naming convention. 

o Photos: create a folder per item photographed – folder name “case_item#” ex. “10I1234_item1”.  
The individual photo file names shall, at a minimum, have the laboratory case number and the 
Forensic Scientist’s or Forensic Technician’s initials, name, or permanent employee (PE) 
number. 
 

 
Note: RT-PCR and 3500 Plates generated by the automation team may substitute Batch ID # for Lab 
Case #.  RT-PCR plate names generated by the automation team shall also include the automation 
analyst initials and PE number.    
 
Note: For RT-PCR projects and 3500 run folders – only the first case on the plate should be included in 
the name.  Do not write more than one case number and do not write “et al.” after the name. 
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APPENDIX 10 
RELATIONSHIP COMPARISON STATISTICAL 

REFERENCE SHEET 
Formulas for Paternity Index (PI) and Random Man Not Excluded (RMNE) (Table below adapted from the 
AABB, Standards for Relationship Testing Laboratories, 9th Edition, Appendix 7 and 8) 

 
Mother Child Alleged 

Father 
PI RMNE PE 

BD AB AC 1/2a 1-(1-a)2 (1-a)2 
BC AB AC 1/2a 1-(1-a)2 (1-a)2 
BC AB AB 1/2a 1-(1-a)2 (1-a)2 
BC AB A 1/a 1-(1-a)2 (1-a)2 
B AB AC 1/2a 1-(1-a)2 (1-a)2 
B AB AB 1/2a 1-(1-a)2 (1-a)2 
B AB A 1/a 1-(1-a)2 (1-a)2 

AB AB AC 1/[2(a+b)] 1-(1-a-b)2 (1-a-b)2 
AB AB AB 1/(a+b) 1-(1-a-b)2 (1-a-b)2 
AB AB A 1/(a+b) 1-(1-a-b)2 (1-a-b)2 
AB A AC 1/2a 1-(1-a)2 (1-a)2 
AB A AB 1/2a 1-(1-a)2 (1-a)2 
AB A A 1/a 1-(1-a)2 (1-a)2 
A A AB 1/2a 1-(1-a)2 (1-a)2 
A A A 1/a 1-(1-a)2 (1-a)2 
 AB AC 1/4a 1-(1-a-b)2 (1-a-b)2 
 AB AB (a+b)/4ab 1-(1-a-b)2 (1-a-b)2 
 AB A 1/2a 1-(1-a-b)2 (1-a-b)2 
 A AC 1/2a 1-(1-a)2 (1-a)2 
 A A 1/a 1-(1-a)2 (1-a)2 

 
 
Paternity Index for Null allele in standard trio comparisons = 

Known parent = AB, Child = AA or AS, Alleged parent = CC or CS 
a = known parent shared allele frequency 
c = alleged parent unshared allele frequency  
s = silent allele frequency = 0.001 

 
Adapted from ISFG 2022 Kinship Analysis Workshop and California Criminalistics Institute Kinship 
Analysis Course 
 
Combined Paternity Index (CPI) = PI1 x PI2 x PI3… 
 
 
Probability of Paternity (W) = [CPI x Pr]/[CPI x Pr + (1-PR)] 

  Pr = Prior Probability 
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Formulas for Reverse Paternity 
(Table below adapted from the AABB, Guidelines for Mass Fatality DNA Identification Operations, 2010, 
Appendix B) 
 

Mother Possible Child Father Formula 

A A AB 1/2a2 
A AB AB 1/4ab 
A AB BC 1/4ab 

AB A AB 1/4a2 
AB A AC 1/4a2 
BC AB AB 1/8ab 
BC AB AC 1/8ab 
BD AB AC 1/8ab 
A A A 1/a2 

AB A A 1/2a2 
B AB A 1/2ab 

BC AB A 1/4ab 
AB AB AC 1/8ab 
AB AB A 1/4ab 
AB AB AB 1/4ab 

 
Formulas for Sibship 
(Table below adapted from the AABB, Guidelines for Mass Fatality DNA Identification Operations, 2010, 
Appendix B) 

 
Sibling Possible Full 

Sibling 
Formula 

AB AB (1+a+b+2ab)/8ab 
A A (1+a)2/(2a)2 
A AB (1+a)/4a 

AB AC (1+2a)/8a 
AB CD ¼ 

   
Half Sibling Possible Half 

Sibling 
Formula 

AB AB (a+b+4ab)/8ab 
A A (1+a)/2a 
A AB (1+2a)/4a 

AB AC (1+4a)/8a 
AB CD ½ 
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Mutation Rates 
Mutation rates for all autosomal loci present in the PowerPlex® Fusion 6C kit and D17S1301 and D6S1043 
present in the ForenSeqTM DNA Signature Prep Kit Primer Set B were reported in AABB, Relationship 
Testing Technical Report For Testing in 2023: As compared to the reported data from 2021 and 2022. 

 
D20S482, D4S2408, and D9S1122 utilize the average paternal and maternal mutation rates from the 
tetranucleotide markers. 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The average mutation rate used for iiSNP loci is set to 1 x 10-8, the default parameter set in DBLR™ and 
supported by Nachman, M.W., Crowell, S. (2000) Estimate of the Mutation Rate per Nucleotide in Humans. 
Genetics. 156: 297-304.  
 
The mutation factor for a single discordant Y-STR locus contained in the kit shall be incorporated as a 
haplotype Relationship Index and incorporated manually into the CRI by multiplying by 0.001 for all Y-STR 
loci except DYS570, DYS576, DYS612, and DYF387S1. This mutation rate value is supported by 
Ballantyne, K.N., et. al., (2012) A New Future of Forensic Y-chromosome Analysis: Rapidly Mutating Y-
STRs for Differentiating Male Relatives and Paternal Lineages. Forensic Science International: Genetics. 6: 
208-218.  DYS570, DYS576, DYS612, and DYF387S1 are identified as rapidly mutating Y-STR loci. The 
mutation factor for a single discordant Y-STR locus defined as rapidly mutating will be incorporated as a 
haplotype Relationship Index and incorporated manually into the CRI by multiplying by 0.01.  This rapidly 
mutation Y-STR definition and mutation rate value is supported by Boattini, A., et. al., (2016) Mutation 

LOCUS PATERNAL MATERNAL 
CSF1PO 0.000847 0.000086 

D10S1248 0.00045 0.000116 
D12S391 0.004373 0.000564 
D13S317 0.000782 0.000152 
D16S539 0.000556 0.000137 
D18S51 0.001199 0.000251 

D19S433 0.000411 0.00021 
D1S1656 0.000628 0.000108 
D21S11 0.00073 0.000486 

D22S1045 0.000117 0.00004 
D2S1338 0.000788 0.000081 
D2S441 0.00025 0.000082 

D3S1358 0.000736 0.000072 
D5S818 0.000588 0.0001 
D7S820 0.000562 0.000088 

D8S1179 0.000909 0.000121 
FGA 0.001761 0.00024 

Penta D 0.001357 0.000407 
Penta E 0.0034 0.000476 
SE33 0.002501 0.000577 
TH01 0.000057 0.000022 
TPOX 0.000107 0.000038 
vWA 0.001363 0.000158 

D17S1301 0.000196 0.000588 
D20S482 0.000969 0.000209 
D4S2408 0.000969 0.000209 
D6S1043 0.001519 0.000322 
D9S1122 0.000969 0.000209 
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Rates and Discriminating Power for 13 Rapidly-Mutating Y-STRs between Related and Unrelated 
Individuals.  PLoS ONE.    
 
 
NIST 1036 Revised U.S. Population Dataset (July 2017) 
Hill, C.R., Duewer, D.L., Kline, M.C., Coble, M.D., Butler, J.M. (2013) U.S. population data for 29 
autosomal STR loci. Forensic Sci. Int. Genet. 7: e82-e83. 
 
Steffen, C.R., Coble, M.D., Gettings, K.B., Valone, P.M. (2017) Corringendum to ‘U.S. Population Data for 
29 Autosomal STR Loci’. Forensic Sci. Int. Genet.  31: e36-e40.  
 
NIST 1036 Expanded U.S. Population Dataset 
Gettings, K.B., Borsuk, L.A., Steffen, C.R., Kiesler, K.M., Vallone, P.M. (2018).  Sequence-based U.S. 
population data for 27 autosomal STR loci.  Forensic Sci. Int. Genet. 37: 106-115. 
 
SNP Allele Frequencies 
Churchill, J.D., Novroski, N.M.M., King, J.L., Seah L.H., & Budowle, B.  (2017).  Population and 
performance analyses of four major populations with Illumina’s FGx Forensic Genomics System.  Forensic 
Sci. Int. Genet. 30: 81-92.   
 
Linkage Map for use in DBLR™ 
Matise, T.C. et al. (2007). A second-generation combined linkage physical map of the human 
genome. Genome Res. 17:1783-6.  
 
Nato, A.Q., Buyske, S., and Matise, T.C. The Rutgers map: A third-generation combined linkage-physical 
map of the human genome. Human Genetics Institute of New Jersey Second Research Day. Life Sciences 
Building, Rutgers University, Piscataway, NJ, USA. (Manuscript in Process) 
 
Phillips, C., Ballard, D., Gill, P., Syndercombe Court, D., Carracedo, Á. & Lareu, M.V.  (2012).  The 
recombination landscape around forensic STRs: Accurate measurement of genetic distances between 
syntenic STR pairs using HapMap high density SNP data.  Forensic Sci. Int. Genet. 6.  354–365. 
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APPENDIX 11 
Applied Biosystems® 3500 Genetic Analyzer - Data Collection Software version 

2.0 - Instrument 
(only necessary the first time PowerPlex® Y23 samples are run or if the parameters 

change) 
See Appendix 3 for security, user roles, and user account settings. 
1.0 Create an Instrument Protocol  

1.1 Navigate to the Library and select “Instrument Protocols”. 
1.2 Select “Create”. 
1.3 Select “HID” for the Application Type. 
1.4 Select “36” for the Capillary Length. 
1.5 Select “POP4” for the Polymer. 
1.6 Select the appropriate Dye Set: “Promega G5 WEN”. 
1.7 Select “HID36_POP4” for the Run Module. 
1.8 Enter the desired Injection Time and Injection Voltage. 
1.9 Name the protocol with the kit name and the injection voltage and time (e.g., 

“PPY23_1.2kV15s”). 
1.10 Ensure settings match the figure below.  
1.11 Mark “Locked” and click “Save”. 

Instrument Protocol: 
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2.0 Create a Size Standard 
2.1 Navigate to the Library and select “Size Standard”. 
2.2 Select “Create”.  
2.3 Assign the appropriate name: “WEN ILS 500 Y23”. 
2.4 Select “Orange” for the Dye Color. 
2.5 Type the following into the left column: 60, 65, 80, 100, 120, 140, 160, 180, 

200, 225, 250, 275, 300, 325, 350, 375, 400, 425, 450, 475, and 500.  Click 
“Add Size(s)”. 

2.6 Mark “Locked” and click “Save”. 
Size Standard: 
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3.0 Create a QC Protocol  
3.1 Navigate to the Library and select “QC Protocols”. 
3.2 Select “Create”. 
3.3 Assign the appropriate name: “WEN_ILS_500_Y23”. 
3.4 Change settings to match the figure below. 
3.5 Mark “Locked” and click “Save”. 

QC Protocol: 
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4.0 Create an Assay 
4.1 Navigate to the Library and Select “Assays”. 
4.2 Select “Create”. 
4.3 Assign a descriptive assay name (e.g., “PPY23_1.2kV15s”). 
4.4 Select “HID” for the Application Type. 
4.5 Select the appropriate QC Protocol: “WEN_ILS_500_Y23”. 
4.6 Select the appropriate instrument protocol. 
4.7 Mark “Locked” and click “Save”. 

Assay: 
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5.0 Create a Naming Convention 
5.1 Navigate to the Library and Select “File Name Convention”. 
5.2 Select “Create”. 
5.3 Assign a descriptive name (e.g., PPY23_FNC). 
5.4 Select desired attributes and click “Add”. 
5.5 Select desired delimiters and click “Add”. 
5.6 Leave file location as the default. 
5.7 Look at the “Preview of File Name” field for accuracy. 
5.8 Mark “Locked” and click “Save”. 

File Name Convention: 

 
  



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 247 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

6.0 Create a Results Group 
6.1 Navigate to the Library and Select “Results Group”. 
6.2 Select “Create”. 
6.3 Assign a descriptive assay name (e.g., . PPY_ResultsGroup). 
6.4 Select the desired attributes and click “Add”. 
6.5 Select the desired delimiters, if there are multiple delimiters click the “Add 

between attributes” box and click “Add”. 
6.5.1 The order of the attributes and delimiters can be changed using the 

“Move Up” and “Move Down” buttons. 
6.6 Ensure that “Store reinjection sample file with original sample files (same 

level)” is selected. 
6.7 Leave file location as the default. 
6.8 Click so the “Include a Result Group Name folder” box is selected. 
6.9 Look at the “Preview of “Results Group Name” field for accuracy. 
6.10 Mark “Locked” and click “Save”. 

Results Group:
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 APPENDIX 12 
GeneMapperTM ID-X Version 1.6 Software - PowerPlex® 

Y23 Software Settings 
1.0 Importing Panel and Bin Files for use with WEN ILS 500 

1.1 Open the GeneMapperTM ID-X Version 1.6 software. 
1.2 Select Tools → Panel Manager. 
1.3 Highlight the “Panel Manager” icon in the navigation pane. 
1.4 Select File → Import Panels. 
1.5 Navigate to the saved panel, bin, and stutter files.  Select 

“PowerPlexY23_Panels_IDX_v2.0” then click “Import”.   
1.6 Select the “ISP Casework Security Group”. Click “OK”. 
1.7 In the navigation pane, highlight the “PowerPlexY23_Panels_IDX_v2.0” folder. 
1.8 Select File → Import Bin Set. 
1.9 Select “PowerPlexY23_Bins_IDX_v2.0” then click “Import”. 
1.10 In the navigation pane, highlight the “PowerPlexY23_Panels_IDX_v2.0” folder.  
1.11 Select File → Import Marker Stutter. A warning box will appear asking to 

overwrite the current values. Select “Yes”.   
1.12 Select “PowerPlexY23_Stutter_IDX_v2.0” then click “Import”. This will import 

the Promega Marker Stutter file that has been modified to include the Indiana 
State Police PowerPlex® Y23 stutter percentages for filtering out stutter as 
determined by the internal validation studies.  

1.13 In the Panel Manager window, select “Apply”, then “OK”. 
2.0 Creating a Casework Analysis Method 

2.1 Select Tools → GeneMapper Manager. 
2.2 Select the “Analysis Methods” tab. 
2.3 Select “New” and a new analysis method dialog box will open. 
2.4 Enter the name: “PowerPlex Y23 WEN”. 
2.5 Select the “ISP Casework Security Group”. 
2.6 Select the “Allele” tab.  In the “Bin Set” drop-down menu select 

“PowerPlexY23_Bins_IDX_v2.0”.  Ensure that the “Use marker-specific stutter 
ratio and distance if available” box is checked. The table values may be left as 
the factory defaults. 
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The Allele Tab: 

 
 

2.7 Select the “Peak Detector” tab. Change the settings to match the figure below.  
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The Peak Detector Tab: 

 
 

2.8 The Peak Amplitude Threshold (analytical threshold) values were determined during 
the internal validation by calculating the noise level of each instrument and 
determining the cut-off in which the majority of the noise peaks would be below. 
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2.9 Select the “Peak Quality” tab. Change the settings to match the image below. 
The Peak Quality Tab: 

 
2.10 Leave the “SQ and GQ Settings” tab set to the factory defaults.  
2.11 Select “Save”. 
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3.0 Creating a Size Standard 
3.1  Select Tools → GeneMapper Manager.  
3.2 Select the “Size Standard” tab and click “New” 
3.3 Create the “WEN ILS 500” size standard (see figure below for exact settings 

and sizes). 
3.4 Select “OK”. 
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4.0 Creating a Table Setting 
4.1 Select Tools → GeneMapper Manager. 
4.2 Select the “Table Setting” tab and click “New”. 
4.3 Under the “General” tab, name the Table Setting “PPY23” and select the “ISP 

Casework Security Group”. 
4.4 Under the “Samples” tab, ensure that check marks are located next to only the 

following:  Status, Sample File, Sample Name, Sample Type, Analysis Method, 
Panel, Size Standard, Sizing Quality Overridden, Sample File Not Found, 
Sample Off-Scale, and Sizing Quality.  Leave the font “Arial” and the size “11”. 
Sort by “Sample Type” and then by “Sample Name”. Select the “Ascending” 
option for both, and leave the final sort option to “None”. 

4.5 Under the “Genotypes” tab, ensure that check marks are located next to only 
the following:  Sample Name, Marker, Allele, and Height.  Sort by “Sample 
Name”, then by “Marker”, and then by “None”.  Select the “Ascending” option 
for all three.  Change the “Show number of alleles” to 8 and check “Keep Allele, 
Size, Height, Area, Data Point, Mutation and Comment together”. (If the option 
to “Keep Allele, Size, Height…” is not visible in the window, expand the window 
size until the option appears.)  Leave the font “Arial” and the size “11”. 

4.6 Select “OK”. 
5.0 Creating a Plot Setting – Samples, Controls, and Ladders 

5.1 Select Tools → GeneMapper Manager. 
5.2 Select the “Plot Settings” tab and click “New”. 
5.3 Under the “General” tab, name the Plot Setting “PPY23” and select the “ISP 

Casework Security Group”. 
5.4 Under the “Sample Header” tab, ensure that check marks are located next to 

the following:  Sample File, Sample Name, Panel, Sizing Quality Overridden, 
Sample Off-Scale and Sizing Quality. 

5.5 Under the “Genotype Header” tab, ensure that check marks are located next to 
the following:  Sample File, Sample Name, Panel, Marker, Sample Off-Scale, 
Out of Bin Allele, Peak Height Ratio, Control Concordance, and Genotype 
Quality. 

5.6 Under the “Sizing Table” tab, ensure that check marks are located next to the 
following:  Dye/Sample Peak, Sample File Name, Marker, Allele, Size, Height, 
Area, and Data Point.  Leave the font “Arial” and the size “11”. 

5.7 Select the “Labels” tab.  Change the settings to match the following figure.  
Alternatively, if the allele edit comment” function is being used, “Label 4” for 
“Assigned Allele”, “Custom Allele”, and “Artifact” can be changed to “AE 
Reason for Change”. 
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Labels Tab: 

 
5.8 Under the “Display Settings” tab, change the display settings so that they 

match the following figure and select “OK”. 
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Display Settings Tab: 
 

 
 

6.0  GeneMapper™ ID-X Maintenance 
6.1 The number of audit records on the GeneMapperTM ID-X database should be 

routinely checked. Audit records should be backed-up, saved to the DNA 
server, and then deleted from the GeneMapperTM ID-X database monthly or if 
the number of records exceeds 40,000.  If the number of audit records exceeds 
60,000, the performance of the software may be affected.  
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6.2 The amount of database space in the GeneMapperTM ID-X software should be 
routinely checked.  If the occupied space exceeds 80%, additional disk space 
should be allocated. 

 
  



INDIANA STATE POLICE 
FORENSIC BIOLOGY SECTION 

TEST METHODS 

Biology Test Methods                                                Page 258 of 266                   Issuing Authority: Division Commander 
Version 40                                                                                                                                            Revised 10/20/2025 

APPENDIX 13 
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APPENDIX 14 
OUTSOURCED SAMPLE ANALYSIS 

 
 

Samples may be sent to an external laboratory for analysis at the request and authorization of the investigating 
agency, prosecutor or by court order.  Payment arrangements for additional analysis shall be agreed upon by 
the appropriate entity prior to sending the samples.  Authorization to send the samples shall be documented in 
the case record.   
 
If possible, only a portion of the evidence should be sent with the remainder retained by the Forensic Services 
Division or returned to the contributing agency.  A subitem (or sub-subitem) of the evidence shall be generated 
for this purpose for tracking in LIMS.  Items and/or subitems sent for analysis shall be tracked in the Chain of 
Custody, including extracts.  Even though extracts are defined as work product, they shall be tracked in the 
Chain of Custody if being sent outside of the Forensic Services Division for the purpose of testing.  The Chain 
of Custody shall document “Carrier Delivery” and the laboratory name of where the evidence is being sent.  
Copies of the shipping paperwork and paperwork filled out for the laboratory doing the testing shall be 
documented in the case record.   
 
A Certificate of Analysis to the original submitting agency shall be generated to document the sample was sent 
out utilizing the wording specified in the report wording guidelines.   
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APPENDIX 15 
Electronic Case Record Generation and Review 

 
1. Electronic Generation of Case Record 

1.1. Analysts may electronically generate case notes using software (e.g., Microsoft Word), provided that 
the notes are clear, legible, and may be easily printed (if a paper record is being generated) or 
incorporated into PDF file format (if an electronic copy is being generated). 

1.1.1. If an official worksheet exists for the examination of a particular evidence workflow (e.g., the 
sexual assault kit worksheets), it shall be used (an analyst may not create their own). If a table 
is included in an analyst’s electronic case notes to record serology results and reagent lot 
numbers, only the approved table shall be used. 

1.1.1.1. Official worksheets and approved tables are available on SharePoint. 
1.2. Results of serological testing shall be recorded on the official stain identification worksheets or in the 

analyst’s generated case notes.  
1.2.1. All required controls, lot numbers, etc. shall be documented.  

 
2. Electronic Technical and Administrative Review 

2.1. At the reporting case analyst’s discretion, a case record may be created in or converted to an 
electronic (PDF) format prior to technical/administrative review.   

2.1.1. Exceptions shall be approved by a Unit Supervisor and documented in the case record.   
2.2. The electronic copy of the case record becomes the official, tracked copy, and is the copy utilized for 

technical and administrative review. 
2.2.1. All data sheets, notes, and other generated information which are normally kept in the paper 

case record shall be included in the electronic file. 
2.2.2. Every page shall include analyst’s initials and case number.   

2.2.2.1. These may be inserted by software (e.g., typed) or hand-written. 
2.2.3. Scanned documents from an original paper case record may be merged with electronically 

generated files to create the electronic copy. 
2.2.4. When the case has been administratively reviewed and uploaded into LIMS, any remaining 

paper copies should be destroyed. 
2.2.4.1. Paper copies should be retained at least 1 week prior to destruction in order to allow for 

a LIMS server backup. 
2.2.4.2. Paper copies should be destroyed within 2 months of administrative review. 

2.3. The analyst may make alterations to their electronic case record using software (e.g., Adobe), 
including but not limited to merging files, inserting/rearranging pages, adding text, strikethroughs, 
highlighting, and drawing lines.  

2.3.1. All alterations (except those with no data gain/loss, such as rearrangement) shall be initialed 
and dated. 

2.4. If a page of the electronic copy needs to be added, recreated, or removed, a watermark or other 
notation shall be placed on the original page stating the reason (e.g. “not used” or “page added”) with 
the case analyst’s initials and date. When data is rejected, the reason shall be listed.  New pages 
should be inserted before or after original pages when appropriate or as best organizes the data.  
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2.4.1. Examples: additional deconvolution worksheets generated after first review, or removal of a 
CODIS sheet for a profile deemed ineligible 

2.5. Completed case records ready for technical review shall be placed into a folder on the reporting 
analyst’s personal working drive, in a subfolder marked “Electronic Reviews”.  

2.5.1. Example: \ DNAworking \ IRL \ JDoe \ Electronic Reviews. 
2.5.2. The case report printed to PDF from LIMS should be saved in the same folder as a separate 

electronic document.  The case analyst shall verify the most up to date copy of the report is 
ready present for technical review.  

2.5.3. This folder shall be separate from the case folder and should include only temporary case 
records for technical and administrative reviews. Case data shall be stored on the secure DNA 
data drive. 

2.5.4. The analyst shall also upload the un-reviewed electronic copy to LIMS prior to technical review.  
This will preserve the record prior to changes.  

2.5.5. If changes are made to the electronic case record by the analyst after a technical reviewer has 
been assigned, the casework analyst shall notify the technical reviewer of such changes. 

2.6. Electronic records shall be retained as indicated in Appendix 9 unless otherwise indicated below. 
2.6.1. The original case record PDF file shall be named as follows:  

DNA_CASE#_REQUEST#_NOTES_ PE#_V0 
2.6.2. The final, technically reviewed case record PDF file shall be named as follows: 

DNA_CASE#_REQUEST#_NOTES_ PE#_V1 
2.7. If the case analyst is converting their case record to electronic format, they shall notify the appropriate 

supervisor/manager when their electronic case record is ready for technical review.  
2.7.1. If someone other than the case analyst has converted the case record to electronic format, they 

shall notify the case analyst and supervisor/manager (as appropriate).  The individual who 
scanned the case record shall place it in the case analyst’s data drive as indicated above.  The 
case analyst shall then upload the electronic record to LIMS as indicated above.   

2.8. The assigned technical reviewer shall use the electronic copy of the case record in the case analyst’s 
personal working folder for review.   

2.8.1. The technical reviewer shall save a copy of the technical review worksheet to the case analyst’s 
personal working folder to document the review.   

2.8.2. The technical reviewer shall check to ensure that the V0 copy is uploaded to LIMS prior to 
review. 

2.8.3. The technical reviewer should save comments to the analyst’s electronic copy.  
2.8.4. The technical reviewer’s electronic alterations to the case record should be limited to drawings 

with the drawing tool and/or comment boxes (i.e., “sticky notes”) within the comment tool in 
Adobe. 

2.8.4.1. All temporary alterations/comments shall be deleted by the technical reviewer before the 
casefile is finalized. 

2.8.4.2. Technical review notation made using the comment tool may be removed by printing the 
PDF file as a PDF file; there is an option in the print menu that allows keeping/omitting 
such markups and shall be selected as appropriate. 

2.8.5. A technical reviewer may opt to print the case record for their own review, at their discretion, but 
any generated paper copies shall be destroyed upon completion of review. 
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2.9. When technical review is complete, the case analyst shall add the completed technical review 
worksheet as the first page of the PDF case notes, save the electronic copy as the final copy, 
named as outlined above and upload it to LIMS.  The case analyst shall notify the appropriate 
supervisor/individual that it is ready for administrative review. 

2.10. If an additional request for lab exam is generated as part of the case exam (e.g., a Y-STR request), 
the case analyst is responsible for creating a print copy and forwarding that request to the case 
manager following administrative review. 

2.10.1. A copy of additional request form(s) should be retained in the original case notes. 
 

3. CODIS Upload and Review 
3.1. When a DNA profile is being submitted to CODIS for upload, the corresponding CMF file(s) shall be 

generated from the current version of STRmix and saved in the appropriate CMF server folder. 
3.1.1.  Paper submissions may be accepted in place of CMF files, pending the Local CODIS 

Administrator’s approval. 
3.2. When ready for CODIS upload, the technical reviewer shall send an email to all appropriate CODIS 

administrators which indicates the case number, and case analyst associated with the upload. Multiple 
cases may be sent in one email. 

3.3. The CODIS administrators will access the case record and CODIS sheet via the case analyst’s data 
review folder.  

3.3.1. A PDF file of the Specimen Detail Sheet (SDS) will be placed in the case analyst’s data review 
folder. The SDS will be labeled with the case number and “spec detail”. This becomes the 
official, tracked copy of the SDS. 

3.3.2. Paper submissions will be returned as a paper copy.  
3.4. A CODIS administrator will notify the case analyst via email when the upload is completed. 
3.5. The case analyst shall merge any electronic copies of the SDS with the electronic copy of the case 

record during review. 
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APPENDIX 16 
DBLR™ SOFTWARE SETTINGS 

 
1. DBLR™ Installation and Set-up 

1.1. Install the current version of DBLRTM (v1.5). 
1.2. Install ISP settings. 

1.2.1. Open C:\ProgramData\DBLR V1.5. DELETE the following folders: Allele frequencies, Data, 
Linkage Maps, Mutation Rates, Sequence Frequencies 

 
1.2.2. Navigate to BiologyQA→Validations→DBLR→DBLR v1.5 install files and COPY the following 

folders to C:\ProgramData\DBLR V1.5: Allele frequencies, Data, Linkage Maps, Mutation 
Rates, Sequence Frequencies 
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1.2.2.1. Optionally, for analysts trained to perform relationship comparisons, previously 
developed pedigrees may be imported into the Pedigrees folder. 

1.3. Open C:\ProgramFiles\DBLR. Copy and replace the DBLR.exe CONFIG File from the BiologyQA 
drive. (Note: you may need to first copy the CONFIG file to your desktop and then drag it into the 
C:\ProgramFiles\DBLR folder. 

1.3.1. Confirm the Date modified matches the image below. 

 
 

1.4. Open DBLRTM to connect to the floating license server: 
1.4.1. A warning window may open that indicates “The fingerprint of settings.xml does not match…”. 

Select “OK”. 
1.4.2. Enter Host Name:  10.16.104.65 
1.4.3. Confirm Port Number:  16091 

 
1.4.4. Select “Connect”.  
1.4.5. Review and agree to Software License Agreement. 

1.5. Confirm the settings update. 
1.5.1. Select the “Settings” tab in the main menu. Open the drop-down menus to confirm the images 

below. 
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1.5.1.1. When finished, close the settings window by selecting “Close without saving”. 
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	APPENDICES:
	2.8.8. Microcon® Concentration of Extracted DNA (Microcon® 100 or Fast Flow)
	2.8.8.1. To a Microcon® Concentrator add 100 µl TE-4.
	2.8.8.2. For Microcon® concentration immediately after organic extraction, transfer the aqueous phase (top layer) to the concentrator in the fume hood.  Avoid pipetting organic solvent from the tube into the concentrator.  For Microcon® concentration ...
	2.8.8.3. Close the cap on the concentrator and spin in a microcentrifuge at 500 rcf for at least 10 minutes. Microcon® 100 may be spun up to 1,200 rcf.
	2.8.8.4. Optional Step: Carefully remove the concentrator unit from the assembly and discard the fluid from the filtrate cup.  Return the concentrator to the top of the filtrate cup.
	2.8.8.5. Remove the cap and add 200 µl TE-4 to the concentrator.  Replace the cap and spin the assembly in a microcentrifuge at 500 rcf for at least 10 minutes. Microcon® 100 may be spun up to 1,200 rcf.
	2.8.8.6. Remove the cap and add a measured volume of TE-4 (40 µl is the recommended amount however, varied amounts can be added in some circumstances) to the concentrator.  Remove the concentrator from the filtrate cup and carefully invert the concent...
	2.8.8.7. Spin the concentrator in a microcentrifuge at 1,000 rcf for at least 3 minutes. The Microcon® 100 should be spun 500-1,200 rcf for at least 5 minutes.
	2.8.8.8. Discard the concentrator.  If desired, the sample can be brought up with additional water by adding it to the retentate cup.  Cap the retentate cup.
	2.8.8.10. Multiple Microcon® concentration steps may be performed to further clean up or concentrate any extract.  The same treatment shall be performed on the associated reagent blank (or a portion of) for each sample batch.
	2.8.19 Archiving Applied Biosystems® 3500 and GeneMapperTM ID-X Projects
	2.8.21 Interpretation Guidelines for PowerPlex® Fusion 6C and STRmix™ Deconvolutions
	2.8.21.1 Scope
	2.8.21.1.1 The following interpretation guidelines shall aid in peak/true allele determinations and profile interpretations.
	2.8.21.1.2 It shall be at the analyst’s discretion, based on experience and training, as to which peaks are suitable for interpretation and input into STRmix™.
	2.8.21.1.3 If an analyst has determined that a peak that has been labeled by the GeneMapperTM ID-X software is not a true allele peak, the analyst shall rename or delete the allele call label in GeneMapperTM ID-X.
	2.8.21.1.4 Final allele calls shall be documented on the STRlite pages retained in the case record.
	2.8.21.1.4.1 For unknown profiles, the STRlite Excel program utilizes a filter to display peaks in the allele table that fall below the mean + 3SD stutter value from the PowerPlex® Fusion 6C validation for backward (n-3/n-4/n-5) and forward (n+3/n+4/n...
	2.8.21.1.5 STRmix™ is a probabilistic genotyping software program for the interpretation of autosomal STR DNA profiling results.  STRmix™ can deconvolute (break down into individual contributors) a DNA mixture and attach a statistical weighting to com...
	2.8.21.1.5.1  The ISP Forensic Services Division has validated STRmix™ v2.7.0 for casework.
	2.8.21.2 DNA Profile Interpretation
	2.8.21.2.1 Assumptions used in the interpretation of mixtures and interpretation decisions shall be documented in the case record.
	2.8.21.2.2 Analysts shall consider the additive effects of allele sharing during interpretation.
	2.8.21.2.3 The flow of interpretation generally follows the steps listed below (Clayton, et al., 1998):
	Identify the presence of a mixture.
	Designate the allele peaks.
	Identify the number of contributors.
	Estimate the relative ratio of the individual contributors to the mixture.
	Consider all genotype combinations.
	Compare reference samples.
	Statistical analysis (if necessary).
	2.8.21.2.4 STRmix™ is utilized to perform the interpretation steps following the identification of the number of contributors.  The general approach to profile interpretation with STRmixTM is outlined here:
	A DNA profile or mixture previously analyzed in GeneMapperTM ID-X is assessed for suitability for STRmix™ analysis.
	If suitable, the profile/mixture is interpreted/deconvoluted within STRmix™.
	Reference samples are compared to the completed interpretation/deconvolution, and statistical calculations are performed reflecting that comparison (if necessary).
	STRmix™ outputs are reviewed for quality and all appropriate results are reported.
	2.8.21.2.5 Identify If the Profile Is A Mixture
	2.8.21.2.5.1 Single Contributor DNA Profile Determination
	2.8.21.2.5.1.1 Generally, a single source profile should contain no more than two alleles at each autosomal locus and no more than one allele at each Y-STR locus. However, three-peak allele patterns have been reported at autosomal loci for single-sour...
	2.8.21.2.5.1.1.1 A tri-allelic pattern for an autosomal locus. If a tri-allelic pattern is indicated, it should be confirmed by concordance to at least one additional sample contained within the case and/or re-amplification.
	2.8.21.2.5.1.1.1.1 Any locus with a confirmed tri-allelic pattern shall not be used for statistical evaluation.
	2.8.21.2.5.1.1.2 A duplication event for a Y-STR locus. If a duplication is indicated, the profile should be confirmed by concordance to at least one additional sample contained within the case and/or re-amplification and documented notification to th...
	2.8.21.2.5.1.2 For single source profiles, the peak height ratio (the smallest peak divided by the largest peak) of heterozygous individuals at a locus should be within 0.65.
	2.8.21.2.5.1.2.1 Samples may display peak height ratios less than expected when the sample is of poor quality or the amplification target is below the ideal input of template DNA.
	2.8.21.2.5.1.3 Conclusions shall be reported for all results in which the assumption of a single contributor is made.
	2.8.21.2.5.2 Mixed DNA Profile Determination
	2.8.21.2.5.2.1 A profile is defined as a mixture of two or more individuals when a locus demonstrates an additional allele, with the exception of a tri-allelic pattern at an autosomal locus or duplication event at a Y-STR locus.
	2.8.21.2.5.2.2 A peak height ratio less than 0.65 at a locus may indicate a mixed profile and that allele sharing may be occurring.
	2.8.21.2.5.2.2.1 Samples may display peak height ratios less than expected when the sample is of poor quality or the amplification target is below the ideal input of template DNA.
	2.8.21.2.5.2.3 Peaks in stutter position that exceed the mean +3 SD stutter percentage may indicate the presence of a mixture.
	2.8.21.2.5.2.4 All loci shall be considered when determining the presence of a mixture.
	2.8.21.2.5.3 Single Contributor Profiles in Which A Single Additional Allele is Detected (not tri-allelic)
	2.8.21.2.5.3.1 If the additional allele is present at Amelogenin or a Y-STR locus:
	2.8.21.2.5.3.1.1 If it is possible drop-in (≤200 RFU), the analyst shall document that they interpreted the peak as drop-in and shall utilize the single source report wording.
	2.8.21.2.5.3.1.2 If it is >200RFU, this shall be considered an indication of an additional contributor.  The profile shall be deconvoluted in STRmix™ with the assumed number of contributors increased to two contributors.
	2.8.21.2.5.3.1.2.1 If the peak is in stutter position, the expected stutter RFU (mean) does not count toward the 200 RFU cut-off to manually allow for the additive effect of stutter and drop-in.
	2.8.21.2.5.3.2 If the additional allele is present at an autosomal locus:
	2.8.21.2.5.3.2.1 If it is possible drop-in (≤200 RFU), the assumed number of contributors should not be increased to two contributors and STRmix™ shall be allowed to model the peak.
	2.8.21.2.5.3.2.1.1 If the sample is not being modeled in STRmix™ due to it being consistent with an assumed standard, the analyst shall document that they interpreted the peak as drop-in and shall utilize the single source report wording.  If the peak...
	2.8.21.2.5.3.2.2 If it is >200 RFU, this shall be considered an indication of an additional contributor.  The profile shall be deconvoluted in STRmix™ with the assumed number of contributors increased to two contributors.
	2.8.21.3 Preliminary Evaluation of Allele Peaks
	2.8.21.3.1 An analyst is required to visually confirm that all allelic ladders used for allele designation performed correctly.
	2.8.21.3.2 The internally validated analytical threshold for Fusion 6C is 100 RFU for the Blue, Green, and Yellow dye channels, 120 RFU for the Red dye channel, and 60 RFU for the Purple and Orange dye channels.  These values shall be used for interpr...
	2.8.21.3.2.1 Peaks below analytical threshold shall not be interpreted, but may be considered when deciding if the possible number of contributors can be reasonably assumed.
	2.8.21.3.2.2 For reference standards, 150 RFU shall be used as the analytical threshold for all Fusion 6C dye channels.
	2.8.21.3.3 There is no static stochastic threshold used for STRmix™ interpretation.  However, a stochastic threshold value of 950 RFU will be utilized to evaluate reference samples for completeness when a single allele is detected at a locus.
	2.8.21.3.3.1 If a reference sample has a locus with a single peak present <950 RFU, the locus shall be ignored in the STRmix™ deconvolution (if the reference sample is being utilized for conditioning) or likelihood ratio calculation (if the reference ...
	2.8.21.3.4 All interpretable autosomal peaks in unknown samples shall not exceed 28,000 RFU.  Exceptions may be allowed with Technical Leader approval documented in the case record.
	2.8.21.3.4.1 Unknown profiles with autosomal peaks over 28,000 RFU should be interpreted with caution, as modeling parameters utilized in STRmix™ may not model profiles with saturated peaks optimally.
	2.8.21.3.4.2 Reference samples and positive control profiles may have up to two autosomal loci with peaks over 28,000 RFU.  These profiles should be interpreted with caution.
	2.8.21.3.5 An initial interpretation of the data shall be made to distinguish non-allelic artifact peaks (e.g., pull-up, spikes, dye blobs, etc.) from true allelic data.
	2.8.21.3.5.1 Artifacts have been observed and documented utilizing the PowerPlex® Fusion 6C amplification kit. Any artifact peaks called as alleles by the GeneMapperTM ID-X software shall be deleted or renamed in the software as an artifact. The case ...
	Amelogenin, D1S1656, DYS391, FGA – n-1
	D13S317, D18S51, vWA, D7S820, D5S818, D19S433, FGA – n-2
	Other DNA-independent artifacts have been documented in the following dyes:
	FL-6C (Blue) - ~65-75 bp, ~113 – 120 bp, ~137 – 145 bp
	JOE-6C (Green) - ~60 – 66 bp
	TMR-5C (Yellow) - ~57-62 bp
	2.8.21.3.5.2 Pull-up or bleed through peaks can occur if signal intensity of sample or ILS peaks are too high or if a new spectral calibration needs to be run. Any pull-up peaks called as alleles by the GeneMapperTM ID-X software shall be deleted or r...
	2.8.21.3.5.3 Spikes are peaks that generally appear in all colors and are sharper than regular peaks; however, they can occur predominantly in one color. Spikes are a natural consequence of capillary electrophoresis and can be caused by dust present i...
	2.8.21.3.6 Stutter peaks are artifacts of the amplification process and display less intensity than the true parent peak. Stutter peaks will typically be observed one repeat unit shorter than the parent peak (ex. n-4 at a tetranucleotide STR), but may...
	2.8.21.3.6.1 Stutter peaks in the backward (n-3/n-4/n-5) and forward (n+3/n+4/n+5) positions at the autosomal loci, as well as in the n-2 position for locus SE33, are modeled by STRmixTM and shall not be removed from GeneMapperTM ID-X data of unknown ...
	2.8.21.3.6.2 The stutter peaks listed below are not modeled by STRmixTM and shall be removed from GeneMapperTM ID-X data of unknown profiles destined for STRmix™ analysis.  GMID-X stutter filters can aid in the removal of these stutter peaks below the...
	2.8.21.3.6.2.1 Stutter peaks in the double-backward position (n-6/n-8/n-10).
	2.8.21.3.6.2.2 Partial repeat (n-2/n+2) stutter peaks not included above (most common for D1S1656, D19S433, SE33 n+2 only and FGA).
	2.8.21.3.6.2.3 All stutter peaks at the Y-STR loci.
	2.8.21.3.6.3 For reference profiles, all stutter peaks shall be deleted.
	2.8.21.3.7 Rare variants (microvariants) have been described in the literature. These peaks will have a similar intensity to the other allelic peaks for that locus but will not line up with the allelic ladder and will fall outside of established bins.
	2.8.21.3.7.1 Any allele peak that is not present in the allelic ladder and does not have an associated “bin” in the GeneMapperTM ID-X analysis software is labeled “OL” (Off-Ladder) and shall be renamed by the analyst in the software.
	2.8.21.3.7.1.1 Alleles which are located between two alleles on the ladder shall be described as the short repeat followed by the number of base pairs it is larger (e.g., 0.1, 0.2, 0.3, or 0.4). Therefore, if a peak is 1 base pair larger than the 5 al...
	2.8.21.3.7.1.2 Alleles which are located outside the range of the ladder or bin set but within the designated marker range of the locus shall be evaluated to determine the appropriate repeat number that should be assigned to the allele.
	2.8.21.3.7.1.2.1 Any allele recognized by the CODIS software to fall outside of the allelic ladder shall be renamed during CODIS entry as “<” the smallest allele or “>” the largest allele for the locus.
	2.8.21.3.7.1.3 Alleles which are labeled “OMR” (Outside Marker Range) by the GeneMapperTM ID-X analysis software shall be evaluated to determine which locus the allele likely belongs to.  If the analyst can reasonably determine which locus the allele ...
	2.8.21.3.7.1.4 In instances where non-numeric alleles (e.g., OL and/or OMR) are marked and retained in the GeneMapperTM ID-X data, the resulting STRmixTM run shall be analyzed with that locus ignored from analysis.
	2.8.21.3.7.2 Unresolved peaks may be observed with alleles and/or stutter peaks that are one bp apart.  Most often this is observed at loci that have partial repeat alleles (e.g., D1, D12) and it occurs if the allele peak is very large and the allele ...
	 If the unresolved peak is estimated to be below the analytical threshold, no action is required, proceed with analysis.
	 If the unresolved peak is above the analytical threshold, determine if the peak is potentially allelic or likely stutter. If the peak is potentially allelic, the locus shall be ignored in deconvolution.
	 If the unresolved peak is likely stutter in a single source sample, the unlabeled stutter shall be documented in the notes and analysis can proceed as normal.  Careful evaluation of the STRmix™ deconvolution shall be done as the stutter variance wil...
	 If the unresolved peak is in a stutter position in a mixture, the estimated peak height shall be evaluated. If the estimated peak height is roughly equal or greater than the RFU height of minor alleles, the locus shall be omitted in the STRmix™ deco...
	2.8.21.4 Evaluation of Controls
	2.8.21.4.1 Failed controls require documented notification to the Technical Leader with appropriate documentation in the case record.
	2.8.21.4.2 The appearance of pull-up or known artifact peaks does not render the following controls inconclusive.
	2.8.21.4.3 Reagent Blank:
	2.8.21.4.3.1 The purpose of the reagent blank is to determine if the reagents used to extract the associated samples were contaminated by human DNA. Therefore, no signal should be detected in this sample well other than the internal lane standard. If ...
	2.8.21.4.3.2 A reagent blank with peaks below the analytical threshold shall not prevent associated samples from being interpreted.
	2.8.21.4.3.3 A reagent blank with peaks at or above the analytical threshold shall be considered a failed negative control.
	2.8.21.4.4 Positive Control:
	2.8.21.4.4.1 The 2800M DNA is used as a positive control to demonstrate that the kit is performing properly.  A positive control is considered a failed positive control if expected alleles are not detected, a single autosomal locus peak is < 950 RFU, ...
	2.8.21.4.5 Amplification Blank:
	2.8.21.4.5.1 The purpose of the amplification blank is to determine if human DNA contaminated the samples at the amplification step. Because no template DNA was placed in the reaction, the sample should be blank except for the internal lane standard p...
	2.8.21.4.5.2 An amplification blank with peaks below the analytical threshold shall not prevent associated samples from being interpreted.
	2.8.21.4.5.3 An amplification blank with peaks at or above the analytical threshold shall be considered a failed negative control.
	2.8.21.4.6 Interpreting, Comparing and Reporting DNA results associated with Failed Controls and Contamination Events
	2.8.21.4.6.1 The Technical Leader shall be notified if a positive or negative control fails and/or if sample contamination occurs. Sample contamination is defined as additional peaks present in an unknown or reference sample that can be conclusively i...
	2.8.21.4.6.2 Assessment of the integrity of the associated DNA results shall be done in consultation with the Technical Leader.  This shall include the possible cause and effect of the failed control or contamination.  Additionally, an assessment of t...
	2.8.21.4.6.2.1 If retesting is performed, the reasons for doing so shall be documented.
	2.8.21.4.6.2.2 If results are determined to be suitable for interpretation without retesting, the appropriate interpretations, comparisons, and statistical results and a description of the failed control or contamination event shall be reported per th...
	2.8.21.4.6.2.3 If results are determined to not be suitable for interpretation and retesting cannot be performed, the results shall be reported as not suitable for comparison per the Report Writing Guidelines.
	2.8.21.4.6.3 Documentation in the case record shall include at a minimum: the forensic sample, reference, or control test result that failed or was contaminated, the likely or known cause of the failed control or contamination, the likely or known sou...
	2.8.21.5 Determination of the Assumed Number of Contributors
	2.8.21.5.1 The assignment of the number of contributors to a profile should be made by the analyst prior to the comparison of the profile to any reference samples.  Reference sample profiles from individuals who are assumed to be present in a sample a...
	2.8.21.5.1.1 The profile from the corresponding fraction of a differential extraction may also be used to aid in the determination of the number of contributors.
	2.8.21.5.2 Determination of the number of contributors shall be done at the analyst’s discretion, based on experience and training, and should take into account peak height ratios and possible genotype pairings, as well as sub-analytical threshold and...
	2.8.21.5.3 Depending on sample data, an analyst may assign the number of contributors to a sample as one, two, three, four, or at least five.
	2.8.21.5.4 In circumstances when the number of contributors cannot be determined, the profile is reported as too complex to interpret (inconclusive).  Such profiles include:
	 5 person or greater mixtures
	 Sample results with data at less than two autosomal loci
	 Sample results with poor quality data in which peak number, peaks below analytical threshold, peak height ratios and other qualitative factors prevent the reasonable determination of the number of contributors
	2.8.21.5.5 The following steps should be followed in assigning the number of contributors to a profile:
	2.8.21.5.5.1 Review the profile as a whole, assessing the level of degradation, presence of low level peaks, noisy or clean baseline and the general quality of the profile.
	2.8.21.5.5.2 If replicate amplifications have been undertaken, all qualifying replicate profiles should be reviewed when determining the number of contributors.
	2.8.21.5.5.3 Identify possible stutter peaks (both forward and backward) by reference to stutter table (see Appendix 6).
	2.8.21.5.5.4 Find the locus with the highest number of unambiguous allelic peaks to determine the minimum number of contributors.  Peak height imbalance between alleles may mean the presence of an additional contributor(s) above that indicated by alle...
	2.8.21.5.5.5 If one or more contributors at this locus is a clear major, check that this pattern is represented at other loci.
	2.8.21.5.5.6 Apply the general pattern of contributors (e.g., number of alleles, peak height ratios) to other loci in the profile.
	2.8.21.5.5.7 Discriminating loci such as FGA and SE33 are likely to be the most informative when determining the number of likely contributors.
	2.8.21.5.5.8 The presence of a single minor peak or elevated stutter may indicate the presence of drop-in and not an additional contributor.
	2.8.21.5.5.8.1 If a single additional allele at a Y-STR locus that is <200 RFU is the only indication of an additional contributor, the peak shall be deleted and documented on the electropherogram as drop-in. The number of contributors shall not be in...
	2.8.21.5.5.8.2 If the peak is in stutter position the expected stutter RFU (mean) does not count toward the 200 RFU cut-off to account for the potential for drop-in and stutter being additive.
	2.8.21.5.5.9 After initial assignment of the number of contributors and subsequent STRmix™ analysis, and prior to comparison with the person of interest reference profiles, the analyst may determine that the deconvolution did not conform to scientific...
	2.8.21.5.5.10 The Variable Number of Contributors (varNOC) function in STRmix™ may be utilized if the analyst is unable to determine a single number of contributors estimate, but feels the data quality is suitable for STRmix™ analysis.
	2.8.21.5.5.10.1 It is recommended that the analyst utilize other troubleshooting methods to resolve the number of contributors (such a reamplification) prior to utilization of varNOC.
	2.8.21.5.5.10.2 Technical Leader permission is required if varNOC is utilized. DBLR software shall not be used with varNOC.
	2.8.21.5.5.10.3 The range of contributors evaluated in varNOC shall not exceed a difference of one contributor.
	2.8.21.6 General Interpretation Considerations for STRmix™
	2.8.21.6.1 STRmix™ should be used to deconvolute all qualifying samples, where a qualifying sample is defined as:
	2.8.21.6.1.1 All evidence DNA samples where the number of contributors can be assumed (up to four contributors) unless the profile is completely accounted for by conditioning.
	2.8.21.6.1.1.1.1 A sample demonstrating a partial profile may be interpreted if the number of contributors can be reasonably assumed. STRmix™ requires a minimum of two autosomal loci for interpretation.
	2.8.21.6.2 Evidence samples with identical profiles shall be analyzed independently with STRmix™.
	2.8.21.6.3 Y-STR loci present in PowerPlex® Fusion 6C shall only be used for interpretation purposes and not for statistical evaluations.  The Y-STR loci are not evaluated within the STRmix™ software.
	2.8.21.6.4 The basis of STRmix™ is that, given a set of mass parameters (e.g., DNA amount, degradation, and amplification efficiency), the software can determine the expected height of a peak of a certain size at a given locus.  If there are reasons f...
	2.8.21.6.4.1 Tri-allelic loci
	2.8.21.6.4.2 Somatic and primer binding site mutations
	2.8.21.6.4.3 Technical issues (saturated or poorly resolved GeneMapperTM ID-X data)
	2.8.21.6.5 If these effects are discovered after the original deconvolution (e.g. upon inclusion of a tri-allelic standard), a second deconvolution should be performed ignoring the affected locus.
	2.8.21.6.5.1 If the effect causes an analyst to change their original number of contributors decision, Technical Leader approval is required.
	2.8.21.6.6 Non-numeric values such as OL, <, or > are not permitted within the STRmix™ input files.
	2.8.21.6.7 The Ignore Locus function within STRmix™ may be used to ignore an affected locus within an interpretation.  A locus with this option selected will be removed from the subsequent deconvolution or LR from Previous calculation.
	2.8.21.6.7.1 Analyst discretion may be used to ignore a single locus within the STRmix™ deconvolution or LR from Previous calculation with reasoning documented in the case record.  Ignoring more than one locus requires Technical Leader approval with d...
	2.8.21.6.7.2 If a locus has been ignored due to the inability of STRmix™ to handle a biological effect (e.g., a tri-allelic locus), an analyst may document their manual interpretation for CODIS entry purposes only.
	2.8.21.6.8 A replicate is defined as a repeat amplification of the same extract and may be analyzed together in STRmix™ to aid sample interpretation, including determination of the number of contributors.
	2.8.21.6.8.1 Replicates may only be analyzed together through STRmix™ with Technical Leader approval documented in the case record.
	2.8.21.6.9 If it has been determined that a sample is unsuitable for interpretation, an explanation as to why the sample is un-interpretable should be given.  Examples include:
	2.8.21.6.9.1 No results:  No peaks were detected in the electropherogram.
	2.8.21.6.9.2 Inconclusive:  Peaks were observed at one or more loci; however, no conclusive results could be drawn due to an inability to reasonably determine the number of contributors.
	2.8.21.6.10 Test results from an unknown sample that are suitable for comparison to a reference sample may have the following conclusions reported:
	2.8.21.6.10.1 Included: The STRmix™ calculated HPD (Highest Posterior Density) Likelihood Ratio favors inclusion.
	2.8.21.6.10.2 Excluded:  The profile obtained from the unknown stain had discrepant genotypes as compared to the profile of the reference sample (i.e., was not the same) and can be visually excluded or the STRmix™ calculated HPD Likelihood Ratio favor...
	2.8.21.6.10.3 Uninformative:  The profile obtained from the unknown stain has sufficient ambiguity when compared to the profile of the reference sample and the HPD Likelihood Ratio falls in the uninformative range.
	2.8.21.6.11 If conclusive results are obtained from a sample, appropriate CODIS eligible profiles which do not match the victim shall be entered into CODIS for searching.  The analyst and technical reviewer shall evaluate CODIS eligibility before subm...
	2.8.21.7 Setting Up Propositions for Calculating the Likelihood Ratio (LR)
	2.8.21.7.1 The Likelihood Ratio (LR) assesses the probability of the evidence given two alternate propositions or hypotheses; one that aligns with the prosecution (H1 or Hp) and one that aligns with the defense (H2 or Hd).  H1 is typically inclusionar...
	2.8.21.7.2 Analysts will need to review all case information in order to determine which likelihood ratio calculations should be calculated and reported.  Multiple propositions may need to be considered.
	2.8.21.7.2.1 Examples:
	2.8.21.7.2.1.1 Two-person mixture from intimate swab collected from victim.  The victim and the Person of Interest (POI) cannot be excluded as possible contributors to the sample.
	H1: DNA originates from victim and POI
	H2: DNA originates from victim and unknown contributor
	2.8.21.7.2.1.2 Three-person mixture from firearm located at scene.  The POI cannot be excluded as a possible contributor to the sample.
	H1: DNA originates from POI and two unknown contributors
	H2: DNA originates from three unknown contributors
	2.8.21.7.2.1.3 Three-person mixture from firearm located at scene.  POI1 and POI2 both cannot be excluded as possible contributors to the sample.  Three separate LRs may be calculated:
	H1-1: DNA originates from POI1 and two unknown contributors
	-Or-
	H1-2: DNA originates from POI2 and two unknown contributors
	-Or-
	H1-3: DNA originates from POI1, POI2 and one unknown contributor
	H2: DNA originates from three unknown contributors
	2.8.21.7.3 Conditioning is defined as a DNA profile that is present in both propositions (H1 and H2) because it is reasonable to concede the presence of the individual’s DNA.  Conditioning where appropriate provides a more accurate likelihood ratio fo...
	2.8.21.7.3.1 At this time, only DNA reference samples may be used for conditioning, except as indicated for CODIS purposes only.
	2.8.21.7.3.2 The reference profiles shall have at least 20 complete autosomal loci (loci with no possible allelic drop-out).  In cases where degradation of the reference sample results in less than 20 complete autosomal loci and conditioning may be be...
	2.8.21.7.3.3 If a reference profile being used for conditioning is a partial profile or has loci with possible allelic drop-out (a single allele ≤ 950 RFU), the loci with incomplete allelic information shall be omitted from the STRmix™ deconvolution.
	2.8.21.7.3.4 The determination for the use of a reference profile for conditioning should be based on the analyst’s visual determination if the individual is included in the evidence profile.  A likelihood ratio should not be performed to determine if...
	2.8.21.7.3.5 Intimate samples should be conditioned on the owner, unless a single source foreign profile is obtained (e.g., sperm fractions or blood of another on one’s person).
	2.8.21.7.3.5.1 Intimate samples should also be conditioned on an elimination standard from a consensual partner.
	2.8.21.7.3.6 Non-intimate samples may be conditioned on elimination standards, depending on the profile and case information (e.g., steering wheel profile conditioned on owner or clothing profile conditioned on wearer).
	2.8.21.8 Initial STRmix™ Analysis for Evidentiary Sample Data (Deconvolution)
	2.8.21.8.1 To start a new STRmix™ deconvolution, from the STRmix™ main menu select Interpretation.
	2.8.21.8.1.1 Alternately, Batch Mode for deconvolutions may be utilized for multiple samples, which is accessed from the main menu and functions as below.
	2.8.21.8.2 In the Interpretation window, enter the case number in the “Case Number” box.   The deconvolution number should be entered after the item number in the “Sample ID” box.  For subsequent deconvolutions of the same item number, increase “Decon...
	2.8.21.8.3 Enter the proposed number of contributors for the sample (1, 2, 3, or 4), and select Confirm.
	2.8.21.8.4 Ensure the Contributor Range box is not checked if varNOC is not being utilized.
	2.8.21.8.4.1 If varNOC is being utilized, check the Contributor Range box.  Enter the minimum and maximum number of contributors.  The range of contributor number shall be +/- 1.  Select NIST_2017_Combined as the population for the range.
	2.8.21.8.5 Select Run Settings and ensure that the number of burn-in accepts per chain is set to 10,000, and the number of post burn-in accepts per chain is set to 50,000, and click Apply, then Next.
	2.8.21.8.5.1 For troubleshooting purposes, an analyst may increase the number of burn-in accepts per chain to 100,000, and the number of post burn-in accepts per chain to 500,000 with notification to the Technical Leader documented in the case record.
	2.8.21.8.5.2 Aside from number of accepts, no other changes should be made in Run Settings without Technical Leader approval.
	2.8.21.8.6 Verify that ISP_Fusion6C_v3 is the selected DNA kit used.
	2.8.21.8.7 Add a new profile to the box marked Evidence Profile Data.  This may be done by selecting + and navigating the file tree, or by dragging and dropping the appropriate GeneMapperTM ID-X export file into the box.  If multiple samples are prese...
	2.8.21.8.8 If conditioning on a reference sample, add a new profile to the box marked Reference Profile Data.  This may be done by selecting + and navigating the file tree, or by dragging and dropping the appropriate GeneMapperTM ID-X export file or p...
	2.8.21.8.9 After the reference profile is added, check the Contributor to: Hd box to reflect that it is a conditioned sample.
	2.8.21.8.10 Ensure that the Perform Database Search box is checked.
	2.8.21.8.11 To ignore loci from deconvolution, select Kit Settings, then select Loci, then select Ignore? for appropriate loci, then select Apply.
	2.8.21.8.12 Select Start.  This will begin a deconvolution analysis of the chosen sample and search the results against the ISP QA DNA Database.
	2.8.21.8.13 When the deconvolution is complete, STRmix™ will generate several data files and save them to the STRmixTM Results folder on the C: drive.
	2.8.21.8.14 Save each deconvolution folder to the DNA server for the appropriate case.
	2.8.21.9 Review of Run Diagnostics
	2.8.21.9.1 Upon completion, the Deconvolution Report shall be reviewed for quality by assessing the deconvolution diagnostics.  Skewed diagnostics may indicate that the sample is in need to further scrutiny (e.g., inclusion of inappropriate artifacts ...
	2.8.21.9.1.1 The weights of the genotype combinations generated by STRmix™ should be assessed at each locus for their intuitiveness when compared visually to the accompanying sample electropherogram.  These may be found under the Weights section of th...
	2.8.21.9.1.1.1 Rarely, due to limitations in stutter modeling for loci with complex repeat structures, STRmix™ may not model stutter peaks as expected (ex. 13 stutter peak from 14 allele at vWA).  If an analyst finds that a peak has not modeled as exp...
	2.8.21.9.1.2 Template (RFU) and Mixture Proportions
	2.8.21.9.1.2.1 Mixture proportions are calculated from the template mass parameter per contributor. The template amount in RFU should approximate the lowest molecular weight alleles/loci for a heterozygous peak (the value would need to be doubled for ...
	2.8.21.9.1.3 Degradation
	2.8.21.9.1.3.1 The degradation mass parameter per contributor is displayed in the STRmixTM report as two values. The first value is the Linear approximation (RFU/bp) which demonstrates the average decrease in RFU per base pair. The second value is the...
	2.8.21.9.1.4 Total Iterations and Acceptance Rate
	2.8.21.9.1.4.1 The Total Iterations value displayed in the Post Burn-In Summary indicates the total number of post burn-in MCMC iterations. This value, along with the number of accepts chosen for the analysis can inform the user as to how often a new ...
	2.8.21.9.1.4.2 A very low acceptance rate (e.g., 1 in thousands to millions) may, in combination with the other diagnostics, indicate that the analysis may benefit from a run with additional iterations. On its own (and without any other indication of ...
	2.8.21.9.1.5 The Effective Sample Size (ESS) value displayed in the Post Burn-In Summary is the number of independent samples the MCMC has taken from the posterior distribution of all parameters. A low ESS in relation to the total number of iterations...
	2.8.21.9.1.6 The log(likelihood) value displayed in the Post Burn-In Summary is the log of the average likelihood (or probability) value created at each of the post burn-in MCMC iterations. The larger this value the better STRmix™ has been able to des...
	 The profile is simply very low level and there is very little data making up the likelihood.
	 The proposed number of contributors does not model well (and may be incorrect), forcing an interpretation of large stochastic events (e.g., large heterozygote peak imbalances or variation in mixture proportions across the profile) in the STRmix™ run.
	 Data has been removed that was real, (e.g., stutter peaks), forcing an interpretation of dropout by STRmix™.
	 Artifacts have been left labelled (not removed) in the imported data, forcing an interpretation of drop-in by STRmix™.
	2.8.21.9.1.6.1 A low or negative value for the average log(likelihood) may indicate to users that the analysis requires additional scrutiny.
	2.8.21.9.1.6.2 Good quality mixed DNA profiles are likely to give higher average log(likelihood) values than good quality single source profiles.
	2.8.21.9.1.6.3 Low average log(likelihood) values alone are not necessarily an indicator of an issue, especially if the profile is single source.
	2.8.21.9.1.7 The Gelman-Rubin Convergence Diagnostic (GR) value displayed in the Post Burn-In Summary informs the user whether the MCMC analysis has likely converged. STRmix™ uses multiple MCMC chains to carry out the deconvolution, and ideally each c...
	2.8.21.9.1.7.1 If the GR is above 1.2 then there exists the possibility that the analysis hasn’t converged. If the GR value is above 1.2, STRmix™ will automatically run an additional 50,000 post burn-in accepts.  This may decrease the GR to below 1.2,...
	2.8.21.9.1.7.2 If the GR continues to remain above 1.2 after the additional post burn-in accepts, this may be an indicator that the sample requires rework.
	2.8.21.9.1.8 The allele, stutter, and Locus Specific Amplification Efficiency (LSAE) variance data depicted in the Variance Charts (see below for allele and back stutter variance only) can be used as a guide as to the level of stochastic variation in ...
	2.8.21.9.1.8.1 If the variance constant has increased markedly from the mode of the prior distribution, then this may indicate that the DNA profile is sub-optimal or that the number of contributors is incorrect.
	2.8.21.9.1.8.2 Used in conjunction with the average log(likelihood), a large allele variance or stutter variance constant can indicate poor PCR.
	2.8.21.9.1.8.2.1 A low-level sample may result in a low average log(likelihood) and an average variance constant.
	2.8.21.9.1.8.2.2 Data with missing information, extra information (e.g., artifact peaks), or misinterpreted data may result in a low average log(likelihood) and high variances.
	2.8.21.10 Indiana State Police Forensic Services Division Quality Assurance DNA Database Search Review
	2.8.21.10.1 In the Database Search Report, verify that no positive associations with LR ≥ 10,000 have occurred.
	2.8.21.10.2 Any database matches with a LR ≥ 10,000 should be evaluated for the likelihood of potential contamination.  The Technical Leader shall be consulted for evaluation of the match. If the match is determined to be a suspected contamination eve...
	2.8.21.10.2.1 Database matches (LR ≥ 10,000) shall be interpreted with caution and acknowledged in the report wording.
	2.8.21.10.2.1.1 The database profile shall be utilized and conditioned upon in an additional STRmix™ deconvolution.
	2.8.21.10.2.1.2 The database Excel tool shall be used to convert the database profile into the correct STRmix™ reference profile format.
	2.8.21.10.2.1.3 Any LRs calculated for the samples shall be performed on the deconvolution conditioned on the database profile.
	2.8.21.11 Evaluating Deconvolution Components for Comparison Suitability
	2.8.21.11.1 Any component of a mixture with STRmixTM determined template <50 RFU shall be considered unsuitable for comparisons. This does not apply to assumed individuals.
	2.8.21.11.2 All single-source profiles and STRmixTM determined template amounts for 2-person mixture components >150 RFU, 3-Person mixture components >250 RFU, and 4-Person mixture components >350 RFU shall be considered suitable for comparisons.
	2.8.21.11.3 DBLRTM v1.5 or currently approved version shall be used to evaluate individual contributor positions for the following components prior to comparison of reference standards, except assumed contributor(s), and calculation of LRs:
	 2-Person mixture components with STRmixTM determined template amounts from 50-150 RFU.
	 3-Person mixture components with STRmixTM determined template amounts from 50-250 RFU.
	 4-Person mixture components with STRmixTM determined template amounts from 50-350 RFU.
	2.8.21.11.3.1 Monte Carlo estimates <0.01 for P(Log10LR >= 0 | H2) shall be considered suitable for comparison to reference profiles and LRs shall be calculated/reported.
	2.8.21.11.3.2 Contributor positions which demonstrate a Monte Carlo estimate ≥ 0.01 for P(Log10LR >= 0 | H2) shall be considered unsuitable for comparison.
	2.8.21.11.3.2.1 Once a higher contributor has been identified as unsuitable for comparison, the lower contributors are automatically deemed unsuitable for comparison and DBLRTM shall not be run.  For example, in a 4 person mixture, if contributor 2 is...
	2.8.21.11.3.2.2 Any reference standard in which an LR is calculated and the contributor order giving the highest LR aligns with a contributor position determined to be unsuitable for comparison shall be reported as an exclusion.  The LR shall be marke...
	2.8.21.11.3.2.2.1 When running a combined LR with reference standards that have support for inclusion into the comparable portion of a mixture individually, and the combined LR statistic aligns one of the references into a contributor position determi...
	2.8.21.11.3.2.3 An LR need not be calculated for a reference standard that can be unambiguously excluded from the interpretable portion(s) of the mixture.
	2.8.21.11.4 To start a new DBLRTM evaluation, from the DBLRTM main menu select Explore Deconvolution.
	2.8.21.11.4.1 Drag and drop the sample deconvolution file folder or select Browse to navigate to the sample deconvolution and open the config file.
	2.8.21.11.4.2 Expand the Simulation menu and mark an appropriate contributor position for evaluation. If more than one contributor position requires evaluation, they shall be simulated independently.
	2.8.21.11.4.3 Open the Population menu and select ISP_NIST_Combined w iSNP: ISP_NIST_combined w iSNP (100%, Fst=0.01).
	2.8.21.11.4.4 Ensure the remaining search configuration settings match below:
	2.8.21.11.4.4.1 H1 Relationship: Contributor; H2 Relationship: Unrelated
	2.8.21.11.4.4.2 Include loci: All loci marked
	2.8.21.11.4.4.3 Log10(LR) threshold: 0 (corresponds to LR threshold of 1)
	2.8.21.11.4.4.4 Extended Output: Unmarked
	2.8.21.11.4.4.5 Sample: H1 true and H2 true marked; Additional hypothesis (H3) unmarked.
	2.8.21.11.4.4.6 Seed: Random
	2.8.21.11.4.4.7 Number of samples: 100,000
	2.8.21.11.4.5 Select Sample Likelihood Ratios
	2.8.21.11.4.6 Select Save Simulation Results. Save the DBLR results folder to the DNA data drive and add the PDF report to the case file.
	2.8.21.12 Comparing Sample Deconvolutions to Reference Standards (LR from Previous)
	2.8.21.12.1 A reference standard may be visually excluded without STRmix™ analysis.
	2.8.21.12.2 To compare reference STR profiles to a previously run STRmix™ deconvolution, from the STRmix™ main menu, select Investigation, then LR from Previous.
	2.8.21.12.2.1 Alternately, a Batch Mode for LR from Previous may be utilized for multiple samples, which is accessed from the main menu.  In the Add to Batch drop down menu, select add LR from Previous and then follow the instructions below.
	2.8.21.12.3 In the Previous Interpretation box, select Browse and navigate to the config.xml file for the appropriate STRmix™ deconvolution or drag and drop the deconvolution folder into the window.
	2.8.21.12.4 Leave the Case Number as it is carried over.  In the “Sample ID” box the appropriate LR number should be added behind LRPrev (e.g., 001A_Decon1_LRPrev1). Each LR calculated from a deconvolution shall have a unique identifier.  If additiona...
	2.8.21.12.4.1 The number of contributors, number of burn-in accepts per chain, and number of post burn-in accepts per chain will be grayed out and cannot be changed.  No changes should be made to Run Settings.
	2.8.21.12.5 Add a new profile to the box marked Reference Profile Data.  This may be done by selecting + and navigating the file tree, or by dragging and dropping the appropriate GeneMapper® ID-X export file or previous STRmix™ evidence file into the ...
	2.8.21.12.6 To ignore loci from deconvolution, select Kit Settings, then select Loci, then select Ignore? for appropriate loci, then select Apply.
	2.8.21.12.6.1 If a locus in the reference profile has potential allelic drop-out (a single allele ≤ 950 RFU), the locus shall be omitted from the LR from Previous calculation.
	2.8.21.12.7 If a varNOC deconvolution was performed, select LR Settings.  Under Contributor Range, select MLE for the priors method, then select Apply.
	2.8.21.12.7.1 Upon request by the submitting agency, Prosecuting or Defense attorney or with Technical Leader permission documented in the casefile, a User Defined LR may be performed.
	2.8.21.12.7.1.1 Select LR Settings.  Under Contributor Range, select User Defined for the priors method, enter the selected number of contributors for Hp and Hd, then select Apply.
	2.8.21.12.8 Select Start.  This will begin the LR calculation of the chosen sample.
	2.8.21.12.9 When the analysis is complete, STRmix™ will generate several data files and save them to the Results folder on the C: drive.
	2.8.21.12.10 Save the results folder for the LR calculation containing all appropriate STRmix™ files to the corresponding deconvolution master folder located on the DNA server for the appropriate case.
	2.8.21.13 LR Calculations
	2.8.21.13.1 Each analyzed proposition (and therefore each LR From Previous report) will contain a generated set of calculations including a Likelihood Ratio (LR) Total (sub-sub-source), Factor of N! (sub-source) LR, and a 99% 1-Sided Lower HPD Interval.
	2.8.21.13.2 The (sub-sub-source) LR Total is a ratio between the probability of the evidence given two competing propositions or hypotheses and forms the basis for subsequent statistical calculations.
	2.8.21.13.2.1 Calculations for (sub-sub-source) LR Total utilize the National Research Council recommendation 4.2, equations 4.10, more commonly referred to as the Balding & Nichols formulae.
	2.8.21.13.2.1.1 Homozygous   [2θ + (1-θ)p][3θ + (1-θ)p]
	[1+θ][1+2θ]
	2.8.21.13.2.1.2 Heterozygous  2[θ + (1-θ)p][θ + (1-θ)q]
	[1+θ][1+2θ]
	2.8.21.13.2.1.3 Each locus LR shall be multiplied together to form the multi-locus LR for the profile.
	2.8.21.13.3 The Factor of N! (sub-source) LR is a calculation that uses the (sub-sub-source) LR Total with additional consideration for the number of ways to combine the different contributor probabilities in a mixture.
	2.8.21.13.4 The HPD calculation uses the Factor of N! (sub-source) LR with additional consideration for the uncertainty in the allele frequencies and deconvolution process. HPD is the most conservative of the three calculations and will be used for re...
	2.8.21.13.5 Additionally, a Unified LR may be calculated under propositions that consider only a single person of interest. The unified LR takes into account that the unknown contributor(s) are made up of both unrelated people and relatives of the per...
	2.8.21.13.6 The varNOC Maximum Likelihood Estimate LR (MLE) assigns an LR using the most probable number of contributors under H1 and H2. This means the number of contributors in the numerator and denominator may be the same or they may be different. ...
	2.8.21.14 Troubleshooting STRmix™ Results
	2.8.21.14.1 After a STRmix™ analysis has completed, the results are interpreted by examining the weightings of various genotypes and the DNA results observed. There are instances when the results obtained do not intuitively seem correct. Examples of t...
	 Large LRs (greater than 1) are obtained for each locus, except one where the LR is 0.
	 The mixture proportions do not reflect what is observed.
	 The interpreted contributor genotypes are not intuitively correct.
	2.8.21.14.2 Possible causes for these issues include:
	 The MCMC has not run for enough iterations.
	 The number of contributors has not been correctly chosen.
	 An artifact was left in the GeneMapperTM ID-X interpretation.
	2.8.21.14.3 Should the weights and/or the diagnostics highlight to the user that further scrutiny is necessary then a number of rework options are available, if required. For example, a review of the proposed number of contributors could be considered...
	2.8.21.14.3.1 Additional troubleshooting options may be available after consultation with the Technical Leader (documented in the case record).  This may include utilizing informed priors to designate the mixture proportions utilized in the deconvolut...
	2.8.21.14.4 If after comparison to a reference sample from a person of interest, an analyst suspects an error was made during the interpretation of the sample (e.g., determining the wrong number of contributors or an artifact was not deleted), indepen...
	2.8.21.14.4.1 The analyst shall only provide the .hid files for the unknown sample of concern and the allelic ladder to the Technical Leader.  If a reference standard may be assumed, the .hid file for that reference may also be included.  If the analy...
	2.8.21.14.5 In a single source sample, if an error is discovered that did not affect the STRmix deconvolution of the sample (ex. a pull-up peak was not deleted, but it was modeled as drop-in), a second deconvolution does not need to be performed.  The...
	2.8.21.14.5.1  An error of this type requires a new deconvolution in a mixed sample.
	2.8.21.15 CODIS Eligibility and Entry
	2.8.21.15.1 Casework profiles shall be carefully evaluated for CODIS eligibility in accordance with National DNA Index System (NDIS) Operational Procedures “DNA Records Accepted at NDIS” and the flowchart “A Guide to Determining What is Allowable in t...
	2.8.21.15.2 Each year, every qualified analyst shall complete the ‘Annual Review of DNA Data Accepted as NDIS’. The timing of this review is specified by NDIS and completion is documented within the CODIS learning management system. Appropriate extens...
	2.8.21.15.3 If a casework profile is determined to be ineligible after CODIS entry and upload, that profile shall be deleted by a CODIS administrator. The case analyst shall issue a supplemental report stating that the profile was removed.
	2.8.21.16 Use of STRmix™ to aid in deconvolution of mixtures for CODIS entry
	2.8.21.16.1 Additional STRmix™ deconvolutions utilizing conditioning may be performed to aid in the deconvolution of a mixture for improved CODIS entry.
	2.8.21.16.1.1 If a mixture includes support for inclusion of a reference profile (an LR has been calculated in support for H1), the mixture may be deconvoluted conditioning on that reference profile to provide improved genotype weightings of an additi...
	2.8.21.16.1.1.1 The case documentation of this deconvolution shall be clearly marked as for CODIS purposes only.
	2.8.21.16.1.1.2 The analyst shall ensure all alleles to be entered in CODIS are present in the original mixture.
	2.8.21.16.1.1.3 The original deconvolution should generally be utilized for comparison if an evidentiary reference standard is submitted at a later date.
	2.8.21.16.1.2 If a mixture indicates that an additional single source unknown profile in the case cannot be excluded as a contributor, that unknown profile may be utilized to improve genotype weightings of an additional contributor for CODIS entry.
	2.8.21.16.1.2.1 The single source unknown profile may be reanalyzed in GeneMapperTM ID-X utilizing reference profile settings.
	2.8.21.16.1.2.2 The mixture may be deconvoluted conditioning on the reanalyzed single source unknown profile.
	2.8.21.16.1.2.3 The analyst shall ensure all alleles to be entered in CODIS are present in the original mixture.
	2.8.21.16.1.2.4 The case documentation of the reanalysis and the deconvolution shall be clearly marked as for CODIS purposes only.
	2.8.21.16.1.2.5 The original deconvolution with no conditioning on the unknown profile shall be utilized for all LR calculations.
	2.8.21.17 Use of the STRlite Excel program
	2.8.21.17.1 The ISP STRlite Excel program shall be utilized to provide a summary of GeneMapperTM ID-X allele calls for reference and unknown samples; as well as information collated from the STRmix™ deconvolution, database search and LR from Previous ...
	2.8.21.17.1.1 STRlite v2.0 (or most current version as approved by the Technical Leader) shall be utilized.
	2.8.21.17.1.2 Worksheets, as appropriate, from the STRlite program shall be maintained in the case record.  These worksheets may include Pre-STRmix, Deconvolution, Likelihood Ratios, Standards, CODIS, 1P Combo, and 2P Combo.  An electronic copy of STR...
	2.8.21.17.1.2.1 The STRlite Deconvolution page or a 1P/2P Combo worksheet shall be maintained for all deconvolutions that represent a valid interpretation of the profile.
	2.8.21.17.1.2.1.1 If an analyst error is made during a deconvolution run (e.g., An unintended number of contributors was entered, a pull-up peak was not deleted etc.), a deconvolution worksheet does not need to be generated for that run, but the STRmi...
	2.8.21.17.1.2.2 On STRlite Deconvolution pages, Combo worksheets, and CODIS pages, the use of “{ }” at a locus with one or two alleles clarifies that the 99% cumulative weighting contains more than one possible genotype (mixture or partial) and would ...
	2.8.21.17.1.2.3 For single source profiles, the analyst shall manually add results for Amelogenin to the CODIS worksheet.
	2.8.21.17.1.2.4 For mixed profiles, the analyst may manually add results for Amelogenin to the CODIS worksheet if they feel the data supports the determination.
	2.8.21.17.1.3 The electronic STRmix™ reports saved to the case folder on the DNA server shall be referenced for further troubleshooting as needed.
	2.9 Records:
	2.9.1 The appropriate worksheets as contained in the Worksheet Manual, STRlite, or the equivalent workbooks shall be used to record all procedures.
	2.9.2 All data sheets, notes, photographs, and other information generated from the laboratory examination shall be kept in the case record.
	2.9.3 The technical review of the case record shall be recorded on the technical review worksheet.
	2.9.4 Electronic records shall be retained as indicated in Appendix 9.
	2.10 Interpretations of Results:
	2.10.1 Interpretation guidelines are located within the Procedures Section 2.8.
	4.8.6. GeneMapperTM ID-X Version 1.6 Software - PowerPlex® Y23 Software Settings.  See Appendix 12
	4.8.7.1.2. In the “Add Samples to Project” screen, navigate to the run folder that contains the sample files.  If the entire run folder is to be imported, click on the folder to highlight it; then click the “Add to List” button at the bottom of the wi...
	4.8.7.1.2.1. A run folder shall not be created manually by manipulating sample files.
	4.8.7.1.3. Ensure that the necessary files are now located in the “Samples to Add” window by double-clicking on the folder in the right pane, then click “Add”.
	4.8.7.1.4. After the samples have been added to the project, first briefly scan the raw data to ensure that a bad injection did not occur.  To check the raw data, first expand the project folder in the left navigation pane, then click on a sample file...
	4.8.7.1.5. The GeneMapperTM ID-X project shall contain at least one allelic ladder from each run folder included in the project for proper genotyping.  Multiple allelic ladders within a run folder will be averaged by the software to calculate the alle...
	4.8.7.1.6. Ensure that the Table Setting at the top of the screen is set to “PPY23”.
	4.8.7.1.7. In the Sample Type column, verify that the correct sample types are displayed (e.g., Allelic Ladder, Sample, Positive Control, and Negative Control). Should a sample type need altered, use the drop-down menu to select the appropriate type.
	4.8.7.1.8. In the Analysis Method column, select the appropriate method from the drop-down menu: “PowerPlex Y23 WEN”.  Click the column header cell to highlight the entire column, then select “Edit”, then “Fill Down” (or the shortcut Ctrl + D).
	4.8.7.1.9. In the Panel column, select the appropriate panel file: Open the “PowerPlexY23_Panels_IDX_v2.0” folder then select “PowerPlexY23_IDX_v2.0”.  Click the column header cell to highlight the entire column, then select “Edit”, then “Fill Down” (...
	4.8.7.1.10. In the Size Standard column, select the appropriate ILS from the drop-down menu: “WEN ILS 500”.  Click the column header cell to highlight the entire column, then select “Edit”, then “Fill Down” (or the shortcut Ctrl + D).
	4.8.7.1.11. The Analysis Method, Size Standard, and Panel can be set as defaults when a GeneMapperTM ID-X project is opened.  Select File → Project Options.  Under the “Add Samples” tab select the above settings as the default in the drop-down menus f...
	4.8.7.1.12. Select the green Analyze arrow button to start the data analysis.  At the Project name prompt, save the project. The project name shall contain the date the 3500 plate was prepared so that it matches the run folder name. See the DNA Server...
	4.8.7.2. Evaluating Sample Data
	4.8.7.2.1. The Sizing Quality for unknown samples and allelic ladders shall be at least 0.75 for a sample to pass.  The Sizing Quality for reference samples, negative controls, and positive controls shall be at least 0.25 for a sample to pass.  All ap...
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